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Notice
While reasonable efforts were made to ensure that the information in this 
document was complete and accurate at the time of printing, Avaya Inc. 
can assume no liability for any errors. Changes and corrections to the 
information in this document may be incorporated in future releases.

Preventing toll fraud
"Toll fraud" is the unauthorized use of your telecommunications system 
by an unauthorized party (for example, anyone who is not a corporate 
employee, agent, subcontractor, or person working on your company's 
behalf). Be aware that there may be a risk of toll fraud associated with 
your system and that, if toll fraud occurs, it can result in substantial 
additional charges for your telecommunications services.

Avaya fraud intervention
If you suspect that you are being victimized by toll fraud and you need 
technical assistance or support, call Technical Service Center Toll Fraud 
Intervention Hotline at +1-800-643-2353 for the United States and 
Canada. For additional support telephone numbers, see the Avaya Web 
site:
http://www.avaya.com 
Select Support, then select Escalation Lists. This Web site includes 
telephone numbers for escalation within the United States. For escalation 
telephone numbers outside the United States, select Global Escalation 
List.

Providing telecommunications security
Telecommunications security (of voice, data, and video communications) 
is the prevention of any type of intrusion to (that is, either unauthorized or 
malicious access to or use of) your company's telecommunications 
equipment by some party.
Your company's "telecommunications equipment" includes both this 
Avaya product and any other voice/data/video equipment that could be 
accessed via this Avaya product (that is, "networked equipment").
An "outside party" is anyone who is not a corporate employee, agent, 
subcontractor, or person working on your company's behalf. Whereas, a 
"malicious party" is anyone (including someone who may be otherwise 
authorized) who accesses your telecommunications equipment with 
either malicious or mischievous intent.
Such intrusions may be either to/through synchronous (time-multiplexed 
and/or circuit-based) or asynchronous (character-, message-, or 
packet-based) equipment or interfaces for reasons of:

� Use (of capabilities special to the accessed equipment)
� Theft (such as, of intellectual property, financial assets, or 

toll-facility access)
� Eavesdropping (privacy invasions to humans)
� Mischief (troubling, but apparently innocuous, tampering)
� Harm (such as harmful tampering, data loss or alteration, 

regardless of motive or intent)
Be aware that there may be a risk of unauthorized intrusions associated 
with your system and/or its networked equipment. Also realize that, if 
such an intrusion should occur, it could result in a variety of losses to your 
company (including, but not limited to, human and data privacy, 
intellectual property, material assets, financial resources, labor costs, and 
legal costs).

Your responsibility for your company's telecommunications 
security
The final responsibility for securing both this system and its networked 
equipment rests with you, an Avaya customer's system administrator, 
your telecommunications peers, and your managers. Base the fulfillment 
of your responsibility on acquired knowledge and resources from a 
variety of sources, including, but not limited to:

� Installation documents
� System administration documents
� Security documents
� Hardware-/software-based security tools
� Shared information between you and your peers
� Telecommunications security experts

To prevent intrusions to your telecommunications equipment, you and 
your peers should carefully program and configure:

� Your Avaya-provided telecommunications systems and their 
interfaces

� Your Avaya-provided software applications, as well as their 
underlying hardware/software platforms and interfaces

� Any other equipment networked to your Avaya products.

Warranty
Avaya Inc. provides a limited warranty on this product. Refer to your 
sales agreement to establish the terms of the limited warranty. In 
addition, Avaya�s standard warranty language, as well as information 
regarding support for this product, while under warranty, is available 
through the following Web site:
http://www.avaya.com/support 

Link disclaimer
Avaya Inc. is not responsible for the contents or reliability of any linked 
Web sites and does not necessarily endorse the products, services, or 
information described or offered within them. We cannot guarantee that 
these links will work all of the time and we have no control over the 
availability of the linked pages.

Trademarks
Avaya is a trademark of Avaya Inc.

All trademarks identified by the ® or � are registered trademarks or 
trademarks, respectively, of Avaya Inc. All other trademarks are the 
property of their respective owners.

Third-party royalty-free license agreements
This product and future updates and service packs to this product may 
contain third-party royalty-free technology which is provided to you under 
terms and conditions which are different from your Avaya product license 
agreement. A file containing these third-party royalty-free licenses, 
3plirdme.txt or a similar name, is in the root directory of the product 
CD. Your use of this technology described in this file will be subject to the 
terms and conditions of such other license agreements, and not the 
Avaya product license agreement.

Ordering information: Avaya Publications Center
Voice: +1-207-866-6701

1-800-457-1764 (Toll-free, U.S. and Canada only)

Fax: +1-207-626-7269
1-800-457-1764 (Toll-free, U.S. and Canada only)

Write: Globalware Solutions
200 Ward Hill Avenue
Haverhill, MA 01835 USA
Attention: Avaya Account Manager

Web: http://www.avayadocs.com 
E-mail: totalware@gwsmail.com 
Order: Document No. 07-300100, Issue 2.0

June 2004

Avaya support
Avaya provides a telephone number for you to use to report problems or 
to ask questions about your contact center. The support telephone 
number is 1-800-242-2121 in the United States. For additional support 
telephone numbers, see the Avaya Web site:
http://www.avaya.com 
Select Support, then select Escalation Lists. This Web site includes 
telephone numbers for escalation within the United States. For escalation 
telephone numbers outside the United States, select Global Escalation 
List.

Comments
To comment on this document, send e-mail to crminfodev@avaya.com.
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Before you begin

This section includes the following topics:

● Typographical conventions on page 15.

● Notes, tips, and cautions on page 16.

● Contacting Technical Support on page 16.

● Product documentation on page 17.

● Educational services on page 19.

Typographical conventions
This guide uses the following font conventions: 

Font Type Meaning

command This font signifies commands, information that you type into the 
computer, or information contained in a file on your computer.

commandvariable This font indicates variables in a command string.

italics This font is used to add emphasis to important words and for 
references to other chapter names and manual titles.

link Blue underlined text in online documents indicates a hypertext 
jump to related information. 
To view the related material, click the blue underlined text.
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Notes, tips, and cautions
Note:

Note: A note calls attention to important information.

! Important:! Important:
Important: An important note calls attention to a situation that has the potential to cause 

serious inconvenience or other similar repercussions.

Tip:
Tip: A tip offers additional how-to advice.

! CAUTION:
CAUTION: A caution points out actions that may lead to data loss or other serious 

problems.

Contacting Technical Support
If you are having trouble using Avaya software, you should:

1. Retry the action. Carefully follow the instructions in written or online documentation.

2. Check the documentation that came with your hardware for maintenance or 
hardware-related issues.

3. Note the sequence of events that led to the problem and the exact messages 
displayed. Have the Avaya documentation available.

4. If you continue to have a problem, contact Avaya Technical Support by:

● Logging in to the Avaya Technical Support Web site http://www.avaya.com/support 

● Calling or faxing one of the following numbers from 8:30 a.m. to 8:30 p.m. (Eastern 
Standard Time), Monday through Friday (excluding holidays):

- Toll free in the U.S. and Canada: 1-888-TECH-SPT (1-888-832-4778)

- Direct line for international and domestic calls: 1-512-425-2201

- Direct line for faxes: 1-512-997-4330

http://www.avaya.com/support
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● Sending email with your question or problem to crmsupport@avaya.com. You may 
be asked to email one or more files to Technical Support for analysis of your 
application and its environment.

Note:
Note: If you have difficulty reaching Avaya Technical Support through the above 

URL or email address, please go to http://www.avaya.com for further 
information.

Product documentation
Most Avaya product documentation is available in both printed and online form. However, 
some reference material is available only online, and certain information is available only in 
printed form. A PDF document with detailed information about all of the documentation for 
the Avaya Interaction Center is included in the Doc directory on the product CD-ROM. This 
PDF document is also included on the separate documentation CD-ROM.

Readme file
The Readme file is a PDF file included on the Avaya Interaction Center software CD-ROM. 
This file contains important information that was collected too late for inclusion in the 
printed documentation. The Readme file can include installation instructions, system 
requirements, information on new product features and enhancements, suggested 
work-arounds to known problems, and other information critical to successfully installing 
and using your Avaya software. Avaya may also deliver an Addendum to the Readme, 
which will be posted on the Avaya Technical Support Website. The Readme Addendum will 
contain similar information uncovered after the manufacture of the product CD-ROM. 
Review the Readme file and the Readme Addendum before you install your new Avaya 
software.

Electronic documentation
The electronic documentation (in PDF or HTML format) for each Avaya Interaction Center 
product is installed automatically with the program. Electronic documentation for the entire 
Avaya product suite is included on the product CD-ROM and the documentation CD-ROM.

You can also view the documentation set online at http://www.avayadocs.com.

mailto:crmsupport@avaya.com
http://www.avaya.com
http://www.avayadocs.com
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Printed documentation
You can purchase printed copies of these manuals separately. For details, see Ordering 
information: Avaya Publications Center on the back of this manual�s title page.

License to print the electronic documentation
Online copies of documentation are included on the CD-ROM that accompanies every 
software release. An Avaya customer who has licensed software (a �Licensee�) is entitled 
to make this online documentation available on an internal network or �intranet� solely for 
the Licensee's use for internal business purposes. Licensees are granted the right to print 
the documentation corresponding to the software they have purchased solely for such 
purposes.

Right-to-print license terms

Documents must be printed �as-is� from the provided online versions. Making changes to 
documents is not permitted. Documents may be printed only by any employee or 
contractor of Licensee that has been given access to the online documentation versions 
solely for Licensee's internal business purposes and subject to all applicable license 
agreements with Avaya. Both online and printed versions of the documents may not be 
distributed outside of Licensee enterprise or used as part of commercial time-sharing, 
rental, outsourcing, or service bureau use, or to train persons other than Licensee's 
employees and contractors for Licensee's internal business purposes, unless previously 
agreed to in writing by Avaya. If Licensee reproduces copies of printed documents for 
Licensee's internal business purposes, then these copies should be marked �For internal 
use only within <Licensee> only.� on the first page or cover (where <Licensee> is the name 
of Licensee). Licensee must fully and faithfully reproduce any proprietary notices contained 
in the documentation. The copyrights to all documentation provided by Avaya are owned 
by Avaya and its licensors. By printing any copy of online documentation Licensee 
indicates its acceptance of these terms and conditions. This license only governs terms 
and conditions of printing online documentation. Please reference the appropriate license 
agreement for terms and conditions applicable to any other use, reproduction, 
modification, distribution or display of Avaya software and documentation.
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Educational services
Avaya University provides excellent training courses on a variety of topics. For the latest 
course descriptions, schedules, and online registration, you can get in touch with us:

● Through the web at http://www.avaya-learning.com/logon_form.asp

● Over the telephone at 800-288-5327 (within the U.S.) +001 303-406-6089 (outside of 
the U.S.)

● Through email at Avaya.U.Helpdesk@accenture.com 

http://www.avaya-learning.com/logon_form.asp
mailto:Avaya.U.Helpdesk@accenture.com
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Chapter 1: Introduction

Use the following information and procedures to install and configure an out-of-the-box 
Avaya IC system. If your Avaya IC system includes some customizations, install a 
development system first. You must test your customizations on the development system 
before you deploy your production system.

This section describes useful information that you should know before you install and 
configure an Avaya IC system. This section includes the following topics:

● Avaya IC installation files on page 22.

● Installing Avaya IC with other system components on page 23.

● Customizing Avaya IC on page 24.

● Port assignments on page 26.

● Ephemeral ports on page 38.
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Avaya IC installation files
Avaya� Interaction Center (Avaya IC) provides the installation files on the CD-ROMs 
described in the following table. With these CD-ROMs, you can install all of the 
components in an Avaya IC system.

CD-ROM Contents

Avaya IC CD-ROM 1 Contains the following files:
● Installer files for servers on Windows
● Installer files for Design & Administration Tools
● Installer files for the Agent Site Preparation wizard
● Documentation
● Connectors for supported IVRs
● Server SDK

Avaya IC CD-ROM 2 Contains the following files:
● Installer files for servers on Solaris and AIX
● Connectors for supported IVRs
● Server SDK

Avaya IC CD-ROM 3
Business Advocate for 
Avaya IC

Contains files required to install Business Advocate 
components.

Avaya IC CD-ROM 4
Avaya IC for Siebel 7 

Contains files and documentation required to integrate 
Avaya IC with Siebel 7.

Avaya Full Text Search 
Engine 1.0 CD-ROM

Contains files required to install and configure the Avaya 
Full Text Search Engine.

Avaya IC Documentation 
CD-ROM

Contains the complete set of documentation for Avaya IC 
with a search function that lets you search across the entire 
set.
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Installing Avaya IC with other system components
Avaya IC requires the following Avaya components that you install Avaya OA and Avaya 
FTSE from separate CD-ROMs:

● Avaya Operational Analyst (Avaya OA)

● Avaya Full Text Search Engine (Avaya FTSE) 

Both Avaya IC and Avaya OA require access to the IC Repository database. 

You must consider the requirements of Avaya OA when you plan, install, and configure 
your Avaya IC system.

This section describes the correct order to install and configure Avaya IC with Avaya OA 
and Avaya FTSE. This section includes the following topics:

● Installation order on page 23.

● Database properties on page 24.

! CAUTION:
CAUTION: For an Avaya IC deployment that includes Avaya IC and Avaya OA 

components on the same machine, to avoid potential port conflicts, always 
start the Avaya IC components first, then start the Avaya OA components.

Installation order
The installation and configuration of Avaya Full Text Search Engine (Avaya FTSE) is part 
of the configuration of Avaya IC. You must follow the correct installation order to ensure 
that IC Repository is correctly configured and that the Avaya IC system functions correctly. 

Install and configure the components of Avaya IC, Avaya OA, and Avaya Full Text Search 
Engine (FTSE) in the following order:

1. Install and configure all prerequisites in the following documentation, including the 
installation of your database software and the creation of your database instance:

a. For Avaya IC, see IC Installation Planning and Prerequisites.

b. For Avaya OA, see Operational Analyst Installation Planning and Prerequisites.

2. Install the Avaya IC servers and create the primary server environment, as described 
in Installing Avaya IC servers on page 49 and Creating the primary server 
environment on page 58.

3. Install the Design & Administration Tools, as described in Setting up Design & 
Administration Tools on page 62.
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4. Install Avaya FTSE, as described in Avaya Full Text Search Engine Installation and 
Configuration.

5. Configure Avaya IC, as described in this manual.

6. Configure Avaya FTSE, as described in Avaya Full Text Search Engine Installation and 
Configuration.

7. Install and configure Avaya OA for Avaya IC, as described in Operational Analyst 
Installation and Configuration.

Database properties
Both Avaya IC and Avaya OA use the values shown in the following table for their 
database properties.

Customizing Avaya IC
Use the information and procedures in this guide to install and configure an out-of-the-box 
Avaya IC system with little or no customization. If your Avaya IC system includes 
customization requirements, use this guide to install a development system. Use the 
development system to test and, if desired, customize your Avaya IC system.

For more information on how to customize Avaya IC components, see the other 
documentation in the Avaya IC documentation set. The introduction provided on the Avaya 
IC documentation CD-ROM includes a complete description of all documentation in the 
Avaya IC documentation set.

Property DB2 Oracle SQL Server

Database Administration 
Login

db2inst1 sys sa level user name

Database Administration 
Password

db2inst1 password sys password sa level password

IC Repository database 
name 
See Configuring the IC 
Repository database 
connection on page 91.

Database name that 
you enter in Database 
Designer. For 
example, repository.

Database name for 
the Oracle user that 
you enter in Database 
Designer. For 
example, repository.

Database schema 
name that you enter 
in Database 
Designer. For 
example, repository. 
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The following table describes some of the Avaya IC documentation that you can use to 
customize an Avaya IC system.

Avaya IC Component Documents

Avaya Agent ● Avaya Agent Integration
● IC Administration Volume 2: Agents, Customers, 

& Queues

Avaya Business Applications ● IC Database Designer User Guide
● IC Scripts Language Reference
● IC Scripts VBA Scripting Reference
● WebQ Reference

Avaya IC databases and data 
models

● IC Database Designer User Guide
● Data Model Reference files

Servers ● IC Administration Volume 1: Servers & Domains
● Agent Data Unit Server Programmer Guide
● Electronic Data Unit Server Programmer Guide
● IC Telephony Connectors Programmer Guide
● Core Services Programmer Guide
● IC Client and Server Programmer Design Guide
● Vox Server Programmer Guide

Telephony ● IC Administration Volume 1: Servers & Domains
● IC Telephony Connectors Programmer Guide
● Vox Server Programmer Guide
● External Function Library for Avaya IVR 

Programmer Guide
● Telephony Services for Aspect CallCenter
● Migration Guide

Workflows ● Avaya Workflow Designer User Guide
● Avaya IC Workflow API Reference
● Media Workflow Reference
● Agent Script Workflow Reference
● IC Scripts Language Reference
● IC Scripts VBA Scripting Reference

Avaya Business Advocate ● IC Business Advocate Configuration and 
Administration

● Media Workflow Reference

Avaya IC for Siebel 7 ● Avaya IC for Siebel 7 Integration
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Port assignments
The Avaya IC servers require several ports to communicate with other Avaya IC servers 
and third-party servers and applications. Whenever possible, use the default ports and 
locations in the Avaya IC configuration to reduce potential conflict. 

If an Avaya IC server uses a port that is already assigned to a network application or 
another server, either the server or the application may not function. 

This section describes the guidelines for assigning ports and the default port assignments 
in Avaya IC and Avaya OA. This section includes the following topics:

● Guidelines for assigning ports on page 26.

● Ports used by Avaya IC components on page 28.

● Ports used by Business Advocate components on page 32.

● Ports used by Avaya OA components on page 33.

● Ports used for Siebel Integration on page 34.

● Ports used for third party servers on page 34.

● Changing the default ICM service ports on page 35.

● Changing default service ports for servers on page 36.

! CAUTION:
CAUTION: To avoid potential port conflicts, for an Avaya IC deployment that includes 

Avaya IC and Avaya OA components on the same machine, always start the 
Avaya IC components first, then start the Avaya OA components.

Guidelines for assigning ports
This section includes the following topics:

● Allowable values on page 27.

● Multiple server instances on page 27.

● Automatic settings for Avaya IC core servers on page 27.

● Primary and secondary Avaya IC servers on page 27.

● Port verification on page 27.

● Changing default port assignments on page 28.
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Allowable values

All ports must be numeric and in the range of 1024-65535. 

Multiple server instances

Multiple instances of a server that run on the same machine require different port numbers 
for each instance.

Automatic settings for Avaya IC core servers

Port numbers for the Avaya IC core servers are sequential. Avaya IC assigns port numbers 
to all core servers according to the port assigned to the ORB server. For example, Avaya 
IC automatically assigns the ports in the following table to the servers that are added when 
you configure the primary server environment. When you configure the other servers, IC 
Manager assigns port numbers sequentially, starting with 9005.

Primary and secondary Avaya IC servers

If you install primary and secondary servers, use the default port number of 9001 for the 
primary port. You can use the same number for the secondary servers on another 
machine. If you select a different port, Avaya IC assigns ports sequentially from that port 
number.

Port verification

Avaya IC servers use TCP/IP ports for communication with the other Avaya IC servers. 
These ports start at 9001 and increment from there. Before you install these servers, verify 
with your network administrator that no other network applications use the same ports. 

Review the current port numbers in IC Manager to verify that there are no conflicts when 
you assign ports. 

Server Default Port

ORB server 9001

Directory server 9002

Alarm server 9003

License server 9004
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Changing default port assignments

You can change the default port numbers:

● When you configure Avaya IC servers

● In IC Manager

For more information, see Configuring core servers on page 113 or IC Administration 
Volume 1: Servers & Domains. 

Avaya OA does use some other ports. However, the CORBA third party product 
(ORBAcus) does not allow you to specify a range for those ports. ORBacus dynamically 
gets whatever port the operating system provides. You can tell the operating system what 
range of port it can assign to applications. For more information, see Ephemeral ports on 
page 38.

Ports used by Avaya IC components
The following table contains default port assignments for the Avaya IC servers and some 
third-party servers. To make sure that you assign unique ports to each server, write your 
port assignments in the empty cells of the Assigned Port column.

! CAUTION:
CAUTION: By default, Solaris runs the HTT Input Method Server (htt_server) on port 

9010. On non-English Solaris machines, this port assignment creates a 
conflict with any Avaya IC server that you configure to run on port 9010. To 
avoid the conflict, you can update htt_server to use a different port, or not 
assign an Avaya IC server to port 9010. In a typical installation, with the 
primary ORB server on port 9001, IC Manager automatically assigns port 
9010 to the Report server.

Server Default port Assigned Port Notes

ORB server 9001 Default port assignment.

Directory server 9002 Sequential from ORB server.

Alarm server 9003 Sequential from Directory server.

License server 9004 Sequential from Alarm server

Blender server Sequential Sequential from the previous 
server created in IC Manager.

Workflow server Sequential Sequential from the previous 
server created in IC Manager.
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ADU server Sequential Sequential from the previous 
server created in IC Manager.

Data server Sequential Connects to the following ports:
● Oracle database on 1521
● SQL Server database on 1433
● DB2 database on 50000
For DB2, this port is the default for 
the first DB2 instance that is 
created. Additional instances use 
a different port
Sequential from the previous 
server created in IC Manager.

EDU server Sequential Sequential from the previous 
server created in IC Manager.

Report server Sequential Sequential from the previous 
server created in IC Manager.

HTTP Connector server Sequential Connects to HTTP protocol on 
port 80.
Sequential from the previous 
server created in IC Manager.

Notification server Sequential Sequential from the previous 
server created in IC Manager.

WebACD server Sequential Sequential from the previous 
server created in IC Manager.

ComHub server Sequential Sequential from the previous 
server created in IC Manager.

Paging server Sequential Sequential from the previous 
server created in IC Manager.

Attribute server Sequential Sequential from the previous 
server created in IC Manager.

IC Email server Sequential Connects to the following ports:
● POP3 server on 110
● SMTP server on 25
Sequential from the previous 
server created in IC Manager.

DUStore server Sequential Sequential from the previous 
server created in IC Manager.

Server Default port Assigned Port Notes
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Telephony server Sequential Sequential from the previous 
server created in IC Manager.
Note: Some switch interfaces 
require additional ports. For more 
information, see the 
documentation for your switch.

TS Queue Statistics server Sequential Sequential from the previous 
server created in IC Manager.

VOX server Sequential Connects to the IVR through 
default port 3000. You can change 
this port assignment in the IVR.
Sequential from the previous 
server created in IC Manager.

Dialing Kernel server Sequential Sequential from the previous 
server created in IC Manager.

Softdialer server Sequential Sequential from the previous 
server created in IC Manager.

Content Analyzer 
Administration server

Sequential Sequential from the previous 
server created in IC Manager.

Content Analyzer Operation 
server

Sequential Sequential from the previous 
server created in IC Manager.

WebACD server - Service 
port (Legacy services)

4010 If you must change this port, see 
Changing the service port for the 
WebACD server on page 36.

ComHub server - Service 
port (Legacy services)

4001 If you must change this port, see 
Changing the service port for the 
ComHub server on page 36.

Paging server - Service port 
(Legacy services)

4200 If you must change this port, see 
Changing the service port for the 
Paging server on page 37.

Attribute server - Service port 
(Legacy services)

2300 If you must change this port, see 
Changing the service port for the 
Attribute server on page 37.

HTTP Connector server - 
HTTP request port

9170 Can change default if required.

WebQ 9180 Can change default if required.

WebQ Router 9190 Can change default if required.

Ports reserved for ICM and 
CIRS

9500 to 9520 See cells below for details.

Server Default port Assigned Port Notes
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Internet Call Manager service 
- ICM agent

9501 Change this port in the ICM 
Directory server table through 
Configuration tab of IC Manager.

Internet Call Manager service 
- ICM caller

9502 Change this port in the ICM 
Directory server table through 
Configuration tab of IC Manager.

Internet Call Manager service 
- ICM bridge in Attribute 
server port

9503 Change this port in the ICM 
Directory server table through 
Configuration tab of IC Manager.

Internet Call Manager service 
- ICM administration (Util 
port)

9504 Change this port in the ICM 
Directory server table through 
Configuration tab of IC Manager.

Internet Call Manager service 
- ICM tunnel

9505 If you must change this port, see 
Changing the ICM tunnel port on 
page 35.

CIRS service - CIRS servlet 
port

9506 If you must change this port, see 
Changing the CIRS servlet port on 
page 35.

CIRS service - CIRS 
administration (Util port)

9507 Change this port in the CIRS 
Directory server table through 
Configuration tab of IC Manager.
This port is used to monitor the 
CIRS server.

CIRS service - CIRS caller 9508 Change this port in the CIRS 
Directory server table through 
Configuration tab of IC Manager.

VMM server - VOIP caller 
port

8120 Used for Voice Chat.

Dialing Kernel server - 
serverport

7800 Used for outbound voice contacts.

IC Email server - Email 
provider port

19113 Used by Web Agent to retrieve 
email contacts from the IC Email 
server.

IC Email server - HTTP port 
for administration interface

19114 Used by Email Template 
Administration to send changes to 
the IC Email server.

Server Default port Assigned Port Notes



Introduction

32 Installation and Configuration

Ports used by Business Advocate components
The following table lists the ports used for Business Advocate, plus additional information 
on how to control those ports:

Website, Email Template 
Administration, QKnowledge, 
Letter Generator, Agent 
Installer, and ICM tunneling

Http - 80
Https - 443

HTTP and HTTPS connections for 
web applications.

Tomcat servlet 9600 HTTP port.
Change through the Configuration 
Tool. 
If you configure multiple Web 
applications on one machine, the 
Configuration Tool uses the 
following sequential ports:
● baseport+1 for Web License 

Manager 
● baseport+2 for Website
● baseport+3 for Email Template 

Administration
● baseport+4 for QKnowledge
● baseport+5 for Letter Generator
● baseport+6 for IC Test

Server Default port Assigned Port Notes

Component Default port Assigned port Notes

Business Advocate Resource 
Manager server

Sequential Sequential from the previous 
server created in IC Manager.

Business Advocate 
Telephony Services Adaptor 
server

Sequential Sequential from the previous 
server created in IC Manager.

Web Advocate Adaptor 
server

Sequential Sequential from the previous 
server created in IC Manager.

Advocate Services 1521 Use by connection to Oracle 
database.
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Ports used by Avaya OA components
The following table lists the default ports used by Avaya OA components. For information 
about ports used by the Event Collector server and the Event Collector bridge, see Ports 
used by Avaya IC components on page 28.

DCOM 5000 to 5050 Business Advocate servers that 
use DCOM, limit to 5000-5050.
See Microsoft Knowledge Base 
article 154596 and the article 
entitled "Using Distributed COM 
with Firewalls" by Michael Nelson

Active Directory and MSMQ per Windows 
configuration

See Microsoft Knowledge Base 
article 179442.

Windows network share to 
primary Resource Manager 
server.

per Windows 
configuration

See Microsoft Knowledge Base 
article 179442.

Component Default port Assigned port Notes

Component Default port Assigned port Notes

Avaya OA Event Collector 
server

Sequential Sequential from the previous 
server created in IC Manager.

Orbacus 10000 Orbacus naming service

OA services 1521 Used by connection to Oracle 
database. 

OA services 1433 Used by connection to Microsoft 
SQL Server database.

OA services 50000 Used by connection to IBM DB2 
database. 
This listen port is the default for 
the first DB2 instance that is 
created. Any additional instances 
will use a different port
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Ports used for Siebel Integration
The following table lists the ports used for Siebel integration servers and components, plus 
additional information on how to control those ports:

Ports used for third party servers
Avaya IC and Avaya OA also use third party servers which are accessed through TCP/IP. 
These third party servers include, but are not limited, to those listed in the following table.

Component Default port Assigned port Notes

Siebel AED server Sequential Sequential from the previous 
server created in IC Manager.

Siebel AICD server Sequential Sequential from the previous 
server created in IC Manager.

Siebel EAI server Sequential Communicates with Siebel on 
HTTP port 80.
You can configure this port by 
setting hostname:port on the 
Configuration tab of the server.
Sequential from the previous 
server created in IC Manager.

Default Port Protocol or Component Avaya IC Components

25 SMTP IC Email server and Web Management 
website

110 POP IC Email server and POP3 email servers

1433 SQL Server database Data server, Web Management website, 
and ICM connection for SQL Server 
installation

1521 Oracle database Data server, Web Management website, 
and ICM connection for Oracle 
installation

50000 DB2 database Data server, Web Management website, 
and ICM connection for DB2 installation
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Changing the default ICM service ports
You can change some ICM service ports as described in the following topics:

● Changing the ICM tunnel port on page 35

● Changing the CIRS servlet port on page 35

Changing the ICM tunnel port

To change the ICM tunnel port:

1. On the machine that hosts the ICM server, open the following file in a text editor: 
IC_INSTALL_DIR\IC61\comp\website\WEB-INF\web.xml

2. In the section for the Tunnel servlet, add a new parameter with the value in the 
following table:

3. Save the web.xml file.

4. Restart the Website.

Changing the CIRS servlet port

To change the CIRS servlet port:

1. On the primary machine that hosts the ICM server and the Website, open the following 
file in a text editor: IC_INSTALL_DIR\IC61\comp\website\WEB-INF\web.xml

2. In the section for the CIRS servlet, add a new parameter with the value in the following 
table:

3. Save the web.xml file.

4. Restart the Website.

Parameter Value

port new port number

Parameter Value

port new port number
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Changing default service ports for servers
You can change the default service ports, if required, as shown in the following topics:

● Changing the service port for the WebACD server on page 36

● Changing the service port for the ComHub server on page 36

● Changing the service port for the Paging server on page 37

● Changing the service port for the Attribute server on page 37

Changing the service port for the WebACD server

For more information about the WebACD server, see Creating the WebACD server on 
page 249.

To change the service port for the WebACD server:

1. In IC Manager, update the WebACD server configuration:

a. Double-click the WebACD server in the list of servers.

b. Select the WACD tab.

c. Change the port number in the Service Port field.

2. In Notepad or another text editor, open the Webadmin.cfg file, and change the service 
port property to the new port number.

Changing the service port for the ComHub server

For more information about the ComHub server, see Creating the ComHub server on 
page 254.

To change the service port for the ComHub server:

1. In IC Manager, update the ComHub server configuration:

a. Double-click the ComHub server in the list of servers.

b. Select the ComHub tab.

c. Change the port number in the Service Port field.

2. In IC Manager, update the masterserverport property of the WebACD server:

a. Double-click the WebACD server in the list of servers.

b. Select the WACD tab.

c. Change the value of the Comhub Port field to the new port.
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3. In IC Manager, update the Paging server configuration:

a. Double-click the Paging server in the list of servers.

b. Select the Paging tab.

c. Right-click on an empty area in the tab and select the Show Advanced Properties 
box.

d. Change the value of the Comhub Port field to the new port.

Changing the service port for the Paging server

For more information about the Paging server, see Creating the Paging server on 
page 255.

To change the service port for the Paging server:

1. In IC Manager, update the Paging server configuration:

a. Double-click the Paging server in the list of servers.

b. Select the Paging tab.

c. Change the port number in the Service Port field.

2. In IC Manager, update the port value for the Agent/Desktop/WAC property for each 
agent. You can change the global value for all agents through the Group Manager, or 
change the value for each agent. For more information, see:

● Setting global properties for all agents on page 389.

● Setting properties for individual agents on page 389.

Changing the service port for the Attribute server

For more information about the Attribute server, see Creating the Attribute server on 
page 252.

To change the service port for the Attribute server:

1. In IC Manager, update the Attribute server configuration:

a. Double-click the Attribute server in the list of servers.

b. Select the Attribute tab.

c. Change the port number in the Port field.

2. In Notepad or another text editor, open the datawake.cfg file, and change the service 
port property to the new port number.
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Ephemeral ports
A TCP/IPv4 connection consists of two endpoints, and each endpoint consists of an IP 
address and a port number. When a client user connects to a server computer, an 
established connection can be thought of as the combination of server IP, server port, 
client IP, client port. Usually, three of the four are readily known: the client machine uses its 
own IP address, and when connecting to a remote service, the server machine's IP 
address and service port number are required. 

What is not immediately evident is that when a connection is established, the client side of 
the connection uses a port number. Unless a client program explicitly requests a specific 
port number, the port number used is an ephemeral port number. Ephemeral ports are 
temporary ports assigned by a machine's IP stack, and are assigned from a designated 
range of ports for this purpose. When the connection terminates, the ephemeral port is 
available for reuse, although most IP stacks won't reuse that port number until the entire 
pool of ephemeral ports have been used. So, if the client program reconnects, it will be 
assigned a different ephemeral port number for its side of the new connection.

This section includes the following topics:

● Limits implied by the ephemeral port range on page 38

● Traditional configuration of the ephemeral port range on page 39

● Firewalling the ephemeral port range on page 39

● Changing the ephemeral port range on page 39

Limits implied by the ephemeral port range
Another important ramification of the ephemeral port range is that it limits the maximum 
number of connections from one machine to a specific service on a remote machine. The 
TCP/IP protocol uses the connection's combination of server IP, server port, client IP, and 
client port to distinguish between connections, so if the ephemeral port range is only 4000 
ports wide, that means that there can only be 4000 unique connections from a client 
machine to a remote service at one time.

A port range of 4000 may seem large, but it is actually small for current computing 
demands when you consider that a TCP connection must expire through the TIME_WAIT 
state before it is really completed. For example, even if both sides of a connection properly 
close their ends of the connection, due to TCP's error control, each side must wait until the 
TIME_WAIT state is expired before the connection's resources can really be disposed. The 
TIME_WAIT state is twice the maximum segment lifetime (MSL) which, depending on the 
IP stack, is usually configured to be 240 seconds total. That means that you could have 
only 4000 connections per 240 second window, and in practice this can be exhausted.
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Traditional configuration of the ephemeral port range
The BSD Sockets TCP/IP stack used ports 1024 through 4999 as ephemeral ports. 
Additionally, ports 1 through 1023 were intended for systems services running as the 
superuser, so those ports are called reserved ports. 

As discussed earlier, BSD's choice of the ephemeral port range is unfortunate because of 
its relatively small size (3975 ports) and its low numbered position. Many feel that the 
default range should be 49152 through 65535, which is both much larger (16383 ports) 
and is at the very top of the full port range.

Firewalling the ephemeral port range
For firewalls, administrators often choose to restrict access to as many port numbers as 
possible. For cases where inbound connections to the ephemeral ports is required, an 
entire range of ports must be opened. It is imperative that when opening a range of ports 
on the firewall that no system services are listening on ports in the open range. 
Administrators will often want to open a specific range on the firewall, and then for each 
machine on the internal network, make sure that the ephemeral port range on the machine 
coincides with the open range on the firewall.

It must be made clear that the ephemeral port range on machines on the internal network 
often do not coincide with each other since different operating systems may use different 
ranges. That is why it can be time consuming to manually configure each machine's 
ephemeral port range so it coincides with the open range on the firewall. As a result, 
administrators often end up changing to a policy of allowing all incoming ports and deny 
access to specific ports when needed.

It may not be necessary to open the ephemeral port range. It is usually only necessary 
when FTP is being served to the outside world (Passive "PASV" data connections use 
inbound ephemeral ports), or when FTP client access must work in non-passive mode 
("PORT" connections from the server are inbound to clients using ephemeral ports).

Changing the ephemeral port range
It is desirable to change which port numbers are used for the ephemeral port range for any 
of the following:

● To use a larger range so that more simultaneous connections are possible.

● To shift the range to the higher numbered ports. The higher numbered ports should be 
used as ephemeral ports because they are less likely to be used as port numbers for 
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system services. Well known service ports have traditionally been assigned to lower 
port numbers.

● To change the range to coincide with other systems for purposes of firewalling and 
automatic network address translation. 

When changing the range, we suggest you change it to 49152 through 65535. If you need 
a larger range, continue downward from 49152, but leave 65535 as your upper bound. The 
following sections describe how to change the ephemeral port range on the OA operating 
systems:

● Microsoft Windows on page 40

● Solaris on page 41

● AIX on page 43

As noted in these sections, some systems already use the preferred range and will not 
need to be changed. Some operating systems also use two or more ranges, and to use the 
other ranges an application will have to be explicitly coded to choose the other range. 

Microsoft Windows

Windows uses the traditional BSD range of 1024 through 4999 for its ephemeral port 
range. You can only set the upper bound of the ephemeral port range. Here is information 
excerpted from Microsoft Knowledgebase Article Q196271:

To set the upper boundary of the ephemeral port range on Windows:

1. Start the registry editor (Regedt32.exe).

2. Locate the following key in the registry:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Para
meters

3. On the Edit menu, click Add Value, and then add the following registry value:

Value Name: MaxUserPort Data Type: REG_DWORD Value: 65534

Valid Range: 5000-65534 (decimal) Default: 0x1388 (5000 decimal)

Description: This parameter controls the maximum port number 
used when an application requests any available user port from 
the system. Normally, ephemeral (that is, short-lived) ports 
are allocated between the values of 1024 and 5000 inclusive.

4. Quit the registry editor. 
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Solaris

Solaris uses the ndd utility program to change tunable IP stack parameters. The 
ephemeral ports on Solaris can be tuned individually for both TCP and UDP, so there are 
really two separate ephemeral port ranges. Solaris also provides options to change the 
privileged port range (ports only processes running with superuser privileges can use).

Solaris, by default, provides a large range at the end of the port range (32768 
through 65535, or the upper 50%) so it is unlikely you will need to change the range from 
the default values.

The example below shows how to query the existing range for the TCP ephemeral ports 
and change the range to 49152 through 61000:

1. Enter:

/usr/sbin/ndd /dev/tcp tcp_smallest_anon_port 
tcp_largest_anon_port

The current range (by default, 32768 to 65535) is displayed.

2. Enter the following commands to change the ephemeral port range to 49152 
through 61000:

/usr/sbin/ndd -set /dev/tcp tcp_smallest_anon_port 49152

/usr/sbin/ndd -set /dev/tcp tcp_largest_anon_port 61000

3. Enter the following command to display the new range:

/usr/sbin/ndd /dev/tcp tcp_smallest_anon_port 
tcp_largest_anon_port

The new range, 49152 through 61000, is displayed.

Note:
Note: If you change the range values, you must do it each time the system boots. 

Although we recommend that you just use the default range which is 
sufficient, here is a sample script you can use to change the range at 
startup:

#!/sbin/sh
#
# Copy me to /etc/init.d/ephemports, then do
# "ln -s /etc/init.d/ephemports /etc/rc2.d/S70ephemports".
#
EPHEM_HI="65535"
EPHEM_LO="49152"

if [ "$#" -eq 0 ] ; then arg="start" ; else arg="$1" ; fi
case "$arg" in
'start')

;; # Fall through -- rest of script is the initialization code
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'stop')
exit 0
;;

'status')
EPHEM_HI=`/usr/sbin/ndd /dev/udp udp_largest_anon_port`
EPHEM_LO=`/usr/sbin/ndd /dev/udp udp_smallest_anon_port`
echo "UDP ephemeral port range is ${EPHEM_LO}..${EPHEM_HI}."
EPHEM_HI=`/usr/sbin/ndd /dev/tcp tcp_largest_anon_port`
EPHEM_LO=`/usr/sbin/ndd /dev/tcp tcp_smallest_anon_port`
echo "TCP ephemeral port range is ${EPHEM_LO}..${EPHEM_HI}."
exit 0
;;

*)
echo "Usage: $0 { start | stop | status }"
exit 1
;;

esac

/usr/sbin/ndd -set /dev/udp udp_smallest_anon_port "${EPHEM_LO}"
/usr/sbin/ndd -set /dev/udp udp_largest_anon_port "${EPHEM_HI}"
/usr/sbin/ndd -set /dev/tcp tcp_smallest_anon_port "${EPHEM_LO}"
/usr/sbin/ndd -set /dev/tcp tcp_largest_anon_port "${EPHEM_HI}"

EPHEM_HI=`/usr/sbin/ndd /dev/udp udp_largest_anon_port`
EPHEM_LO=`/usr/sbin/ndd /dev/udp udp_smallest_anon_port`
echo "UDP ephemeral port range is ${EPHEM_LO}..${EPHEM_HI}."
EPHEM_HI=`/usr/sbin/ndd /dev/tcp tcp_largest_anon_port`
EPHEM_LO=`/usr/sbin/ndd /dev/tcp tcp_smallest_anon_port`
echo "TCP ephemeral port range is ${EPHEM_LO}..${EPHEM_HI}."

exit 0

For more information about tuning Solaris, refer to the Solaris Tunable Parameters 
Reference Manual. 
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AIX

AIX uses the no command to set network options. AIX uses two separate ephemeral port 
ranges, one for TCP and UDP, and both default to the values 32768 through 65535.

To display the current port range, enter:

/usr/sbin/no -a | fgrep ephemeral

The port range is displayed:

The default range is sufficient, but you can change it using the no command. 

For example, to set the TCP ephemeral port range to 49152 through 65535, enter:

/usr/sbin/no -o tcp_ephemeral_low=49152 -o 
tcp_ephemeral_high=65535

The options you set with no must be done each time the system starts up. One way to do 
that is to edit /etc/rc.tcpip and insert the no commands just before the script starts 
running the server daemons.

tcp_ephemeral_low = 32768
tcp_ephemeral_high = 65535
udp_ephemeral_low = 32768
udp_ephemeral_high = 65535
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Chapter 2: Installing Avaya IC components

This section describes how to install the Avaya IC servers and Design & Administration 
Tools, how to configure environments for servers and Design & Administration Tools, and 
how to configure secondary servers. 

Install and configure the Avaya IC components in the order that the topics appear in this 
section. For example, install and configure the primary servers before you install and 
configure the Design & Administration Tools.

This section includes the following topics:

● Before you install Avaya IC components on page 46.

● Upgrading Avaya IC on page 48.

● Reinstalling Avaya IC on page 49.

● Installing Avaya IC servers on page 49.

● Changing ownership for Avaya IC - Solaris and AIX only on page 56.

● Creating the primary server environment on page 58.

● Setting up Design & Administration Tools on page 62.

● Configuring the design and administration environment on page 66.

! CAUTION:
CAUTION: Do not install Avaya IC on machines that also host software that filters or 

controls network access. These types of software can cause Avaya IC to fail 
or seriously impact performance. For example, pornography filters or 
software firewalls can affect network access in several ways. They can 
cause a slowdown in network access, cause applications that open a large 
number of sockets to fail, or rewrite packets.

For information about installing other Avaya IC components, see:

● Configuring agent applications on page 353.

● Installing Business Advocate components on page 419.
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Before you install Avaya IC components
This section describes the steps that you must perform before you install Avaya IC 
components. This section includes the following topics:

● Readme files on page 46

● Avaya IC prerequisites on page 46

● License file on page 46

● Required administrator privileges on page 47

● Solaris machines on page 48

● AIX machines on page 48

Readme files
Read the following Avaya IC readme files:

● Avaya IC Readme file on the Avaya IC CD-ROM 

● Avaya IC Readme Addendum on the CRM Technical Support Website at 
http://www.avaya.com/support/qq

Avaya IC prerequisites
Read the IC Installation Planning and Prerequisites and install all prerequisite 
components.

License file
Obtain the necessary Avaya IC license file for your Avaya IC system. For more 
information, see IC Installation Planning and Prerequisites.

http://www.avaya.com/support/qq
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Required administrator privileges
All Avaya IC users who perform certain tasks require administrator privileges. This section 
includes the following topics that describe the administrator privileges required for the 
different operating systems:

● Required administrator privileges for Windows on page 47.

● Required administrator privileges for Solaris and AIX on page 47.

Required administrator privileges for Windows

All Avaya IC users who perform the following tasks must have a Windows Administrator 
login or a Windows login with administrator privileges.

● Install and configure Avaya IC servers

● Install or use Design & Administration Tools

Required administrator privileges for Solaris and AIX

All Avaya IC users who install and configure Avaya IC servers require one of the following 
UNIX accounts, depending upon which tasks they need to perform.

Root user - You need this account when you:

● Install Avaya IC on a machine that will host a Telephony server for an Avaya switch with 
Definity® or Communication Manager software.

● Configure the Web applications with the Configuration Tool, including the Website, 
Email Template Administration, Web License Manager, and Letter Generator.

Installation user - Use this account to perform all tasks to install and configure Avaya IC 
that do not require the root user. The Avaya IC installation directory must be owned by this 
account. 

For example, you can create an installation user account named avaya.

! Important:! Important:
Important: If you do not use a root account to install Avaya IC servers on a machine, 

and need to configure that machine with a Telephony server for an Avaya 
switch with DEFINITY or Communication Manager software, reinstall the 
Avaya IC servers under the root account.
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Solaris machines
If you host your servers on Solaris:

● Install a Windowing environment such as X-Windows.

● Set the DISPLAY parameter.

● Make sure that the server machine has sufficient space in the /var/tmp directory for 
the Java Virtual Machine installation. The Avaya IC installer typically requires at least 
360MB of extra temp space.

AIX machines
If you host your servers on AIX:

● Install a Windowing environment such as X-Windows.

● Set the DISPLAY parameter.

● Make sure that the server machine has sufficient space in the /tmp directory for the 
Java Virtual Machine installation. The Avaya IC installer typically requires at least 
360MB of extra temp space.

Upgrading Avaya IC
For information on how to upgrade your Avaya IC system from an earlier release of Avaya 
IC, including an Avaya IC 6.1.x release, see IC/OA Software Upgrade and Data Migration.
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Reinstalling Avaya IC
You can reinstall Avaya IC over an existing Avaya IC installation. To uninstall Avaya IC files 
before you reinstall, see Uninstalling Avaya IC on page 536.

To reinstall Avaya IC: 

1. Stop all Avaya IC servers and Avaya IC services on the target machine. 

2. Follow the instructions in the appropriate section below to reinstall the desired Avaya 
IC files:

● Installing Avaya IC servers on page 49.

● Setting up Design & Administration Tools on page 62.

● Configuring agent applications on page 353.

● Installing Business Advocate components on page 419.

Installing Avaya IC servers
This section includes the following topics:

● Cautions and tips for installing Avaya IC servers on page 49.

● Installing Avaya IC servers on Windows on page 50.

● Installing Avaya IC servers on Solaris on page 53.

● Installing Avaya IC servers on AIX on page 55.

Cautions and tips for installing Avaya IC servers
This section includes some important cautions and tips that you need to consider when 
you install the Avaya IC servers. 

This section includes the following topics:

● Avaya IC server files on page 50.

● Required disk space on page 50.

● InstallShield mode on page 50.

● Backup configuration files on page 50.

● Installation options on page 50.
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Avaya IC server files

The Servers option copies all Avaya IC server files to the machine. You cannot select 
which server files you will copy to the target machine. However, you do not need to 
configure and run all servers on that machine.

Required disk space

Make sure that you have sufficient space on the target machine to install the selected files. 
The Avaya IC installation does not check the amount of free disk space on the machine 
until after you select the components to install.

InstallShield mode

The Avaya IC installation can run only in console mode of InstallShield. The Avaya IC 
installation cannot run in silent mode.

Backup configuration files

The Avaya IC installer backs up configuration files in the following directory before making 
any changes to those files: bin\config\backup.

Installation options

At any time before the Avaya IC installation copies the files, select Back on an installation 
screen to change the options that you selected.

Installing Avaya IC servers on Windows
To install Avaya IC servers on Windows:

1. Log in to the machine with an account that has the required Administrator privileges.

2. Insert CD-ROM 1 for Avaya Interaction Center 6.1.3.

Avaya IC installation starts automatically. 

If you disabled Autorun on the machine, navigate to the Servers directory on the CD-
ROM and run setup.exe.

3. In the first screen of the Avaya IC installation, select Servers, Design & 
Administration Tools.

The Avaya IC installation may disappear from your screen. During this time, the 
installation copies the compressed files from the CD-ROM to the machine and loads 
the Java Virtual Machine. This process can take a few minutes.
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4. When the Avaya IC installation opens, read the entire Avaya IC license agreement 
carefully, then:

● If you agree to the terms of the agreement, select I accept the terms of the license 
agreement. Select Next.

● If you do not agree to the terms of the agreement, select I do not accept the terms 
of this license agreement. The Avaya IC installation exits. 

5. Select Next in the Welcome screen.

6. In the Installation Directory screen.

a. Accept the default or type a directory path for the Avaya IC components in the 
Directory Name field.

If you do not know the directory path, select Browse, then navigate to the desired 
directory. 

You cannot change the installation directory when you reinstall Avaya IC.

b. Select Next.
7. In the Product Installation screen, shown in the following figure:

a. Check the Interaction Engine Servers box.

b. Do not check the Design & Admin box. 

c. Select Next.
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8. In the next installation screen, review the details of the components you selected. 
Select Next
Avaya IC installation copies the requested files to the machine. This process can take 
several minutes. If the target machine does not have sufficient space to install the 
components, the Avaya IC installation displays an error message.

9. In the next installation screen:

a. Select Yes to answer the question Do you want to run the Configuration Tool 
now?, as shown in the following figure. 

b. Select Next.

10. In the next installation screen:

a. Select one of the following options for the mode in which you want the Configuration 
Tool to run:

● If this machine hosts the primary ORB server, select Primary.

● If this machine does not host the primary ORB server, select Secondary.

b. Select Next.
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11. The next step in the server installation depends upon the type of servers that will run 
on the target machine. Perform either of the steps in the following table.

Installing Avaya IC servers on Solaris
To install Avaya IC servers on Solaris:

1. Log in to the machine with an account with the required privileges. 

For more information, see Required administrator privileges on page 47.

2. Insert CD-ROM 2 for Avaya Interaction Center 6.1.3.

The Avaya IC CD-ROM mounts automatically. 

3. To start the Avaya IC installation:

a. Change to the following directory on the CD-ROM: <CD-ROM_drive>/Solaris

b. Execute ./setup.bin

If you launch the setup.bin command from Solaris File Manager, the installation 
window may not terminate after the installation is complete.

If the default temp directory does not have sufficient space to override the TMPDIR 
environment variable, run: ./setup.bin -is:tempdir <dir_name>

The Avaya IC installation may disappear from your screen. During this time, the 
installation copies the compressed files from the CD-ROM to the machine and loads 
the Java Virtual Machine. This process can take a few minutes.

4. When the Avaya IC installation opens, read the entire Avaya IC license agreement 
carefully, then:

● If you agree to the terms of the agreement, select I accept the terms of the license 
agreement. Select Next.

● If you do not agree to the terms of the agreement, select I do not accept the terms 
of this license agreement. The Avaya IC installation exits. 

5. Select Next in the Welcome screen.

Type of servers Location of steps

Primary servers, including primary 
ORB server

Creating the primary server 
environment on page 58

Secondary servers Creating a secondary server 
environment on page 162
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6. In the Installation Directory screen:

a. Accept the default or type a directory path for the Avaya IC components in the 
Directory Name field.

If you do not know the directory path, select Browse, select a directory from the 
available list to highlight the directory, then select Open or Update.

b. Select Next.
7. In the next installation screen, review the details of the components you selected and 

the disk space that they require. Select Next
Avaya IC installation copies the requested files to the machine. This process can take 
several minutes. If the target machine does not have sufficient space to install the 
components, the Avaya IC installation displays an error message.

8. In the next installation screen:

a. Select Yes to answer the question Do you want to run the Configuration Tool 
now?

b. Select Next.
9. In the next installation screen:

a. Select one of the following options for the mode in which you want the Configuration 
Tool to run:

● If this machine hosts the primary ORB server, select Primary.

● If this machine does not host the primary ORB server, select Secondary.

b. Select Next.
10. The next step in the server installation depends upon the type of servers that will run 

on the target machine. Perform either of the steps in the following table.

Type of servers Location of steps

Primary servers, including primary 
ORB server

Creating the primary server 
environment on page 58

Secondary servers Creating a secondary server 
environment on page 162
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Installing Avaya IC servers on AIX
To install Avaya IC servers on AIX:

1. Log in to the machine with an account with the required privileges. 

For more information, see Required administrator privileges on page 47.

2. Insert CD-ROM 2 for Avaya Interaction Center 6.1.3 and mount the CD-ROM.

3. To start the Avaya IC installation:

a. Change to the following directory on the CD-ROM: <CD-ROM_drive>/AIX

b. Execute ./setup.bin

If the default temp directory does not have sufficient space to override the TMPDIR 
environment variable, run: ./setup.bin -is:tempdir <dir_name>

The Avaya IC installation may disappear from your screen. During this time, the 
installation copies the compressed files from the CD-ROM to the machine and loads 
the Java Virtual Machine. This process can take a few minutes.

4. When the Avaya IC installation opens, read the entire Avaya IC license agreement 
carefully, then:

● If you agree to the terms of the agreement, select I accept the terms of the license 
agreement. Select Next.

● If you do not agree to the terms of the agreement, select I do not accept the terms 
of this license agreement. The Avaya IC installation exits. 

5. Select Next in the Welcome screen.

6. In the Installation Directory screen, shown in the following figure:

a. Accept the default or type a directory path for the Avaya IC components in the 
Directory Name field.

If you do not know the directory path, select Browse, select a directory from the 
available list to highlight the directory, then select Open or Update.

b. Select Next.
7. In the next installation screen, review the details of the components you selected and 

the disk space that they require. Select Next
Avaya IC installation copies the requested files to the machine. This process can take 
several minutes. If the target machine does not have sufficient space to install the 
components, the Avaya IC installation displays an error message.
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8. In the next installation screen:

a. Select Yes to answer the question Do you want to run the Configuration Tool 
now?

b. Select Next.
9. In the next installation screen:

a. Select one of the following options for the mode in which you want the Configuration 
Tool to run:

● If this machine hosts the primary ORB server, select Primary.

● If this machine does not host the primary ORB server, select Secondary.

b. Select Next.
10. The next step in the server installation depends upon the type of servers that will run 

on the target machine. Perform either of the steps in the following table.

Changing ownership for Avaya IC - Solaris and AIX 
only

If you installed Avaya IC as the root user and do not want to run Avaya IC servers and 
services as root in your Solaris or AIX system, you need to change the ownership of the 
Avaya IC directories and files.

Note:
Note: Create a user for the Avaya IC system before you perform these steps. For 

more information, see IC Installation Planning and Prerequisites.

This section includes the following steps that you must perform if you do not want to run 
Avaya IC as root:

1. Changing ownership of the Avaya IC directories and files on page 57.

2. Changing ownership for Telephony server - Solaris with Avaya switch only on page 57.

3. Changing ownership for Telephony server - AIX with Avaya switch only on page 58.

Type of servers Location of steps

Primary servers, including primary 
ORB server

Creating the primary server 
environment on page 58

Secondary servers Creating a secondary server 
environment on page 162
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Changing ownership of the Avaya IC directories and files
To change ownership of the Avaya IC directories and files:

1. Log in as root user.

2. Navigate to IC_INSTALL_DIR/IC61/bin.

3. Shutdown all Avaya IC servers, as described in Stopping all servers on page 152.

4. Navigate to the parent directory of AVAYA_IC61_HOME.

5. Execute the following command:

chown -R <avayauser>:<avayagroup> IC61

where <avayauser> represents the non-root user that you use to run the Avaya IC 
components and <avayagroup> is the primary group for <avayauser>.

6. Switch to <avayauser> and restart the Avaya IC servers.

7. For a Solaris system, continue with Changing ownership for Telephony server - Solaris 
with Avaya switch only on page 57.

Changing ownership for Telephony server - Solaris with 
Avaya switch only

For a Solaris system that includes an Avaya switch with Definity® or Communication 
Manager software, change the ownership of every Telephony server.

You configure the SUID bit and root ownership to ensure that the Telephony server for the 
Avaya switch can start up as the root user to enable agent event reporting. The Telephony 
server resets its process user ID to <avayauser> immediately after startup.

To change ownership for the Telephony server on Solaris:

1. Log in as root user.

2. Navigate to IC_INSTALL_DIR/IC61/bin.

3. Execute the following command: 

chown root cvlansrv

4. Execute the following command to verify that the SUID bit is set on cvlansrv:

ls -l cvlansrv

5. Execute the crle command as follows: 

crle -s AVAYA_IC61_HOME/lib
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Changing ownership for Telephony server - AIX with Avaya 
switch only

For an AIX system that includes an Avaya switch with Definity® or Communication 
Manager software, change the ownership of every Telephony server.

You configure the SUID bit and root ownership to ensure that the Telephony server for the 
Avaya switch can start up as the root user to enable agent event reporting. The Telephony 
server resets its process user ID to <avayauser> immediately after startup.

To change ownership for the Telephony server:

1. Log in as root user.

2. Navigate to IC_INSTALL_DIR/IC61/bin.

3. Execute the following command: 

chmod u-s cvlansrv

4. Execute the following command to verify that the SUID bit is not set on cvlansrv:

ls -l cvlansrv

Creating the primary server environment
The primary server environment includes the configuration settings required for the 
primary ORB server and the other Avaya IC servers on the machine that hosts the primary 
ORB server. 

You specify the configuration of the primary server environment on the Initial Configuration 
tab of the Configuration Tool. The Initial Configuration tab is dynamic. The Configuration 
Tool does not automatically display all of the fields. For more information about the Initial 
Configuration tab, see Initial Configuration tab on page 480.

Some of the steps are optional. You need to perform them only if the Avaya IC system 
includes an Oracle or DB2 database, or if the primary server machine will also host a 
Telephony server.

To create the primary server environment, complete the steps in the following sections:

1. Configuring the primary server environment on page 59.

2. Specifying the Telephony switch on page 59.

3. Configuring database settings on page 60.

4. Completing the configuration on page 61.
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Configuring the primary server environment
This procedure continues from Installing Avaya IC servers on page 49. 

To configure the primary server environment:

1. In the Initial Configuration tab of the Configuration Tool, confirm that Primary is 
selected in the Select Mode drop-down list.

2. Confirm that the IP address in the IP Address drop-down list is the correct IP address 
for the machine that hosts the primary ORB server.

! Important:! Important:
Important: If the primary ORB server runs on a machine with multiple network interface 

cards, you must select the IP address for the first network interface card on 
the machine. The primary ORB server cannot run on any other network 
interface card.

3. Make sure the port assignment in the Start Port field is an available port on the target 
machine. Type a new port assignment if necessary.

4. Select Start ORB Server.
5. The next step in this procedure depends upon the deployment of the Avaya IC system:

● If the machine hosts a Telephony server, continue with Specifying the Telephony 
switch on page 59.

● If the machine does not host a Telephony server, continue with Configuring 
database settings on page 60.

Specifying the Telephony switch
Only perform this step if the machine hosts a Telephony server. If the machine does not 
host a Telephony server, skip this step and continue with Configuring database settings on 
page 60.

To specify the Telephony switch:

1. Select and check the Telephony Switch box.

2. From the Telephony Switch drop-down list, select the name of the switch that the 
Telephony server will communicate with.

The Telephony server must communicate with a switch that is supported for the 
operating system of the machine. For example, do not select a Nortel switch if you plan 
to host the Telephony server on an AIX machine. For more information about switch 
support, see IC Installation Planning and Prerequisites.



Installing Avaya IC components

60 Installation and Configuration

3. The next step in this procedure depends upon the deployment of the Avaya IC system:

● If the Avaya IC system includes an Oracle or DB2 database, continue with 
Configuring database settings on page 60.

● If the Avaya IC system includes a SQL Server database, continue with Completing 
the configuration on page 61.

Configuring database settings
Only perform this step if the Avaya IC system uses an Oracle or DB2 database. If the 
Avaya IC system uses a SQL Server database, skip this step and continue with 
Completing the configuration on page 61.

To configure database settings, perform one of the following steps:

1. If your Avaya IC system includes an Oracle database, see Configuring database 
settings for Oracle on page 60.

2. If your Avaya IC system includes a DB2 database, see Configuring database settings 
for DB2 on page 61.

Configuring database settings for Oracle

To configure database settings for Oracle:

1. Select and check the Oracle Setup box. 

The Configuration Tool displays the required fields for an Avaya IC system with an 
Oracle database.

2. For all Oracle databases, type the NLS Lang parameter in the NLS Lang field to 
specify the character set of the database.

For more information about the NLS Lang parameter, including a list of NLS LANG 
parameters for supported languages, see Specifying the NLS Lang property for 
Oracle on page 544.

3. For all Oracle databases, type the home directory of the Oracle client on the machine 
that hosts the core servers in the Oracle Home field.

For example, type /opt/oracle/8.1.7

4. For Oracle databases on Solaris, type the Oracle SID of the database in the Oracle 
SID field.

For example, type icutf8db. The Oracle SID field is case-sensitive.

5. For Oracle databases on Solaris, select the correct version of Oracle from the Oracle 
Version field.

6. Continue with Completing the configuration on page 61.
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Configuring database settings for DB2

To configure database settings for DB2:

1. Select and check the DB2 Setup box. 

The Configuration Tool displays the required fields for an Avaya IC system with an DB2 
database.

2. Type the home directory of the DB2 client on the machine that hosts the core servers in 
the DB2 Home field.

For example, type /usr/lpp/db2_07_01

3. Type the name of the DB2 instance in the DB2 Instance field.

For example, type db2inst1

4. Continue with Completing the configuration on page 61.

Completing the configuration
To complete the configuration of the primary server environment:

1. If you host the servers on Solaris or AIX, select the primary locale from the Locale 
drop-down list.

The drop-down list includes all of the locales supported by the operating system. For 
example, if your servers use an English locale:

● For AIX, select EN_US.

● For Solaris, select en_US.UTF-8.

2. Select Apply Settings in the Configuration Tool to configure and start the core 
servers.

3. Select OK in the Success dialog box.

4. Select Exit.
The Configuration Tool closes and you return to the Avaya IC Installation.

5. In the Avaya IC installation, select Next.
6. Review the Avaya IC Readme information and view the readme, if desired. Select 

Next.
For Windows, if you leave the View Readme field checked, the Avaya IC Readme 
opens in Adobe Acrobat. After you have reviewed the Readme, close Acrobat to return 
to the Avaya IC installer.

7. On Windows machines, select Yes, restart my system. 

8. Select Finish.
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Setting up Design & Administration Tools
This section describes how to install the Design & Administration Tools and configure the 
design and administration environment. This section also includes some important 
cautions and tips for the Design & Administration Tools. 

This section includes the following topics:

● Cautions and tips for Design & Administration Tools on page 62.

● Installing Design & Administration Tools on page 63.

● Configuring the design and administration environment on page 66.

Cautions and tips for Design & Administration Tools
This section includes some important cautions and tips that you need to consider when 
you install and use the Avaya IC Design and Administration Tools.

This section includes the following topics:

● Components installed with Design & Administration Tools on page 62.

● Design & Administration machines on page 62.

● Supported operating systems on page 63.

● Running multiple instances of IC Manager on page 63.

Components installed with Design & Administration Tools

Avaya IC installs all of the Design & Administration Tools on the target machine. You 
cannot select which tools to install. 

The tools and files that you install with the Design & Administration Tools are:

● IC Manager

● Avaya Workflow Designer, with blocks, sample workflows, and related files

● Avaya Database Designer, with the IC Script Editor, design files, and related files

Design & Administration machines

IC Manager and other administrative applications can potentially consume a significant 
amount of CPU resources. To ensure that the requirements of IC Manager do not interfere 
with the performance of your Avaya IC servers, deploy your Design & Administration Tools 
on a dedicated machine.
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Supported operating systems

Design & Administration Tools work only on a supported Windows operating system. For 
more information, see IC Installation Planning and Prerequisites.

Running multiple instances of IC Manager

IC Manager does not support concurrent administration. When an administrator selects 
and updates a record, such as a server or an agent, IC Manager does not lock that record. 
Another administrator can open and update the same record.

! CAUTION:
CAUTION: Simultaneous administration of servers, domains, and Directory server 

tables in more than one IC Manager can cause corruption of the 
configuration files and loss of configuration data.

If you plan to have more than one instance of IC Manager, you must clearly define the 
administrative policies for Avaya IC. For example:

● Only use one instance of IC Manager at a time to administer servers. 

● Determine which Avaya IC elements an administrator can update, and assign the 
appropriate permissions to the login ID for that administrator.

● Do not allow administrators to log in to more than one instance of IC Manager with the 
same login ID and password. 

For more information about multiple instances of IC Manager, see IC Administration 
Volume 1: Servers & Domains.

Installing Design & Administration Tools
At any time before the Avaya IC installation copies the files, select Back to change the 
options that you selected.

To install Avaya IC Design & Administration Tools:

1. Log in to the machine as Administrator or a user with administrator privileges.

2. Insert Avaya Interaction Center 6.1 CD 1 and select Servers, Design & 
Administration Tools to start the installation.

If you disabled Autorun on the machine, navigate to the Servers directory on the CD-
ROM and run setup.exe.

Note:
Note: The Avaya IC installation may disappear from your screen while the 

installation copies the compressed files from the CD-ROM to the machine, 
and loads the Java Virtual Machine. This process can take a few minutes.



Installing Avaya IC components

64 Installation and Configuration

3. When the Avaya IC installation opens, read the entire Avaya IC license agreement 
carefully, then:

● If you agree to the terms of the agreement, select I accept the terms of the license 
agreement. Select Next.

● If you do not agree to the terms of the agreement, select I do not accept the terms 
of this license agreement. The Avaya IC installation exits. 

4. Select Next in the Welcome screen.

5. In the Installation Directory screen:

a. Accept the default or type a directory path for the Avaya IC components in the 
Directory Name field.

If you do not know the directory path, select Browse and navigate to the desired 
directory. You cannot choose the installation directory when you reinstall Avaya IC.

b. Select Next.
6. In the Product Installation screen, shown in the following figure:

a. Complete the following fields:

● Check the Avaya Interaction Center 6.1 box.

● Do not check the Interaction Engine Servers box.

● Check the Design & Admin box. 
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b. Select Next.

7. Review the details of the components you selected. Select Next
Avaya IC installation copies the requested files to the machine. This process can take 
several minutes. If the target machine does not have sufficient space to install the 
components, the Avaya IC installation displays an error message.

8. Select Next in the Installation Confirmation screen.

9. In the next Installer screen:

a. Select one of the fields as shown in the following table.

b. Select Next.
If you selected No and did not install IndexQ or Outbound Reporting, continue with 
Step 11.

Field Description

Yes If the installation on the current machine includes 
IndexQ or Outbound Contact Reports.

No If the machine does not include those components.
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10. If you chose to install IndexQ or Outbound Reporting, in the message box:

a. Select one of the fields as shown in the following table.

b. After the System 32 files are updated, select Finish to return to the Avaya IC 
installation.

Tip:
Tip: If the message box is not visible, the box may have opened behind the 

Installation screen.

11. In the next installation screen:

a. Select Yes to answer the question Do you want to run the Configuration Tool 
now? 

b. Select Next.

Configuring the design and administration environment
You must run the Configuration Tool to configure the design and administration 
environment. During this configuration, the Configuration Tool copies the files in the 
following table from the machine that hosts the primary ORB server to the machine that 
hosts IC Manager.

Field Description

Yes To update the System 32 files and continue with the 
installation.

No To skip this step and continue with the installation. 
Select No if you did not choose to install IndexQ or 
Outbound Contact Reports but still see this 
message box.

File type File name

Implementation file vesp.imp

Interface file vespidl.pk
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To configure the design and administration environment:

1. In the next installation window:

a. Select the Client option for the mode in which you want the Configuration Tool to 
run, as shown in the following figure.

b. Select Next.

2. In the Initial Configuration tab of the Configuration Tool, confirm that Client is 
selected in the Select Mode drop-down list.

3. Complete and confirm the default entries in the fields shown in the following table.

For more information about these fields, see Client fields on the Initial Configuration 
tab on page 487.

4. Select Apply Settings in the Configuration Tool.

5. Select OK in the Success dialog box.

6. Select Exit.

Field Description Sample entry

Primary Host Name The name of the machine that hosts the 
primary ORB server.
The primary host name can be the IP 
Address or fully-qualified domain name of 
the machine.

coresvr.avaya.com

Primary ORB Port The port that the primary ORB server uses 
for communications.

Default: 9001

IC Domain This is the Avaya IC domain that includes 
the primary ORB server. This domain is 
typically the Default domain.

Default
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Chapter 3: Installing Avaya Full Text Search 
Engine

Avaya Full Text Search Engine (Avaya FTSE) is the full text search engine for Avaya 
Interaction Center (Avaya IC). Avaya IC requires Avaya FTSE to function correctly.

This section describes how to install Avaya FTSE. You must install Avaya FTSE before you 
complete the configuration of the Avaya IC system. For more information, see Installation 
order on page 23.

This section includes the following topics:

● Cautions and tips for installing Avaya FTSE on page 69.

● Installing Avaya FTSE for Microsoft Windows on page 70.

● Installing Avaya FTSE for Sun Solaris on page 72.

● Installing Avaya FTSE for IBM AIX on page 74.

Cautions and tips for installing Avaya FTSE
Review the cautions and tips in the following topics before you install Avaya FTSE:

● Disk space on page 70.

● Required administrator privileges on page 70.
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Disk space
Make sure that you have sufficient space on the target machine to install the selected files. 
The Avaya FTSE installation does not check the amount of free disk space on the machine 
until after you select the components to install.

The following table describes the disk space required by the program files for Avaya FTSE 
on the supported operating systems. These disk space requirements do not include 
estimates for the space used by QKnowledge files and Web Self-Service files.

The disk space requirements for Avaya IC, described in IC Installation Planning and 
Prerequisites, include the space required by Avaya FTSE. 

Required administrator privileges
The Avaya FTSE installation requires the same administrator privileges as Avaya IC. For 
more information, see Required administrator privileges on page 47.

Installing Avaya FTSE for Microsoft Windows
This section describes the installation and configuration of Avaya FTSE for Microsoft 
Windows.

This section includes the following topics:

● Where to install and configure Avaya FTSE for Microsoft Windows on page 71.

● Default port assignment for QKnowledge on page 71.

● Installing Avaya FTSE on a Microsoft Windows machine on page 71.

Operating system Disk space required by program files

Microsoft Windows 250 MB

Sun Solaris 120 MB

IBM AIX 120 MB
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Where to install and configure Avaya FTSE for Microsoft 
Windows

Install Avaya FTSE on all Windows machines that host one or more of the following:

● QKnowledge

● IndexQ

● Customer Website

● Administrative Website

● The following Web Management servers:

- Attribute server

- WebACD server

- ICM server

- CIRS server

Default port assignment for QKnowledge
By default, Avaya FTSE configures the Tomcat service for QKnowledge on Tomcat base 
port +4. You set the Tomcat base port on the Web tab of the Avaya IC Configuration Tool 
when you configure Avaya IC Web applications.

The default Tomcat base port is 9600. If you do not change this base port in the Avaya IC 
Configuration Tool, the default port assignment for QKnowledge is 9604.

You cannot change this port assignment when you configure QKnowledge.

Installing Avaya FTSE on a Microsoft Windows machine
To install Avaya FTSE on a Windows machine:

1. Log in to the machine with an account that has the required administrator privileges. 

2. Insert the Avaya FTSE CD-ROM.

The Avaya FTSE installation starts automatically. 

3. If you disabled Autorun on the machine, navigate to CD_ROM_DRIVE:\win32 and run 
setupwin32.exe.

4. In the Welcome screen of the installer, select Next.
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5. In the License screen of the installer, read the entire Avaya FTSE license agreement 
carefully, then:

● If you agree to the terms of the agreement, select I accept the terms of the license 
agreement. Select Next. 

● If you do not agree to the terms of the agreement, select I do not accept the terms 
of this license agreement. The Avaya FTSE installation exits. 

6. Review the details of the Avaya FTSE components. Select Next
Avaya FTSE installation copies the requested files to the machine. This process can 
take several minutes. If the target machine does not have sufficient space to install the 
components, the Avaya FTSE installation displays an error message.

7. Review the summary information to confirm that Avaya FTSE installed correctly. Select 
Next.

8. Select Yes, restart my computer. 
9. Select Finish.

Restart the machine, if the machine does not restart automatically.

10. Continue with the configuration of Avaya IC.

Installing Avaya FTSE for Sun Solaris
This section describes the installation of Avaya Full Text Search Engine (Avaya FTSE) for 
Sun Solaris.

This section includes the following topics:

● Where to install Avaya FTSE for Sun Solaris on page 73.

● Installing Avaya FTSE on a Sun Solaris machine on page 73.
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Where to install Avaya FTSE for Sun Solaris
Install Avaya FTSE on all machines that host:

● Customer Website

● Administrative Website

● The following Web Management servers:

- Attribute server

- WebACD server

- ICM server

- CIRS server

Tip:
Tip: Avaya IC does not support QKnowledge or IndexQ on Sun Solaris. If the 

Avaya IC system includes one or both of these components, install these 
components and Avaya FTSE on a Windows machine. For more 
information, see Installing Avaya FTSE for Microsoft Windows on page 70.

Installing Avaya FTSE on a Sun Solaris machine
To install Avaya FTSE on a Solaris machine:

1. Log in to the machine with an account with the required administrator privileges. 

2. Insert the Avaya FTSE CD-ROM.

The Avaya FTSE CD-ROM mounts automatically.

3. Navigate to CD-ROM_drive/Solaris

4. Execute IC_INSTALL_DIR/IC61/bin/icenv ./instftse 

where AVAYA_IC_HOME is the installation directory for Avaya IC. For example, 
/opt/Avaya/IC61 

The Avaya FTSE files are installed.
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Installing Avaya FTSE for IBM AIX
This section describes the installation of Avaya FTSE for IBM AIX.

This section includes the following topics:

● Where to install Avaya FTSE for IBM AIX on page 74.

● Installing Avaya FTSE on IBM AIX on page 74.

Where to install Avaya FTSE for IBM AIX
Install Avaya FTSE on all machines that host:

● Customer Website

● Administrative Website

● The following Web Management servers:

- Attribute server

- WebACD server

- ICM server

- CIRS server

Tip:
Tip: Avaya IC does not support QKnowledge or IndexQ on IBM AIX. If the Avaya 

IC system includes one or both of these components, install these 
components and Avaya FTSE on a Windows machine. For more 
information, see Installing Avaya FTSE for Microsoft Windows on page 70.

Installing Avaya FTSE on IBM AIX
To install Avaya FTSE on an AIX machine:

1. Log in to the machine with an account with the required administrator privileges. 

2. Insert the Avaya FTSE CD-ROM.

The Avaya FTSE CD-ROM mounts automatically. 

3. Navigate to CD-ROM_drive/AIX.
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4. Execute IC_INSTALL_DIR/IC61/bin/icenv ./instftse 

where AVAYA_IC_HOME is the installation directory for Avaya IC. For example, 
/usr/Avaya/IC61 

The Avaya FTSE files are installed.
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Chapter 4: Configuring databases

This section describes how to configure the Avaya IC data server, databases, data 
sources, and Business Applications. All Avaya IC systems require an IC Repository 
database and a CallCenterQ database. 

This section includes the following topics. Perform the steps in these topics in the order set 
out below.

1. Before you configure Avaya IC databases on page 77.

2. Copying the stored procedure library - DB2 only on page 78.

3. Setting up the primary Data server on page 79.

4. Data sources and Business Applications on page 86.

5. Creating IC Repository on page 89.

6. Creating the CCQ database on page 101.

7. Creating Business Applications on page 111.

Before you configure Avaya IC databases
Before you configure the Avaya IC databases, complete the following prerequisites:

Install Avaya IC servers - You must create and configure the primary server environment, 
then start the primary servers before you can configure the Avaya IC servers and 
components. 

At a minimum, do the following:

● On the machine that hosts the Avaya IC primary ORB server, install the Avaya IC server 
files and configure the primary server environment. 

● On the machine that hosts the Data server, install the Avaya IC server files and 
configure the server environment. If this machine is different from the one that hosts the 
primary ORB server, configure a secondary server environment on this machine.

If you have not installed the server files, see Installing Avaya IC servers on page 49.
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Install Avaya IC Design & Administration tools - Install these tools on a dedicated 
machine that has network access to all server machines. For information on how to install 
these tools, see Setting up Design & Administration Tools on page 62.

Install database management system - For more information, see IC Installation 
Planning and Prerequisites and the documentation provided with the database 
management system.

Install and configure the database client software - The database client software also 
includes the vendor libraries, and support files. Install and configure these files on the 
machine that hosts the Data server. The Data server requires the database client software 
to communicate with the database. For example, if your Avaya IC system includes a 
supported Oracle database, install the Oracle client for that version on the machine that 
hosts the Data server.

Database connections - Configure and validate the database software connections on 
the machine where you plan to install the Data server.

Copying the stored procedure library - DB2 only
If you host your Avaya IC databases on DB2, you must copy the qdb2sp stored procedure 
library from the machine that hosts the primary ORB server to the machine that hosts the 
Avaya IC database instance.

To copy the qdb2sp stored procedure library to the DB2 server installation hierarchy:

1. On the machine that hosts the DB2 Data server, navigate to the 
IC_INSTALL_DIR/IC61/lib directory where Avaya IC installs the qdb2sp stored 
procedure library.

2. Use the ftp command or the rcp command to copy the qdb2sp stored procedure library 
to the following directory on the machine that hosts the DB2 server:

db2inst1/sqllib/function

Note:
Note: Do not copy the stored procedure library to any machine that hosts the DB2 

client. The stored procedure library must be copied to the function directory 
of the DB2 server. 
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Setting up the primary Data server
The Data server is specific to the type of database you use in your Avaya IC system. All 
Avaya IC server and client components use the Data server to communicate with your 
database. The Data server uses the Avaya IC account for each component or user to link 
the Avaya IC components and the database server. 

All Data servers support connection pooling.

After you configure the Data server, you can configure other Avaya IC applications on the 
same machine.

This section includes the following topics:

● Cautions and tips for configuring the Data server on page 79.

● Configuring the primary Data server on page 80.

Cautions and tips for configuring the Data server
When you configure the Data server, note the following:

Database machine - Do not install and configure the Data server on the machine that 
hosts your database. 

Host your database server on a dedicated machine, so you can tune your database server 
to maximize database operations and improve the reliability and performance of the 
database.

Multiple database types - A Data server can only communicate with one type of 
database. Install multiple Data servers if your Avaya IC configuration requires more than 
one type of database. For example, you need a second Data server if you maintain a 
legacy database in a different type of database. 

The CCQ database, IC Repository database, and Avaya OA database must all be the 
same database type.

DB2 stored procedure library - If you use DB2 for your Avaya IC databases, you must 
copy the qdb2sp stored procedure library from the machine that hosts the primary ORB 
server to the DB2 installation hierarchy. If you do not copy the stored procedure library, the 
Data server will not be able to communicate with the DB2 database server, and Database 
Designer will not be able to configure the Avaya IC databases. For more information, see 
Copying the stored procedure library - DB2 only on page 78.
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Configuring the primary Data server
You configure the Data server in IC Manager.

Note:
Note: These instructions are for the primary Data server, and therefore do not 

include information about the ODBC Data server or the Legacy Data server. 
For more information about those Data servers, see IC Administration 
Volume 1: Servers & Domains. For more information about how to configure 
a secondary Data server, see Creating a secondary Data server on 
page 169.

This section includes the following topics:

● Configuring a primary Data server for Microsoft SQL Server on page 80.

● Configuring a primary Data server for Oracle on page 82.

● Configuring a primary Data server for IBM DB2 on page 84.

Configuring a primary Data server for Microsoft SQL Server

To configure the primary Data server:

1. On the machine where you installed the Design & Administration Tools, select 
Start > Programs > Avaya Interaction Center 6.1 > IC Manager.

2. Log in to IC Manager with the pre-assigned login ID and password shown in the 
following table.

The next time you log in, IC Manager will prompt you to change the password. 

3. Select the Server tab, then: 

a. Select Server > New.

b. Select DataServerMSSQL from the list of servers.

c. Select OK.

Login Password

Admin admin
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4. In the General tab of the Server Editor, complete the fields as shown in the following 
table.

5. In the DataServer tab of the Server Editor, complete the fields as shown in the 
following table.

Field Recommended entry Notes

Name Enter a logical name for the 
Data server. For example, 
DataServerMSSQL.

Include the type of database on your 
Avaya IC system in the name. You 
need this name to configure IC 
Repository and the CCQ database.
Tip: For all secondary Data servers, 
include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

For example, select Default from 
the drop-down list if the server is in 
the Default domain.

Host Select the IP address of the 
machine that hosts the 
server, or enter the IP 
address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

DB Login Enter your DBA user name. The name used by the Data server to 
access databases.

DB Password Enter your database 
password.

The password that corresponds to 
the database login name used by the 
Data server to access databases.

Request Handler 
Thread Pool Size

Enter the number of requests 
in the thread pool.
Default is 30.

Maximum number of threads that 
handle client requests in the Data 
server. These threads accept 
requests from the Data server clients 
and queues them for execution in the 
database.

DB Connection 
Pool Size

Enter the number of 
connections in the pool.
Default is 15.
Minimum is 1.

Maximum number of database 
connections to open in a connection 
pool.
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6. Select the Debug tab and perform the following steps:

a. Select the Ellipsis (�) button next to Trace Levels. 

b. In the Trace Levels dialog box, check the following boxes.

c. Select OK.

For information about the other options in the Trace Levels dialog box, see IC 
Administration Volume 1: Servers & Domains.

7. Select OK to save the Data server configuration. 

8. Right-click on the Data server, and select Start from the drop-down list.

Configuring a primary Data server for Oracle

To configure the primary Data server for Oracle:

1. On the machine where you installed the Design & Administration Tools, select 
Start > Programs > Avaya Interaction Center 6.1 > IC Manager.

2. Log in to IC Manager with the pre-assigned login ID and password shown in the 
following table.

The next time you log in, IC Manager will prompt you to change the password. 

3. Select the Server tab, then: 

a. Select Server > New.

b. Select DataServerOracle from the list of servers.

c. Select OK.

Field Recommended entry Notes

idl ● Check this box for 
development systems 
only.

● Clear this box for 
production systems.

idl is a higher level trace that is 
more readable than msg. idl 
writes all method invocations to 
the log file.

flush ● Check this box for 
development systems 
only.

● Clear this box for 
production systems.

When the server writes to the 
log buffer, flush immediately 
writes the information to the log 
file. Flush does not wait for the 
buffer to fill before writing 
entries to the log file. 

Login Password

Admin admin
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4. In the General tab of the Server Editor, complete the fields as shown in the following 
table.

5. In the DataServer tab of the Server Editor, complete the fields as shown in the 
following table.

6. Select the Debug tab and perform the following steps:

Field Recommended entry Notes

Name Type DataServerOracle or 
another logical name for the 
Data server. 

Include the type of database on your 
Avaya IC system in the name. You 
need this name to configure IC 
Repository and the CCQ database.
Tip: For all secondary Data servers, 
include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

For example, select Default from 
the drop-down list if the server is in 
the Default domain.

Host Select the IP address of the 
machine that hosts the 
server, or enter the IP 
address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

DB Login Enter the Oracle database 
user name.

The database login name used by 
the Data server to access databases.

DB Password Enter the password for the 
ODBC database.

The password as configured in the 
Oracle database. 

Oracle Home 
Directory

Enter the pathname of the 
home directory of the Oracle 
database.

Oracle Data server only.
This home directory overrides the 
home directory specified in the IC 
Data Source.

Request Handler 
Thread Pool Size

Enter the number of requests 
in the thread pool.
Default is 30.

Maximum number of threads that 
handle client requests in the Data 
server. These threads accept 
requests from the Data server clients 
and queues them for execution in the 
database.

DB Connection 
Pool Size

Enter the number of 
connections in the pool.
Default is 15.
Minimum is 1.

Maximum number of database 
connections to open in a connection 
pool.
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a. Select the Ellipsis (�) button next to Trace Levels. 

b. In the Trace Levels dialog box, check the following boxes.

c. Select OK.

For information about the other options in the Trace Levels dialog box, see IC 
Administration Volume 1: Servers & Domains.

7. Select OK to save the Data server configuration. 

8. Right-click on the Data server, and select Start from the drop-down list.

Configuring a primary Data server for IBM DB2

To configure the primary Data server:

1. On the machine where you installed the Design & Administration Tools, select 
Start > Programs > Avaya Interaction Center 6.1 > IC Manager.

2. Log in to IC Manager with the pre-assigned login ID and password shown in the 
following table.

The next time you log in, IC Manager will prompt you to change the password. 

3. Select the Server tab, then: 

a. Select Server > New.

b. Select DataServerDB2 from the list of servers.

c. Select OK.

Field Recommended entry Notes

idl ● Check this box for 
development systems 
only.

● Clear this box for 
production systems.

idl is a higher level trace that is 
more readable than msg. idl 
writes all method invocations to 
the log file.

flush ● Check this box for 
development systems 
only.

● Clear this box for 
production systems.

When the server writes to the 
log buffer, flush immediately 
writes the information to the log 
file. Flush does not wait for the 
buffer to fill before writing 
entries to the log file. 

Login Password

Admin admin
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4. In the General tab of the Server Editor, complete the fields as shown in the following 
table.

5. In the DataServer tab of the Server Editor, complete the fields as shown in the 
following table.

6. Select the Debug tab and perform the following steps:

a. Select the Ellipsis (�) button next to Trace Levels. 

Field Recommended entry Notes

Name Type DataServerDB2 or 
another logical name for the 
Data server.

Include the type of database on 
your Avaya IC system in the 
name. You need this name to 
configure IC Repository and the 
CCQ database.
Tip: For all secondary Data 
servers, include the domain in 
the server name to identify the 
server.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

For example, select Default 
from the drop-down list if the 
server is in the Default domain.

Host Select the IP address of the 
machine that hosts the 
server, or type in the IP 
address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

DB Login Enter your database login 
name. 

The name used by the Data server to 
access databases.

DB Password Enter your database 
password.

The password that corresponds to 
the database login name used by the 
Data server to access databases.

Request Handler 
Thread Pool Size

Enter the number of requests 
in the thread pool.
Default is 30.

Maximum number of threads that 
handle client requests in the Data 
server. These threads accept 
requests from the Data server clients 
and queues them for execution in the 
database.

DB Connection 
Pool Size

Enter the number of 
connections in the pool.
Default is 15.
Minimum is 1.

Maximum number of database 
connections to open in a connection 
pool.
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b. In the Trace Levels dialog box, check the following boxes.

c. Select OK.

For information about the other options in the Trace Levels dialog box, see IC 
Administration Volume 1: Servers & Domains.

7. Select OK to save the Data server configuration. 

8. Right-click on the Data server, and select Start from the drop-down list.

Data sources and Business Applications
Application Design Language (ADL) files contain the data models for Avaya IC databases 
and Business Applications, including tables, table sets, browsers, and modules. These 
files also contain the interface for one or more Business Applications. 

For an out-of-the-box, non-customized Avaya IC installation, use ADL files to perform the 
following tasks:

● Configure Avaya IC databases

● Create Avaya IC data sources

● Generate Avaya Business Applications

Field Recommended entry Notes

idl ● Check this box for 
development systems 
only.

● Clear this box for 
production systems.

idl is a higher level trace that is 
more readable than msg. idl 
writes all method invocations to 
the log file.

flush ● Check this box for 
development systems 
only.

● Clear this box for 
production systems.

When the server writes to the 
log buffer, flush immediately 
writes the information to the log 
file. Flush does not wait for the 
buffer to fill before writing 
entries to the log file. 
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About data sources
All Avaya IC components that must access a database use Avaya IC data sources. These 
components include servers, workflows, and agent applications. You create an Avaya IC 
data source when you generate an application from the application ADL file. 

Even if your Avaya IC configuration does not include a Business Application, you must 
generate an application to create the following data sources:

● Repository data source

● Interaction Center data source 

Repository and Interaction Center are only data sources. They do not have a user 
interface. Although you generate a Windows application to create the data sources, you 
cannot use repository or interaction_center as a Business Application.

The following table describes the typical data sources in an out-of-the-box Avaya IC 
installation. 

Data Source ADL File Description

repository repository.adl Required for all Avaya IC systems.
Used by the Directory server, Report server, and 
DUStore server for access to the IC Repository.

interaction_center ccq.adl Required for all Avaya IC systems.
Used by all other Avaya IC servers, except the 
Letter Generator Workflow server, to access the 
database. This data source also handles most 
server-related transactions, such as workflows, 
that are not specifically related to a Business 
Application.
Note: Use this data source for all Avaya IC 
systems that integrate with third party 
applications.

Report Wizard repository.adl Optional.
Used by Avaya IC systems that include Report 
Wizard for mappings to retire EDUs to the IC 
Repository database.

ccq_contact ccq.adl Optional. 
Used only by Avaya IC systems that include 
Contact-based CallCenterQ.

ccq_cr_contact ccq.adl Optional. 
Used only by Avaya IC systems that include 
Contact-based CallCenterQ for Consumer 
Relations.
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About Business Applications
Avaya Business Applications are optional components of Avaya IC. You can use these 
components to add additional features to your agent desktop, or to add reporting 
functionality for administrators.

The following table describes the Business Applications available in an out-of-the-box 
Avaya IC installation.

ccq_request ccq.adl Optional. 
Used only by Avaya IC systems that include 
Request-based CallCenterQ.

ccq_cr_request ccq.adl Optional. 
Used only by Avaya IC systems that include 
Request-based CallCenterQ for Consumer 
Relations.

custq custq.adl Optional. 
Used only by Avaya IC systems that include 
CustomerQ.

hrq hrq.adl Optional. 
Used only by Avaya IC systems that include 
HRQ.

Data Source ADL File Description

Application ADL File Description

Report Wizard repository.adl Sets mappings to retire EDUs to the IC Repository database. 
You must build the Report Wizard application to use or view data 
from EDUs.
To generate Report Wizard, select reportwizard when you 
generate your Windows application.

Interaction 
Center

ccq.adl Performs some administrative tasks for the CCQ database in 
Avaya IC systems that do not include a Business Application. 
To generate Interaction Center, select interaction_center when 
you generate your Windows application.

CallCenterQ ccq.adl Allows contact center agents to handle contacts with customers, 
to place and send out fulfillment orders, and to handle returns. 
Allows you to create and manage marketing campaigns.
To generate CallCenterQ, when you generate your Windows 
application:
● Select ccq_contact for Contact-based CallCenterQ.
● Select ccq_request for Request-based CallCenterQ.
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Creating IC Repository
IC Repository manages current and historical data in the form of Electronic Data Units 
(EDUs), Agent Data Units (ADUs), system configuration, and resource utilization statistics. 
This data includes agents, workgroups, queues, and tenants. IC Repository forms the 
structure that your database server needs to accept contact data from the Avaya IC EDU 
server and ADU server.

The following Avaya IC applications require IC Repository:

● Avaya Agent
● Web Management
● Email Management
● Telephony
● Business Applications, such as CallCenterQ, HRQ, or CustomerQ
Avaya OA queries the data that these Avaya IC components write in the IC Repository 
database and other Avaya IC databases. Avaya OA then reports on the results of the 
queries. For a diagram of how the Avaya IC and Avaya OA databases communicate and 
share data, see IC Installation Planning and Prerequisites.

CallCenterQ for 
Consumer 
Relations

ccq.adl Allows contact center agents to handle customer complaints and 
to send out fulfillment packages. CallCenterQ for Consumer 
Relations is designed specifically for companies that provide 
consumer services or sell consumer packaged goods.
To generate CallCenterQ for Consumer Relations, when you 
generate your Windows application:
● Select ccq_cr_contact for Contact-based CallCenterQ for 

Consumer Relations.
● Select ccq_cr_request for Request-based CallCenterQ for 

Consumer Relations.

CustomerQ custq.adl Allows agents in internal contact centers and help desks to 
handle issues quickly and intelligently. 
To generate CustomerQ, select customerq when you generate 
your Windows application.

HRQ hrq.adl Allows agents in human resource departments and employee 
service centers to provide personalized service over the 
telephone, on the Web, or through corporate intranets.
To generate HRQ, select hrq when you generate your Windows 
application.

Application ADL File Description
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Before you build the IC Repository database:

● You must know the names that you will give to your IC Repository and CCQ databases.

● If you are creating IC Repository for the localization release of Avaya IC, you must 
enable Localization in Database Designer before you open the IC Repository ADL file. 
For more information, see Enabling Database Designer for localization on page 545.

To create IC Repository, complete the steps in the following topics:

1. Building the IC Repository database on page 90.

2. Generating the IC Repository application on page 98.

3. Generating the Report Wizard application on page 99.

4. Updating the Directory server with IC Repository on page 101.

Building the IC Repository database
The following instructions assume that you have reviewed and modified all components of 
the IC Repository ADL file in Database Designer. For information about the ADL file, see 
IC Database Designer User Guide.

Note:
Note: If you use DB2 for your Avaya IC databases, you must copy the qdb2sp 

stored procedure library from the machine that hosts the primary ORB 
server to the DB2 installation hierarchy. If you do not copy the stored 
procedure library, Database Designer will not be able to configure the Avaya 
IC databases. For more information, see Copying the stored procedure 
library - DB2 only on page 78.

To build the IC Repository database, perform the steps in the following topics:

1. Configuring the IC Repository database connection on page 91.

2. Configuring the IC Repository connection set on page 96.

3. Creating the IC Repository database on page 97.
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Configuring the IC Repository database connection

To configure the IC Repository database connection:

1. In Database Designer, select File > Open.

2. Open the IC Repository ADL file.

You can find this ADL file in 
IC_INSTALL_DIR\IC61\design\repository\repository.adl

If you have enabled Database Designer for localization, select OK and ignore the 
warning about the missing ALF file. Database Designer will automatically generate the 
ALF file when you save the ADL file. For more information, see Enabling Database 
Designer for localization on page 545.

3. Expand Components > Physical DB Connections and select 
repositoryDBConnection in the tree pane.

4. In the DB Connection Properties tab, complete the fields in the General group as 
shown in the following table:

Property Recommended entry Notes

Timeout (sec) Type the maximum number of 
seconds that the client application 
waits for a response to a database 
request before the application 
assumes the connection to the 
Data server is lost.

Default value is 60 seconds.
If no response is returned within the 
specified time, the client application 
closes the connection to the Data server 
and returns an error. The client application 
attempts to create a new connection to 
the database on the next database 
request. 
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5. From the Database Type drop-down menu, select the type of database to which you 
want to connect.

Database Designer uses the selected database type to generate a SQL statement 
which can be applied to the database.

Description Type a description of the database 
connection, if desired.

You can leave this field empty.

Display Time Select the display time setting. The display time option determines how 
Avaya IC handles the difference in time 
between the agent desktop machine and 
the time as reported by the Database for 
all database activities, such as select, 
insert, and update.
The display time options are:
● DBMSTIME � Select this option if you 

want the DateTime data to display as 
database time, and not adjusted to 
local time. With DBMSTIME, Avaya IC 
ignores the difference in time and does 
not apply the difference to any 
database activity.

● LOCALTIME if you want the DateTime 
data to display as adjusted to local time 
on the client. With LOCALTIME, Avaya 
IC uses the difference in time, rounds it 
to the nearest half hour, and applies 
this difference to all database activity 
that involves date and time information.

● HOSTTIME if you want the DateTime 
data to display as adjusted to the local 
host time, including small differences 
between system clocks. With 
HOSTTIME, Avaya IC uses the 
difference in time and applies this 
difference to all database activity that 
involves date and time information.

Property Recommended entry Notes
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6. Complete the Mandatory fields for your database, as shown in the following table.

Database type Property Recommended entry Notes

All database 
types

Data Server 
Type/Alias

Type the name of the 
primary Data server. 

This server is the one that 
you created in Setting up the 
primary Data server on 
page 79.
For example, defaults are:
● DataServerMSSQL
● DataServerOracle
● DataServerDB2

SQL Server Database server Type the host name of the 
machine that hosts your 
database server.

For the default database 
instance, type the host name. 
For another database 
instance, type 
<machine>\<db_name>.

Database Name Type the name of the IC 
Repository database. For 
example, repository.

Avaya recommends that you 
use repository to reduce 
the possibility of a migration 
impact. 

Oracle TNS Name Type the server alias from 
the tnsnames.ora file

For example, type 
support.xyzcorp.com.

Database Name Type the name of the 
Oracle user for the IC 
Repository database. For 
example, repository.

Avaya recommends that you 
use repository to reduce 
the possibility of a migration 
impact. 

Client Library 
Home Directory

Type the full directory path 
for the Oracle client on the 
machine that hosts the 
Data server. 

For example, type 
.../opt/oracle/8.1.7

DB2 DB2 Database 
Name

Type the name of the DB2 
database that includes the 
Avaya IC schema.

DB2 allows a maximum of 
eight characters for database 
names.
For example, type db2IC.

IC Schema Name Type the schema name of 
the IC Repository 
database. For example, 
repository.

Avaya recommends that you 
use repository to reduce 
the possibility of a migration 
impact. 

Database Territory Type the territory that 
represents the locale of the 
database that includes the 
IC Repository schema.

The territory defines the 
language and locale of the 
database. For more 
information, see the DB2 
documentation.
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7. If necessary, complete the Optional fields for your database, as shown in the following 
table.

Database type Property Recommended entry Notes

SQL Server Database Location Leave this field blank. Identifies the logical space 
where the named database is 
stored. 
The SQL Server DBMS 
specifies the database 
location.

Database Size Leave this field blank. The size of the database 
location specifies the amount 
of space that the configured 
application database 
occupies. 
The SQL Server RDBMS 
specifies the database size.

Log Location Leave this field blank. Database-generated log files 
store cumulative transaction 
information. The SQL Server 
RDBMS specifies a default 
location for the database log.

Log Size Leave this field blank. The size of the location for 
database log files specifies 
the amount of space that the 
database-generated log files 
can occupy. 
The SQL Server RDBMS 
specifies a default size for the 
database log.
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Oracle Default tablespace 
name

Type the name of the 
default tablespace where 
objects are created for the 
Avaya IC databases. For 
example, type IC_TS.

The database location 
identifies the logical space 
where the named database is 
stored. If you leave this field 
blank, and the Oracle 
RDBMS does not specify a 
database location, Oracle 
uses the �system� space to 
define the database. 
Caution: Configuring a 
database in the system space 
can crash your database.

Default tablespace 
size

Type the number of bytes 
for the size of the default 
tablespace.

Caution: If you do not specify 
a default tablespace size 
here, and your RDBMS does 
not define the default 
tablespace size, the default 
tablespace can expand to 
use all available space.

Temp tablespace 
name

Type the name of the 
tablespace that stores 
temporary files. For 
example, type 
T_CI_TEMP.

Temporary tables store 
database-generated 
intermediate sorting files and 
client session information for 
Oracle databases. If you do 
not specify a location for 
temporary tables, the location 
is specified by the Oracle 
RDBMS.

Temp tablespace 
size

Type the number of bytes 
for the size of the 
tablespace that includes 
temporary tables.

The size of the location for 
temporary tables in Oracle 
databases specifies the 
amount of space that the 
temporary tables can occupy. 
If you do not specify the 
amount of space to be 
allocated for temporary 
tables, the size is specified by 
the Oracle RDBMS.

Database type Property Recommended entry Notes
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8. Select File > Save to save the ADL file. Do not close the file.

Configuring the IC Repository connection set

To configure the connection set for IC Repository:

1. In Database Designer, expand DB Connection Sets and select 
DefaultDBConnectionSet in the tree pane.

2. Select Application from the Logical DB Connections list in the Connection Set 
Properties tab.

3. Make sure the properties are set as shown in the following table:

4. Select Repository from the Logical DB Connections list.

DB2 Catalogued Node Type the remote node on 
the machine that hosts the 
Data server.

Complete this field if you host 
your Data server on a 
different machine from the 
Avaya IC databases.

Tablespace Name Type the name of the 
tablespace used by the IC 
Repository database.

Complete this field if you 
created a dedicated 
tablespace that the IC 
Repository database uses. 
Note: Avaya OA requires 
dedicated tablespaces. For 
more information, see Avaya 
OA Installation Planning and 
Prerequisites.

Database type Property Recommended entry Notes

Field Recommended entry

Physical DB Connection Select repositoryDBConnection.

Primary Do not check this box.

Use External Database Check this box.

Database Name Type the name of your application database.
This name must be the exact name that you 
will give your application database when you 
create it. For example, type ccq.
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5. Make sure the properties are set as shown in the following table:

6. Select File > Save to save the ADL file. Do not close the file.

Creating the IC Repository database

These steps perform the following:

● Create the schema that Avaya IC requires for IC Repository

● Seed IC Repository with the configuration data in the seed.cfg file. 

You do not need to modify the IC Repository seed data. The following table describes the 
contents of the seed data for IC Repository:

To create the IC Repository database:

1. In Database Designer, select File > Database Administration.

2. Select defaultDBConnectionSet from the DB Connection Set list.

3. Set the options as shown in the following table:

Field Recommended entry

Physical DB Connection Select repositoryDBConnection.

Primary Check this box.

Type of data Description

Property data System configuration data for IC Manager and Avaya 
Agent.

Initialization data Default workgroup, queue, and tenant data for Web 
Management and Email Management. This data also 
includes templates you can use to create custom 
workgroups, queues, and tenants.

Mapping data Default mapping rules for the Report Server. These rules 
tell the server how to write data from retired EDUs to IC 
Repository.

Field Recommended entry

Configure Select Configure.

Import Seed Data Check this box.
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4. Select Run to configure the database and import the seed data.

Database Designer pauses briefly between configuring the database and importing the 
seed data. 

5. Select Close to close the Database Administration screen. Do not close the ADL file. 

Generating the IC Repository application
You generate the IC Repository application to initialize the database with the ADL and 
version information, and to create the Repository data source.

To generate the IC Repository application:

1. In Database Designer, select File > Generate Windows Application.

2. Check the following boxes to load the files to the database:

● Messages

● IC Scripts

3. Select repository from the Name list.

4. Type the path for the directory where you want Database Designer to store the 
application files.

For example, type C:\Program Files\Avaya\IC61\apps.

If you do not know the directory path, select the Ellipsis (�) button and navigate to the 
directory.

5. From the DB Connection Set drop-down list, select defaultDBConnectionSet.

Login Id Type your IC Manager login ID.
Note: Do not use your DBA login ID and 
password.

Password Type your password.

Field Recommended entry
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6. If the fields in the following table do not have entries, re-type your IC Manager account 
and password. 

7. Select OK.

Database Designer creates a new folder with the same name as the application in the 
target directory.

Generating the Report Wizard application
You use the Report Wizard to set mappings to retire EDUs to the IC Repository database. 
You must build the Report Wizard application to use or view data from EDUs.

Generate the Report Wizard application from the IC Repository ADL file.

To build the Report Wizard application:

1. In Database Designer, select File > Generate Windows Application.

2. In the Generate Windows Application dialog box, complete the fields as shown in the 
following table:

Field Recommended entry

Login Id Type your IC Manager login ID.
Note: Do not use your DBA login ID and 
password.

Password Type your password.

Field Recommended entry

Messages Check this box.

IC Scripts Check this box.

Forms Check this box.
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3. Select reportwizard from the Name drop-down list.

4. Type the path for the directory where you want Database Designer to store the 
application files.

For example, type C:\Program Files\Avaya\IC61\apps.

If you do not know the directory path, select the Ellipsis (�) button and navigate to the 
directory.

5. From the DB Connection Set drop-down list, select defaultDBConnectionSet.
6. If the fields in the following table do not have entries, re-type your IC Manager account 

and password. 

7. Select OK.

Database Designer creates a new folder with the same name as the application in the 
target directory. This folder contains the Report Wizard ADL file.

Help ● Check this box.
● Type the path and file name for the help file, 

as follows: 
IC_INSTALL_DIR\IC61\help\
ReportWizard\Reports.chm

Avaya Agent Layout ● Check this box.
● Type the path and file name for the layout 

file, as follows: 
IC_INSTALL_DIR\IC61\design\
QConsole\avaya_agent_<lang>.cdl

where <lang> is the language in your Report 
Wizard desktop. For example, if your Report 
Wizard desktop includes Avaya Agent in 
English, select avaya_agent_en.cdl
For more information about Avaya Agent 
layouts in non-English languages, see 
Configuring Avaya Agent for a supported 
language on page 548.

Field Recommended entry

Login Id Type your IC Manager login ID.
Note: Do not use your DBA login ID and 
password.

Password Type your password.

Field Recommended entry
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Updating the Directory server with IC Repository
You must initialize the connection between the Directory server and IC Repository. Until 
this point in the configuration, your Avaya IC ORB environment obtained configuration 
information from the machine�s local hard drive. After you update the Directory server, the 
Avaya IC ORB environment obtains and stores configuration information in IC Repository.

To update the Directory server for IC Repository:

1. On the Server tab in IC Manager, double-click the Directory server.

2. Select the Directory tab.

3. Select the IC Repository data source from the IC Data Source drop-down list. Select 
OK.

4. Stop and start the Directory server.

5. When the Alarm Monitor indicates that the Directory server started properly, select 
Manager > Refresh. 

The Alarm Monitor should display a message such as "Server has started:: DS" 
followed by the IP address of the machine that hosts the Directory server, the port used 
to communicate with the server, and an identification string.

If you do not receive a Success message, perform the steps in Troubleshooting the 
refresh in IC Manager on page 510.

Note:
Note: If you prefer to create and configure all databases at the same time, you can 

also create and configure the other databases used by your Avaya IC 
system at this time. For the Dialer database used by Outbound Contact, see 
Configuring the Dialer database on page 220. For the Avaya OA databases, 
see the Operational Analyst Installation and Configuration. 

Creating the CCQ database
You must create and seed the CCQ database to run all Avaya IC components and 
applications.

The CCQ database collects, stores, and manages:

● Customer-specific data, including contact information and customer history information

● Application data, including information about Web Management, Email Management, or 
CallCenterQ
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Note:
Note: If you use DB2 for your Avaya IC databases, you must copy the qdb2sp 

stored procedure library from the machine that hosts the primary ORB 
server to the DB2 installation hierarchy. If you do not copy the stored 
procedure library, Database Designer will not be able to configure the Avaya 
IC databases. For more information, see Copying the stored procedure 
library - DB2 only on page 78.

To create the CCQ database, complete the steps in the following topics:

1. Modifying the Avaya Agent layout on page 102.

2. Building the CCQ database on page 102.

3. Generating the Interaction Center application on page 109.

Modifying the Avaya Agent layout
If your system does not include Avaya Agent, do not perform this step. Go to Building the 
CCQ database on page 102.

Avaya IC installs the default Avaya Agent layout in the following directory:

IC_INSTALL_DIR\IC61\design\QConsole\avaya_agent_<lang>.cdl

where <lang> represents the language that the agent will use on the desktop. For 
example, if the agent desktop includes Avaya Agent in English, select 
avaya_agent_en.cdl. For more information about Avaya Agent layouts in non-English 
languages, see Configuring Avaya Agent for a supported language on page 548.

The default layout includes task lists for all media channels, including Telephony, Web 
Management, Email Management, and Outbound Contact. To customize the Avaya Agent 
layout for your contact center, see Avaya Agent Integrator�s Guide.

Building the CCQ database
To build the CCQ database, perform the steps in the following topics:

1. Configuring the CCQ database connection on page 103.

2. Configuring the CCQ connection set on page 107.

3. Creating the CCQ database on page 108.
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Configuring the CCQ database connection

To configure the CCQ database connection:

1. If you do not already have the CallCenterQ ADL file open in Database Designer, select 
File > Open.

You can find this ADL file in 
IC_INSTALL_DIR\IC61\design\CallCenterQ\ccq.adl

2. Expand Components > Physical DB Connections and select ccqDBConnection in 
the tree pane.

3. In the DB Connection Properties tab, complete the fields in the General group as 
shown in the following table:

4. From the Database Type drop-down menu, select the type of database to which you 
want to connect.

Database Designer uses the selected database type to generate a SQL statement 
which can be applied to the database.

Property Recommended entry Notes

Timeout (sec) Type the maximum number of 
seconds that the client application 
waits for a response to a database 
request before the application 
assumes the connection to the 
Data server is lost.

Default value is 60 seconds.
If no response is returned within the 
specified time, the client application 
closes the connection to the Data server 
and returns an error. The client application 
attempts to create a new connection to 
the database on the next database 
request. 

Description Type a description of the database 
connection, if desired.

You can leave this field empty.

Display Time Select the display time setting that 
specifies how DateTime data from 
the database is presented in the 
client application.

The display time options are:
● DBMSTIME if you want the DateTime 

data to display as database time, and 
not adjusted to local time.

● LOCALTIME if you want the DateTime 
data to display as adjusted to local time 
on the client

● HOSTTIME if you want the DateTime 
data to display as adjusted to the local 
host time, including small differences 
between system clocks.
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5. Complete the Mandatory fields for your database, as shown in the following table.

Database type Property Recommended entry Notes

All database 
types

Data Server 
Type/Alias

Type the name of the 
primary Data server. 

This server is the one that 
you created in Setting up the 
primary Data server on 
page 79.
For example, defaults are:
● DataServerMSSQL
● DataServerOracle
● DataServerDB2

SQL Server Database server Type the host name of the 
machine that hosts your 
database server.

For the default database 
instance, type the host name. 
For another database 
instance, type 
<machine>\<db_name>.

Database Name Type the name of the 
CallCenterQ database. For 
example, ccq.

Avaya recommends that you 
use ccq to reduce the 
possibility of a migration 
impact. 

Oracle TNS Name Type the server alias from 
the tnsnames.ora file

For example, type 
support.xyzcorp.com.

Database Name Type the name of Oracle 
user for the CallCenterQ 
database. For example, 
ccq.

Avaya recommends that you 
use ccq to reduce the 
possibility of a migration 
impact. 

Client Library 
Home Directory

Type the full directory path 
for the Oracle client on the 
machine that hosts the 
Data server. 

For example, type 
.../opt/oracle/8.1.7

DB2 DB2 Database 
Name

Type the name of the DB2 
database that includes the 
Avaya IC schema.

DB2 allows a maximum of 
eight characters for database 
names.
For example, type db2IC.

IC Schema Name Type the schema name of 
the CallCenterQ database. 
For example, ccq.

Avaya recommends that you 
use ccq to reduce the 
possibility of a migration 
impact. 

Database Territory Type the territory that 
represents the locale of the 
database that includes the 
CallCenterQ schema.

The territory defines the 
language and locale of the 
database. For more 
information, see the DB2 
documentation.
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6. If necessary, complete the Optional fields for your database, as shown in the following 
table.

Database type Property Recommended entry Notes

SQL Server Database Location Leave this field blank. Identifies the logical space 
where the named database is 
stored. 
The SQL Server DBMS 
specifies the database 
location.

Database Size Leave this field blank. The size of the database 
location specifies the amount 
of space that the configured 
application database 
occupies. 
The SQL Server RDBMS 
specifies the database size.

Log Location Leave this field blank. Database-generated log files 
store cumulative transaction 
information. The SQL Server 
RDBMS specifies a default 
location for the database log.

Log Size Leave this field blank. The size of the location for 
database log files specifies 
the amount of space that the 
database-generated log files 
can occupy. 
The SQL Server RDBMS 
specifies a default size for the 
database log.
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Oracle Default tablespace 
name

Type the name of the 
default tablespace where 
objects are created for the 
Avaya IC databases. For 
example, type IC_TS.

The database location 
identifies the logical space 
where the named database is 
stored. If you leave this field 
blank, and the Oracle 
RDBMS does not specify a 
database location, Oracle 
uses the �system� space to 
define the database. 
Caution: Configuring a 
database in the system space 
can crash your database.

Default tablespace 
size

Type the number of bytes 
for the size of the default 
tablespace.

Caution: If you do not specify 
a default tablespace size 
here, and your RDBMS does 
not define the default 
tablespace size, the default 
tablespace can expand to 
use all available space.

Temp tablespace 
name

Type the name of the 
tablespace that stores 
temporary files. For 
example, type 
T_CI_TEMP.

Temporary tables store 
database-generated 
intermediate sorting files and 
client session information for 
Oracle databases. If you do 
not specify a location for 
temporary tables, the location 
is specified by the Oracle 
RDBMS.

Temp tablespace 
size

Type the number of bytes 
for the size of the 
tablespace that includes 
temporary tables.

The size of the location for 
temporary tables in Oracle 
databases specifies the 
amount of space that the 
temporary tables can occupy. 
If you do not specify the 
amount of space to be 
allocated for temporary 
tables, the size is specified by 
the Oracle RDBMS.

Database type Property Recommended entry Notes
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7. Select File > Save to save the ADL file. Do not close the file.

Configuring the CCQ connection set

To configure the CCQ connection set:

1. In Database Designer, expand DB Connection Sets and select 
DefaultDBConnectionSet in the tree pane.

2. Select CallCenterQ from the Logical DB Connections list in the Connection Set 
Properties tab and make sure the properties are set as shown in the following table:

3. Select Repository from the Logical DB Connections list and make sure the 
properties are set as shown in the following table:

DB2 Catalogued Node Type the remote node on 
the machine that hosts the 
Data server.

Complete this field if you host 
your Data server on a 
different machine from the 
Avaya IC databases.

Tablespace Name Type the name of the 
tablespace used by the 
CallCenterQ database.

Complete this field if you 
created a dedicated 
tablespace that the IC 
Repository database uses. 
Note: Avaya OA requires 
dedicated tablespaces. For 
more information, see Avaya 
OA Installation Planning and 
Prerequisites.

Database type Property Recommended entry Notes

Field Recommended entry

Physical DB Connection Select ccqDBConnection.

Primary Check this box.

Field Recommended entry

Physical DB Connection Select ccqDBConnection.

Primary Do not check this box.
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4. If your Avaya IC system includes Outbound Contact, select Dialer from the Logical 
DB Connections list and make sure the properties are set as shown in the following 
table:

5. Select File > Save to save the ADL file. Do not close the file.

Creating the CCQ database

These steps create the schema for the CCQ database and seed the database with the 
configuration data in the seed.cfg file. You do not need to modify the seed file.

The seed data contains system data for the Web Management servers and Web Self-
Service. You must seed the CCQ database with this data if your system includes Web 
Management and Email Management.

To create the CCQ database:

1. Select File > Database Administration.

2. Select DefaultDBConnectionSet from the DB Connection Set list.

Use External Database Check this box.

Database Name Type the name of your IC Repository 
database.
This name must be the exact name that you 
gave your IC Repository database. For 
example, type repository.

Field Recommended entry

Physical DB Connection Select ccqDBConnection.

Primary Do not check this box.

Use External Database Check this box.

Database Name Type the name of your Dialer database.
This name must be the exact name that you 
will give your Dialer database. For example, 
type dialer.

Field Recommended entry
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3. Set the options as shown in the following table:

4. If the fields in the following table do not have entries, re-type your IC Manager account 
and password. 

5. Select Run to configure the database.

Database Designer pauses briefly between configuring the database and importing the 
seed data. 

6. Select Close. Do not close the ADL file.

Generating the Interaction Center application
You generate the Interaction Center application to initialize the database with the ADL and 
version information and to create the Interaction Center data source.

You also can use these instructions to generate all Business Applications, including 
CallCenterQ and CustomerQ.

If you are configuring a localized version of Avaya IC, you must import the localized seed 
data after you perform this step. For more information, see Importing localized seed 
data on page 550.

Field Recommended entry

Configure Select Configure.

Import Seed Data Check this box.

Field Recommended entry

Login Id Type your IC Manager login ID.
Note: Do not use your DBA login ID and 
password.

Password Type your password.
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To generate the Interaction Center application:

1. In Database Designer, select File > Generate Windows Application to open the 
Generate Windows Application dialog box.

2. Complete the fields as shown in the following table:

3. If your Avaya IC system does not include a Business Application, complete the fields 
as shown in the following table:

For more information about Avaya Agent layouts in non-English languages, see 
Configuring Avaya Agent for a supported language on page 548.

4. Select interaction_center from the Name list.

5. Type the path for the directory where you want Database Designer to store the 
application files.

For example, type C:\Program Files\Avaya\IC61\apps.

If you do not know the directory path, select the Ellipsis (�) button and navigate to the 
directory.

6. From the DB Connection Set drop-down list, select defaultDBConnectionSet.

Field Recommended entry

Messages Check this box.

IC Scripts Check this box.

Forms Check this box.

Field Recommended entry

Avaya Agent Layout ● Check this box.
● Type the path and file name for the layout file, as 

follows: IC_INSTALL_DIR\IC61\design\
QConsole\avaya_agent_<lang>.cdl

where <lang> is the language of the agent 
desktop. For example, if Avaya Agent is in English, 
select avaya_agent_en.cdl

EDU Layout ● Check this box.
● Type the path and file name for the layout file, as 

follows: IC_INSTALL_DIR\IC61\design\
QConsole\eduviewer_<lang>.xsl

where <lang> is the language on the agent 
desktop. For example, if Avaya Agent is in English, 
select eduviewer_en_US.xsl
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7. If the fields in the following table do not have entries, re-enter your IC Manager account 
and password. 

8. Select OK.

Database Designer creates a new folder with the same name as the application in the 
target directory. This folder contains the Interaction Center ADL files.

9. Select File > Exit to close Database Designer if you do not need to create a Business 
Application.

Creating Business Applications
All Avaya IC implementations require an IC Repository database, a CallCenterQ database, 
and an Interaction Center data source. If your Avaya IC configuration includes a Business 
Application, you also must generate one or more of the following applications:

Field Recommended entry

Login Id Type your IC Manager login ID.
Note: Do not use your DBA login ID and 
password.

Password Type your password.

Application ADL File Action Required

CallCenterQ IC_INSTALL_DIR\IC61\design
\
CallCenterQ\ccq.adl

Generate the desired CallCenterQ 
application. For example, 
generate ccq_request or 
ccq_contact.

CustomerQ IC_INSTALL_DIR\IC61\design
\
CustomerQ\custq.adl

Create a CustomerQ database 
and generate a CustomerQ 
application.

HRQ IC_INSTALL_DIR\IC61\design
\hrq\
hrq.adl

Create an HRQ database and 
generate an HRQ application 
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To create a database or generate an application for a Business Application, follow the 
directions in the following topics of Creating the CCQ database. Substitute the appropriate 
names and locations for the CCQ-specific information.

1. For the localized version of CallCenterQ only, Enabling Database Designer for 
localization on page 545.

2. Building the CCQ database on page 102.

3. Generating the Interaction Center application on page 109.

4. For the localized version of CallCenterQ only, Configuring Avaya Agent for multiple 
languages on page 549.

5. For the localized version of CallCenterQ only, Importing localized seed data on 
page 550.

When you generate a business application, you must include the help file for that 
application. The following table describes where Avaya IC installs the help files.

For more information about creating databases and generating applications for Business 
Applications, see IC Database Designer User Guide.

Business Application Location

CallCenterQ IC_INSTALL_DIR\IC61\help\CallCenterQ\ccq.ch
m

CustomerQ IC_INSTALL_DIR\IC61\help\CustomerQ\custq.ch
m

HRQ IC_INSTALL_DIR\IC61\help\Hrq\hrq.chm
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Chapter 5: Configuring core servers

Avaya� Interaction Center (Avaya IC) installation copies all Avaya IC server files to the 
target machines. You cannot copy only the files for selected servers on a machine. If your 
Avaya IC configuration requires only certain servers on a machine, run the Avaya IC 
installation on that machine to copy the server files, then configure only those servers that 
you want to host on the machine.

This section describes how to configure the core servers, including the Avaya IC domains 
and accounts required for these servers. This section includes the following topics that 
provide information and the steps that you need to follow to configure the core servers:

1. Completing prerequisites for configuring servers on page 113.

2. Using Avaya IC domains on page 115.

3. Setting up administrative accounts on page 119.

4. Using system and sample workflows on page 124.

5. Configuring core servers on page 125.

6. Starting and stopping Avaya IC servers on page 147.

7. Starting and stopping Avaya IC services on page 154.

Completing prerequisites for configuring servers
Before you configure the Avaya IC servers, make sure that you:

1. Run the Avaya IC installation to copy the server files to the machine where you plan to 
run the servers.

If you have not copied the server files, see Installing Avaya IC servers on page 49.

2. Install the Avaya IC Design & Administration tools.

You should install these tools on a dedicated machine that has network access to all 
server machines. For information on how to install these tools, see Installing Avaya IC 
servers on page 49.
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3. Install and configure all prerequisite software and hardware. Depending on which 
servers you plan to configure, the prerequisites can include one or more of the 
following:

● Database
● POP3 and SMTP email servers and environment
● JDK
● Web servers
For information on which prerequisites you need for each machine, see IC Installation 
Planning and Prerequisites.

4. Start the Web server.

5. Configure the Avaya IC databases. For more information, see Configuring 
databases on page 77.

Creating sites
A site is a physical location that agents or servers can occupy in an Avaya IC system. For 
a single site system, you can use the Default site that is preconfigured.

For an Avaya IC system that includes multiple physical locations, create a site for each 
physical location. The site name should identify the physical location. Avaya IC uses the 
site information for routing decisions.

For more information about sites, see IC Administration Volume 1: Servers & Domains.

To create a site:

1. In IC Manager, select Tools > Site. 

2. In the Site Editor dialog box, select New. 

3. In the Create Site dialog box, complete the following fields:

a. Type a name for the site that identifies the physical location in the Name field.

b. Type a description of the site in the Description field.

c. Select OK.

4. In the Site Editor dialog box, select OK.
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Using Avaya IC domains
At a minimum, an Avaya IC system should include the preconfigured domains installed 
with Avaya IC. Create multiple Avaya IC domains for your servers and agents to increase 
performance and allow Avaya IC to handle higher contact rates. For example, use a Voice 
domain for the servers used for Telephony.

To use domains, review and perform the steps in the following topics:

1. Preconfigured domains on page 115.

2. Guidelines for Avaya IC domains on page 116.

3. Creating domains on page 117.

4. Establishing the failover order for domains on page 118.

Preconfigured domains
Avaya IC includes several domains that are preconfigured with failover paths. The 
following table describes the preconfigured domains.

Preconfigured domain Members Failover path

Default ● Alarm server
● Directory server
● License server
● ORB server

● Default

Email None ● Email
● Email_Helper
● Web
● Default

Email_Helper None ● Email_Helper
● Email
● Default

Prompter1 None ● Prompter1
● Default
● Voice1
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Guidelines for Avaya IC domains
Avaya IC domains can span server machines at different locations and multiple domains 
can share the same server machine. A failover order is associated with each domain. The 
failover order defines how the members of a domain will failover to servers in other 
domains. If a server in one domain becomes unavailable, the requests to that server are 
routed to a server in the failover domain.

Tip:
Tip: Plan your failover policy carefully. If you specify a failover domain at a 

remote site, you must be sure that you have a high-bandwidth connection 
between the two sites or system performance will be adversely affected.

User1 None ● User1
● Prompter1
● Voice1
● Default
● Email
● Email_Helper
● Web
● Web_Helper

Voice1 None ● Voice1
● Default

Web None ● Web
● Web_Helper
● Email
● Default

Web_Helper None ● Web_Helper
● Web
● Default

Website None ● Website
● Web
● Voice1
● Default

Preconfigured domain Members Failover path
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While you are deciding on the domains you need in your Avaya IC environment, consider 
the following guidelines:

● Use logical names that include identifying information, such as the site, the media 
channel, or the agent workgroup.

● Set up the failover paths for domain that include agents to ensure that the domains 
failover to one or more domains with an ORB server, Alarm server, and Directory 
server. If the domains that contain agents do not failover to domains with these servers, 
then Avaya Agent cannot function correctly.

● Do not assign an agent or a server to more than one domain. If you assign an agent or 
server to a second domain, IC Manager automatically deletes that agent or server from 
the first domain.

● Do not associate multiple servers of the same type with the same domain, with the 
possible exception of the ORB server. You can have multiple ORB servers in the same 
domain if those servers reside on different machines.

You should also assign agents to User domains. Typically, you should divide your agents 
between two User domains. If you configure the failover of each User domain to the other 
domain, then you will have a minimum amount of interruption if a Blender server or agent 
Workflow server fails.

For examples of how to divide Avaya IC servers between domains, see IC Installation 
Planning and Prerequisites. For more information about domains and failover, see IC 
Administration Volume 1: Servers & Domains.

Creating domains
You can add as many domains as you need to handle the agents and servers in your 
Avaya IC system. For suggested deployments, see IC Installation Planning and 
Prerequisites.

! CAUTION:
CAUTION: Do not delete the Default domain. Avaya IC requires the Default domain to 

function. 

To create a domain:

1. Select Domain on the IC Manager toolbar.

2. Select Servers in the Items box at the top of the Domain Manager.

3. Right-click on All Domains and select New.
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4. Type the name of the new domain.

The domain name can have a maximum of 32 characters or underscores, starting with 
an alphabetic character. It cannot have spaces. Use an underscore, if necessary.

5. Select OK to create the domain. 

IC Manager displays the new domain name under All Domains on the left pane of the 
Domain Manager.

Establishing the failover order for domains
If a server becomes unavailable, failover redirects all requests from the clients of the 
unavailable server to an alternative server in a failover domain. A server�s client can be an 
agent desktop application or another server.

A client or server logs in to the Avaya IC system by invoking a DS.Login request. At the 
time that this request is invoked, there is no information available to identify the group of 
the client or domain of the server making the request. Avaya IC components assume that 
the requester is in the Default domain. 

While membership in a domain determines how the domain members communicate to 
servers, it also defines how failover is performed. We strongly recommend that you take 
the time to pre-plan your server failover strategy before proceeding. 

You must ensure that your failover plan follows the deployment guidelines, including:

User domain failover - If your User domain does not include a secondary ORB server, 
this domain must failover to a domain that includes an ORB server, such as the Default 
domain.

Data server failover - When an agent logs in, Avaya IC cannot determine that agent�s 
assigned domain until after the login request succeeds. Therefore, during the login 
process, Avaya IC components assume that all agents belong to the Default domain. To 
ensure that the Data servers handling login requests failover correctly, these servers must 
include the Default domain in their server group.

IC Email server failover - The domain that includes your IC Email server must failover to 
the domain that includes your WebACD server.

WebACD server failover - The domain that includes your WebACD server must failover 
to the domain that includes your IC Email server.

For more suggestions on how to plan your failover strategy, see the deployment scenarios 
in IC Installation Planning and Prerequisites. You can also establish failover order on a 
server-by-server basis. For more information, see IC Administration Volume 1: Servers & 
Domains.
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To establish the failover order for a domain:

1. In the Domain Manager, select Servers in the Items box.

2. Select on the name of the domain for which you want to establish failover.

3. In the right pane, select the Failover tab.

4. Select the failover domain from the list in the Available pane.

5. Select Add to move the backup domain into the Members pane.

You can specify multiple domains to be used for failover. Avaya IC uses these failover 
domains in the order specified. Use the up-arrow and down-arrow located above the 
Members list to rearrange failover order. Do not move a failover domain above the 
primary domain.

6. Select OK to assign the servers in the domain for failover.

Setting up administrative accounts
Avaya IC requires two types of administrative accounts:

Non-human users - These administrative accounts are reserved for non-human Avaya IC 
users, such as servers and IVRs. For guidelines, see Using administrative accounts for 
non-human users on page 120.

Human users - These administrative accounts are reserved for human Avaya IC users, 
such as supervisors and managers. For guidelines, see Using administrative accounts for 
human users on page 122.

This section describes the minimum number of administrative accounts required to install 
and configure Avaya IC, and how to create those accounts. Topics include:

● About Avaya IC passwords on page 120.

● Using administrative accounts for non-human users on page 120.

● Using administrative accounts for human users on page 122.

● Creating administrative accounts on page 122.

For more information about administrative and agent accounts, see IC Administration 
Volume 2: Agents, Customers, & Queues.
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About Avaya IC passwords
All Avaya IC accounts, including administrative accounts, must have passwords that meet 
the requirements that you specify in the Agent/Security properties for the workgroup or for 
individual agents. These requirements can include:

● Maximum length

● Minimum length

● Minimum number of alphabetic characters

● Minimum number of numeric characters

All passwords that you use for administrative users, including non-human users, must 
meet these requirements. 

For more information, see IC Administration Volume 2: Agents, Customers, & Queues.

Using administrative accounts for non-human users
Some Avaya IC components, such as the Configuration Tool and some servers, require 
administrative accounts. These accounts should not be used by a human Avaya IC user.

! Important:! Important:
Important: Configure all Avaya IC accounts for non-human users to ensure that the 

password for these accounts does not expire or change.

These administrative accounts are non-human accounts for Avaya IC components only. 
You do not need to create these accounts in a User domain. When you create an 
administrative account for an Avaya IC server or component, such as Outbound Contact or 
the ICM server, the account must be in either of the following domains:

● The same domain as the component that uses the account

● A domain in a failover path from the domain of the component

The following table describes the minimum number of administrative accounts your Avaya 
IC system requires for non-human Avaya IC users. 
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! Important:! Important:
Important: Change the password on all accounts created by the seed data.

Account Component Description Login

Administrative Avaya IC servers Create an administrative account in:
● The same domain as the 

component that uses the account
OR
● A domain in a failover path from the 

domain of the component
Note: Do not use the Admin account 
created by the seed data, or an 
account that you use to log in to IC 
Manager.

As created by user.
Not available in seed 
data. 

Admin IC Manager login Administration account that you use to 
log in to IC Manager and the 
Configuration Tool when you configure 
the system.
Domain: User
Security: Administrator
Note: IC Manager forces you to 
change the password for this account 
when you use IC Manager.

Login: Admin
Password: admin

website Configuration Tool 
and Avaya IC 
servers

The website account is created by the 
seed data. 
The Avaya IC components in the DMZ 
use this account to access other 
Avaya IC servers.
Domain: Website
Security: Operator
Use this account to configure the 
Website Web application and Web 
Management services.

Login: website
Password: website

icmbridge ICM Bridge The icmbridge account is created by 
the seed data. This account has 
Operator privileges. 
Include a Workflow server in the same 
domain as the ICM account.
Domain: Website
Security: Operator
This is the Avaya IC Login account 
that you use to configure the Attribute 
server. For more information, see 
Creating the Attribute server on 
page 252.

Login: icmbridge
Password: icmbridge
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Using administrative accounts for human users
All human Avaya IC users who require administrative privileges, such as access to IC 
Manager and other Design & Administration Tools, require administrative accounts. These 
accounts should not be used by a non-human Avaya IC user. You should require that the 
Avaya IC user regularly change the password for these accounts.

When you create an administrative account for a human Avaya IC user, the account must 
be in a User domain. You can create an administration domain that is restricted to 
administrative accounts for human users.

Creating administrative accounts
You must create the domain for the administrative accounts before you perform these 
steps.

You may want to create an additional administrative account in the User domain that can 
communicate with the parent directory server. This account is useful if you have a problem 
with the configuration of one or more domain. After you configure a temporary account, log 
in to IC Manager and confirm that you can use this account for administrative access.

To create administrative accounts:

1. In IC Manager, select the Agent tab.

2. Select Administrator in the left pane.

If Administrator is not visible in the left pane, select Manager > Refresh to update the 
information that is available in IC Manager.

3. Select Agent > New.

4. Select the General tab and complete the following fields:

Field Description

First Name Required field
Type agent�s first name.

Last Name Required field
Type agent�s last name.

Preferred Name Required field
Type agent�s preferred name.

Employee ID Type the agent�s company employee ID (optional).
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5. Select the Security tab and complete the fields as shown in the following table:

6. Select OK.

Login ID Required field
Type a login ID that the agent uses for all Avaya IC 
applications.

Domain Required field
Select the appropriate domain from the list. 

Task Load Required field
Set to 0.

Task Ceiling Required field.
Set to 0.

Site Select a site from the drop-down list.
Note: Avaya IC uses the Site to compile statistics for 
groups or agents or queues.

Field Recommended entry

Password Type the password for this account.

Confirm Re-type the password for this account.

Force password change on 
login

Perform one of the following:
● Check this field for human Avaya IC users
● Do not check this field for non-human Avaya IC 

users

Disable login Do not check this field.

Administrator Check this field.
Note: Do not check any of the other roles.

Field Description
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Using system and sample workflows
When you install Workflow Designer, you also install system and sample workflows. Avaya 
IC installs the project folders for system and sample workflows in subfolders of the 
following directory:

IC_INSTALL_DIR\IC61\design\IC\Flows\

! CAUTION:
CAUTION: Do not change a system workflow. If you change a system workflow, one or 

more components of your Avaya IC system will not function.

Sample workflows
The following table describes the sample workflows for Avaya IC.

For a complete list of the workflows in these projects, including the directories where 
Avaya IC installs the workflows, see Avaya Workflow Designer User Guide.

Workflow project Description

Blender Required for all installations.

ICEmail Required for installations that include Email Management.

Prompter Required for installations that include Prompter.

TS Required for all installations that include Telephony or Voice 
Chat.

WACD Required for all installations that include Web Management or 
Email Management.

IVChat Required for all installations that include Voice Chat.
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Using sample workflows
You can use the sample workflows to set up and test your Avaya IC system. When you test 
your system, review the settings of the sample workflows for the media channels and 
components in your Avaya IC system. 

You can customize these workflows to meet the business requirements of your contact 
center. For example, the Email Analysis flows in the ICEmail project contain three sample 
routing hints for testing purposes. You must review and change these properties to routing 
hints that meet your contact center�s needs.

After you customize the sample workflows, recompile the workflows and load them in the 
database. For more information, see Avaya Workflow Designer User Guide.

Workflows in Avaya IC seed data
The Avaya IC seed data includes compiled system and sample workflows for all projects. 
When you created the CCQ database, you imported the compiled workflows with the seed 
data and stored them in the database. 

You must update some of these workflows, such as the workflows in the TS project before 
you can use them in your Avaya IC. Instructions for updating the sample workflows are in 
the appropriate chapter.

Configuring core servers
The Avaya IC installation program automatically created and installed some of the core 
servers when you started the primary servers (see Creating the primary server 
environment on page 58). 

Use caution if you modify server configuration parameters. Errors can seriously impact the 
performance of your Avaya IC system. 

This section describes the core servers. This section also describes the steps you need to 
perform to configure the remaining core servers. You have already created and configured 
some core servers. Before you configure media channels and media-specific servers, 
perform the steps in the following topics to configure the remaining core servers:

● Avaya IC core servers on page 126.

● Server naming guidelines on page 128.

● Recommended tuning parameters for Avaya IC servers on page 128.



Configuring core servers

126 Installation and Configuration

● Creating an ADU server on page 129.

● Creating a DUStore server on page 130.

● Creating an EDU server on page 132.

● Creating a Report server on page 134.

● Creating a Workflow server on page 135.

● Creating a Blender server on page 140.

● Creating an HTTP Connector server on page 142.

● Creating a Notification server on page 144.

Note:
Note: If you reconfigure a running server in IC Manager, stop and restart the 

server for the settings to take effect. Do not check the Auto start option until 
you successfully add and configure the servers and start them manually.

These topics only contain information about required server parameters. For more detailed 
information, see IC Administration Volume 1: Servers & Domains.

Avaya IC core servers
All components of Avaya IC require the following core servers:

ORB server - Oversees and starts other servers. This server is also known as the Object 
Request Broker server.

You must install an ORB server on all machines that host Avaya IC servers. If your Avaya 
IC system includes multiple server machines, install a secondary ORB server on each of 
the secondary machines.

Data server - Provides access to your database server for all Avaya IC applications and 
users. The Data server is specific to the type of database you use in your Avaya IC system. 
All Avaya IC server and client applications use the Data server to communicate with your 
database. The Data server uses the Avaya IC account for each component or user to link 
the Avaya IC components and the database server. 

All Data servers support connection pooling.

ADU server - Holds up-to-date information on all active agent and queue data units 
(ADUs) in the Avaya IC system. This server is also known as the Agent Data Unit server.

Alarm server - Receives and propagates alarms to interested client applications. This 
server notifies interested clients of problems.
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Blender server - Controls agent availability across the different channel types and 
monitors ADU change events. You can configure this server to run blender flows when any 
agent state changes. You can also configure this server to raise alarms or run workflows 
when agent or queue ADUs exceed their thresholds.

Directory server - Looks up agent, workgroup, queue, tenant, and server configuration 
information for other servers in the Avaya IC system. IC Manager uses this server for 
administrative purposes.

DUStore server - Serves as the backup store for the data unit servers (ADU server and 
EDU server). Allows idle data units to be pushed out of memory and into the data store so 
that active data units can use the available memory. This server provides back up in cases 
of recovery from failure, because it allows data units to persist across server shutdowns. 
You must install this server when you use the ADU and EDU servers. This server is also 
known as the Data Unit persistent Store server. 

EDU server - Maintains all active Electronic Data Units (EDUs). Each EDU represents a 
contact in the Avaya IC system. All Avaya IC components use this server to track and 
update contact information. This server is also known as the Electronic Data Unit server.

Create an EDU server for each of the following media channels in your Avaya IC system:

● Chat
● Email
● Voice

HTTP Connector server - Allows Avaya IC server requests to be made as HTTP requests 
and serves Prompter pages. This server also handles customer account management and 
authentication for Web Self-Service. This server is a generic HTTP interface server.

Notification server - Allows Avaya IC components to schedule future events, such as the 
delivery of messages or alerts to agents. Events can be scheduled by an agent or based 
on the escalation and action rules defined in an Avaya Business Application. 

Report server - Records data unit information for the EDU and ADU servers. The 
reporting tools use this information to generate historical reports. When Avaya IC 
terminates an EDU or ADU, the data unit is passed to the Report Server. This server may 
execute mapping rules to convert an EDU into the appropriate format for reporting. The 
Report Server writes its information into the IC Repository database. 

Workflow server - Processes workflows that route contacts and implement business 
rules. The Workflow server can handle specific tasks, such as media routing, agent 
blending, agent scripts, letter generation, and generic business logic. Workflows can be 
executed by direct invocation or as a result of receiving events from another server.

You can distribute these responsibilities across multiple Workflow servers to maximize 
performance and response from the server. For example, if your Avaya IC system includes 
multiple server machines, configure dedicated Workflow servers for each media.
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Server naming guidelines
Under certain circumstances, the Workflow server fails to connect with a server that uses 
the server type as the name of the server. For example, if an ADU server is named "ADU" 
or a Web Advocate Adaptor server is named "WAA".

To ensure optimal functioning of your Avaya IC system, Avaya recommends that you use 
the following naming conventions for your Avaya IC servers:

● Always use a unique server name of up to 32 characters long with no spaces.

● Name your Data servers Data_<databasetype>_<domain>. For example, 
Data_Oracle_Default. 

● In a single site environment, name all other servers <servername>_<domainname>. For 
example: ADU_User1. 

● In a multi-site environment, name all other servers 
<servername>_<sitename>_<domainname>. For example: ADU_London_User1. 

● Do not set the server name to be the same as the server type, or Avaya IC may 
encounter errors during operation. For example, use TS_Voice1 as the name of your 
Telephony server, not just TS.

! Important:! Important:
Important: Do not use the name localVDU or localADU for EDU or ADU servers. 

These are used when the servers are taken off-line to prevent 
communication with other EDU and ADU servers.

Recommended tuning parameters for Avaya IC servers
A set of recommended tuning parameters to enhance the performance of an Avaya IC 
system is available in IC Administration Volume 1: Servers & Domains. 

After you install the development Avaya IC system as described in this document:

1. Review those tuning parameters.

2. Verify the expected contact volume in the production system.

3. Test the recommended settings for the tuning parameters to find the optimal settings 
for the production system.
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Creating an ADU server
Typically, an Avaya IC deployment includes more than one ADU server. 

All agent and human administrative accounts should be in User domains. Avaya 
recommends that you create at least one separate domain for administrative accounts. 
Therefore, after you change the domains of the Administrative accounts, as described in 
Setting up administrative accounts on page 119, you must create ADU servers in each 
domain that includes agents, then delete the ADU server in the Default domain.

If the Avaya IC system includes an ADU server that handles queue ADU entries for a 
WebACD server, configure that ADU server not to accept failover requests from an ADU 
servers that handles agent accounts. For more information, see IC Administration Volume 
1: Servers & Domains.

For Business Advocate the ADU server contains statistics for service classes.

An ADU server must be able to communicate directly with the parent Directory server. For 
more information about the parent Directory server, see Creating a secondary Directory 
server on page 167. 

To create an ADU server:

1. In IC Manager, select Server > New.

2. Select ADU from the list of servers. 

3. Select OK.

4. Select the General tab, and complete the fields shown in the following table.

5. Select the ADU tab.

Field Recommended entry Notes

Name ADU_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for the 
server from the drop-down list.

For example, select Voice from 
the drop-down list if the server 
is in the Voice domain.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.
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6. In the Idle Time (min) field, make sure that the number of minutes entered in this field 
is greater than the length of a typical agent�s shift.

For example, if an agent in your contact center typically works a nine hour shift 
(including lunch), type 540 in the Idle Time (min) field. 

! Important:! Important:
Important: If an agent is logged into an Avaya IC agent desktop application for longer 

than the idle time set in the ADU server, the ADU for the agent will timeout. 
An ADU timeout can cause problems, such as inconsistent data in Avaya 
OA reports and the inability to defer email contacts. To avoid this issue, 
ensure that the idle time is always longer than a typical agent�s shift and that 
all agents log out of Avaya IC at the end of their shift.

You can use the default settings for the ADU server to get your system up and running. 
For more detailed information about these parameters and how to customize them for 
your system, see IC Administration Volume 1: Servers & Domains.

7. Select OK to save your configuration settings.

Note:
Note: Do not start this server until you have configured all core servers. To ensure 

that the servers start in the correct order, see Starting and stopping Avaya IC 
servers on page 147.

Creating a DUStore server
All Avaya IC systems that include Email Management require a DUStore server. You can 
also add a DUStore server for Telephony or Web Management. For more information about 
deployment scenarios for Avaya IC servers, see IC Installation Planning and Prerequisites.

The Avaya IC installation program does not automatically add this server.

To create a DUStore server:

1. In IC Manager, select Server > New.

2. Select DUStore from the list of servers. 

3. Select OK.
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4. Select the General tab, and complete the fields shown in the following table.

5. Select the DUStore tab and complete the fields shown in the following table.

Field Recommended entry Notes

Name DUStore_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for the 
server from the drop-down list.

Include the DUStore server in 
the same domain as the EDU 
server for the channel. 
For example, select 
Email_Helper from the drop 
down list if this server handles 
email contacts.
For more information about 
recommended domains, see IC 
Installation Planning and 
Prerequisites.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

IC Data Source Select the IC Data Source for 
the IC Repository database.

For example, if you used the default 
name to create the IC Repository 
application, the data source name is 
repository.

Default deletion 
age (Days)

Enter the number of days that 
Avaya IC holds an EDU in 
absence of other information.
Default is 60 days.

Avaya ICAfter this period, the 
DUStore deletes the EDU from the 
DUStore table and retires the EDU to 
the database.

Deleted per scan Enter the number of EDUs 
the DUStore retires to the 
database when it scans the 
system for expired EDUs.
Default is 1000.
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6. Select OK to save your configuration settings.

Note:
Note: Do not start this server until you have configured all core servers. To ensure 

that the servers start in the correct order, see Starting and stopping Avaya IC 
servers on page 147.

Creating an EDU server
Create at least one EDU server for each media type in your Avaya IC system. For 
example, using the preconfigured domains, if your Avaya IC system includes Telephony, 
Web Management, and Email Management, create the following EDU servers: 

● VoiceEDUServer in the Voice1 domain

● WebEDUServer in the Web_Helper domain

● EmailEDUServer in an Email_Helper domain

The Avaya IC installation program does not automatically add these servers.

! CAUTION:
CAUTION: Avaya IC requires that you place each EDU server in a separate Avaya IC 

domain. An Avaya IC domain cannot include more than one EDU server. For 
more information about recommended deployment scenarios and guidelines 
for the EDU server, see IC Installation Planning and Prerequisites.

To create an EDU server:

1. Select Server > New in IC Manager.

2. Select EDU from the list of servers. Select OK.

Scan Interval 
(min)

Enter the amount of time, in 
minutes, between server 
scans for expired EDUs.
Default is 15.

Higher values may save some CPU 
time; lower values make for more 
predictable behavior during 
prototyping and testing.
When testing, assume that the other 
timers in the EDU could be off by as 
much as (this interval + 1) to start.

Purge Alarm Check to raise an alarm if a 
delete scan finds any EDUs 
that meet the criteria for 
deletion and retirement to the 
database.
Default is checked.

Field Recommended entry Notes



Configuring core servers

Issue 2.0 June 2004 133

3. In the Initialize EDU dialog box, select the media type from the drop-down list. Select 
OK.

4. Select the General tab, and complete the fields shown in the following table.

5. Select the EDU tab and review the default settings. 

You can use the default settings for the EDU server to get your system up and running. 
For more detailed information about these parameters and how to customize them for 
your system, see IC Administration Volume 1: Servers & Domains.

6. Select OK to save your configuration settings.

Note:
Note: Do not start this server until you have configured all core servers. To ensure 

that the servers start in the correct order, see Starting and stopping Avaya IC 
servers on page 147.

Field Recommended entry Notes

Name EDU_<domain>_<media> Include the domain in the server 
name to identify the server.
For example, if you must create an 
EDU server for voice media, type 
EDU_Voice1_Voice.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

The domain for the EDU server 
depends upon which channel the 
EDU server handles.
For voice contacts, add the EDU 
server to the same domain as the 
associated Telephony server.
For chat contacts and email 
contacts, add the EDU server to a 
"Helper" domain. For example, 
select Email_Helper from the 
drop-down list if this server 
handles email contacts.
For more information about 
recommended domains, see IC 
Installation Planning and 
Prerequisites.

Host Select the machine�s IP 
address from the drop-
down list, or type in the IP 
address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.
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Creating a Report server
The Report server writes values from EDUs to the IC Repository database. Avaya OA uses 
these values to generate historical reports. 

The Report server maps the EDU values to database fields. The server uses field 
expressions from the fieldexpressions table in IC Repository. Database Designer 
loaded the creation rules and field expressions in the database when you imported seed 
data to the IC Repository database (see Creating the IC Repository database on page 97).

The Avaya IC installation program does not automatically add this server.

! CAUTION:
CAUTION: Solaris runs the HTT Input Method Server (htt_server) on port 9010 by 

default. This port assignment creates a conflict with any Avaya IC server 
that you configure to run on port 9010. To avoid the conflict, you can update 
htt_server to use a different port, or not assign an Avaya IC server to port 
9010. In a typical installation, with the primary ORB server on port 9001, IC 
Manager automatically assigns port 9010 to the Report server.

If you set the Server Trace Level field on the Debug tab to 10, the Report server saves text 
files with information about each EDU in the IC_INSTALL_DIR\IC61\temp directory. 
The Report server names these text files <eduid>.txt. Avaya IC does not automatically 
delete these files. You must manually delete them when they are no longer needed for 
debugging. If you do not reset the Server Trace Level, the files will continue to accumulate 
in the IC_INSTALL_DIR\IC61\temp directory. 

To create a Report server:

1. Select Server > New in IC Manager.

2. Select Report from the list of servers. Select OK.

3. Select the General tab and complete the fields shown in the following table.

Field Recommended entry Notes

Name Enter a name for the Report 
server. 
For example, Report_<domain>

Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for 
the server from the drop-down list.

For example, select Voice1 
from the drop-down list if the 
server is in the Voice domain.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.
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4. Select the Report tab, and complete the fields shown in the following table.

5. Select OK to save your configuration settings.

Note:
Note: Do not start this server until you have configured all core servers. To ensure 

that the servers start in the correct order, see Starting and stopping Avaya IC 
servers on page 147.

Creating a Workflow server
The Avaya IC installation program does not automatically add a system Workflow server. 
Typically, an Avaya IC system includes more than one Workflow server. 

To create the Workflow server, perform the steps in the following topics:

1. Configuring multiple Workflow servers on page 135.

2. Creating a Workflow server on page 136.

3. Completing the Workflow server configuration on page 140.

Configuring multiple Workflow servers

If your Avaya IC system includes Letter Generator, you must configure a separate 
Workflow server to run Letter Generator workflows. You need a separate workflow server 
because Letter Generator workflows use a different data source to access the database 
than the other workflows.

For a large Avaya IC system that has a high contact delivery rate and that hosts servers 
across multiple machines, you can distribute the workflow responsibilities across multiple 
Workflow servers to maximize performance and response.

For example, you can set up the following workflow servers to process contacts in the 
different media channels and to handle the different agent-related tasks:

Workflow server for the voice channel - Runs voice contact routing workflows to 
process incoming and outbound voice contacts, and runs the Incoming Voice Chat 
workflow. These Workflow servers are in a voice domain. For more information, see 
Configuring a Workflow server for Telephony on page 211.

Field Recommended entry Notes

IC Data Source Select the IC Data Source for 
the IC Repository database.

For example, if you used the 
default name to create the IC 
Repository application, the data 
source name is repository.
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Workflow server for the chat channel - Runs web contact routing workflows to process 
incoming chat contacts, and runs the Voice Chat workflow. These Workflow servers are in 
a Web domain. For more information, see Configuring a Workflow server for Web 
Management on page 274.

Workflow server for the email channel - Runs email contact routing workflows and 
email analysis workflows to process incoming and outbound email contacts. These 
Workflow servers are in an email domain. For more information, see Configuring a 
Workflow server for Email Management on page 336.

Workflow server for agent prompting - Runs Prompter workflows and agent script 
workflows. For information on how to configure a Workflow server to run Prompter flows, 
see Creating a Workflow server on page 136.

Workflow server for agent searches and transfers - Runs agent search and transfer 
workflows for the Unified Agent Directory. These Workflow servers are in a User domain. 
For more information about configuration for these servers, see Configuring a Workflow 
server for the Unified Agent Directory on page 393.

Workflow server for Letter Generator - Runs the workflows and processes tasks for 
Letter Generator. For more information, see Configuring a Workflow server for Letter 
Generator on page 464.

Note:
Note: The Letter Generator Workflow server shares the same Windows temp file 

as the Tomcat server used by Letter Generator. You must install the 
Workflow server and the Web application for Letter Generator on the same 
physical machine.

Creating a Workflow server

These instructions create a basic Workflow server. You must configure this Workflow 
server to handle the appropriate tasks. For more information, see Configuring multiple 
Workflow servers on page 135. For more detailed information about parameters in the 
Workflow server, see IC Administration Volume 1: Servers & Domains.

To create a Workflow server:

1. In IC Manager, select Server > New.

2. Select Workflow from the list of servers. 

3. Select OK.
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4. Select the General tab, and complete the fields shown in the following table.

5. Select the Workflow tab and perform the following steps:

a. From the IC Data Source drop-down list, select the data source that this Workflow 
server uses.

Most Workflow servers use the Interaction Center data source. The default name for 
this data source is interaction_center. This is the data source that you created in 
Generating the Interaction Center application on page 109.

Note:
Note: For a Workflow server that runs Prompter flows and agent script workflows, 

the IC Data Source must match the database that was used to build and 
store the workflows.

b. Review the remaining fields on the tab, as shown in the following table. You will 
need to complete some of these fields, such as the Synchronous Startup Flows, 
when you create Workflow servers for specific tasks.

Field Recommended entry Notes

Name Workflow_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for 
the server from the drop-down list.

For example, select Users1 
from the drop-down list if the 
server is in the Users1 domain.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

Reload Flows Select this button to reload 
workflows in the Workflow 
server. 

You can choose to update file-based 
workflows and workflows stored in 
the database, and whether to force 
an immediate reload rather than wait 
for running workflows to complete 
execution. 
Select Force immediate reload to 
reload all currently loaded flows 
even if the version numbers are the 
same.
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Unload Flow Select this button to unload a 
workflow from the server. 
You will be prompted to type 
the workflow name.

When the workflow is next 
requested, the latest version of the 
workflow will be loaded from the 
Database or File System. 
If the workflow is currently running, it 
will complete before being unloaded. 
You must manually increment the 
workflow version number. If the 
version has not been incremented, 
the workflow is not reloaded.

Run Flow Select this button to run a 
workflow that updates the 
variable that contains queue-
workflow information. 

Type the workflow name. The 
queue-workflow information is 
required by contact routing flows in a 
Blender environment. Update the 
variable whenever any change is 
made to the queue.

IC Data Source Select a data source from the 
drop-down list. 

For most Workflow servers, select 
the Interaction Center data source. If 
you used the default name, select 
interaction_center.

For the Workflow server used by 
Letter Generator, select the data 
source for your Business 
Application.
For example, if your Avaya IC 
system includes Request-based 
CallCenterQ, the default name for 
the data source is ccq_request.

Preload Flows Select the Ellipsis (�) and 
specify the workflow to be 
loaded when the server is 
first started.

If you have a workflow that must 
react very quickly when the event 
triggering it is received by Avaya IC, 
use the Preload Flows option to 
have that flow ready and waiting in 
memory. When the event actually 
occurs, Avaya IC can run the flow 
without having to load it first.

Syntax: projectname.flowname 

Note: Preloading a large flow can 
slow down server startup.

Synchronous 
Startup Flows

Select the Ellipsis (�) and 
specify the workflow to be 
loaded before the startup 
workflows and before the 
server accepts requests.

For example, Workflow servers that 
run contact routing workflows need 
to run 
web_routing.update_qw_cache as a 
synchronous startup workflow.

Field Recommended entry Notes
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6. Select OK.

Note:
Note: Do not start this server until you have configured all core servers. To ensure 

that the servers start in the correct order, see Starting and stopping Avaya IC 
servers on page 147.

Startup Flows Select the Ellipsis (�) and 
specify the workflow to be run 
when the Workflow server 
starts. 

These workflows are run in addition 
to Initial Startup Script. Workflows in 
this list are not guaranteed to 
execute in any particular order in 
relation to themselves, Initial Script, 
or arriving requests.
Note that the Initial Script field also 
specifies a flow to be started, but 
that parameter can set only one flow. 
You can specify multiple Startup 
Scripts.

Semaphores Select the Ellipsis (�) and 
specify the list of semaphores 
used by the workflows.

For more information about 
semaphores, see Avaya IC Media 
Workflow Reference.

Directory tables Select the Ellipsis (�) and 
specify the Directory server 
tables to be preloaded in 
memory at startup.

Event Threads Accept the default or type a 
number of threads.

The default entry is 10.
The number of threads that are 
listening and available to process 
events sent to the server.

Enable Heap 
Validate

Do not check this field unless:
● Instructed by Avaya 

Technical Support
● Debugging a workflow

This field is for debugging workflows 
only. Impacts performance of the 
Workflow server if checked.
If the Workflow server fails when it 
runs a workflow, use this field to 
check each block as the workflow 
runs to ensure that the block does 
not corrupt the Heap.

Field Recommended entry Notes
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Completing the Workflow server configuration

For the Agent Prompting Workflow server, configure your agent desktop and your agents 
for Prompter and wrapup functionality. A sample Prompter workflow is included in the seed 
data. 

This sample workflow is only intended to help you test Prompter and agent wrapup. For 
information about how to create and modify Prompter workflows, see Agent Script 
Workflow Reference.

You will complete the configuration of other Workflow servers when you configure the 
media channels and other components, such as the Unified Agent Directory, in your Avaya 
IC system. You do not need to perform these steps at this point in your installation and 
configuration. 

Creating a Blender server
The Blender server controls agent availability across the different channel types and 
monitors ADU change events. 

The Blender server depends on the Workflow server. Therefore, you cannot configure the 
Blender server if you have not already performed the steps in Creating a Workflow 
server on page 135. If the Blender server connects to a Workflow server for a media 
channel, create the Blender server after you configure the Workflow server.

Do not assign a Blender server to a domain that cannot be reached by agents. If agents 
cannot reach the Blender server, the Avaya IC system will operate incorrectly.The domain 
for a Blender server must meet one of the following guidelines:

● The Blender server must be in the same domain as a Workflow server and an ADU 
server. 

OR

● The failover path for the domain of the Blender server must include a Workflow server 
and an ADU server. 

! Important:! Important:
Important: If the Blender server domain does not include a Workflow server and an 

ADU server, or those servers are not in the failover path for the Blender 
server, you will not be able to start the Blender server. For more information, 
see IC Installation Planning and Prerequisites.

The Avaya IC installation program automatically adds this server.

To create a Blender Server:

1. In IC Manager, select Server > New.

2. Select Blender from the list of servers.
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3. Select OK.

4. Select the General tab, and complete the fields shown in the following table.

5. Select the Blender tab, and complete the fields shown in the following table.

Field Recommended entry Notes

Name Blender_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for the 
server from the drop-down list.

For example, select Default 
from the drop-down list if the 
server is in the Default domain.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

WorkFlow Server Select the Workflow server 
used by this Blender server 
from the drop-down list.

If you only have one Workflow server 
and one Blender server, select 
Workflow_system.
If your configuration includes 
multiple Workflow and Blender 
servers, select the Workflow server 
that you created to work with this 
Blender server.

Flow Set Enter the name of the 
workflow project that contains 
the Blender flows.

The default name is blender.

Initialization Flow Enter the name of the 
workflow that initializes the 
Blender server.

Default name is initialization.

Initialization Data 
Name

You can leave this field blank. Optional field. 
The initialization data name contains 
values to be added to indata when 
InitRule is run. InitRule has an indata 
Event and outdata Event that fill in 
indata with a string (InitName) and 
seqcouple (InitData).

Initialization Data You can leave this field blank. Optional field.
The name to add to indata when 
InitRule is run. 
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6. Select OK to save your configuration settings.

Note:
Note: Do not start this server until you have configured all core servers. To ensure 

that the servers start in the correct order, see Starting and stopping Avaya IC 
servers on page 147.

Creating an HTTP Connector server
The Avaya IC installation program does not automatically add this server.

Letter Generator and Prompter use the HTTP Connector server. You can create separate 
HTTP Connector servers for each of these features. You can host more than one HTTP 
Connector server on the same machine, if the HTTP Connector servers use different HTTP 
ports. 

To create an HTTP Connector server:

1. Select Server > New in IC Manager.

2. Select HTTP Connector from the list of servers. Select OK.

3. Select the General tab, and complete the fields shown in the following table.

Client Login Flow Enter the name of the Client 
Login workflow.

Default name is clientlogin.

Client Logout 
Flow

Enter the name of the Client 
Logout workflow.

Default name is clientlogout.

Field Recommended entry Notes

Field Recommended entry Notes

Name HTTPConnector_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for the 
server from the drop-down list.

For example, select Default 
from the drop-down list if the 
server is in the Default domain.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.



Configuring core servers

Issue 2.0 June 2004 143

4. Select the HTTP Connector tab and complete the fields shown in the following table.

Field Recommended entry Notes

IC Data Source Select the application name 
associated with the server. This 
name should match the IC Data 
Source setting for the 
corresponding Workflow server.

If you used the default name, 
select interaction_center.
You created this data source in 
Generating the Interaction Center 
application on page 109.

Workflow Server Select the name or type of the 
Workflow server that this 
connector should use to 
execute Workflows and 
Prompter flows.

Doc Directory Accept the default or enter a 
new directory path.

The directory where the server 
looks for java script and error 
pages to serve to prompter and 
agent applications. Always 
consider as the relative path from 
the AVAYA_IC61_HOME.

Start Page Accept the default or enter a 
new file name.

The name of the file that the 
Prompter serves when a client 
asks for a director.

HTTP Port Enter 9170 for default port. The server uses this port for 
HTTP requests.
If you must change this port, see 
Ports used by Avaya IC 
components on page 28 for a list 
of the default port numbers used 
by the other Avaya IC servers. 
Port conflicts can cause serious 
problems within the Avaya IC 
system.
Note: If you are running multiple 
HTTP Connector servers on the 
same machine, ensure that they 
use different ports.
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5. Select OK to save your configuration settings.

6. If the Avaya IC system includes support for Traditional Chinese, configure the 
language support as described in Configuring an HTTP Connector server for 
Traditional Chinese on page 561.

Note:
Note: Do not start this server until you have configured all core servers. To ensure 

that the servers start in the correct order, see Starting and stopping Avaya IC 
servers on page 147.

Creating a Notification server
The Avaya IC installation program does not automatically add this server.

Before you create the Notification server, configure the SMTP and POP3 email servers 
and verify the configuration, as described in IC Installation Planning and Prerequisites.

To create a Notification server:

1. Select Server > New in IC Manager.

2. Select Notification from the list of servers. Select OK.

Request Timeout 
(sec)

Enter the number of seconds 
that the HTTP Connector should 
wait for a response from one of 
its clients.

The upper limit of the response 
time (in seconds) of the Workflow 
server. The HTTP Connector 
assumes the current HTTP 
request from the client has timed 
out if it did not receive a response 
from the Workflow server within 
this time interval.
The default is 60 seconds.

Session Timeout 
(sec)

Enter the time in seconds that 
the agent has to complete a 
page and submit the information 
back to the server. 

The maximum idle time for a 
session. Agent needs to complete 
and submit the information of the 
current page within the specified 
interval value. The HTTP 
Connector assumes the session 
as timed out if it did not receive 
any response from the agent 
within this time interval.
The default is 600 seconds.

Field Recommended entry Notes
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3. Select the General tab and complete the fields in the following table.

4. Select the Notification tab and complete the fields in the following table.

Field Recommended entry Notes

Name Notification_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for the 
server from the drop-down list.

For example, select Email from 
the drop-down list if the server 
is in the Email domain.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

IC Data Source Select the data source for the 
Business Application in the 
Avaya IC system.

If the Avaya IC system does not 
include a Business Application, 
select interaction_center.

SMTP Server 
Name

Enter the name of your IC 
Email server.

This is the IC Email server that 
Avaya IC uses for outbound email. 
For example, enter 
MailSrvExchange.

SMTP Domain Enter the domain where your 
IC Email server is located

For example, enter xyzcorp.com

Default Sender 
Email Address

Enter a valid email address 
that acts as the sender of the 
notification emails. 

For example, enter 
notify@xyzcorp.com.

Poll Interval 
(sec)

60 Number of seconds between polls. 

Poll Future (sec) 86,400 Number of seconds for a long poll.
The default equals 24 hours.

Search Limit 250 Number of database records for 
Notification Server to process at the 
same time.

Work Schedule 
Name

Enter the name of the work 
schedule, if desired.

The name of the work schedule the 
server should use to determine 
business time.
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5. Select OK to save your configuration settings.

6. To configure an alternate email encoding, such as Traditional Chinese, see Configuring 
a Notification server for alternate email encodings on page 560.

Note:
Note: Do not start this server until you have configured all core servers. To ensure 

that the servers start in the correct order, see Starting and stopping Avaya IC 
servers on page 147.

Notification 
Agent

Accept the default, or enter 
another agent number, if 
desired.

The number representing the agent 
for which this service instance 
responds. Agent #0 is the default, 
and catches all messages. You can 
also configure multiple Notification 
server agents, where Agent #1 is for 
all escalations and Agent #2 is for 
email and printer.
Note: If you configure multiple 
Notification server agents, you 
cannot specify an Agent #0, 
because Agent #0 responds to all 
messages.

Fire Direct 
Notification

Check this field, if desired. Select this option if the server should 
fire notifications.

Fire Escalations Check this field, if desired. Select this option if the server should 
send scheduled escalations.

Fire Scheduled 
Reports

Check this field, if desired. Select this option if the server should 
run scheduled reports.

Language Select the language in which 
data for this server will be 
written.

The allowable codes are: 
● en (English)
● fr (French)
● de (German)
● es (Spanish)
● it (Italian)
● pt (Portuguese)
● zh (Chinese, Simplified)
● ko (Korean)
● ja (Japanese)
● th (Thai)
● zt (Traditional Chinese)

Print Font SSize For Windows systems, enter 
the size of the font to use for 
the printed message�s 
subject line.

Default: 24

Field Recommended entry Notes
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Starting and stopping Avaya IC servers
After you add and configure the servers, you can modify the server configuration in IC 
Manager. However, if you modify multiple servers, you must start and stop the servers in a 
specific order. Dependencies between the servers determine the order. If you start and 
stop the servers in the wrong order, your Avaya IC system may lose data or encounter 
other problems. For more specific details, see IC Administration Volume 1: Servers & 
Domains.

! CAUTION:
CAUTION: Never stop the DUStore server before you stop the EDU server. If you stop 

the DUStore server first, you may lose EDU data. Always stop these servers 
in the following order:

1. EDU server 
2. ADU server
3. DUStore server
4. Report server

This section covers startup and shutdown for all Avaya IC servers, including some that you 
do not install and configure until later in the installation process.

This section includes the following topics: 

● Determining server dependencies on page 147.

● Starting and stopping the ORB server on page 150.

● Starting and stopping servers in IC Manager on page 152.

● Stopping all servers on page 152.

● Starting and stopping servers with the Avaya IC Admin utility on page 153.

Determining server dependencies
Starting and stopping servers in Avaya IC is a simple process. However, you should 
exercise caution because starting or stopping Avaya IC processes in the wrong order can 
lead to data loss or system errors. In addition, if your Avaya IC installation spans multiple 
machines, you need to pay attention to the order in which the machines are shut down 
because of the impact on other Avaya IC services. 

This section includes the following topics:

● Server startup dependencies on page 148.

● Server shutdown dependencies on page 149.
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Server startup dependencies

Servers can be started:

● Explicitly by an administrator

● Automatically when the machine on which they reside is started

● As a result of a request from a client 

Tip:
Tip: The start up time each server requires depends on such factors as user 

population, the number of queued emails, and database size. If your servers 
are taking a long time to start, you can try to reduce the sever load by 
adjusting some of these dependencies.

To view the state of each server, use the Alarm Monitor in IC Manager. As servers are 
started, that server�s state will change to �Up,� and ORB server sends informational 
messages to the Alarm Monitor. 

Note:
Note: If IC Manager is running and the Alarm server should fail, Avaya IC will 

prompt the administrator to re-monitor alarms immediately.

The ICM, IC Website (Tomcat), CIRS, and ICM Bridge (Attribute server) are dependent on 
several Avaya IC CORBA servers. These components perform a client login that, at 
minimum, requires the Directory, Alarm, ORB, and Data servers to be running. 

To work with a Web Server such as IIS, IBM HTTP server, and Sun ONE server, Avaya IC 
uses ISAPI and NSAPI filters respectively. These interfaces are used to enable Web 
Management, DataWake, and Tomcat support via plugins that can recover if a dependent 
component is not available. 

The VOX server interfaces with an IVR (Interactive Voice Response) Unit. If the VOX 
server connects to an external IVR, you should start the IVR first. The VOX server will 
attempt to connect to the configured IP address and port, for the length of time specified in 
the VOX server�s Maximum Wait Time and Disable Wait parameters. If the IVR connects to 
the VOX server, the VOX server must be started first. 

Tip:
Tip: For an Avaya IC deployment that includes Avaya IC and Avaya OA 

components on the same machine, to avoid potential port conflicts, always 
start the Avaya IC components first, then start the Avaya OA components.
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Server shutdown dependencies 

Common reasons for stopping an Avaya IC service include: 

● Upgrading to a new version

● Performing regular maintenance

● Changing configuration

! Important:! Important:
Important: Shutting down any Avaya IC CORBA process or machine may have an 

impact on agent clients and dependent processes. Therefore, you should 
only do so during non-business hours unless you are dealing with an 
emergency situation.

If failover is configured, the clients should revert from their primary to their backup servers. 
The connections to the backup server will remain active until the client logs out, is 
restarted, or another disruption in service occurs. 

If failover is not configured and you stop an Avaya IC server, active clients may either raise 
alarms or show error dialogs and potentially fail if the server is down long enough. 

If you need to shutdown an Avaya IC service, you should:

● Do so during a scheduled maintenance period where clients are shutdown and incoming 
activity can be curtailed.

● Use IC Manager�s Server Shutdown facility in order to ensure the correct 
communication flow between Avaya IC components, all Avaya IC clients, and the 
services at the site that should be stopped. The Server Shutdown facility ensures that all 
Avaya IC CORBA processes on that machine are shutdown in the correct order. It does 
not shutdown dependent Avaya IC processes located on other machines. To use this 
facility, see Stopping all servers on page 152.

Before stopping the services on a machine, you need to consider the impact it will have. 
Other dependent clients (both agent clients and Avaya IC processes) may need to be 
shutdown first. 

To confirm that an Avaya IC process was shutdown properly, use the System 
Administration tools provided with your operating system make sure that the process is no 
longer active. IC Manager may report some servers as being stopped while they are 
actually finishing important clean up tasks such as committing data to the database. 

Avaya IC processes should be restarted as soon as practical in order to minimize the 
impact on clients. In many cases, the processes will restart automatically when the 
machine comes back up, or when client requests trigger the server to restart. 

Dependent clients will attempt to reconnect if they lose communication with an Avaya IC 
process. If the stopped process does not recover in time, requests will failover based on 
the server configuration and the failover strategy implemented at your site. 

If you need to shutdown individual Avaya IC servers, it is vital that you follow the correct 
shutdown order to prevent data loss. Stopping a server obviously results in a disruption of 
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the services provided by that server. The following list reflects the impacts beyond the 
immediate services provided by the server.

Starting and stopping the ORB server
The ORB server controls other Avaya IC servers. You must start the ORB server to open 
IC Manager. When you start the ORB server, the Alarm, Directory, EDU, and ADU servers 
start up in sequence.

The following table describes the components of the ORB server.

Server Impact

Alarm server This is typically the last to be shutdown so that other servers can 
still submit alarms.

Data server Without a Data server, other servers will be unable to commit, 
read, or write from the database.

DUStore server If you have configured the ADU and EDU servers to persist data 
units, these servers become dependent on the DUStore server. 
Shutting down the DUStore server before the EDU or ADU 
servers will result in data units not being saved.

Event Collector server Without the Event Collector, real time statistics will not be 
collected for the associated domain.

ORB server This server is responsible for process management. If the ORB 
server is not running, no other Avaya IC server can start.

Component Description

orbsrv.exe Executable for the ORB server

qntorbsrv.exe Windows service executable that starts the 
orbsrv executable.

Avaya IC ORB Service 6.1 Windows only.
Helper service that represents the 
qntorbsrv.exe executable in the Windows 
Services control panel
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! CAUTION:
CAUTION: Do not use Stop Server in IC Manager, the Windows Task Manager, or the 

Windows Services control panel to start or stop the ORB server.

The Avaya IC Configuration Tool starts the ORB server the first time. If you must stop and 
start the ORB server again, use:

● Avaya IC Admin utility

● IC Manager Shutdown option

Configuring the ORB server to start automatically on Windows

The ORB server is set to automatically start when you install the server. However, if you 
reboot a machine and the ORB server does not start, you can follow these steps to 
manually configure the ORB server.

To configure the ORB server to start automatically on a Windows machine:

1. Select Start > Control Panel > Services to open the Windows Services control panel.

2. Double-click Avaya IC ORB Service 6.1 in the list of services.

3. In the General tab, select Automatic from the Startup Type drop-down list.

4. Select OK.

Configuring the ORB server to start automatically on Solaris

To configure the ORB server to start automatically on a Solaris machine:

1. Log in as root.

2. Navigate to the <AVAYA_IC_HOME>/bin directory

3. Execute setup_orb.

Configuring the ORB server to start automatically on AIX

To configure the ORB server to start automatically on an AIX machine:

1. Log in as root.

2. Navigate to the <AVAYA_IC_HOME>/bin directory

3. Run setup_orb.
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Starting and stopping servers in IC Manager
IC Manager allows you to start multiple servers at the same time. The Status column 
displays the server�s new status. If the system cannot start a server, IC Manager displays 
an error message.

! CAUTION:
CAUTION: Never stop the DUStore server before you stop the EDU server. If you stop 

the DUStore server first, you may lose EDU data.

After you add and configure a server, stop and restart that server.

To start or stop a server: 

1. Select the Server tab in IC Manager.

2. Select the server from the list on the right side of the window.

3. Select the Start or Stop traffic light.

Stopping all servers
You can simultaneously shut down all servers that reside on a machine. The server 
shutdown feature in IC Manager shuts down the servers in the correct order. This process 
can take several minutes to complete as all servers must complete their current tasks 
before shutting down. For example, if there are a lot of persistent EDUs for email contacts, 
the DUStore server can take several minutes to write the EDUs to the database.

To shut down all servers: 

1. Select Server > Shutdown in IC Manager. 

2. Select the IP address or the name of the machine where you want to shut down the 
servers.

3. Select OK.
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Starting and stopping servers with the Avaya IC Admin utility
You can use the Avaya IC Admin utility to:

● Start the ORB server and all Avaya IC servers that have Autostart enabled (see Starting 
servers with the Avaya IC Admin utility on page 153)

● Stop the ORB server and all associated Avaya IC servers (see Stopping all servers with 
the Avaya IC Admin utility on page 153)

For information about how to start and stop Web services, such as the ICM server, see 
Starting and stopping Avaya IC services on page 154,

Starting servers with the Avaya IC Admin utility

To start servers with the Avaya IC Admin utility:

1. In a command window, navigate to the directory shown in the following table.

2. Execute the following command:

icadmin so

Stopping all servers with the Avaya IC Admin utility

To stop all servers on a machine with the Avaya IC Admin utility:

1. Navigate to the directory shown in the following table.

2. Execute the following command:

icadmin tv <IC_administrative_user> <password>

Operating system Directory

Windows IC_INSTALL_DIR\IC61\bin

Solaris IC_INSTALL_DIR/IC61/bin

AIX IC_INSTALL_DIR/IC61/bin

Operating system Directory

Windows IC_INSTALL_DIR\IC61\bin

Solaris IC_INSTALL_DIR/IC61/bin

AIX IC_INSTALL_DIR/IC61/bin
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Accessing the help for the Avaya IC Admin utility

The Avaya IC Admin utility includes additional commands that are not listed in this section. 
The help for the Avaya IC Admin utility includes Information about those additional 
commands.

To access the help for the Avaya IC Admin utility:

1. Navigate to the directory shown in the following table.

2. Execute the following command:

icadmin help

Starting and stopping Avaya IC services
When you use the Web tab of the Configuration Tool to configure Web applications, the 
Configuration Tool creates services for Avaya IC. 

This section describes how to stop, start, and configure startup options for the Avaya IC 
services, and how to set startup options for the services. This section includes the 
following topics:

● Starting and stopping services on Windows on page 155

● Starting and stopping services on Solaris and AIX on page 155

For information about the VMM, see Setting startup options for the VMM server on 
page 316.

Tip:
Tip: Avaya recommends that you configure all Avaya IC services to autostart.

Operating system Directory

Windows IC_INSTALL_DIR\IC61\bin

Solaris IC_INSTALL_DIR/IC61/bin

AIX IC_INSTALL_DIR/IC61/bin
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Starting and stopping services on Windows
Set the following Windows NT services to autostart. 

● Avaya IC 6.1 ICM Service

● Avaya IC 6.1 CIRS Service

● World Wide Web Publishing Service (for IIS)

● If you configure the Web applications as a Single Tomcat instance:
- Avaya IC Jakarta Service 6.1

● If you configure the Web applications as Multiple Tomcat instances:
- Avaya IC WebLM Service 6.1

- Avaya IC Web Management Service 6.1

- Avaya IC Email Template Management Service 6.1

- Avaya IC Letter Generation Service 6.1

- Avaya IC Test Service 6.1

To set startup options for services on Windows:

1. In the Services control panel, right-click on the service and select Properties.

2. Select Automatic from the Startup Type drop-down list. Select OK.

Starting and stopping services on Solaris and AIX
Topics in this section include:

● Starting and stopping the ICM server on page 156.

● Starting and stopping the CIRS server on page 156.

● Starting and stopping Sun ONE Server Web server on page 156.

● Starting and stopping IBM http Web server on page 157.

● Starting and stopping Web applications on multiple Tomcat instances on page 157.

● Starting and stopping Web applications on single Tomcat instances on page 158.
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Starting and stopping the ICM server

Execute all ICM server commands from the IC_INSTALL_DIR/IC61/bin directory. For 
the ICM server to be able to log in, the Avaya IC servers must start before the ICM server.

Starting the ICM server - To start the ICM server, execute the following command:

./icm.sh start

Stopping the ICM server - To stop the ICM server, execute the following command where 
-force is an optional parameter that terminates the server processes:

./icm.sh stop -force

Setting the ICM server to autostart - Avaya recommends that you set the ICM server to 
autostart. To set the ICM server to autostart, add the following command to the UNIX 
startup facility: 

IC_INSTALL_DIR/IC61/bin/icm.sh start

Starting and stopping the CIRS server

Execute all CIRS server commands from the IC_INSTALL_DIR/IC61/bin directory. For 
the CIRS server to be able to log in, the Avaya IC servers must start before the CIRS 
server.

Starting the CIRS server - To start the CIRS server, execute the following command:

./cirs.sh start

Stopping the CIRS server - To stop the CIRS server, execute the following command 
where -force is an optional parameter that terminates the server processes:

./cirs.sh stop -force

Setting the CIRS server to autostart - Avaya recommends that you set the CIRS server 
to autostart. To set the CIRS server to autostart, add the following command to the UNIX 
startup facility: 

IC_INSTALL_DIR/IC61/bin/cirs.sh start

Starting and stopping Sun ONE Server Web server

Starting Sun ONE Server - To start Sun ONE Server, execute the following command:

<SunONE_install_dir>/servers/<my_ONE_server>/start
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Stopping Sun ONE Server - To stop Sun ONE Server, execute the stop script packaged 
with the Web server:

<SunONE_install_dir>/servers/<my_ONE_server>/stop

Setting Sun ONE Server to autostart - Avaya recommends that you set the Sun ONE 
Server to autostart. To set Sun ONE server to autostart, add the following command to the 
UNIX startup script:

<SunONE_install_dir>/https-<my_ONE_server>/start

Starting and stopping IBM http Web server

Starting IBM http Web Server - To start IBM http Web Server, execute the following 
command:

./httpserver.sh start

Stopping IBM http Web Server - To stop IBM http Web Server, execute the following 
command:

./httpserver.sh stop

Setting IBM http Web Server to autostart - Avaya recommends that you set the IBM http 
Web server to autostart. To set IBM http Web server to autostart, add the following 
command to the UNIX startup script:

../bin/httpserver.sh start

Starting and stopping Web applications on multiple Tomcat instances

If you configure the Web applications as Multiple Tomcat instances, where each Web 
application is configured on a separate Tomcat instance, use the following commands.

Execute all Tomcat commands for the Web Applications from the 
IC_INSTALL_DIR/IC61/bin directory.

Starting all services - To start services for all Web applications, execute the following 
command:

./ictomcat.sh start all

Stopping all services - To stop all services for Web applications, execute the following 
command where -force is an optional parameter that terminates the server processes:

./ictomcat.sh stop all -force



Configuring core servers

158 Installation and Configuration

Starting an individual Web application - To start an individual Web application, execute 
the appropriate command from the following table:

Stopping an individual Web application - To stop an individual Web application, execute 
the appropriate command from the following table. -force is an optional parameter that 
terminates the server processes.

Starting and stopping Web applications on single Tomcat instances

If you configure the Web applications as single Tomcat instances, where each Web 
application is configured on the same Tomcat instance, execute the following commands.

Execute all Tomcat commands for the Web Applications from the 
IC_INSTALL_DIR/IC61/bin directory.

Starting Web applications - To start services for all Web applications on the Tomcat 
instance, execute the following command:

./ictomcat.sh start

Stopping Web applications - To stop services for all Web applications on the Tomcat 
instance, execute the following command where -force is an optional parameter that 
terminates the server processes:

./ictomcat.sh stop -force

Web application Start command

Website ictomcat.sh start website

Web License Manager ictomcat.sh start weblm

Email Template Administration ictomcat.sh start rlmanager

Letter Generator ictomcat.sh start docgen

Web application Stop command

Website ictomcat.sh stop website -force

Web License Manager ictomcat.sh stop weblm -force

Email Template Administration ictomcat.sh stop rlmanager -force

Letter Generator ictomcat.sh stop docgen -force
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Setting Tomcat Web applications to autostart

Avaya recommends that you set the Tomcat Web applications to autostart. To set them to 
autostart, add the following command to the UNIX startup facility:

IC_INSTALL_DIR/IC61/bin/ictomcat.sh start all

For the Tomcat Web applications to be able to log in, the Avaya IC servers must start first.
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Chapter 6: Configuring secondary servers

The secondary server environment includes the configuration settings required for the 
Avaya IC servers on a machine that does not host the primary ORB server and for the 
secondary ORB server required on that machine.

This section includes the following topics:

● When to configure a machine for secondary servers on page 161.

● Creating a secondary server environment on page 162.

● Creating a secondary Directory server on page 167.

● Creating a secondary Data server on page 169.

Tip:
Tip: You must run the Configuration Tool to create the secondary server 

environment. You cannot configure secondary servers without the 
Configuration Tool.

When to configure a machine for secondary servers
Configure a machine for secondary servers if you:

● Install a secondary instance of a core Avaya IC server, such as the Data server or the 
Directory server

● Install and configure Avaya IC servers on a machine other than the machine that hosts 
the primary ORB server

For example, if you host a Telephony server on a dedicated machine, that machine 
requires a secondary ORB server. You must configure that machine for secondary servers.
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Creating a secondary server environment
You create a secondary server environment and start a secondary ORB server in the 
Initial Configuration tab of the Configuration Tool. The secondary server environment 
only configures the secondary ORB server. Use IC Manager to create all other servers 
required on the target machine.

Note:
Note: You cannot use the Configuration Tool to create a secondary ORB server on 

the same machine as the primary ORB server.

Some of the steps are optional. You need to perform them only if the Avaya IC system 
includes an Oracle or DB2 database, or if the secondary server machine will host a 
Telephony server.

To create the secondary server environment, complete the steps in the following sections:

1. Before you begin on page 162.

2. Configuring the secondary server environment on page 163.

3. Specifying the Telephony switch on page 164.

4. Configuring database settings on page 165.

5. Completing the configuration on page 166.

Before you begin
You must complete the following prerequisites before you configure secondary servers:

Install server files - If you plan to host Avaya IC servers on more than one machine, you 
must install the secondary servers on every machine except the one that hosts the primary 
ORB server, as described in Installing Avaya IC servers on page 49.

Start servers - You must start the following servers before you can install secondary 
servers on the target machine:

● Primary ORB server
● Data server
● Alarm server
● Directory server
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Configuring the secondary server environment
This procedure continues from Installing Avaya IC servers on page 49. During the 
installation, you must select Yes to answer the question Do you want to run the 
Configuration Tool now? to see the installation window required by this procedure.

To configure the secondary server environment:

1. After you choose to run the Configuration Tool in the server installation, in the next 
installation window:

a. Select the Secondary option for the mode in which you want the Configuration Tool 
to run.

b. Select Next.
2. In the Initial Configuration tab of the Configuration Tool, confirm that Secondary is 

selected in the Select Mode drop-down list.

Note:
Note: The Initial Configuration tab of the Configuration Tool is dynamic. The 

Configuration Tool does not automatically display all of the fields. For more 
information, see Initial Configuration tab on page 480.

3. Complete the fields in the following table.

Field Description Sample entry

IP Address The IP address for the machine that hosts the 
secondary ORB server.
Note: If the secondary ORB server runs on a 
machine with multiple network interface cards, 
you must select the IP address for the first 
network interface card on the machine. The 
secondary ORB server cannot run on any other 
network interface card.

145.170.12.245

Secondary ORB 
Port

The port on the target machine that the 
secondary ORB server uses for communications.
Because the secondary ORB server is on a 
different machine from the primary ORB server, 
the secondary ORB server can use the same port 
as the primary ORB server.
You must make sure that the port assignment in 
the Start Port field is an available port. Type a 
new port assignment if necessary.

Default:
9001

Primary Host Name The name of the machine that hosts the primary 
ORB server.
The primary host name can be the IP Address or 
fully-qualified domain name of the machine.

coresvr.avaya.com
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4. Make sure the port assignment in the Start Port field is an available port on the target 
machine. Type a new port assignment if necessary.

5. Select Start ORB Server.
6. The next step in this procedure depends upon the deployment of the Avaya IC system:

● If the machine hosts a Telephony server, continue with Specifying the Telephony 
switch on page 164.

● If the machine does not host a Telephony server, continue with Configuring 
database settings on page 165.

Specifying the Telephony switch
Only perform this step if the machine hosts a Telephony server. If the machine does not 
host a Telephony server, skip this step and continue with Configuring database settings on 
page 165.

To specify the Telephony switch:

1. Select and check the Telephony Switch box.

2. From the Telephony Switch drop-down list, select the name of the switch that the 
Telephony server will communicate with.

The Telephony server must communicate with a switch that is supported for the 
operating system of the machine. For example, do not select a Nortel switch if you plan 
to host the Telephony server on an AIX machine. For more information about switch 
support, see IC Installation Planning and Prerequisites.

Primary ORB Port The port that the primary ORB server uses for 
communications.

Default: 
9001

IC Login The administrative login ID that you must create 
for Avaya IC servers.
For more information, see Setting up 
administrative accounts on page 119.

serveradmin

IC Password The password associated with the IC Login. admin1

IC Domain This is the Avaya IC domain that includes the 
primary ORB server. This domain is typically the 
Default domain.

Default

Start ORB Server If you place a checkmark in this box, the 
Configuration Tool automatically starts the 
secondary ORB server on the target machine.

Checkmark in box

Field Description Sample entry



Creating a secondary server environment

Issue 2.0 June 2004 165

3. The next step in this procedure depends upon the deployment of the Avaya IC system:

● If the Avaya IC system includes an Oracle or DB2 database, continue with 
Configuring database settings on page 165.

● If the Avaya IC system includes a SQL Server database, continue with Completing 
the configuration on page 166.

Configuring database settings
Only perform this step if the Avaya IC system uses an Oracle or DB2 database. If the 
Avaya IC system uses a SQL Server database, skip this step and continue with 
Completing the configuration on page 166.

To configure database settings, perform one of the following steps:

1. If your Avaya IC system includes an Oracle database, see Configuring database 
settings for Oracle on page 165.

2. If your Avaya IC system includes a DB2 database, see Configuring database settings 
for DB2 on page 166.

Configuring database settings for Oracle

To configure database settings for Oracle:

1. Select and check the Oracle Setup box. 

The Configuration Tool displays the required fields for an Avaya IC system with an 
Oracle database.

2. For all Oracle databases, type the NLS Lang parameter in the NLS Lang field to 
specify the character set of the database.

For more information about the NLS Lang parameter, including a list of NLS LANG 
parameters for supported languages, see Specifying the NLS Lang property for 
Oracle on page 544.

3. For all Oracle databases, type the home directory of the Oracle client on the machine 
that hosts the core servers in the Oracle Home field.

For example, type /opt/oracle/8.1.7

4. For Oracle databases on Solaris, type the Oracle SID of the database in the Oracle 
SID field.

For example, type icutf8db. The Oracle SID field is case-sensitive.

5. For Oracle databases on Solaris, select the correct version of Oracle from the Oracle 
Version field.

6. Continue with Completing the configuration on page 166.



Configuring secondary servers

166 Installation and Configuration

Configuring database settings for DB2

Note:
Note: For machines on AIX that host a DB2 client, you must manually catalog the 

database. For information on how to do this, see IC Installation Planning and 
Prerequisites and the documentation for your DB2 database.

To configure database settings for DB2:

1. Select and check the DB2 Setup box. 

The Configuration Tool displays the required fields for an Avaya IC system with an 
DB2 database.

2. Type the home directory of the DB2 client on the machine that hosts the core servers 
in the DB2 Home field.

For example, type /usr/lpp/db2_07_01

3. Type the name of the DB2 instance in the DB2 Instance field.

For example, type db2inst1

4. Continue with Completing the configuration on page 166.

Completing the configuration
To complete the configuration of the secondary server environment:

1. If you host the servers on Solaris or AIX, select the primary locale from the Locale 
drop-down list.

The drop-down list includes all of the locales supported by the operating system. For 
example, if your servers use an English locale:

● For AIX, select EN_US.

● For Solaris, select en_US.UTF-8.

2. Select Apply Settings in the Configuration Tool to configure and start the servers.

3. Select OK in the Success dialog box.

4. Select Exit.
The Configuration Tool closes and you return to the Avaya IC Installation.

5. Select Next.
6. On Windows machines, select Yes, restart my system. 
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7. Select Finish.

8. Restart the machine, if the machine does not restart automatically.

Tip:
Tip: If the Configuration Tool displays a "Failed to load vesp.imp" error message, 

confirm that your secondary ORB server has started, and that your primary 
ORB server and secondary ORB server have not lost their connections to 
the network.

You have configured and started the secondary ORB server. Continue with the 
configuration of the other Avaya IC servers that the machine hosts.

Creating a secondary Directory server
The Directory server maintains a list of all the servers in Avaya IC. When you create 
multiple Directory servers, they share one common directory. 

You must designate one Directory server to synchronize the directories and ensure that 
changes made by one Directory server are reflected throughout the network. This 
designated Directory server is called the parent. If there is only one Directory server in 
Avaya IC, IC Manager automatically assigns parent status to that server.

For more information about how to synchronize Directory servers, see IC Administration 
Volume 1: Servers & Domains.

To create a secondary Directory server:

1. In IC Manager, select the Server tab, then: 

a. Select Server > New.

b. Select Directory from the list of servers.

c. Select OK.

2. Select the General tab and complete the fields as shown in the following table.

Field Recommended entry Notes

Name Directory_<domain> Include the domain in the server 
name to identify the server.
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3. Select the Directory tab and complete the fields as shown in the following table.

Domain Select the domain from the 
drop-down list.

For example, select Default 
from the drop-down list if the 
server is in the Default domain.

Host Select the machine�s IP 
address from the drop-down 
list, or type in a new IP 
address.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

IC Data Source Select the IC Repository data 
source from the IC Data 
Source drop-down list.

If you used the default name, select 
repository. 

Is Parent Do not check this box, as this 
Directory server is a 
secondary, or child, Directory 
server.

The parent Directory server 
synchronizes the directories for all 
Directory servers.

Backup Enter the name of a backup 
file to be created. This file 
used a backup copy of the 
directory.
Click the Start button to 
create the file in the server�s 
home directory.

Avaya IC appends an .ffd extension 
to the file name.

Restore Enter file name of the backup 
file used as the name of the 
directory you want to restore.
Click the Start button to 
restore the directory.

The file name you enter must be a 
previously created backup directory 
file.

Field Recommended entry Notes
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4. Select OK to save the Directory server configuration. 

5. Copy the ds.ffd file from the machine that hosts your primary Directory server to the 
machine that hosts your secondary Directory server.

6. In IC Manager, start the secondary Directory server.

Creating a secondary Data server
Note:

Note: These instructions do not include information about the ODBC Data server 
or the Legacy Data server. For more information about those Data servers, 
see IC Administration Volume 1: Servers & Domains. 

This section includes the following topics:

● Configuring a secondary Data server for Microsoft SQL Server on page 170.

● Configuring a secondary Data server for Oracle on page 171.

● Configuring a secondary Data server for IBM DB2 on page 172.

First update lag 
(sec)

Enter the number of seconds 
that the Directory server 
waits before sending updates 
to the first of its children.

During normal operation, set this 
value to 0. (A small delay occurs 
automatically.) 
There is no maximum value.
If this value is greater than 0, the 
Advanced tab contains a couple with 
the name "PropagationDelay" and a 
value equal to the current buffer 
updates setting.

Succeeding 
update lag (sec)

Enter the number of seconds 
that the Directory server 
pauses before sending an 
update to the next child.

During normal operation, set this 
value to 0 or 1. 
There is no maximum value.
If this value is greater than 0, the 
Advanced tab contains a couple with 
the name "LagBetweenChildren" and 
a value equal to the current childlag 
setting.

Field Recommended entry Notes
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Configuring a secondary Data server for Microsoft SQL Server

To configure the secondary Data server:

1. In IC Manager, select the Server tab, then: 

a. Select Server > New.

b. Select DataServerMSSQL from the list of servers.

c. Select OK.

2. In the General tab of the Server Editor, complete the fields as shown in the following 
table.

3. In the DataServer tab of the Server Editor, complete the fields as shown in the 
following table.

Field Recommended entry Notes

Name Type a logical name for the 
Data server, such as 
DataServerMSSQL_
<domain>

Include the type of database on 
your Avaya IC system in the 
name. 
Tip: For all secondary Data 
servers, include the domain in 
the server name to identify the 
server.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

For example, select Default 
from the drop-down list if the 
server is in the Default domain.

Host Select the IP address of the 
machine that hosts the 
server, or type in the IP 
address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

DB Login Enter your DBA user name. The name used by the Data server to 
access databases.

DB Password Enter your database 
password.

The password that corresponds to 
the database login name used by the 
Data server to access databases.
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4. Select OK to save the Data server configuration. 

5. Select the Data server.

6. Right-click on the Data server, and select Start from the drop-down list.

Configuring a secondary Data server for Oracle

To configure the secondary Data server for Oracle:

1. In IC Manager, select the Server tab, then: 

a. Select Server > New.

b. Select DataServerOracle from the list of servers.

c. Select OK.

2. In the General tab of the Server Editor, complete the fields as shown in the following 
table.

Request Handler 
Thread Pool Size

Enter the number of requests 
in the thread pool.
Default is 30.

Maximum number of threads that 
handle client requests in the Data 
server. These threads accept 
requests from the Data server clients 
and queues them for execution in the 
database.

DB Connection 
Pool Size

Enter the number of 
connections in the pool.
Default is 15.
Minimum is 1.

Maximum number of database 
connections to open in a connection 
pool.

Field Recommended entry Notes

Field Recommended entry Notes

Name Type a logical name for the 
Data server, such as 
DataServerOracle_<domain>

Include the type of database on 
your Avaya IC system in the 
name. 
Tip: For all secondary Data 
servers, include the domain in 
the server name to identify the 
server.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

For example, select Default 
from the drop-down list if the 
server is in the Default domain.

Host Select the IP address of the 
machine that hosts the 
server, or type in the IP 
address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.
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3. In the DataServer tab of the Server Editor, complete the fields as shown in the 
following table.

4. Select OK to save the Data server configuration. 

5. Select the Data server.

6. Right-click on the Data server, and select Start from the drop-down list.

Configuring a secondary Data server for IBM DB2

To configure a secondary Data server:

1. In IC Manager, select the Server tab, then: 

a. Select Server > New.

b. Select DataServerDB2 from the list of servers.

c. Select OK.

Field Recommended entry Notes

DB Login Enter the Oracle database 
user name.

The database login name used by 
the Data server to access databases.

DB Password Enter the password for the 
ODBC database.

The password as configured in the 
Oracle database. 

Oracle Home 
Directory

Enter the pathname of the 
home directory of the Oracle 
database.

Oracle Data server only.
This home directory overrides the 
home directory specified in the IC 
Data Source.

Request Handler 
Thread Pool Size

Enter the number of requests 
in the thread pool.
Default is 30.

Maximum number of threads that 
handle client requests in the Data 
server. These threads accept 
requests from the Data server clients 
and queues them for execution in the 
database.

DB Connection 
Pool Size

Enter the number of 
connections in the pool.
Default is 15.
Minimum is 1.

Maximum number of database 
connections to open in a connection 
pool.
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2. In the General tab of the Server Editor, complete the fields as shown in the following 
table.

3. In the DataServer tab of the Server Editor, complete the fields as shown in the 
following table.

4. Select OK to save the Data server configuration. 

5. Select the Data server.

6. Right-click on the Data server, and select Start from the drop-down list.

Field Recommended entry Notes

Name Type a logical name for the 
Data server, such as 
DataServerDB2_<domain>

Include the type of database on 
your Avaya IC system in the 
name. 
Tip: For all secondary Data 
servers, include the domain in 
the server name to identify the 
server.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

For example, select Default 
from the drop-down list if the 
server is in the Default domain.

Host Select the IP address of the 
machine that hosts the 
server, or type in the IP 
address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

DB Login Enter your database login 
name. 

The name used by the Data server to 
access databases.

DB Password Enter your database 
password.

The password that corresponds to 
the database login name used by the 
Data server to access databases.

Request Handler 
Thread Pool Size

Enter the number of requests 
in the thread pool.
Default is 30.

Maximum number of threads that 
handle client requests in the Data 
server. These threads accept 
requests from the Data server clients 
and queues them for execution in the 
database.

DB Connection 
Pool Size

Enter the number of 
connections in the pool.
Default is 15.
Minimum is 1.

Maximum number of database 
connections to open in a connection 
pool.
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Chapter 7: Installing Avaya IC licenses

Avaya� Interaction Center (Avaya IC) components will not run if you do not install the 
license server, and obtain the appropriate license file. For information on how to obtain a 
license, see IC Installation Planning and Prerequisites.

If Avaya IC components cannot access the License server and WebLM, agents may not be 
able to log in, and servers may not be able to start. To provide redundant operation in the 
event of a failure, install at least one Web License Manager (WebLM) and License server 
per site, with a minimum of two WebLMs and License servers per Avaya IC system. 

To configure Avaya IC licensing, perform the steps in the following topics:

1. Completing prerequisites for configuring Avaya IC licenses on page 176

2. Configuring the Web License Manager on page 176.

3. Installing the license file on page 184.

4. Configuring multi-site licenses on page 186 (multi-site systems only).

5. Configuring the License server on page 187.

6. Changing the administrative password on page 189.
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Completing prerequisites for configuring Avaya IC 
licenses

Before you install and configure WebLM:

1. Obtain a license file for your Avaya IC components from Avaya, as described in IC 
Installation Planning and Prerequisites.

Configuring the Web License Manager
The Web License Manager (WebLM) is a Web application that hosts your Avaya IC 
licence. You must configure the Web LM on each machine that hosts an Avaya IC or Avaya 
OA license. You use the Web tab of the Configuration Tool to configure the WebLM.

This section describes how to install and configure the Web License Manager for each 
operating system that Avaya IC supports. This section includes the following topics:

● Hosting multiple Web applications on one machine on page 176.

● Advanced properties for the Web LM on page 177.

● Configuring the WebLM on Windows on page 177.

● Configuring the WebLM on Solaris on page 179.

● Configuring the WebLM on AIX on page 181,

Hosting multiple Web applications on one machine
If the Avaya IC system includes more than one Web application on the same machine as 
the WebLM, Avaya recommends that you:

● Select Multiple for the Tomcat Setup option.

● Configure all of the Web applications on the target machine at the same time.

! Important:! Important:
Important: If you do not configure all of the Web applications simultaneously, leave the 

options for all Web applications on the target machine checked when you re-
run the Configuration Tool to create the new Web applications. If you do not 
leave the options for the previously created Web applications checked, the 
Configuration Tool may delete those Web applications from the machine.
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Advanced properties for the Web LM
The Web tab also includes advanced properties for the Java Virtual Machine. 

Only configure the advanced properties if you expect a high volume of traffic for the Web 
License Manager. For more information, see Advanced properties on the Web tab on 
page 501. 

Configuring the WebLM on Windows
Use these instructions if you plan to host the WebLM on a Windows machine.

You do not need to stop the IIS Web server on Windows machines.

To configure the Web License Manager to run on a Windows machine:

1. To start the Configuration Tool, select Start > Programs > Avaya Interaction Center 
6.1 > Configuration Tool.

2. Log in with your IC Manager login ID and password.

3. Complete the general fields in the following table.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple

JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

C:\jdk1.3.1_06

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600



Installing Avaya IC licenses

178 Installation and Configuration

4. Check the Configure Web License Manager box.

5. Select Apply Settings. 

6. Select OK in the Success dialog box.

7. Select Exit.
8. To complete the configuration:

a. Open the Windows Services control panel.

IIS Website The name of the IIS Web server that the Web 
application will use. 
Tip: For a localized version of IIS, type the 
localized name for the IIS Web server.

Default Web Site

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct.

xyzcorp.com

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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b. Start the Tomcat NT services:

● For a multiple Tomcat setup, start Avaya IC WebLM Service 6.1.

● For a single Tomcat setup, start Avaya IC Jakarta Service 6.1.

For more information about how to start and stop Web application services, see 
Starting and stopping Avaya IC services on page 154.

Configuring the WebLM on Solaris
Use these instructions if you plan to host the WebLM on a Solaris machine.

! Important:! Important:
Important: To configure the Web License Manager on Solaris, you must log in as a user 

with write permissions on the Web server directories and the Avaya IC 
installation directories. The root user usually has these write permissions.

To configure the Web License Manager to run on a Solaris machine:

1. Stop the Sun ONE server that hosts the Website application with the stop script 
packaged with the Web server: 
<SunONE_install_dir>/servers/<my_ONE_server>/stop

2. Start the Configuration Tool:

a. Navigate to IC_INSTALL_DIR/IC61/bin 

b. Run ./configure

3. Log in with your IC Manager login ID and password.

4. Complete the general fields in the following table that apply to the operating system on 
the target machine.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple
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JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

/opt/j2sdk1_3_1_06

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600

Web Server Home The installation path for the Sun ONE� Server 
instance that hosts the Web application.

/opt/iplanet

Web Server Name The root name of the server as found in the Sun 
ONE� Server home directory.
Note: Do not include https- in the Web server 
name.

testbox.xyzcorp.com

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct. 

xyzcorp.com

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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5. Check the Configure Web License Manager box.

6. Select Apply Settings. 

7. Select OK in the Success dialog box.

8. Select Exit.
9. To complete the configuration, perform the following steps to ensure that all WebLM 

services start properly:

a. In the Sun ONE Server installation directory:

● Open the https-admserv directory.

● If the directory includes a file called start-ICEnv.backup, execute the following 
command to rename the file:

mv start-ICEnv.backup oldstart-ICEnv

b. Start the Sun ONE server that hosts the Web License Manager application with the 
following start script:

<SunONE_install_dir>/servers/<my_ONE_server>/start

c. Navigate to the IC_INSTALL_DIR/IC61/bin directory.

d. Use the following script to start Tomcat:

● If you selected Multiple in the Tomcat Setup field: 

./ictomcat.sh start all

● If you selected Single in the Tomcat Setup field:

./ictomcat.sh start docgen

Configuring the WebLM on AIX
Use these instructions if you plan to host the WebLM on an AIX machine.

! Important:! Important:
Important: To configure the Web License Manager on AIX, you must log in as a user 

with write permissions on the Web server directories and the Avaya IC 
installation directories. The root user usually has these write permissions.

To configure the Web License Manager to run on an AIX machine:

1. Stop the IBM HTTP Server that hosts the Website application with the stop script 
packaged with the Web server: 
./httpserver.sh stop
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2. Start the Configuration Tool:

a. Navigate to IC_INSTALL_DIR/IC61/bin 

b. Run ./configure

3. Log in with your IC Manager login ID and password.

4. Complete the general fields in the following table that apply to the operating system on 
the target machine.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple

JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

/usr/java131

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600

Web Server Home The installation path for the IBM HTTP server 
instance that hosts the Web application.

/usr/HTTPServer

Web Server Name A Solaris-only field. You do not need to complete 
this field for AIX.

Leave this field blank.

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct. 

xyzcorp.com
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5. Check the Configure Web License Manager box.

6. Select Apply Settings. 

7. Select OK in the Success dialog box.

8. Select Exit.
9. To complete the configuration, perform the following steps to ensure that all WebLM 

services start properly:

a. Start the IBM HTTP Server that hosts the Web License Manager application with the 
following start script:

./httpserver.sh start

b. Navigate to the IC_INSTALL_DIR/IC61/bin directory.

c. Use the following script to start Tomcat:

● If you selected Multiple in the Tomcat Setup field: 

./ictomcat.sh start all

● If you selected Single in the Tomcat Setup field:

./ictomcat.sh start weblm

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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Installing the license file
After you obtain the license file, install the file in the WebLM. For more information on how 
to obtain a license file, see IC Installation Planning and Prerequisites.

! CAUTION:
CAUTION: Do not change your license file after you receive it from Avaya. WebLM will 

not accept a modified license.

The following figure shows the License Administration page of the WebLM.
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To install the license file:

1. In your Web browser, navigate to the following URL for the WebLM: 
http://<machine_name>.<domain>:<webLM_port>/weblm/LicenseServer

For example, http://testbox.xyzcorp.com:9601/weblm/LicenseServer

If your contact center uses a proxy server or enhanced security for Internet Explorer, 
you must include this address in the browser exception list and the acceptable Web 
addresses list. 

2. Select License Administration.

3. Type weblm in the Password field and select Continue.

WebLM forces you to change this password immediately to help prevent unauthorized 
access to your license file.

4. To change the password

a. Type the new password. 

b. Re-type the new password.

c. Select Change password.

5. In the License File Name field, type the directory path to your license file.

If you do not know the directory path, select Browse and navigate to the license file.

6. Select Install.
If the installation is successful, you see a page confirming that the WebLM license file 
is installed. If you installed an incorrect license file, or WebLM could not access the 
location of the license file on your network, you will receive an error page.



Installing Avaya IC licenses

186 Installation and Configuration

7. Select the hyperlink under Licensed Products, shown in the following figure, and 
confirm that the number of agents and servers matches your expectations.

Configuring multi-site licenses
If your Avaya IC system includes multiple sites, or a redundant multi-server solution, Avaya 
provides you with a series of segmented licenses for Avaya IC. Each segmented license is 
specific to a WebLM in your Avaya IC system. 

To configure multi-site licenses:

1. Install the appropriate segmented license in all WebLMs in your Avaya IC system, by 
following the instructions in Installing the license file on page 184. 

2. After you install the licenses, return to the License Administration page.

3. Configure the peer servers for the segmented license, by following the instructions 
below.

4. Repeat the configuration process on every machine in your Avaya IC system that 
hosts a WebLM.
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Configuring peer servers for multi-site licenses
To configure peer servers for multi-site licenses:

1. In the License Administration page, scroll down to the Peer Server Administration 
section at the bottom of the page. 

2. Select View/Edit Host List.
3. In the Peer Host Administration page, type the fully-qualified domain name and port 

of the machine in your Avaya IC system that hosts a WebLM. 

Type <machine_name>.<domain>:<webLM_port>. For example, type 
testbox.xyzcorp.com:9601.

4. Select Submit Changes.

Repeat steps 3 and 4 for every machine in your system that hosts a WebLM except the 
machine that you are configuring.

Note:
Note: If you are unable to add a peer host machine to the Peer Host 

Administration page, make sure that the other machine is up and running, 
and that the appropriate segmented license is installed.

Configuring the License server
This section includes information about how to configure the License server that is 
automatically installed with the primary ORB server. Use the same configuration 
parameters in all other License servers in the Avaya IC system. 

Do not host more than one License server on a machine. If your Avaya IC system requires 
multiple License servers, you must host them on different machines.

To configure the License server:

1. In IC Manager, double-click the License server in the list of servers.

2. Select the General tab and complete the fields in the following table.

Field Recommended entry Notes

Name License_<domain> Include the domain in the server 
name to identify the server.
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3. Select the License Server tab and complete the fields in the following table.

4. Select OK.

5. Start the License Server.

6. Confirm that the Alarm Manager at the bottom of the IC Manager window displays a 
confirmation message, such as "At least one WebLM server configuration is working". 
If you do not see this alarm message, your license is not working correctly.

Domain Select the Avaya IC domain for 
the server from the drop-down 
list.

For example, select Default 
from the drop-down list if the 
server is in the Default domain.

Host Select the machine�s IP address 
from the drop-down list, or type 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

Warn about 
upcoming 
license expiry

Check this field.

Time in advance 
of expiry (hours)

If you selected Warn about 
Upcoming License Expiry, 
enter the amount of time 
before the license expires 
that you want to be warned.

Default is 96 hours.

Alarm on no 
licenses

Check this field.

WebLM Server 
URLs

1. Select the Ellipsis (�) 
button.

2. Add the URL of the 
server page for each 
WebLM License 
Manager. 

3. Select the OK button.

Repeat this step for each WebLM in 
your Avaya IC system.
For example, the default URL is 
http://<machine_name>.
<domain>:<port>/weblm/
LicenseServer
Important: Avaya recommends that 
you do not use the IP address of the 
machine in the URL. 

Field Recommended entry Notes
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Changing the administrative password
To change the administrative password for Web License Manager:

1. In your internet browser, navigate to the URL of the server page for the WebLM. 

For example, the URL is 
http://<machine_name>.<domain>.<webLM_port>/weblm/LicenseServer

2. Select License Administration.

3. Type your current password in the Old Password field.

4. Complete the following fields under Change Administrator Password:

● Old password 

● New password 

● Re-type new password

5. Select Change password.
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Chapter 8: Configuring Telephony

The Avaya Computer Telephony for IC (Telephony) is part of the voice channel of Avaya 
Interaction Center (Avaya IC). 

You can use the information in this chapter to set up a simple Telephony environment with 
one Telephony server and one PBX or ACD. Avaya IC also supports more complex 
Telephony environments, including multiple Telephony servers with multiple PBXs or ACDs 
that work independently or together as an integrated environment. You can also configure 
an IVR.

To configure Telephony, perform the steps in the following topics:

1. Prerequisites for configuring Telephony on page 192.

2. Creating a secondary server environment for Telephony on page 192.

3. Configuring the ACD name parameter on page 193.

4. Creating the Telephony server on page 193.

5. Creating the Telephony Queue Statistics server on page 201.

6. Creating a voice queue on page 207.

7. Starting the Telephony servers on page 210.

8. Configuring a Workflow server for Telephony on page 211.

9. Building and loading workflows for Telephony on page 214.

10. Creating routing hints for the Incoming Call workflow on page 216.

Your Avaya IC system can also include the following optional configurations:

● Multi-site heterogeneous switches, as described in IC Telephony Connectors 
Programmer Guide.

● Return on No Answer (RONA), as described in IC Telephony Connectors Programmer 
Guide.

● Connections to an IVR, as described in VOX Server Programmer Guide.
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Prerequisites for configuring Telephony
Before you configure Telephony and related components, make sure that you:

1. Install and configure all prerequisite software and hardware. The prerequisites can 
include one or more of the following:

● Database
● Telephony switch, equipment, and software
● IVR (optional)
For more information about the prerequisites and supported platforms for Telephony, 
see IC Installation Planning and Prerequisites.

2. Copy the server files to the machines where you plan to run the Avaya IC servers, 
described in Installing Avaya IC servers on page 49.

3. Install the Avaya IC design and administration tools.

4. Perform all the steps to configure the Avaya IC servers, databases, and related 
components, described in Configuring core servers on page 113.

5. If your Avaya IC system includes multiple media channels, or multiple Telephony 
servers, create and configure a separate Avaya IC domain for Telephony.

For information on how to create a domain, see Using Avaya IC domains on page 115 
and IC Administration Volume 1: Servers & Domains.

Creating a secondary server environment for 
Telephony

You must create a secondary server environment, including a secondary ORB server, if 
you host the servers that you need to configure for Telephony on a different machine than 
the machine that hosts the primary ORB server. For more information about how to create 
a secondary server environment, see Configuring secondary servers on page 161.

! CAUTION:
CAUTION: Do not create a secondary server environment on the machine that hosts 

your primary ORB server.

You can omit this step if you host the Telephony server and all Workflow servers that 
process voice contacts on the same machine as the primary ORB server. 
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Configuring the ACD name parameter
You must configure an ACD name parameter for each ACD in your Avaya IC system. You 
can include identifying information, such as department or site in the ACD name.

To configure the ACD name parameter:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Telephony > ACD Name.

3. Select New.

4. Type an alphanumeric name for the ACD in the ACD Name field.

Do not use spaces or special characters in the name.

5. Select OK. 

6. Select Manager > Refresh.

If you do not receive a Success message, perform the steps in Troubleshooting the refresh 
in IC Manager on page 510.

Creating the Telephony server
The Telephony server (TS) is the connector server for the voice channel. This server 
interfaces with a switch (PBX), monitors phone calls, and controls telephony routing. This 
server uses the EDU server to record information on telephone calls. The Telephony 
server is specific to the switch you are using.

The Avaya IC installation program does not automatically add this server.

This section includes information about how to set up a Telephony server for a single site 
that does not receive more than 10,000 voice contacts per hour. If you need to configure a 
Telephony server for a more complex system or a higher volume site, or you would like 
more detailed information about the Telephony server, see IC Telephony Connectors 
Programmer Guide. 

For information about how to configure the VDN, CDN, or CCT on each link of the switch to 
communicate with the Telephony server, see IC Installation Planning and Prerequisites.

To create a Telephony server:

1. Select Server > New in IC Manager.

2. Select TS from the list of servers. Select OK.
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3. Select the General tab and complete the fields as shown in the following table.

4. Perform the steps shown in the following table to configure the Telephony server for 
your system�s switch:

Field Recommended entry Notes

Name TS_<domain>_<switch> Include the name of the domain 
and the name of the switch in 
the server name to identify the 
server.

Domain Select the Avaya IC domain for the 
server from the drop-down list.

For example, select Voice1 
from the drop-down list if the 
server is in the Voice domain.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Telephony switch Location of step

Avaya DEFINITY or Avaya 
Communication Manager 
(Avaya DEFINITY/Communication 
Manager)

Configuring the Telephony server for Avaya 
DEFINITY or Avaya Communication 
Manager on page 195

Aspect Configuring the Telephony server for 
Aspect on page 197

Nortel Meridian Configuring the Telephony server for Nortel 
Meridian Link on page 199

Nortel Symposium Configuring the Telephony server for Nortel 
Symposium on page 200
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Configuring the Telephony server for Avaya DEFINITY or 
Avaya Communication Manager

For information about the interface between Avaya products and the Avaya IC Telephony 
server, see Telephony Connectors Programmer's Guide. 

This section includes only the basic required properties. For more information about the 
advanced properties, see IC Administration Volume 1: Servers & Domains.

To configure the Telephony Server for Avaya DEFINITY/Communication Manager:

1. If you have not already done so, double-click the Telephony server in the list of servers.

2. Select the TS tab and complete the fields as shown in the following table:

Field Recommended entry Notes

ACD Name Select the name of the ACD 
assigned to the Avaya switch.

This is the name of the ACD that this 
TS is serving from a pick list of 
names assigned to the ACD during 
system configuration.

ACD Type Select Avaya The type of ACD with which the TS 
will communicate.

ACD Model Select Definity The model of the ACD that 
corresponds to the selected ACD 
Type.

ACD Protocol Select asai The protocol to be used between the 
TS and the ACD. 
If your system includes a Legacy TS 
with switch with Avaya DEFINITY 
software, see IC/OA Software 
Upgrade and Data Migration.

Site Select the site of your TS. Select the site that this server is 
associated with. The TS uses this 
information to retrieve the queues for 
internal monitoring.
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Tip:
Tip: The Telephony server also has some additional configuration parameters 

that you can add on the Configuration tab. For example, you can add a 
parameter to handle blocked ANIs. For more information, see IC 
Administration Volume 1: Servers & Domains and IC Telephony Connectors 
Programmer Guide.

3. Select OK.

ACD Link Enter the IP address (or a 
name if it can be resolved 
into an IP) of the MAPD card 
set. 
Maximum length is 32.

The ACD Link is the device through 
which the Avaya TS communicates 
with the ACD.

Signal Number Specify a signal number 
when configuring multiple 
Avaya users on a single 
machine. 
There is no default value in 
the TS, but IC Manager sets 
this value to 1.
Maximum length is 8.

The signal extension number of the 
ASAI line associated with each TS.
The signal number is mandatory, if it 
is not specified, the TS will not be 
able to establish the link between 
users.

Field Recommended entry Notes
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Configuring the Telephony server for Aspect
For information about the interface between the Aspect CallCenter switch and the Avaya 
IC TS, see Telephony Connectors Programmer's Guide.

This section includes only the basic required properties. For more information about the 
advanced properties, see IC Administration Volume 1: Servers & Domains.

To configure the Telephony Server for Aspect:

1. If you have not already done so, double-click the Telephony server in the list of servers.

2. Select the TS tab and complete the fields as shown in the following table.

Field Recommended entry Notes

ACD Name Select the name of the ACD 
assigned to the Aspect 
switch.

This is the name of the ACD that this 
TS is serving from a pick list of 
names assigned to the ACD during 
system configuration.

ACD Type Select Aspect The type of ACD with which the TS 
will communicate.

ACD Model Select Aspect8 The model of the ACD that 
corresponds to the selected ACD 
Type.

ACD Protocol Select AspectCMI The protocol to be used between the 
TS and the ACD. Avaya IC 
automatically selects AspectCMI 
when ACD Type of Aspect is 
selected.

Site Select the site of your TS. Select the site that this server is 
associated with. The TS uses this 
information to retrieve the queues for 
internal monitoring.

Aspect Contact 
Server Host

Enter the IP address of the 
machine that hosts the 
Aspect Contact server.

Data Interlink 
Number

Enter the Data Interlink 
number.

The Data Interlink number from the 
Aspect ACD thE TS uses to 
communicate with the ACD.

Aspect Header Enter the link definition on the 
Aspect switch.

If this field is empty, the server uses 
the machine name of the ACD.
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Device Enter the TCP/IP port where 
the TS needs to create a 
connection.
Default is 7,046.

For a list of default port numbers for 
components in the Avaya IC suite, 
see the IC Installation and 
Configuration.

Monitored Agent 
Group

Enter the number assigned to 
the agent group to monitor. 
Default is 1.

Do not complete this field if the TS is 
monitoring all the agent groups on 
Avaya IC.

Monitored Trunk 
Group

Enter the number assigned to 
the trunk group to monitor. 
Default is 1.

Do not complete this field if the TS is 
monitoring all the trunk groups on 
Avaya IC.

Monitor All Agent 
Groups

Check this box if you want 
the TS to monitor all agent 
groups.
Default is unchecked.

This overrides the entry in the 
Monitored Agent Group field.

Monitored Super 
Agent Group

Enter the number assigned to 
the super agent group to 
monitor.
Default is 1.

Leave this field blank if you do not 
want the TS to monitor the super 
agent group.

Monitor All Trunk 
Groups

Check this field if you want 
the TS to monitor all trunk 
groups.
Default is unchecked.

This overrides the entry in the 
Monitored Trunk Group field.

Blind Transfer 
CCT

Enter the Call Control Table 
number used to perform blind 
transfers.

Make Call CCT Enter the Call Control Table 
number used to make calls 
within the Aspect switch.

External Calls 
CCT

Enter the Call Control Table 
number used to make calls 
external to the Aspect switch.

Route CCT Enter the Call Control Table 
number used to route calls 
external to the Aspect switch.

Transfer CCT Enter the Call Control Table 
number used during call 
transfers.

Field Recommended entry Notes
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Tip:
Tip: The Telephony server also has some additional configuration parameters 

that you can add on the Configuration tab. For example, you can add a 
parameter to handle Aspect data variables. For more information, see IC 
Administration Volume 1: Servers & Domains and IC Telephony Connectors 
Programmer Guide.

3. Select OK.

Configuring the Telephony server for Nortel Meridian Link
For information about the interface between Nortel Meridian switches and the Avaya IC 
TS, see Telephony Connectors Programmer's Guide.

This section includes only the basic required properties. For more information about the 
advanced properties, see IC Administration Volume 1: Servers & Domains.

To configure the Telephony Server for Meridian Link:

1. If you have not already done so, double-click the Telephony server in the list of servers.

2. Select the TS tab and complete the fields as shown in the following table.

Transfer Init CCT Enter the Call Control Table 
number used during transfer 
init operations.

Predictive CCT Enter the Call Control Table 
number used during 
predictive operations.

Field Recommended entry Notes

Field Recommended entry Notes

ACD Name Select the name of the ACD 
assigned to the switch.

This is the name of the ACD that this 
TS is serving from a pick list of 
names assigned to the ACD during 
system configuration.

ACD Type Select Nortel The type of ACD with which the TS 
will communicate.

ACD Model Select Meridian The model of the ACD that 
corresponds to the selected ACD 
Type.

ACD Protocol Select MLP. This is the protocol used by the 
Symposium Server.
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Tip:
Tip: The Telephony server also has an additional configuration parameter that 

you can add on the Configuration tab. For example, you can add a 
parameter to handle queues with mixed case names. For more information, 
see IC Administration Volume 1: Servers & Domains and IC Telephony 
Connectors Programmer Guide.

3. Select OK.

Configuring the Telephony server for Nortel Symposium
For information about the interface between Nortel Meridian switches and the Avaya IC 
TS, see Telephony Connectors Programmer's Guide.

This section includes only the basic required properties. For more information about the 
advanced properties, see IC Administration Volume 1: Servers & Domains.

To configure the Telephony Server for Symposium:

1. If you have not already done so, double-click the Telephony server in the list of servers.

2. Select the TS tab and complete the fields as shown in the following table.

Site Select the site of your TS. Select the site that this server is 
associated with. The TS uses this 
information to retrieve the queues for 
internal monitoring.

Link The logical identifier in the 
server where NetMerge is 
running. 

The Link establishes a path between 
a NetMerge client and a given PBX 
interface. The logical identifier is 
established in the NetMerge server 
configuration program.

Node Enter the name of the server 
where NetMerge is running.

The Node needs to translate to an IP 
address via DNS or host table.

Field Recommended entry Notes

Field Recommended entry Notes

ACD Name Select the name of the ACD 
assigned to the switch.

This is the name of the ACD that this 
TS is serving from a pick list of 
names assigned to the ACD during 
system configuration.

ACD Type Select Nortel The type of ACD with which the TS 
will communicate.
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Tip:
Tip: The Telephony server also has an additional configuration parameter that 

you can add on the Configuration tab. For example, you can add a 
parameter to handle queues with mixed case names. For more information, 
see IC Administration Volume 1: Servers & Domains and IC Telephony 
Connectors Programmer Guide.

3. Select OK.

Creating the Telephony Queue Statistics server
The Telephony Queue Statistics server (TSQS) monitors the voice channel and maintains 
queue statistics in the ADU Server. These statistics include contact count and age of oldest 
contact. 

You must includes a TSQS server on all machines that host Outbound Contact servers.

If Business Advocate handles all routing for voice contacts, you do not need a TSQS 
server.

The Avaya IC installation program does not automatically add this server.

ACD Model Select Symposium The model of the ACD that 
corresponds to the selected ACD 
Type.

ACD Protocol Select MLS. This is the protocol used by the 
Symposium Server.

Site Select the site of your TS. Select the site that this server is 
associated with. The TS uses this 
information to retrieve the queues for 
internal monitoring.

Link The logical identifier in the 
server where NetMerge is 
running. 

The Link establishes a path between 
a NetMerge client and a given PBX 
interface. The logical identifier is 
established in the NetMerge server 
configuration program.

Node Enter the name of the server 
where NetMerge is running.

The Node needs to translate to an IP 
address via DNS or host table.

Field Recommended entry Notes
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To create the TSQS:

1. In IC Manager, select Server > New.

2. Select TsQueueStatistics from the list of servers. Select OK.

3. Select the General tab and complete the fields as shown in the following table.

4. Perform the steps shown in the following table to configure the TSQS server for the 
switch:

Field Recommended entry Notes

Name TsQueueStatistics_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for the 
server from the drop-down list.

For example, select Voice1 
from the drop-down list if the 
server is in the Voice domain.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Telephony switch Location of step

Avaya DEFINITY or Avaya 
Communication Manager 

Configuring the TSQS server for Avaya 
DEFINITY or Avaya Communication 
Manager on page 203

Aspect Configuring the TSQS server for Aspect on 
page 204

Nortel Meridian Configuring the TSQS server for Nortel 
Meridian Link on page 205

Nortel Symposium Configuring the TSQS server for Nortel 
Symposium on page 206
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Configuring the TSQS server for Avaya DEFINITY or Avaya 
Communication Manager

This section includes only the basic required properties. For more information about the 
advanced properties, see IC Administration Volume 1: Servers & Domains.

To configure the TSQS for Avaya DEFINITY or Avaya Communication Manager:

1. If you have not already done so, double-click the TSQS server in the list of servers.

2. Select the TSQS tab and complete the fields as shown in the following table.

3. Select OK.

Field Recommended entry Notes

ACD Name Select an ACD Name. The name of the ACD (switch) that 
this TSQS is serving. Provides a 
pick list of name(s) assigned to the 
switch during system configuration.
Each TSQS on the system must 
have a unique ACD Name.

Site Select the site where the 
TSQS is located.

The site used by your TS configured 
for the Avaya switch.

ACD Type Select Avaya. The ACD Type option used by your 
TS configured for the Avaya switch.

ACD Model Displays Definity after you 
select Avaya as ACD Type.

The ACD Model option used by your 
TS configured for the Avaya switch.

ACD Protocol Select asai. The ACD Protocol option used by 
your TS configured for Avaya switch.
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Configuring the TSQS server for Aspect
This section includes only the basic required properties. For more information about the 
advanced properties, see IC Administration Volume 1: Servers & Domains.

To configure the TSQS for Aspect:

1. If you have not already done so, double-click the TSQS server in the list of servers.

2. Select the TSQS tab and complete the fields as shown in the following table.

3. Select OK.

Field Recommended entry Notes

ACD Name Select an ACD Name The name of the ACD (switch) that 
this TSQS is serving. Provides a 
pick list of name(s) assigned to the 
switch during system configuration.
Each TSQS on the system must 
have a unique ACD Name.

Site Select the site where the 
TSQS is located.

The Site used by your TS configured 
for the Aspect switch

ACD Type Select Aspect. The ACD Type option used by the 
TS configured for the Aspect switch. 

ACD Model Select Aspect8. The ACD Model option used by your 
TS configured for the Aspect switch.

ACD Protocol Displays AspectCMI after you 
select Aspect8 as the ACD 
Model.

Select the ACD Protocol option used 
by your Telephony server configured 
for the Aspect switch.

Switch Name Enter the IP address of the 
link that connects the switch 
to the TSQS.

This is different from the IP address 
used by the switch.

Switch Port Enter the number of the port 
used by the switch.
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Configuring the TSQS server for Nortel Meridian Link
This section includes only the basic required properties. For more information about the 
advanced properties, see IC Administration Volume 1: Servers & Domains.

To configure the TSQS for Nortel Meridian Link:

1. If you have not already done so, double-click the TSQS server in the list of servers.

2. Select the TSQS tab and complete the fields as shown in the following table.

3. Select OK.

Field Recommended entry Notes

ACD Name Select an ACD Name. The name of the ACD (switch) that 
this TSQS is serving. Provides a 
pick list of name(s) assigned to the 
switch during system configuration.
Each TSQS on the system must 
have a unique ACD Name.

Site Select the site where the 
TSQS is located.

The site used by your TS configured 
for the Nortel switch using Meridian 
Link.

ACD Type Select Nortel. The ACD Type option used by your 
TS configured for the Nortel switch 
using Meridian Link. 

ACD Model Select Meridian. The ACD Model option used by your 
TS configured for the Nortel switch 
using Meridian Link.

ACD Protocol Select MLP. The ACD Protocol option used by 
your TS configured for the Nortel 
switch using Meridian Link.

Switch Name Enter the IP address of the 
link that connects the switch 
to the TSQS.

This is different from the IP address 
used by the switch.

Switch Port Enter the number of the port 
used by the switch.
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Configuring the TSQS server for Nortel Symposium
This section includes only the basic required properties. For more information about the 
advanced properties, see IC Administration Volume 1: Servers & Domains.

To configure the TSQS for Nortel Symposium:

1. If you have not already done so, double-click the TSQS server in the list of servers.

2. Select the TSQS tab and complete the fields as shown in the following table.

3. Select OK.

Field Recommended entry Notes

ACD Name Select an ACD Name. The name of the ACD (switch) that 
this TSQS is serving. Provides a 
pick list of name(s) assigned to the 
switch during system configuration.
Each TSQS on the system must 
have a unique ACD Name.

Site Select the site where the 
TSQS is located.

The site used by the TS configured 
for your Nortel switch using 
Symposium Server.

ACD Type Select Nortel. The ACD Type option used by your 
TS configured for the Nortel switch 
using Symposium Server. 

ACD Model Select Symposium. The ACD Model option used by your 
TS configured for the Nortel switch 
using Symposium Server.

ACD Protocol Select MLS. The ACD Protocol option used by 
your TS configured for the Nortel 
switch using Symposium Server.

Switch Name Enter the IP address of the 
link that connects the switch 
to the TSQS.

This is different from the IP address 
used by the switch.

Switch Port Enter the number of the port 
used by the switch.
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Creating a voice queue
The sample Incoming Call workflow uses the DefaultVoiceQueue@DefaultTenant voice 
queue. Avaya recommends that you create this queue and additional queues, including a 
queue for each of the possible route (transfer) points where the Incoming Call workflow 
can route a voice contact.

Avaya IC uses voice queues for the following:

To gather statistics information - The TSQueueStatistics server monitors the queues 
and maintains statistics in the ADU server. These statistics can then be processed by, for 
example, Avaya OA. For more information, see Creating the Telephony Queue Statistics 
server on page 201.

To provide a literal translation for a switch device - With this literal translation, you can 
reference a destination in the switch. For example, you can reference VDN 1234 as 
queue_sales. Avaya IC displays queue_sales as a destination in the Unified Agent 
Directory. 

To provide support for multi-site heterogeneous switches - Avaya IC uses the 
information you enter in the Voice tab of the queue to support multi-site heterogeneous 
switches. For more information, see Telephony Connectors Programmer�s Guide.

To integrate with routing hints - You add the ID of the voice queue to the RoutingHint 
table when you configure the routing hints used by the Incoming Call workflow. For more 
information about routing hints, see Creating routing hints for the Incoming Call 
workflow on page 216. 

The following procedure explains how to create a simple voice queue. For information 
about more complex voice queues, including transfer queues and queues for multi-site 
heterogeneous switches, see IC Administration Volume 2: Agents, Customers, & Queues 
and IC Telephony Connectors Programmer Guide.

To create a simple voice queue:

1. In IC Manager, select the Device tab.

2. Select Device > New Device.

3. In the New Device dialog box, select Voice Queue. Select OK.
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4. In the Device Editor (Voice) dialog box:

a. Select the General tab and complete the fields shown in the following table.

Field Recommended entry Description

Id The device number known 
to the PBX (or ACD).

The ID is the VDN or vector 
identifier that your PBX or ACD 
uses for the queue.
The ID must be a numeric 
value.
For a Nortel Meridian switch 
with Symposium, the ID must 
be the name of the SkillSet 
defined in the PBX or ACD. 

Site Select the site of your 
Telephony server.

ACD Name Select the name of the 
ACD.

This is the ACD Name that you 
confirmed in Configuring the 
ACD name parameter on 
page 193,

Name Type a name for the voice 
queue.

For the default voice queue, 
type DefaultVoiceQueue
@DefaultTenant.
Queue names can have up to 
256 characters, including 
special characters and spaces. 
Queue names cannot: 
● Start with a digit
● Start with an asterisk "*" or a 

pound sign "#" 
● Contain "@" (except default 

queue)
The Unified Agent Directory 
displays this name to agents. 

Media Voice Automatically set by IC 
Manager. You cannot change 
this field.

Priority Assign a priority to the 
queue.

For example, type 1.

Service Level Type the number of hours, 
minutes, and seconds in 
the format HH:MM:SS

The service level defines the 
time within which all voice 
contacts in the queue must be 
answered. Type the time in the 
format HH:MM:SS.
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b. Select the Voice tab and complete the fields in the following table.

Minimum agents 1 Type the minimum number of 
agents who must be active to 
use the queue.

Addressable Check this box. Determines whether the queue 
is displayed in the Unified 
Agent Directory.

Field Recommended entry Description

Enable EDU 
Tracking

If selected, the first Telephony 
server in the TS Set monitors 
this queue internally. 
Select this option only under 
one of the following conditions: 
● The switch and CTI link 

cannot make a call-to-data 
association.

● The switch supports queue 
monitoring.

● The environment is 
configured to ensure that 
new contacts are pre-
processed by one 
Telephony server, where all 
the queues reside, but all 
agents are handled by 
another Telephony server. 
(Usually the pre-process 
has to do with call routing 
and queue monitoring.)

Note: In addition to selecting 
this check box, make sure that 
the associated Telephony 
server is the first one in the TS 
Set list.

Field Recommended entry Description
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5. Select OK.

Starting the Telephony servers
! Important:! Important:

Important: Create the voice queues before you start the Telephony server and the 
TSQS server.

To start Telephony servers:

1. Right-click on the Telephony server and select Start from the menu.

After the Alarm Monitor displays a message confirming that the server has started 
correctly, continue with the next step.

2. Right-click on the TSQS server and select Start from the menu.

After the Alarm Monitor displays a message confirming that the server has started 
correctly, continue with the next step.

Wait Treatment 
Style

Type a numeric value for a 
wait treatment if you want 
customers on this queue to 
hear a wait treatment while 
on hold.

The numeric value associated 
with the wait treatment 
configuration on the switch. 
For more information, contact 
your switch administrator.

TS Set Select the Ellipsis (�) 
button and in the dialog 
box:
● Select New.
● Select the Telephony 

server that handles 
voice contacts for this 
queue from the drop-
down list.

● After you have added all 
of the Telephony 
servers, select OK.

Defines the Telephony servers 
that can be used to deliver 
voice contacts to this queue, 
and the order that the Multi-
Site Heterogeneous Switch 
(MSHS) mechanism follows 
when attempting to deliver 
contacts to specific queues. In 
order to do this, the MSHS 
uses the ADU for its central 
data store.
The TS Set can only include 
Telephony servers that handle 
contacts from the switch where 
the queue resides
Note: Queue names are kept 
in cache for 24 hours.

Field Recommended entry Description
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3. Set your Telephony server to start automatically:

a. Double-click the Telephony server in the list of servers.

b. Select the General tab.

c. Check the Autostart box.

d. Select OK.

4. Set your TSQS server to start automatically:

a. Double-click the TSQS server in the list of servers.

b. Select the General tab.

c. Check the Autostart box.

d. Select OK.

Configuring a Workflow server for Telephony
To create and configure a Workflow server for Telephony, perform the steps in the following 
topics:

1. Creating a Workflow server for Telephony on page 211

2. Configuring the voice channel for the Workflow server on page 212

If the Avaya IC system includes multiple Workflow servers, perform these steps on each 
Workflow server that processes voice contacts.

Creating a Workflow server for Telephony
These instructions only provide information about those parameters you need to set when 
you create a Workflow server to handle voice contacts. For more information about other 
parameters in the Workflow server, see Configuring multiple Workflow servers on 
page 135 and IC Administration Volume 1: Servers & Domains.

To create a Workflow server for Telephony:

1. In IC Manager, select Server > New.

2. Select Workflow from the list of servers. 

3. Select OK.



Configuring Telephony

212 Installation and Configuration

4. Select the General tab, and complete the fields shown in the following table.

5. Select the Workflow tab.

6. From the IC Data Source drop-down list, select the Interaction Center data source.

The default name for this data source is interaction_center. This is the data source that 
you created in Generating the Interaction Center application on page 109.

7. Select Synchronous Startup Flows.
8. If the following row does not exist, add it to the Synchronous Startup Flows:

a. Select New.

b. In the new row, type web_routing.update_qw_cache

c. Select OK.

9. Continue with Configuring the voice channel for the Workflow server on page 212.

Configuring the voice channel for the Workflow server
To configure the voice channel for the Workflow server:

1. In the Server Editor for the Workflow server, select the Channels tab.

2. Select New Channel.

Field Recommended entry Notes

Name Workflow_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for 
the server from the drop-down list.

For example, select Voice1 to 
use the preconfigured domain 
for Telephony.

Host Select the machine�s IP address 
from the drop-down list, or type 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.
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3. In the Channel Editor dialog box, complete the fields as shown in the following table. 
Select OK.

4. Select the channel that you created in the step above.

5. Select New Association.

Field Recommended entry Notes

Global Do not check this field. Do not check this field to create a 
create a channel for a specific server 
or media, such as Telephony.

By Server ● Do not check this field if 
you want this channel to 
handle events from all 
servers of the type that 
you select from the 
Service drop-down list.

● Check this field if you want 
this channel to handle 
events from only one 
specific server that you 
select from the Service 
drop-down list.

If you check this field, and you need 
this Workflow server to communicate 
with more than one server, you must 
create another channel for that 
server.
Warning: If you check this field and 
the Telephony server is named "TS", 
the Workflow server will not be able 
to communicate with the Telephony 
server.

Channel Range No entry necessary. Completed by IC Manager

Service Select TS or a specific 
Telephony server from the 
drop-down list.

Whether you can select a server or a 
type of server, depends up whether 
or not you checked the By Server 
field.

Criteria Type the criteria you want the 
workflow to use for the event.

For example, you can enter a criteria 
for the workflow to route calls that 
arrive at a routing point.
For a detailed description of the 
criteria for each server and server 
type, see the description of the 
Assign method in the Programmer 
Guide for that server. For example, 
to see criteria for the Telephony 
server, see IC Telephony Connectors 
Programmer Guide.
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6. In the Channel Association dialog box, complete the fields as shown in the following 
table. Select OK.

7. Select OK.

8. Select OK.

9. In the Server tab of IC Manager, select the Workflow server that handles voice 
contacts.

10. Right-click the Workflow server and select Start.

Building and loading workflows for Telephony
You can use the sample workflows to configure and test your Telephony servers. When 
you move into production, modify the properties of the sample workflows to meet your 
system needs and configuration. For more information about the sample workflows and 
ways to customize them, see Avaya IC Media Workflow Reference.

For each workflow project, perform the steps in the following topics:

1. Building the Incoming Call workflow on page 215.

2. Loading workflows in the Workflow server on page 215.

Field Recommended entry

Channel Range Completed by IC Manager

Service Interface Completed by IC Manager

Event TS.IncomingCall
Note: This field is case-sensitive.

Flow Type <workflow_project>.<routing_workflow>
For example, if you use the sample Incoming Call workflow, 
type ts.incomingcall
Note: This field is case-sensitive.
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Building the Incoming Call workflow
You do not need to configure any blocks to use the sample Incoming Call flow.

To build the Incoming Call workflow:

1. In Workflow Designer, select File > Open Project and open the TS project.

You can find the TS project in the following directory: 
IC_INSTALL_DIR\IC61\design\IC\Flows\Avaya\TS\TS.prj

2. Double-click incomingcall.qfd in the Project pane.

3. Select Project > Settings.

4. Select the Database tab and type the following values:

● Interaction Center Data Source name in the IC Data Source field

● Valid Avaya IC Administrator account in the Login ID field

The default account is Admin.

● Password for the account in the Password field

5. Select OK.

6. Select Build > Build Flowset.
Workflow Designer verifies and compiles the flows. All error messages, including the 
block name, script name, and offending line, are displayed in the Output bar.

7. Select File > Exit to exit Workflow Designer.

Loading workflows in the Workflow server
When you build a flowset, Workflow Designer does not automatically load and run the 
workflows in the Workflow server. You can reload workflows without restarting the 
Workflow server.

Tip:
Tip: Test the workflows and confirm that they work correctly. If the Workflow 

server is not running the new workflows, stop and restart the server. 

To reload workflows in the Workflow server:

1. In IC Manager, select the Servers tab and double-click the Workflow server.

2. In the Workflow server settings dialog box, select the Workflow tab.

3. Select Reload Flows.
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4. In the Reload Flows dialog box:

a. Select Force Immediate Reload.

b. Select OK to reload all currently loaded workflows even if the version numbers are 
the same.

5. Select OK.

Creating routing hints for the Incoming Call 
workflow

The Add Routing Hints (DNIS) block in the Incoming Call workflow uses the routing hints in 
the RoutingHint table of the Directory server to route incoming voice contacts. The sample 
Incoming Call workflow requires at least one routing hint for the main incoming DNIS 
number. Assign this routing hint to a voice queue that you created in Creating a voice 
queue on page 207.

You can create routing hints for one or more additional DNIS numbers, if required by your 
contact center.

! Important:! Important:
Important: Routing hints must be in lower case. Do not use mixed upper and lower 

case in your routing hints. If the routing hint is not in all lower case, the 
workflow cannot locate the routing hint, and Avaya IC cannot correctly route 
the contact. 

Each row in the routing hint table contains the following:

● A routing hint

● The name of the voice queues where contacts that match the routing hint should be 
routed

For more information about how workflows use routing hints, see Avaya IC Media 
Workflow Reference.

To create routing hints:

1. In IC Manager, select the Configuration tab.

2. In the left pane, select Tables > Workflow > RoutingHint. 
3. Select New.
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4. In the right pane, complete the fields shown in the following table:

5. Select OK.

6. Select Manager > Refresh.

Parameter Recommended entry Description

Routing Hint Type a routing hint. For the sample Incoming Call workflow, 
create a routing hint with the DNIS for the 
incoming calls. For example, if the DNIS 
is 21000, type 21000 in this field.
The routing hint must be a single word in 
all lower case or a series of numbers.
Do not use special characters.

Voice Queue ID Type the name of a voice queue. Avaya recommends that you do not use 
DefaultVoiceQueue@DefaultTenant for 
routing hints. For information on how to 
create a voice queue, see Creating a 
voice queue on page 207.

Category/Qualifier Leave this field blank. Business Advocate uses this field.

Tenant Leave this field blank. Telephony does not use tenancy.
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Chapter 9: Configuring Outbound Contact

Avaya Interaction Center (Avaya IC) uses Avaya Outbound Contact Management 
(Outbound Contact) to initiate and report on outbound calling campaigns.

To configure Outbound Contact, perform the steps in the following topics:

1. Prerequisites for Outbound Contact on page 219.

2. Creating a secondary server environment for Outbound Contact on page 220.

3. Configuring the Dialer database on page 220.

4. Configuring servers for Outbound Contact on page 228.

5. Configuring disconnects for answering machine and nuisance calls on page 237.

6. Configuring Outbound Contact Reports on page 238.

7. Configuring Web scheduled calls on page 240.

Tip:
Tip: After you configure Outbound Contact, you must perform the tasks needed 

to set up and administer your outbound jobs. For more information, see IC 
Administration Volume 2: Agents, Customers, & Queues.

Prerequisites for Outbound Contact
Before you configure Outbound Contact, you must perform the following steps:

1. Install the database client for your database system on all machines that host 
Outbound Contact servers and Outbound Contact Reports.

2. Install and configure Telephony components.

3. Create the CCQ database, as described in Creating the CCQ database on page 108.
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Creating a secondary server environment for 
Outbound Contact

You must create a secondary server environment, including a secondary ORB server, if 
you host the servers that you need to configure for Outbound Contact on a different 
machine than the machine that hosts the primary ORB server.

! CAUTION:
CAUTION: Do not create a secondary server environment on the machine that hosts 

your primary ORB server.

For more information about how to create a secondary server environment, see 
Configuring secondary servers on page 161.

Configuring the Dialer database
Outbound Contact uses a separate database to store data that is specific to outbound 
calling jobs. You must configure that database.

To configure the dialer database, perform the steps in the following topics:

1. Configuring the Dialer database connection on page 220.

2. Configuring the Dialer connection set on page 225.

3. Creating the Dialer database on page 226.

4. Generating the Dialer application and data source on page 227.

Configuring the Dialer database connection
To configure the database connection for the Dialer database:

1. In Database Designer, open the dialer.adl file. 

The ADL file is in the 
IC_INSTALL_DIR\IC61\design\Softdialer\dialer.adl directory.

If you have enabled Database Designer for localization, select OK and ignore the 
warnings about the missing ALF file and ALM file. Database Designer automatically 
generates the ALF file and ALM file when you save the ADL file. For more information, 
see Enabling Database Designer for localization on page 545.
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2. Expand Components > Physical DB Connections and select the Dialer database 
connection in the tree pane.

3. In the DB Connection Properties tab, complete the fields in the General group as 
shown in the following table:

4. From the Database Type drop-down menu, select the type of database to which you 
want to connect.

Database Designer uses the selected database type to generate a SQL statement 
which can be applied to the database.

Property Recommended entry Notes

Timeout (sec) Type the maximum number of 
seconds that the client application 
waits for a response to a database 
request before the application 
assumes the connection to the 
Data server is lost.

Default value is 60 seconds.
If no response is returned within the 
specified time, the client application 
closes the connection to the Data server 
and returns an error. The client application 
attempts to create a new connection to 
the database on the next database 
request. 
For information about when to increase 
this value, see Troubleshooting Outbound 
Contact Management on page 523.

Description Type a description of the database 
connection, if desired.

You can leave this field empty.

Display Time Select DBMSTime as the display 
time setting that specifies how 
DateTime data from the database 
is presented in the client 
application.

If you do not select DBMSTime, Outbound 
Contact cannot function correctly.
Times used for roster and calendar values 
can be incorrectly adjusted if you use 
either of the other two options.
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5. Complete the Mandatory fields for your database, as shown in the following table.

Database type Property Recommended entry Notes

All database 
types

Data Server 
Type/Alias

Type the name of the 
primary Data server. 

This server is the one that 
you created in Setting up the 
primary Data server on 
page 79.
For example, defaults are:
● DataServerMSSQL
● DataServerOracle
● DataServerDB2

SQL Server Database server Type the host name of the 
machine that hosts your 
database server.

For the default database 
instance, type the host name. 
For another database 
instance, type 
<machine>\<db_name>.

Database Name Type the name of the 
database. For example, 
dialer.

Avaya recommends that you 
use dialer to reduce the 
possibility of a migration 
impact. 

Oracle TNS Name Type the server alias from 
the tnsnames.ora file

For example, type 
support.xyzcorp.com.

Database Name Type the name of the 
Oracle user for the 
database. For example, 
dialer.

Avaya recommends that you 
use dialer to reduce the 
possibility of a migration 
impact. 

Client Library 
Home Directory

Type the full directory path 
for the Oracle client on the 
machine that hosts the 
Data server. 

For example, type 
<oracle_install_dir>/
opt/oracle/8.1.7

DB2 DB2 Database 
Name

Type the name of the DB2 
database that includes the 
Avaya IC schema.

DB2 allows a maximum of 
eight characters for database 
names.
For example, type db2IC.

IC Schema Name Type the schema name of 
the database. For 
example, dialer.

Avaya recommends that you 
use dialer to reduce the 
possibility of a migration 
impact. 

Database Territory Type the territory that 
represents the locale of the 
database that includes the 
Dialer schema.

The territory defines the 
language and locale of the 
database. For more 
information, see the DB2 
documentation.
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6. If necessary, complete the Optional fields for your database, as shown in the following 
table.

Database type Property Recommended entry Notes

SQL Server Database Location Leave this field blank. Identifies the logical space 
where the named database is 
stored. 
The SQL Server DBMS 
specifies the database 
location.

Database Size Leave this field blank. The size of the database 
location specifies the amount 
of space that the configured 
application database 
occupies. 
The SQL Server RDBMS 
specifies the database size.

Log Location Leave this field blank. Database-generated log files 
store cumulative transaction 
information. The SQL Server 
RDBMS specifies a default 
location for the database log.

Log Size Leave this field blank. The size of the location for 
database log files specifies 
the amount of space that the 
database-generated log files 
can occupy. 
The SQL Server RDBMS 
specifies a default size for the 
database log.
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Oracle Default tablespace 
name

Type the name of the 
default tablespace where 
objects are created for the 
Avaya IC databases. For 
example, type IC_TS.

The database location 
identifies the logical space 
where the named database is 
stored. If you leave this field 
blank, and the Oracle 
RDBMS does not specify a 
database location, Oracle 
uses the �system� space to 
define the database. 
Caution: Configuring a 
database in the system space 
can crash your database.

Default tablespace 
size

Type the number of bytes 
for the size of the default 
tablespace.

Caution: If you do not specify 
a default tablespace size 
here, and your RDBMS does 
not define the default 
tablespace size, the default 
tablespace can expand to 
use all available space.

Temp tablespace 
name

Type the name of the 
tablespace that stores 
temporary files. For 
example, type 
T_CI_TEMP.

Temporary tables store 
database-generated 
intermediate sorting files and 
client session information for 
Oracle databases. If you do 
not specify a location for 
temporary tables, the location 
is specified by the Oracle 
RDBMS.

Temp tablespace 
size

Type the number of bytes 
for the size of the 
tablespace that includes 
temporary tables.

The size of the location for 
temporary tables in Oracle 
databases specifies the 
amount of space that the 
temporary tables can occupy. 
If you do not specify the 
amount of space to be 
allocated for temporary 
tables, the size is specified by 
the Oracle RDBMS.

Database type Property Recommended entry Notes
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7. Select File > Save to save the ADL file. Do not close the file.

Configuring the Dialer connection set
To configure the connection set for the Dialer database:

1. In Database Designer, expand DB Connection Sets and select 
defaultDBConnectionSet in the tree pane.

2. Select Dialer from the Logical DB Connections list in the Connection Set Properties 
tab and make sure the properties are set as shown in the following table:

3. Select CallCenterQ from the Logical DB Connections list and make sure the 
properties are set as shown in the following table:

DB2 Catalogued Node Type the remote node on 
the machine that hosts the 
Data server.

Complete this field if you host 
your Data server on a 
different machine from the 
Avaya IC databases.

Tablespace Name Type the name of the 
tablespace used by the 
Dialer database.

Complete this field if you 
created a dedicated 
tablespace that the IC 
Repository database uses. 
Note: Avaya OA requires 
dedicated tablespaces. For 
more information, see Avaya 
OA Installation Planning and 
Prerequisites.

Database type Property Recommended entry Notes

Field Recommended entry

Physical DB Connection Select the Dialer connection.

Primary Check this box.

Field Recommended entry

Physical DB Connection Select the Dialer connection.

Primary Do not check this box.
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4. Select File > Save to save the ADL file. Do not close the file.

Creating the Dialer database
To create the Dialer database:

1. In Database Designer, select File > Database Administration.

2. Select the Dialer Connection from the DB Connection Set list.

3. Set the options as shown in the following table:

4. If the fields in the following table do not have entries, re-type your IC Manager account 
and password. 

5. Select Run to configure the database.

Database Designer pauses briefly between configuring the database and importing the 
seed data. 

6. Select Close.

Use External Database Check this box.

Database Name Type the name of your CallCenterQ database.
This name must be the exact name that you 
gave your CallCenterQ database. For 
example, type ccq.

Field Recommended entry

Field Recommended entry

Configure Select Configure.

Import Seed Data Check this box.

Field Recommended entry

Login Id Type your IC Manager login ID.
Note: Do not use your DBA login ID and 
password.

Password Type your password.
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Generating the Dialer application and data source
You generate the Dialer application to initialize the database with the ADL and version 
information, and to create the Dialer data source.

To generate the Dialer application and data source:

1. In Database Designer, select File > Generate Windows Application.

2. Check the Messages box to load the files to the database:

3. Select dialer from the Name list.

4. Type the path for the directory where you want Database Designer to store the 
application files.

For example, type IC_INSTALL_DIR\IC61\apps.

If you do not know the directory path, select the Ellipsis (�) button and navigate to the 
directory.

5. From the DB Connection Set drop-down list, select defaultDBConnectionSet.
6. If the fields in the following table do not have entries, re-type your IC Manager account 

and password. 

7. Select OK.

Database Designer creates a new folder with the same name as the application in the 
target directory.

Field Recommended entry

Login Id Type your IC Manager login ID.
Note: Do not use your DBA login ID and 
password.

Password Type your password.
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Configuring servers for Outbound Contact
Perform the following steps to configure the servers for Outbound Contact:

1. Modifying the server configuration file on page 228.

2. Creating an administrative user for Outbound Contact on page 229.

3. Creating the Softdialer server on page 231.

4. Creating the Dialing Kernel server on page 233.

5. Configuring multiple Dialing Kernel servers on page 235.

6. Updating the runtime settings for Outbound Contact on page 236.

Modifying the server configuration file
The mcscon.ini file contains the configuration parameters for Outbound Contact 
servers. You can modify this file in a text editor.

Avaya IC installation copies the mcscon.ini file to the IC_INSTALL_DIR\IC61\etc 
folder on the machine that hosts your Outbound Contact servers.

To modify the Outbound Contact configuration file:

1. In a text editor, such as Notepad, open IC_INSTALL_DIR\IC61\etc\mcscon.ini

2. Find the following section:

3. Verify that the entries of this section are accurate, or replace the entries with values for 
the area code, country code, and formats of the contact center. For more information 
about:

● Codes used for the format parameters, see IC Administration Volume 1: Servers & 
Domains

● Country codes, see IC Administration Volume 2: Agents, Customers, & Queues

[CCLIC]
TRACE.ALL               = ON
LOCALFORMAT             = E
INTERLOCALFORMAT        = AE
INTERNATIONALFORMAT     = CAE
SYSTEMAREA              = 425
SYSTEMCOUNTRY           = 1
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4. In the Call Control Layer [CCLIC] section of the file:

a. Set the value of the PredictiveRoutePoint property to the value of the 
Predictive Route Point on your switch.

b. Verify that the value of the Allocation = %AM_DETECTION% property is the 
following, or replace this default value:

Allocation = 2

5. Find the following section:

6. Replace with: 

This is the administrative account and password that you created in Creating an 
administrative user for Outbound Contact on page 229. For example, if you use the 
default Administrative account for Outbound Contact, use the following values: 

7. Save and close the file.

Creating an administrative user for Outbound Contact
Outbound Contact requires an administrative account in the same domain as Outbound 
Contact. This account is reserved for use by the Outbound Contact servers. Do not allow 
an agent to use this account to log in to Avaya IC. Do not change the password for this 
account.

The procedure in this section creates an administrative user named pdkdevctrl with a 
password of dialer1 for Outbound Contact and the associated Telephony servers. You 
can use any login ID and password for the administrative user. However, you must make 
sure that the login information in the following are configured to use that administrative 
user and password: 

● Outbound Contact mcscon.ini file

● TS tab of the Telephony server

To create administrative accounts:

1. In IC Manager, select the Agent tab.

2. Select Administrator in the left pane.

LoginName = 
Password =

LoginName = <Administrative_account_name>
Password = <password>

LoginName = pdkdevctrl
Password = dialer1
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3. Select Agent > New.

4. Select the General tab and complete the fields as shown in the following table:

5. Select the Channels tab and complete the fields as shown in the following table:

Field Description

First Name Required field
Type pdkdevctrl.

Last Name Required field
Type pdkdevctrl.

Preferred Name Required field
Type the administrative user name. For example, type 
pdkdevctrl.

Employee ID Type the employee ID. For example, type 
pdkdevctrl.

Login ID Type the login ID. For example type pdkdevctrl

Domain Required field
Select the domain used by the Dialing Kernel server 
and the Telephony server.

Task Load Required field
Set to 0.

Task Ceiling Required field.
Set to 0.

Site Select a site from the drop-down list.
Note: Avaya IC uses the Site to compile statistics for 
groups or agents or queues.

Field Recommended entry

Disable Voice Channel Do not check this box.

Phone Id Leave this field empty.

Password Leave this field empty.

Phone type Select eas from the drop-down list.

Equipment Leave this field empty.

Queue Leave this field empty.
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6. Select the Security tab and complete the fields as shown in the following table:

7. Select Apply.

8. Select OK.

9. If you did not use the defaults administrative user name and password shown in the 
above procedure, update the login ID and password in the mscon.ini file and the 
Telephony server as described in Configuring multiple Dialing Kernel servers on 
page 235.

Creating the Softdialer server
The Softdialer server provides support for outbound agent call management and for web 
scheduled calls. The Avaya IC installation program does not automatically add this server.

To create the Softdialer server:

1. Select Server > New in IC Manager.

2. Select Softdialer from the list of servers. Select OK.

Task Load Accept the default value of 1.

Task Ceiling Accept the default value of 1.

Field Recommended entry

Password Type the password for this account. For 
example, type dialer1 as the password.

Confirm Re-type the password for this account.

Force password change on 
login

Do not check this field.

Disable login Do not check this field.

Administrator Check this field.

Field Recommended entry
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3. Select the General tab and complete the fields shown in the following table.

4. Select the Softdialer tab and complete the fields shown in the following table.

Field Recommended entry Notes

Name SoftDialer_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

This server does not have to be in 
the same domain as the Telephony 
server and the Predictive Dialing 
Kernel server. However, Avaya 
recommends that you put this server 
in the same domain for consistency. 
All domains for Outbound Contact 
agents must failover to this domain.
For example, select Voice1 from 
the drop-down list if the servers are 
in the Voice domain.

Host Select the machine�s IP 
address from the drop-down 
list, or type the IP address if it 
is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

IC Data Source Select the IC Data Source for 
the Dialer database.

If you used the default name, 
select Dialer. 

Site Select a site where the 
SoftDialer server is located from 
the drop-down list.

Avaya IC uses the Site to compile 
statistics for groups or agents or 
queues.

Enable Polling Check this field. When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Polling Rate 
(sec)

30 Enter the number of seconds 
between polls.
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5. Select OK.

6. Start the server.

Creating the Dialing Kernel server
The Dialing Kernel server enables outbound dialing for Outbound Contact. This server also 
integrates with the Telephony server and places outbound calls for jobs based on priority, 
dialing mode, and agent availability. For more information about the Dialing Kernel server 
and Outbound Contact, see IC Administration Volume 2: Agents, Customers, & Queues.

The Avaya IC installation program does not automatically add this server.

You must create the Dialing Kernel server in the same domain and on the same machine 
as the Telephony server that it uses.

Note:
Note: The Dialing Kernel server does not support failover.

To create the Dialing Kernel server:

1. Select Server > New in IC Manager.

2. Select DialingKernel from the list of servers. Select OK.

Enable Agent 
Dispatching

Check this field. Select this check box if the 
SoftDialer server will be 
responsible for dispatching 
agents between inbound 
channels and the outbound 
channel. If it is selected, the 
SoftDialer will blend agents 
based on each channel�s service 
level exception. If this is cleared, 
some other components or 
scripts in the system must 
manage agent blending between 
inbound and outbound.

Agent 
Dispatching Rate 
(sec)

30 If Enable Agent Dispatching is 
selected, use this parameter to 
specify how often to check each 
channel queue�s service level 
exception and dispatch agents 
between inbound and outbound 
channel as needed. The 
minimum is 10 seconds.

Field Recommended entry Notes
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3. Select the General tab and complete the fields shown in the following table.

4. Select the DialingKernel tab.

5. Avaya recommends that you type 1:00 in the Time to Run field.

If you want the server to go through the event report once a day and write selected 
events to the database for reporting purposes, enter the time of day that this process 
should run in this field (format HH:MM). Time when the call data records are taken from 
the Dialing Kernel call detail record (CDR) file and entered in the database. The Dialing 
Kernel server outputs the file at midnight. If you set the Time to Run to 1:00, the data 
records will be entered into the database at 1:00 a.m. If you do not specify this 
parameter, then the server does not write the daily events to the database.

For information about the other fields on the DialingKernel tab, see IC Administration 
Volume 1: Servers & Domains.

6. Select OK.

7. Start the server.

Field Recommended entry Notes

Name Dialing_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

This server must be in the same 
domain as the Telephony server and 
the Softdialer server.
For example, select Voice from the 
drop-down list if the server is in the 
Voice domain.

Host Select the machine�s IP 
address from the drop-down 
list, or enter the IP address if 
it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.
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Configuring multiple Dialing Kernel servers
You can include multiple Dialing Kernel servers in an Avaya IC system. However, you must 
host each Dialing Kernel server on a different machine and configure the server 
configuration file to 

To configure an Avaya IC system for multiple Dialing Kernel servers:

1. Update the mcscon.ini file on each machine that hosts a Dialing Kernel server with 
the user name and password of the administrative account for that server. 

For more information, see Modifying the server configuration file on page 228.

2. In IC Manager, create a separate pdkdevctrl administrative account for each Dialing 
Kernel server that matches the information in the mcscon.ini file. This account must 
have a login that includes pdkdevctrl. 

For example, in a system with three Dialing Kernel servers, create the following three 
administrative accounts: 

● pdkdevctrl1
● pdkdevctrl2
● pdkdevctrl3

3. In IC Manager, create a Telephony server for each Dialing Kernel server. 

4. Specify the log in for the administrative account in the configuration of each Telephony 
server, as follows:

a. In the Server Editor for the Telephony server, select the TS tab.

b. Right-click in the right pane, and check the box next to Show Advanced 
Properties.

c. Type the login of the administrative account for the Dialing Kernel server that uses 
the Telephony server.

d. Select OK to save the configuration.
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Updating the runtime settings for Outbound Contact
To update the runtime settings for the Outbound Contact Dialing Client, you must update 
the MCDesk.ini file in the the IC_INSTALL_DIR\IC61\etc folder on the machine that 
hosts IC Manager.

To update the runtime settings;

1. In a text editor, such as Notepad, open IC_INSTALL_DIR\IC61\etc\mcdesk.ini

2. Find the following section:

[kernel]

ServiceAddress= 135.35.91.49

ServicePort = 7800

3. Update the values for the following properties as shown in the following table:

4. Find the following section:

[trace]

Trace   = on

logpath = C:/Program Files/Avaya/IC61/logs

FileSize= 2000000

5. Confirm that value for logpath is the logs directory for Avaya IC. The default logs 
directory is IC_INSTALL_DIR/IC61/logs. If you did not install Avaya IC in the 
Program Files directory, you must update this value. 

6. Save and close the file.

7. If IC Manager is open, close and re-open IC Manager to ensure that these changes 
take effect.

Property Value

ServiceAddress Type the IP address of the machine that hosts 
the Softdialer server and Dialing Kernel server.

ServicePort Confirm that this is 7800, the port that you 
entered when you configured the serverport 
property for the Dialing Kernel server.
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Configuring disconnects for answering machine and 
nuisance calls

You must configure Outbound Contact to disconnect and route nuisance calls and call 
attempts answered by answering machines.

These instructions use the term "vector" which applies to a switch with Avaya 
DEFINITY/Communication Manager. The following table shows the appropriate term and 
definition for the other switches supported by Outbound Contact.

To configure disconnects for answering machine and nuisance calls:

1. In your telephony switch:

● Create a vector with the following step:

disconnect after announcement none

● Create a VDN as follows:

● Use the VDN value shown in the following table:

● Refer the VDN to the new vector

2. On the machine that hosts your Outbound Contact servers:

a. In a text editor, such as Notepad, open 
IC_INSTALL_DIR\IC61\etc\mcscon.ini

b. Find the following section: CclIc

Switch Term Definition

DEFINITY G3 Vector Directory Number 
(VDN)

Vector

Aspect Monitored subtype Call Control Table (CCT) with the 
appropriate monitored subtype in the 
end Data (001) step

Meridian Control Directory Number 
(CDN)

Customer Controlled Routing (CCR)

Parameter Value

Name PredictiveDropPoint
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c. Add the property shown in the following table:

For example, if your predictive drop point is 7001, add the following property: 
PredictiveDropPoint = 7001

For more information about the Predictive Drop Point, see Telephony Connectors 
Programmer�s Guide. 

Configuring Outbound Contact Reports
This section describes how to create and configure a connection to the Dialer database for 
the Outbound Contact Reports. This section includes the following topics with steps that 
you must perform to configure Outbound Contact Reports:

1. Configuring database connection for reporting on page 238.

2. Setting the environment variable on page 239.

Configuring database connection for reporting
On the machine that hosts Outbound Contact servers, create this connection on the 
Outbound Contact tab of the Avaya IC Configuration Tool, shown in the following figure.

Parameter Value

Name PredictiveDropPoint

Value Predictive drop point on your switch.
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For more information about the Outbound Contact tab of the Configuration Tool, see 
Outbound Contact tab on page 491.

To configure Outbound Contact reports:

1. Select Start > Programs > Avaya Interaction Center 6.1 > Configuration Tool.
If the Configuration Tool is already open, close and re-open it to ensure that the 
Configuration Tool includes all system changes, such as new servers.

2. Select the Outbound Contact tab.

3. From the Dialer Data Source drop-down list, select dialer.
4. In the Database Login field, type a valid DBA login ID for the Dialer database.

Type a DBA login ID for the database server. Do not use the DBA login for a database 
client.

5. In the Database Password field, type the password for the database user.

6. In the Oracle Home field:

● For Avaya IC systems with Oracle databases, type the home directory of the Oracle 
client on the machine that hosts the Outbound Contact Reports. For example, type 
/opt/oracle/8.1.7.

● For Avaya IC systems with SQL Server databases or DB2 databases, leave this 
field empty.

7. Select Apply Settings. 

8. Select OK in the Success dialog box.

9. Select Exit.

Setting the environment variable
Outbound Contact Reports uses an environment variable named DBSCOPE to connect to 
the Dialer database. This variable has different values for different databases. You must 
set this variable on the machine that hosts Outbound Contact Reports.

To set the environment variable:

1. On the Windows desktop, right-click My Computer and select Properties.

2. Select the Advanced tab.

3. Select Environment Variables.

4. In the System Variables section, select New.
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5. Type DBSCOPE for the variable name, and set the value of the environment variable, 
as shown in the following table.

6. Select OK in each dialog box.

Configuring Web scheduled calls
To use Web Scheduled Calls, you must configure the customer website to send scheduled 
call requests to Outbound Contact. This configuration defines the Web interface that sends 
scheduled call request to Outbound Contact.

When you build the Web page and define the interface, you can implement standard 
methods to lookup and populate the variables, such as:

● A standard link to a job

● A drop-down list of the regions defined in Outbound Contact Supervisor from which 
customers can select their region

● Hard code the region

● Dynamically detect the region for the originating request

Database type Value of environment variable

SQL Server DBSCOPE=

Oracle DBSCOPE=<dialer_dbuser>
where dialer_dbuser is the administrative 
login for the Dialer database.
For example, set the value as:
DBSCOPE=sys

DB2 DBSCOPE=<dialer_dbschema>
where dialer_dbschema is the schema 
name for the Dialer database.

For example, if you used the default schema 
for the Dialer database, set the value as:
DBSCOPE=db2inst1
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Prerequisites for configuring Web scheduled calls
Before you configure Web Scheduled Calls, you must define the following before defining 
the web interface. For more information on how to define these items, see IC 
Administration Volume 1: Servers & Domains.

● Outbound Contact system settings on page 241.

● Region on page 241.

● Job ID on page 242.

Outbound Contact system settings

These settings include: Daylight Saving Time (DST) Rules, Time zones, and special dates 
or holidays 

Region

This setting is the region where the scheduled call request originates. A region is an 
Outbound Contact system setting that define areas where the same time zone, DST rule, 
and special dates apply. Outbound Contact uses the settings of the assigned region to 
control its dialing behavior for the telephone number. 

To define a region, the system settings in the following table must exist.

System Setting Description

Daylight Savings Time 
(DST) rule

A DST rule defines the difference between daylight savings 
time and standard time, and the start and end dates of the 
DST period.

Time zone The time zone of the geographical location where 
customers in your calling list are located. A time zone is the 
difference between local time and Coordinated Universal 
Time (UTC), which was formerly known as Greenwich 
Mean Time (GMT). UTC uses a 24 hour clock to express 
time.

Special date(s) Days which need a separate entries in a dialing window 
that sets the legal times that the contact center can conduct 
outbound calling. 
Special dates take precedence over weekdays, Saturdays, 
and Sundays.
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Job ID 

This is the Job ID assigned to the outbound job that will conduct the scheduled calls. An 
outbound job is a calling activity that Outbound Contact uses to contact customers and 
connect them with agents. Each job has a goal or objective. Outbound Contact can run 
multiple outbound jobs simultaneously. One type of outbound job conducts calls customers 
who requested calls through Web Scheduled Calls. 

The definition for each job includes a name, a user-friendly description, and parameters 
that define how Outbound Contact will handle the calling activities. Each job uses 
associated information and an optional script to dial telephone number and connect agents 
with customers.

When a supervisor defines a job, Outbound Contact assigns a Job ID to the job.

For more information about Job IDs, including how to retrieve the Job ID for a particular 
job, see IC Administration Volume 2: Agents, Customers, & Queues.

Configuring the scheduled call method
The following code in the Web page defines the Schedule Call method that sends 
scheduled call request to Outbound Contact.

// scheduled a call specified by local time in seconds since 1970
ORBStatus ScheduleCallLocTm( in string <eduID>, in long <jobID>, 
in string countryCode, 

in string <areaCode>, in string <extension>, in string 
<callerName>, 

in long <scheduleCallTimeInSecondsSince1970>, in long <regionID> 
); 

The following table lists the variables found in the Scheduled Callback method: 

Variable Required Prerequisite Description

eduID Yes The identifier that Outbound Contact 
assigns the customer context EDU 
when the customer issues a 
scheduled call request

jobID Yes Yes The identifier that Outbound Contact 
assigns a job when a supervisor 
defines the job
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countryCode Yes The 1-, 2-, or 3-digit number that 
precedes the national number in an 
international telephone call. The 
country code identifies the
country or the integrated numbering 
plan in which the telephone number is 
located. A country code may be 
referred to as an international area 
code or international dialing code.

areaCode Yes The code for the geographic area or 
locale

extension Yes The telephone subscriber number

callerName Yes The name of the customer.

scheduleCallTimeI
nSecondsSince197
0

Yes The time requested for the scheduled 
call to occur, converted to the number 
of seconds since 1970

regionID Yes Yes The identifier that Outbound Contact 
assigns a region when a supervisor 
defines geographic areas.

Variable Required Prerequisite Description
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Chapter 10:Configuring Web Management

Web Management is a Web-based marketing, sales, and service application that 
personalizes and manages Web transactions for Avaya Interaction Center. Configure Web 
Management if your Avaya IC system includes Web Management, Email Management, or 
Voice Chat.

This section includes the following topic that describes Web Management:

● Web Management support for media channels on page 246.

This section includes the following topics that describe the steps that you must perform to 
complete the configuration of Web Management:

1. Completing prerequisites for configuring Web Management on page 247.

2. Creating a secondary server environment for Web Management on page 248.

3. Configuring servers for Web Management on page 248.

4. Configuring Web Management services on page 257.

5. Integrating Web Management Administration on page 272.

6. Configuring a Workflow server for Web Management on page 274.

7. Using workflows for Web Management on page 277.

8. Configuring routing hints for the Qualify Chat workflow on page 279.

9. Configuring the ICM server on page 282.

10. Configuring the Central Internet Routing service on page 286.

11. Configuring the Website on page 288.

12. Refreshing the Directory server on page 291.

This section includes the following topics that describe optional configurations for Web 
Management:

● Configuring HTTP(S) tunneling (optional) on page 292.

● Configuring SSL security for Web servers (optional) on page 295.

● Setting up a separate administration Website (optional) on page 298.

● Setting up a separate customer Website (optional) on page 302.

For information on how to set up RONA for Web Management, see IC Administration 
Volume 2: Agents, Customers, & Queues
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Web Management support for media channels
This section includes the following topics:

● Features available in chat channel and email channel on page 246.

● Support available for Shared Browsing on page 247.

Features available in chat channel and email channel
The following table shows the integrated functionality that Web Management provides and 
the support that the functionality provides for the chat channel and the email channel.

Feature or component Chat channel Email channel

Customer management X X

Self-service to provide suggested responses for 
agents

X X

Chat escalation X �

Chat & Phone escalation for voice chat X �

Chat & VoIP escalation for voice chat X �

Web scheduled calls for Outbound Contact X �

Email escalation � X

Survey X �

WebACD server administration X X

Web page multi-tenancy and multi-tenancy 
administration

X X

Datawake and Datawake administration X X

Chat channel services:
● Chat server and client components
● Shared browsing

X �
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Support available for Shared Browsing
The Shared Browsing component of Web Management allows agents to view the same 
Web pages as a customer. When you integrate Shared Browsing with your Website, note 
that: 

● Shared Browsing supports:

- State and session information stored in the cookie of the customer

- State and session information stored in query parameters in the URL

- Internet Explorer auto-complete feature

- Form handling and preservation during and after chat sessions, such as separate 
windows for Web browser and chat

● Shared Browsing does not support:

- State and session storage in a custom object

- Form POST

- Server.transfer

Completing prerequisites for configuring Web 
Management

Before you configure Web Management, make sure that you:

1. Install and configure all prerequisite software and hardware, including a Web server 
and a JDK.

For information on which prerequisites you need for each machine, see IC Installation 
Planning and Prerequisites.

2. Copy the server files to the machines where you plan to run the Avaya IC servers, 
described in Installing Avaya IC servers on page 49.

3. Install the Avaya IC design and administration tools.

4. Perform all the steps to configure the Avaya IC core servers, databases, and related 
components, described in Configuring core servers on page 113.

5. On Solaris and AIX machines, install a Windowing environment such as X-Windows on 
the machine that hosts the Website and ICM server.
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Creating a secondary server environment for Web 
Management

You must create a secondary server environment, including a secondary ORB server, if 
you host the servers that you need to configure for Web Management on a different 
machine than the machine that hosts the primary ORB server.

You must configure a secondary server environment on the following machines:

● Machines that host Web Management servers

● Machines that host an IC customer Website or an Administrative Website

For more information about how to create a secondary server environment, see 
Configuring secondary servers on page 161.

Note:
Note: On all machines that host a Website, set the startup options on the 

secondary ORB server to Manual unless that machine also hosts an Avaya 
IC server, such as an Attribute server.

Configuring servers for Web Management
You must add and configure Web Management servers to use Web Management and 
Email Management. These instructions include only those properties required to get the 
servers up and running. For information about other server properties, see IC 
Administration Volume 1: Servers & Domains.

This section describes the Web Management servers and how to configure them. Topics 
include:

Note:
Note: Add and configure the servers in the order in which they are presented in the 

following topics. Avaya IC systems that include the email channel, but not 
the chat channel, do not require the Attribute server.

1. Creating the WebACD server on page 249.

2. Creating the Attribute server on page 252.

3. Creating the ComHub server on page 254.

4. Creating the Paging server on page 255.

5. Starting the Web Management servers on page 257.
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Creating the WebACD server
The WebACD server performs as a call distributor for chat and email contacts. This server 
assigns tasks to agents and tracks the different states of the agent interactions. This server 
uses the Attribute server, Paging server, IC Email server, and ComHub server to complete 
support operations such as managing agent states and administering agent and contact 
interactions. This server is also known as the Web Agent Automatic Call Distributor (ACD) 
server.

The Avaya IC installation program does not automatically add this server. Web 
Management and Email Management require this server.

If your Avaya IC system includes multiple domains, ensure that the failover strategy for the 
WebACD server includes the following:

IC Email server failover - The domain that includes your IC Email server must failover to 
the domain that includes your WebACD server.

WebACD server failover - The domain that includes your WebACD server must failover 
to the domain that includes your IC Email server.

To create the WebACD server:

1. Select Server > New in IC Manager.

2. Select WACD from the list of servers. Select OK.

3. Select the General tab and complete the fields in the following table.

Field Recommended entry Notes

Name WebACD_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for the 
server from the drop-down list.

For example, select Web from 
the drop-down list.

Host Enter or select the machine�s IP 
address from the drop-down list.

When you select the host, IC 
Manager fills in Directory, Port, 
and Executable.
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4. Select the WACD tab and complete the fields in the following table.

Field Recommended entry Notes

Host Name Enter the name of the machine 
that hosts the WebACD server.

For example, enter TESTBOX.

Domain Enter the domain of the 
machine that hosts the 
WebACD server.

For example, enter xyzcorp.com.

Service Port 4010 If you must change this port, see 
Ports used by Avaya IC 
components on page 28 for a list of 
the default port numbers used by 
the other Avaya IC servers. Port 
conflicts can cause serious 
problems within the Avaya IC 
system.

IC Data Source Select the Interaction Center 
Data Source.

If you used the default name, select 
interaction_center. 

WACD 
Webserver

Enter the name and domain of 
the machine that hosts the 
Web Administration pages.

For example, enter 
TEXTBOX.xyzcorp.com.

Port Enter the port that the 
WebACD server uses for 
connections with Web 
applications.

Default port is 80 unless you plan to 
configure SSL for your website.
If you must change this port, see 
Changing the service port for the 
WebACD server on page 36 for a 
list of the default port numbers used 
by the other Avaya IC servers. Port 
conflicts can cause serious 
problems within the Avaya IC 
system.

Protocol Select the protocol that you 
use to connect to the Website.

Select http unless you plan to 
configure SSL for your Website. For 
more information on SSL, see 
Configuring SSL security for Web 
servers (optional) on page 295. 

Comhub Host 
Name

Enter the fully-qualified 
domain name of the machine 
that hosts the ComHub server.

For example, enter 
TESTBOX.xyzcorp.com.
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Comhub Port Enter the service port for the 
Comhub server.

Default service port is 4001. 
If you must change this port, see 
Changing the service port for the 
ComHub server on page 36 for a 
list of the default port numbers used 
by the other Avaya IC servers. Port 
conflicts can cause serious 
problems within the Avaya IC 
system.

Website Context Enter the name of the Web 
application used for Web 
Management.

The default website context is 
website.

Agent Timeout 
(secs)

100 If the WebACD assigns a contact to 
an agent who has turned on the 
"Wait for agent confirmation before 
accepting a contact" option in 
Avaya Agent, then this value 
specifies the number of seconds 
that the WebACD server will wait for 
confirmation from that agent before 
it reassigns the contact to another 
available agent.
For details about setting this option, 
see the Avaya Agent User Guide.

Max Display 
Tasks

Enter the number of currently active 
tasks to display per request in the 
WebACD administration pages.

Task Wrap 
Timeout (secs)

Automatically wraps and completes 
a task after an customer or agent 
has timed out. For example, if the 
Avaya Agent shuts down and the 
user is forced to end the 
consultation, the WebACD server 
waits until the amount of time 
specified in the wrap-up timeout 
parameter has passed, then wraps 
and completes the task. 

Interval Between 
Cleanup (mins)

Enter the period of time that the 
WebACD should wait between 
cleaning up threads from timed out 
and abandoned chat tasks.

Max Allowed 
Queue Time 
(mins)

Enter the maximum time that a chat 
task can stay in a queue before it is 
considered to be dead or 
abandoned.

Field Recommended entry Notes
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5. Select OK to save your configuration settings.

Creating the Attribute server
The Attribute server acts as a communications bridge between the ICM server and the 
WebACD server for chats. Provides tracking of user web page browsing sessions for 
Datawake. This server also provides website property event notifications between the 
website and the ICM server.

If your Avaya IC system includes Datawake, or you are concerned with performance 
issues on the Website, you can host a second Attribute server on the Website machine in 
the DMZ. If your Avaya IC system includes this deployment, configure the secondary ORB 
server on the machine to start automatically.

The Avaya IC installation program does not automatically add this server. Web 
Management requires this server.

To create the Attribute server:

1. Select Server > New in IC Manager.

2. Select Attribute from the list of servers. Select OK.

Summary 
Interval (mins)

Enter the period of time that the 
WebACD should wait between 
creating summary records. This 
interval must be an even divisor of 
60 (for example, you can use 4, 5, 
6, 10, 12, or 15, but you cannot use 
8 or 9.)
If you set the interval to 5 minutes, 
then the WebACD will write 
summaries at 12:00, 12:05, 12:10, 
etc.

Requalify 
Contacts

Enable this option if you want the 
WebACD server to re-run the 
Qualify workflow on unassigned 
tasks. 

Field Recommended entry Notes
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3. Select the General tab and complete the fields in the following table.

4. Select the Attribute tab and complete the fields in the following table.

5. Select OK to save your configuration settings.

Field Recommended entry Notes

Name Attribute_<domain> Include the domain in the server 
name to identify the server in 
the list of servers.

Domain Select the Avaya IC domain for the 
server from the drop-down list.

For example, select Web from 
the drop-down list if the server 
is in the Web domain.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry

Port If you must change the default, see Changing the service port 
for the Attribute server. Port conflicts can cause serious 
problems within the Avaya IC system.

Enable Datawake 
Recording

Check this field if:
● The Avaya IC system includes DataWake
● You want this Attribute server to track the Web pages 

browsed by a Website customer.

Enable ICM Bridge Check this field.

IC Login By default, this field uses the icmbridge account that is 
provided with Avaya IC. 
If you have not already done so, change the default password 
for this account.
Important: Do not use the Administrative account for IC 
Manager or any account for which the password may change.

IC Password Type the password for the account in the IC Login field.

ICM Servers ● Select the Ellipsis (�) button.
● In the ICM Servers dialog box:

- Select New.
- Check Enabled.
- Type the name and domain of the machine that hosts 

the ICM server. For example, TESTBOX.xyzcorp.com.
- Accept the default port number or change to an 

available port.
- Select OK.
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Creating the ComHub server
The ComHub server provides a communications hub for the Web Management and Email 
Management servers. This server also assists in passing information from a web-based 
interface to the WebACD server, and helps the WebACD server to respond to agent 
requests, such as logon or logoff.

The Avaya IC installation program does not automatically add this server. Web 
Management and Email Management require this server.

To create the ComHub server:

1. Select Server > New in IC Manager.

2. Select ComHub from the list of servers. Select OK.

3. Select the General tab and complete the fields in the following table.

4. Select the ComHub tab and complete the fields in the following table.

Field Recommended entry Notes

Name Comhub_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

For example, select Web from the 
drop-down list if the server is in the 
Web domain.

Host Select the machine�s IP 
address from the drop-down 
list, or enter the IP address if 
it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

Host Name Enter the fully-qualified 
domain name of the machine 
that hosts the ComHub 
server.

For example, enter 
TESTBOX.xyzcorp.com.

Service Port Accept the default port of 
4001 or enter a new port. 

If you must change the default, see 
IC Installation and Configuration. 
Port conflicts can cause serious 
problems within the Avaya IC 
system.
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5. Select OK to save your configuration settings.

Creating the Paging server
The Paging server serves as a communications bridge between Avaya Agent and the 
WebACD server. This server brokers messages to ensure they are sent to the correct 
agents and to the WebACD server.

! Important:! Important:
Important: When you create Avaya IC accounts for agents who handle chat contacts, 

make sure that the domain for those agents fails over to the domain that 
includes the Paging server.

The Avaya IC installation program does not automatically add this server. Web 
Management and Email Management require this server.

To create the Paging server:

1. Select Server > New in IC Manager.

2. Select Paging from the list of servers. Select OK.

3. Select the General tab and complete the fields in the following table.

IC Data Source Select the Interaction Center 
Data Source.

If you used the default name, select 
interaction_center.

Threads Accept the default or enter a 
number of threads.

The default entry is 10.
The number of threads that can be 
constructed to handle 
communication tasks.

Field Recommended entry Notes

Field Recommended entry Notes

Name Paging_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for the 
server from the drop-down list.

For example, select Web from 
the drop-down list if the server 
is in the Web domain.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.
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4. Select the Paging tab and complete the fields in the following table.

5. If you changed the default service port of 4001 for the Comhub server, perform the 
following steps:

a. Right-click on a blank space of the Paging tab.

b. Check the box next to Show Advanced Properties.

c. In the Comhub Port field, type the service port for the Comhub server.

6. Select OK to save your configuration settings.

Field Recommended entry Notes

Host Name Enter the name of the 
machine that hosts the 
Paging server.

For example, enter TESTBOX.
Important: The Avaya IC agent 
desktop application uses this host 
name without the "Domain" name to 
connect to the Paging server. 
Configure the agent machine to use 
the host name without the domain 
name suffix to communicate with the 
machine that hosts the Paging 
server.

Domain Enter the domain of the 
machine that hosts the 
Paging server.

For example, enter xyzcorp.com.
Important: The Avaya IC agent 
desktop application does not use 
this Domain field to connect to the 
Paging server. For more information, 
see the Notes for Host Name above.

Service Port 4200 If you must change the default, see 
Changing the service port for the 
Paging server on page 37. Port 
conflicts can cause serious problems 
within the Avaya IC system.

ComHub Host 
Name

Enter the fully-qualified 
domain name of the machine 
that hosts the ComHub 
server.

For example, enter 
TESTBOX.xyzcorp.com.
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Starting the Web Management servers
Before you configure your media channels, Avaya recommends that you start the Avaya IC 
servers, including the Web Management servers. When you start the Attribute server, the 
WebACD server will start automatically.

To start the Avaya IC servers:

1. Select the server.

2. Right-click on the server and select Start.
For more information about the correct order for starting and stopping Avaya IC servers, 
see Starting and stopping Avaya IC servers on page 147.

Setting startup options for servers in IC Manager

Set the following Web Management servers to autostart:

● Attribute server
● ComHub server
● Paging server
● Workflow server that processes chat contacts
To set startup options for servers in IC Manager:

1. Double-click the server in the Server tab.

2. Select the General tab.

3. Check the Auto Start box.

Configuring Web Management services
This section describes how to install and configure Web Management services for each 
operating system that Avaya IC supports. This section includes the following topics:

● Where to configure Web Management services on page 258.

● Hosting multiple Web applications on one machine on page 258.

● Advanced properties for Web Management services on page 258.

● Configuring Web Management services on Windows on page 259.

● Configuring Web Management services on Solaris on page 263.

● Configuring Web Management services on AIX on page 268.
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Where to configure Web Management services
Configure Web Management services on the following: 

● Machines that host Web Management Websites

● Machines that host the WebACD server and Attribute servers to configure database 
access for:

- Suggested Response feature of the WebACD server

- Datawake recording feature of the Attribute server

Hosting multiple Web applications on one machine
If the Avaya IC system includes more than one Web application on the same machine as 
the WebLM, Avaya recommends that you:

● Select Multiple for the Tomcat Setup option.

● Configure all of the Web applications on the target machine at the same time.

! Important:! Important:
Important: If you do not configure all of the Web applications simultaneously, leave the 

options for all Web applications on the target machine checked when you re-
run the Configuration Tool to create the new Web applications. If you do not 
leave the options for the previously created Web applications checked, the 
Configuration Tool may delete those Web applications from the machine.

Advanced properties for Web Management services
The Web tab also includes advanced properties for the Java Virtual Machine. Only 
configure the advanced properties if you expect a high volume of contacts on the Website. 
For more information, see Advanced properties on the Web tab on page 501.

If you expect a high volume of chat contacts, increase the default settings for the advanced 
properties. For example, you can use the advanced properties to increase the memory 
allocations for the Website JVM and ICM JVM should be adjusted upward. For high 
volumes, Avaya recommends that you configure each of these properties to:

-Xms64m -Xmx512m  -Xss64k
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Configuring Web Management services on Windows
Use these instructions if you plan to host Web Management services on a Windows 
machine.

You do not need to stop the IIS Web server on Windows machines.

To configure Web Management services to run on a Windows machine:

1. To start the Configuration Tool, select Start > Programs > Avaya Interaction Center 
6.1 > Configuration Tool.
If the Configuration Tool is already open, close and re-open it to ensure that the 
Configuration Tool includes all system changes, such as new servers.

2. Log in with your IC Manager login ID and password.

3. Complete the general fields in the following table.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple

JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

C:\jdk1.3.1_06

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600

IIS Website The name of the IIS Web server that the Web 
application will use. 
Tip: For a localized version of IIS, type the 
localized name for the IIS Web server.

Default Web Site

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox
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DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct. 

xyzcorp.com

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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4. Complete the Web Management fields in the following table.

Field Description Sample entry

Configure Web 
Management

Check this box if you want to configure Web 
Management services on the target machine.
After you check this box, the Configuration Tool 
automatically:
● Displays the other Web Management fields
● Checks the following boxes:

- Website
- ICM
- CIRS
- Attribute - DataWake recording (PDM)

Checkmark in box

Website Creates the Website Web application and 
performs other tasks that are required to 
configure a Web Management Website on the 
target machine.
After you check this box, the Configuration Tool 
displays the following required fields for the 
Website:
● Website Virtual Directory Name
● WebACD
● Attribute Server

Checkmark in box

Website Virtual 
Directory Name

The name of the virtual directory for the Website. website

WebACD The WebACD server in your Avaya IC system.
You must create the WebACD server before the 
Configuration Tool can include the server in the 
drop-down list. If the list does not include the 
server, close the Configuration Tool and create 
the server. For more information, see Creating 
the WebACD server on page 249.

WebACD_web

Attribute Server The Attribute server that the Datawake plug-in 
uses.
You must create the Attribute server before the 
Configuration Tool can include the server in the 
drop-down list. If the list does not include the 
server, close the Configuration Tool and create 
the server. For more information, see Creating 
the Attribute server on page 252.

Attribute_web

ICM Service Configures the ICM server and related 
components on the target machine.
For more information, see Configuring the ICM 
server on page 282.

Checkmark in box
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CIRS Service Configures the CIRS server and related 
components on the target machine.
For more information, see Configuring the Central 
Internet Routing service on page 286.
Important: Only configure a CIRS server if your 
Avaya IC system includes more than one ICM 
server.

Checkmark in box

Attribute - 
DataWake 
recording (PDM)

Configures the DataWake recording feature of 
the Attribute server.

Checkmark in box

IC Login Use the website account that you imported into 
the database with the seed data. 
If you have not already done so, change the 
default password for this account. For more 
information, see IC Administration Volume 2: 
Agents, Customers, & Queues.
Note: Do not use the Administrator account for IC 
Manager or any other account for which the 
password may change. 

website

IC Password The password used by the IC Login. website

IC Data Source The Interaction Center data source that you 
create with the Interaction Center application for 
the CallCenterQ database. For more information, 
see Generating the Interaction Center 
application on page 109.

interaction_center

Repository Data 
Source

The Repository data source that you create with 
the repository application for the IC Repository 
database. For more information, see Generating 
the IC Repository application on page 98.

repository

Database Login Type a DBA login ID for the database server. SQL Server: sa

Oracle: sys

Database 
Password

The password for the DBA login ID. admin

Oracle Home Oracle databases only.
The home directory of the Oracle client on the 
machine that hosts the Web Management 
servers.

SQL Server: leave empty

Oracle: 
C:\Oracle\Ora81

Field Description Sample entry
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5. Select Apply Settings. 

6. Select OK in the Success dialog box.

7. Select Exit.
8. To complete the configuration, perform the following steps to ensure that all Web 

Management services start properly:

a. Open the Windows Services control panel.

b. Start the Tomcat NT services:

● For a multiple Tomcat setup, start Avaya IC Web Management Service 6.1.

● For a single Tomcat setup, start Avaya IC Jakarta Service 6.1.

For more information about how to start and stop Web application services, see 
Starting and stopping Avaya IC services on page 154.

Configuring Web Management services on Solaris
Use these instructions if you plan to host Web Management services on a Solaris machine.

! Important:! Important:
Important: To configure Web Management services on Solaris, you must log in as a 

user with write permissions on the Web server directories and the Avaya IC 
installation directories. The root user usually has these write permissions.

To configure Web Management services to run on a Solaris machine:

1. Stop the Sun ONE server that hosts the Website application with the stop script 
packaged with the Web server: 
<SunONE_install_dir>/servers/<my_ONE_server>/stop

2. Start the Configuration Tool:

a. Navigate to IC_INSTALL_DIR/IC61/bin 

b. Run ./configure

If the Configuration Tool is already open, close and re-open it to ensure that the 
Configuration Tool includes all system changes, such as new servers.

3. Log in with your IC Manager login ID and password.
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4. Complete the general fields in the following table.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple

JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

/opt/j2sdk1_3_1_06

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600

Web Server Home The installation path for the Sun ONE� Server 
that hosts the Web application.

/opt/iplanet

Web Server Name The root name of the server as found in the Sun 
ONE� Server home directory.
Note: Do not include https- in the Web server 
name.

testbox.xyzcorp.com

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct. 

xyzcorp.com

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80
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5. Complete the Web Management fields in the following table.

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry

Field Description Sample entry

Configure Web 
Management

Check this box if you want to configure Web 
Management services on the target machine.
After you check this box, the Configuration Tool 
automatically:
● Displays the other Web Management fields
● Checks the following boxes:

- Website
- ICM
- CIRS
- Attribute - DataWake recording (PDM)

Checkmark in box

Website Creates the Website Web application and 
performs other tasks that are required to 
configure a Web Management Website on the 
target machine.
After you check this box, the Configuration Tool 
displays the following required fields for the 
Website:
● Website Virtual Directory Name
● WebACD
● Attribute Server

Checkmark in box

Website Virtual 
Directory Name

The name of the virtual directory for the Website. website
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WebACD The WebACD server in your Avaya IC system.
You must create the WebACD server before the 
Configuration Tool can include the server in the 
drop-down list. If the list does not include the 
server, close the Configuration Tool and create 
the server. For more information, see Creating 
the WebACD server on page 249.

WebACD_web

Attribute Server The Attribute server that the Datawake plug-in 
uses.
You must create the Attribute server before the 
Configuration Tool can include the server in the 
drop-down list. If the list does not include the 
server, close the Configuration Tool and create 
the server. For more information, see Creating 
the Attribute server on page 252.

Attribute_web

ICM Service Configures the ICM server and related 
components on the target machine.
For more information, see Configuring the ICM 
server on page 282.

Checkmark in box

CIRS Service Configures the CIRS server and related 
components on the target machine.
For more information, see Configuring the Central 
Internet Routing service on page 286.
Important: Only configure a CIRS server if your 
Avaya IC system includes more than one ICM 
server.

Checkmark in box

Attribute - 
DataWake 
recording (PDM)

Configures the DataWake recording feature of 
the Attribute server.

Checkmark in box

IC Login Use the website account that you imported into 
the database with the seed data. 
If you have not already done so, change the 
default password for this account. For more 
information, see IC Administration Volume 2: 
Agents, Customers, & Queues.
Note: Do not use the Administrator account for IC 
Manager or any other account for which the 
password may change. 

website

IC Password The password used by the IC Login. website

IC Data Source The Interaction Center data source that you 
create with the Interaction Center application for 
the CallCenterQ database. For more information, 
see Generating the Interaction Center 
application on page 109.

interaction_center

Field Description Sample entry
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6. Select Apply Settings. 

7. Select OK in the Success dialog box.

8. Select Exit.
9. To complete the configuration, perform the following steps to ensure that all Web 

Management services start properly:

a. In the Sun ONE Server installation directory:

● Open the https-admserv directory.

● If the directory includes a file called start-ICEnv.backup, execute the following 
command to rename the file:

mv start-ICEnv.backup oldstart-ICEnv

b. Start the Sun ONE server that hosts the Website application with the following start 
script:

<SunONE_install_dir>/servers/<my_ONE_server>/start

c. Navigate to the IC_INSTALL_DIR/IC61/bin directory.

d. Use the following script to start Tomcat:

● If you selected Multiple in the Tomcat Setup field: 

./ictomcat.sh start all

● If you selected Single in the Tomcat Setup field:

./ictomcat.sh start website

Repository Data 
Source

The Repository data source that you create with 
the repository application for the IC Repository 
database. For more information, see Generating 
the Interaction Center application on page 109.

repository

Database Login Type a DBA login ID for the database server. 
Note: Do not use the DBA login for a database 
client on a DB2 database.

Oracle: sys

Database 
Password

The password for the DBA login ID. admin

Database Host The host name of the machine that hosts your 
database server.

testbox.xyzcorp.com

Oracle SID The Oracle SID of your database.
Note: The Oracle SID field is case-sensitive.

icutf8db

Field Description Sample entry
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Configuring Web Management services on AIX
Use these instructions if you plan to host Web Management services on an AIX machine.

! Important:! Important:
Important: To configure Web Management services on AIX, you must log in as a user 

with write permissions on the Web server directories and the Avaya IC 
installation directories. The root user usually has these write permissions.

To configure Web Management services to run on an AIX machine:

1. Stop the IBM HTTP Server that hosts the Website application with the stop script 
packaged with the Web server: 
./httpserver.sh stop

2. Start the Configuration Tool:

a. Navigate to IC_INSTALL_DIR/IC61/bin 

b. Run ./configure

If the Configuration Tool is already open, close and re-open it to ensure that the 
Configuration Tool includes all system changes, such as new servers.

3. Log in with your IC Manager login ID and password.

4. Complete the general fields in the following table.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple

JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

/usr/java131

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600
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Web Server Home The installation path for the IBM HTTP server 
instance that hosts the Web application.

/usr/HTTPServer

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct. 

xyzcorp.com

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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5. Complete the Web Management fields in the following table.

Field Description Sample entry

Configure Web 
Management

Check this box if you want to configure Web 
Management services on the target machine.
After you check this box, the Configuration Tool 
automatically:
● Displays the other Web Management fields
● Checks the following boxes:

- Website
- ICM
- CIRS
- Attribute - DataWake recording (PDM)

Checkmark in box

Website Creates the Website Web application and 
performs other tasks that are required to 
configure a Web Management Website on the 
target machine.
After you check this box, the Configuration Tool 
displays the following required fields for the 
Website:
● Website Virtual Directory Name
● WebACD
● Attribute Server

Checkmark in box

Website Virtual 
Directory Name

The name of the virtual directory for the Website. website

WebACD The WebACD server in your Avaya IC system.
You must create the WebACD server before the 
Configuration Tool can include the server in the 
drop-down list. If the list does not include the 
server, close the Configuration Tool and create 
the server. For more information, see Creating 
the WebACD server on page 249.

WebACD_web

Attribute Server The Attribute server that the Datawake plug-in 
uses.
You must create the Attribute server before the 
Configuration Tool can include the server in the 
drop-down list. If the list does not include the 
server, close the Configuration Tool and create 
the server. For more information, see Creating 
the Attribute server on page 252.

Attribute_web

ICM Service Configures the ICM server and related 
components on the target machine.
For more information, see Configuring the ICM 
server on page 282.

Checkmark in box
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CIRS Service Configures the CIRS server and related 
components on the target machine.
For more information, see Configuring the Central 
Internet Routing service on page 286.
Important: Only configure a CIRS server if your 
Avaya IC system includes more than one ICM 
server.

Checkmark in box

Attribute - 
DataWake 
recording (PDM)

Configures the DataWake recording feature of 
the Attribute server.

Checkmark in box

IC Login Use the website account that you imported into 
the database with the seed data. 
If you have not already done so, change the 
default password for this account. For more 
information, see IC Administration Volume 2: 
Agents, Customers, & Queues.
Note: Do not use the Administrator account for IC 
Manager or any other account for which the 
password may change. 

website

IC Password The password used by the IC Login. website

IC Data Source The Interaction Center data source that you 
create with the Interaction Center application for 
the CallCenterQ database. For more information, 
see Generating the Interaction Center 
application on page 109.

interaction_center

Repository Data 
Source

The Repository data source that you create with 
the repository application for the IC Repository 
database. For more information, see Generating 
the IC Repository application on page 98.

repository

Database Login Type a DBA login ID for the database server. 
Note: Do not use the DBA login for a database 
client on a DB2 database.

DB2: db2inst1

Database 
Password

The password for the DBA login ID. admin

Database Host The host name of the machine that hosts your 
database server.

testbox.xyzcorp.com

DB2 Port The port that the target machine uses to 
communicate with the DB2 database. 

Default:
50,000

Field Description Sample entry
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6. Select Apply Settings. 

7. Select OK in the Success dialog box.

8. Select Exit.
9. To complete the configuration, perform the following steps to ensure that all Web 

Management services start properly:

a. Start the IBM HTTP Server that hosts the Website application with the following start 
script:

./httpserver.sh start

b. Navigate to the IC_INSTALL_DIR/IC61/bin directory.

c. Use the following script to start Tomcat:

● If you selected Multiple in the Tomcat Setup field: 

./ictomcat.sh start all

● If you selected Single in the Tomcat Setup field:

./ictomcat.sh start website

Integrating Web Management Administration
Web Management Administration is a set of Web pages that you use to administer and 
configure Web Management and Email Management. You open Web Management 
Administration from IC Manager. Before you use Web Management Administration, you 
must integrate it with IC Manager.

Note:
Note: Complete only those properties listed in this section to integrate Web 

Management administration. You do not need to complete the other 
properties available in the System/Configuration list. 

To integrate Web Management Administration with IC Manager:

1. In IC Manager, select Tools > Groups.

2. Select the Properties tab.

3. Select the IC node in the left pane.

4. In the Sections list, select System/Configuration.
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5. Double-click the Value column next to ChatLoginServer in the list of properties and 
complete the following fields:

a. In the Property Value field, type the fully-qualified domain name of the machine 
that hosts the Tomcat server for the Web Management Administration Website. For 
example, type support.xyzcorp.com.

b. Select OK.

6. Double-click the Value column next to ChatLoginServerWebsite in the list of properties 
and complete the following fields:

a. Type the name of the Tomcat web application for the Web Management 
Administration Website.

This is the name that you specified when you configured the website Tomcat 
application in Configuring Web Management services on page 257. The Web 
Management Administration Website must be on the machine that you specified for 
the ChatLoginServer property.

b. Select OK.

7. If you serve your Web Management Administration pages from a secure web server, 
you must also modify the properties shown in the following table:

8. Select OK.

9. Exit and restart IC Manager.

Property Recommended entry Notes

ChatLoginServerProtocol Type the protocol that 
your Web server uses.

For secure server protocol, 
type https.
For non-secure server 
protocol, type http.

ChatLoginServerPort Type the port that your 
Web server uses for 
chat communications.

For http, default port is 80.
For https, default port is 443.
Do not change the default 
unless you assign a different 
port to the Web server.
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Configuring a Workflow server for Web Management
To configure the Workflow server for Web Management, perform the steps in the following 
topics:

1. Creating a Workflow server for Web Management on page 274.

2. Creating the chat channel for the Workflow server on page 275.

If your Avaya IC system includes multiple Workflow servers, perform these steps on each 
Workflow server that processes chat contacts.

Creating a Workflow server for Web Management
These instructions only provide information about those parameters you need to set when 
you create a Workflow server to handle chat contacts. For more information about other 
parameters in the Workflow server, see Configuring multiple Workflow servers on 
page 135 and IC Administration Volume 1: Servers & Domains.

! CAUTION:
CAUTION: If you do not configure the Workflow server with synchronous startup flows, 

the Qualify Chat workflow cannot resolve the pkey of the queue where a 
contact is to be routed. If this occurs, Avaya IC cannot route chat contacts.

To create a Workflow server for Web Management:

1. In IC Manager, select Server > New.

2. Select Workflow from the list of servers. 

3. Select OK.

4. Select the General tab, and complete the fields shown in the following table.

Field Recommended entry Notes

Name Workflow_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for 
the server from the drop-down list.

For example, select Web to use 
the preconfigured domain for 
Web Management.

Host Select the machine�s IP address 
from the drop-down list, or type 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.



Configuring a Workflow server for Web Management

Issue 2.0 June 2004 275

5. Select the Workflow tab.

6. From the IC Data Source drop-down list, select the Interaction Center data source.

The default name for this data source is interaction_center. This is the data source that 
you created in Generating the Interaction Center application on page 109.

7. Select Synchronous Startup Flows.
8. If the following rows do not exist, add them to the Synchronous Startup Flows:

a. Select New.

b. In the new row, type web_routing.update_qw_cache

c. Select OK.

9. Continue with Creating the chat channel for the Workflow server on page 275.

Creating the chat channel for the Workflow server
To create the chat channel for the Workflow server:

1. In the Server Editor for the Workflow server, select the Channels tab.

2. Select the Channels tab.

3. Select New Channel.
4. In the Channel Editor dialog box:

a. Complete the fields as shown in the following table.

Field Recommended entry Notes

Global Do not check this field. Do not check this field to create a 
create a channel for a specific server 
or media, such as Chat.

By Server ● Do not check this field if 
you want this channel to 
handle events from all 
servers of the type that 
you select from the 
Service drop-down list.

● Check this field if you want 
this channel to handle 
events from only one 
specific server that you 
select from the Service 
drop-down list.

If you check this field, and you need 
this Workflow server to communicate 
with more than one server, you must 
create another channel for that 
server.
Warning: If you check this field and 
the WebACD server is named 
"WACD", the Workflow server will not 
be able to communicate with the 
WebACD server.

Channel Range No entry necessary. Completed by IC Manager



Configuring Web Management

276 Installation and Configuration

b. Select OK.

5. Select the channel that you created in the step above.

6. Select New Association.

7. In the Channel Association dialog box, complete the fields as shown in the following 
table. Select OK.

8. Select OK.

9. In the Server tab of IC Manager, select the Workflow server that handles voice 
contacts.

10. Right-click the Workflow server and select Start.

Service Select WACD or the 
WebACD server from the 
drop-down list.

Whether you can select a server or a 
type of server, depends up whether 
or not you checked the By Server 
field.

Criteria Type media=chat

Field Recommended entry

Channel Range Completed by IC Manager

Service Range Completed by IC Manager

Event WACD.QualifyChat
Note: This field is case-sensitive.

Flow <flow_project>.<flow_name>
For example, to use the sample workflow, type 
wacd.qualifychat

Field Recommended entry Notes
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Using workflows for Web Management
You can use the sample workflows to configure and test your Web Management servers. 
When you move into production, modify the sample workflows to meet your system needs 
and configuration. For more information, see Avaya IC Media Workflow Reference.

Note:
Note: If you add a queue to route chat contacts, you must re-run the 

update_qw_cache workflow in the Web_Routing project. If you do not want 
to stop and start the Workflow server that processes chat contacts, select 
Run Flows on the General tab of the Workflow server.

This section includes the following topics:

● Workflows required by Web Management on page 277.

● Reloading the customer management workflows on page 278.

Workflows required by Web Management
Web Management requires the following sample and system workflows:

● Qualify Chat workflow in the WACD project

● All workflows in the WebRouting project

● All workflows in the WebCenter project

The Avaya IC seed data includes compiled sample workflows for these projects. When you 
created the CCQ database, you imported the compiled workflows with the seed data and 
stored them in the database.

For a complete list of the workflows in these projects, including the directories where 
Avaya IC installs the workflows, see Avaya Workflow Designer User Guide.

! Important:! Important:
Important: Make sure that no workflows use a formatted telephone number to look up 

customer records. For example, confirm that your Qualify Chat workflow 
does not use a formatted telephone number in the Customer Lookup block.



Configuring Web Management

278 Installation and Configuration

Reloading the customer management workflows
The customer management workflows in the WebCenter project require file-based IC 
Scripts. By default, the include property contains the names of the required file-based IC 
Scripts. 

Before you compile the workflows in the WebCenter project, add the following IC Script 
directory to the project:

IC_INSTALL_DIR\IC61\design\IC\Flows\Avaya\WebCenter

To add the IC Script directory:

1. With the project open in Workflow Designer, select Project > Settings.

2. In the Directories tab of the Project Settings dialog box, select New Folder.
3. In the Open dialog box:

a. Navigate to the following IC Script folder:

IC_INSTALL_DIR\IC61\design\IC\Flows\Avaya\WebCenter

b. Select OK to add the IC Script folder to the Directories tab.

4. In the Project Settings dialog box, select OK.

You can now compile and load the customer management workflows.
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Configuring routing hints for the Qualify Chat 
workflow

The Fetch Routing Hints (chat) block in the Qualify Chat workflow uses the routing hints in 
the RoutingHint table of the Directory server to route incoming chat contacts. The following 
table shows the routing hints used in the sample Qualify Chat workflow.

To route chat contacts with the sample Qualify chat workflow, create these hints, then 
assign them to the default chat queue.

! Important:! Important:
Important: Routing hints must be in lower case. Do not use mixed upper and lower 

case in your routing hints. If the routing hint is not in all lower case, the 
workflow cannot locate the routing hint, and Avaya IC cannot correctly route 
the contact.

To configure routing hints, perform the steps in the following topics:

1. Creating routing hints on page 280.

2. Associating routing hints with Web Self-Service documents on page 281.

Category Sample routing hint values

language This category requires ISO-639-1 values, 
such as:
● en
● sp
● fr
● de
● zh

intent ● sales
● support
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Creating routing hints
Use the Configuration tab of IC Manager to create routing hints and add them to the 
RoutingHint table. The Qualify Chat workflow uses hints from the RoutingHint table to route 
incoming chat contacts.

Each row in the routing hint table contains the following:

● A routing hint

● The IDs of the queues where contacts that match the routing hint should be routed

Tip:
Tip: The default chat queue is DefaultChatQueue@DefaultTenant. You can 

create and use additional chat queues for routing chat contacts. For more 
information, see IC Administration Volume 2: Agents, Customers, & 
Queues.

To create routing hints:

1. In IC Manager, select the Configuration tab.

2. In the left pane, select Tables > Workflow > RoutingHint. 
3. Select New.

4. In the right pane, complete the fields shown in the following table.

Parameter Recommended entry Description

Routing Hint Type a routing hint. For the sample Qualify Chat workflow, 
enter a value for the language or intent 
category.
For language, type a value such as:

- en
- sp
- fr
- de
- zh

For intent, type a value such as:
- sales
- support

The routing hint must be a text string in all 
lower case. The text string cannot contain 
any special characters.

Chat Queue ID Type 
DefaultChatQueue@DefaultT
enant. 

DefaultChatQueue@DefaultTenant is the 
default chat queue. For more information 
about chat queues, see IC Administration 
Volume 2: Agents, Customers, & Queues.
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5. Select OK.

Repeat Steps 3 through 6 to create the second routing hint.

6. Select Manager > Refresh.

Associating routing hints with Web Self-Service documents
After you add the routing hints to the Directory server tables, you can associate the routing 
hints with documents in the Web Self-Service database.

When a customer requests a chat contact with an agent, Web Management records the 
last document that the customer viewed on the Website. If that document has an 
associated routing hint, the Qualify Chat workflow uses that routing hint to determine the 
correct queue for the chat contact.

You need to create at least one document for that database to fully test the Qualify Chat 
workflow. For more information about the Web Self-Service database, see IC 
Administration Volume 2: Agents, Customers, & Queues.

To associate routing hints with Web Self-Service documents:

1. In IC Manager, select Services > Web Response Unit. 
2. In the left frame, select Web Self-Service Console. 

3. In the Web Self-Service Console page:

a. Select a tenant from the drop-down list.

b. In the left frame, select Manage FAQ.

4. In the Manage FAQ page:

a. Select the document in the list of documents.

b. Select Update.

5. In the document, scroll down to the Routing Attributes section.

6. Select one routing hint from the Routing Hint drop-down lists.

7. Select Update.

Category/Qualifier Leave this field blank. Used only for routing hints for chat 
contacts in Business Advocate.

Tenant Select DefaultTenant from the 
queue from the drop-down list.

Select the tenant used by the queue. 
For the DefaultChatQueue, select 
DefaultTenant to ensure that the routing 
hint uses the correct queue.

Parameter Recommended entry Description
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Configuring the ICM server
The ICM server is a service that hosts text conferencing for Web Management. The ICM 
server does not run in IC Manager. For information about how to stop and restart the ICM 
server, see Starting and stopping Avaya IC services on page 154.

! Important:! Important:
Important: The steps in Configuring the ICM server are optional. Do not perform these 

steps if the ICM server requires only the default functionality. For example, 
perform these steps if you want to increase the logging level from the default 
logging level of "1".

To configure the ICM Server:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Chat > ICM.

3. Select New.

4. In the right pane, type a name for the ICM server in the Global ICM Name field.

If your Avaya IC system includes multiple ICM servers, type a name that allows you to 
easily identify the ICM server. For example, for an ICM server on the TESTBOX 
machine, type icm_TESTBOX.

The ICM server uses the global name to determine which ICM record to read for 
configuration. The global name in this field must match the dsObject parameter in the 
etc/systemParms.txt file

5. In the right pane, review the fields as shown in the following table.

Note:
Note: Do not enter a value or change the default values in these fields unless a 

property needs to be explicitly changed from the default value calculated by 
the ICM server during its initialization. Most Avaya IC systems do not require 
changing any of these fields.

Parameter Description

ICM Active External clients use this parameter to determine which 
ICMs to use.

ICM Server Name The fully-qualified domain name of the machine that hosts 
this ICM server.

SMTP Host The fully-qualified domain name of the machine that hosts 
the SMTP server. For example, SMTPSVR.xyzcorp.com.



Configuring the ICM server

Issue 2.0 June 2004 283

Chat Transcript 
Directory

The directory where Avaya IC stores the chat transcripts. 
The default directory is 
IC_INSTALL_DIR\IC61\comp\icm\transcript

Style Sheet Directory The directory where Avaya IC stores the style sheets used 
to format emails that include chat transcripts.
If you use the default installation directory, IC Manager 
automatically enters the following directory:
../comp/icm/transcriptxsl

CIRS Host The name of the machine that hosts the CIRS server used 
for load balancing.

ICM Property 
Management Debug 
Level

A number from 0 to 4 that represents the debug level for 
ICM components. Level 0 provides no debugging 
information in the logs, and level 4 provides full debugging 
information. 

ICM Toolkit Debug 
Level

A number from 0 to 4 that represents the debug level for 
ICM toolkit components. Level 0 provides no debugging 
information in the logs, and level 4 provides full debugging 
information.

ICM Debug Level A number from 0 to 4 that represents the debug level for the 
ICM server. Level 0 provides no debugging information in 
the logs, and level 4 provides full debugging information.

Parameter Description
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6. Right-click in the right pane, check the box next to Show Advanced Properties, and 
then review the fields as shown in the following table.

Note:
Note: Do not enter a value or change the default values in the Advanced 

Properties unless a property needs to be explicitly changed from the default 
value calculated by the ICM server during its initialization. Most Avaya IC 
systems do not require setting any of the advanced properties.

Parameter Description

Agent Connectivity 
Options (sec sec sec)

This field contains three sets of seconds separated by 
spaces. For example, 60 600 1200.
These sets of seconds represent the following parameters 
for configuring agent connections in seconds:
● checkInterval determines how often the ICM server 

should check the state of the agent connections
● sendInterval determines how often the ICM server 

should send a keepalive event across each agent 
connection

● disconnectInterval determines how long the ICM server 
should wait before the server disconnects an agent 
connection due to inactivity

CIRS Connectivity 
Options (sec sec sec)

This field contains three sets of seconds separated by 
spaces. For example, 60 600 1200.
These sets of seconds represent the following parameters 
for configuring CIRS connections in seconds:
● checkInterval determines how often the ICM server 

should check the state of the connections to the CIRS 
server

● sendInterval determines how often the ICM server 
should send a keepalive event across each 
connection to a CIRS server

● disconnectInterval determines how long the ICM server 
should wait before the server disconnects a connection 
to a CIRS server due to inactivity

Caller Connectivity 
Options (sec sec sec)

This field contains three sets of seconds separated by 
spaces. For example, 60 600 1200.
These sets of seconds represent the following parameters 
for configuring caller connections in seconds:
● checkInterval determines how often the ICM server 

should check the state of the caller connections
● sendInterval determines how often the ICM server 

should send a keepalive event across each caller 
connection

● disconnectInterval determines how long the ICM server 
should wait before the server disconnects a caller 
connection due to inactivity
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ICMBridge 
Connectivity Options 
(sec sec sec)

This field contains three sets of seconds separated by 
spaces. For example, 60 600 1200.
These sets of seconds represent the following parameters 
for configuring ICM Bridge connections in seconds:
● checkInterval determines how often the ICM server 

should check the state of each connection to an ICM 
bridge

● sendInterval determines how often the ICM server 
should send a keepalive event across each 
connection to an ICM bridge

● disconnectInterval determines how long the ICM server 
should wait before the server disconnects a connection 
to an ICM bridge due to inactivity

IC Site Automatically lists all sites in your Avaya IC system. This 
field contains the site where this ICM server is located.

Transcript Poll 
Interval (min)

How long the ICM server waits before checking the chat 
transcript directory and processing the transcripts to email 
to customers and save to the database.

CIRS Port Type the port number. The default is 9506.

PDM Path The directory and file name of the pdm.xml file.For 
example, IC_INSTALL_DIR\IC61\etc\pdm.xml.
Note: This field is case-sensitive. Use all lower-case letters 
in the directory and file name. 

Attribute Server Automatically lists all Attribute servers in IC Manager. This 
field contains the same Attribute server that you use in the 
Website configuration. 

Maximum Property 
Management Log 
Size (KB)

The property management log is named: 
icmname_website.log

Tunnel Port The ICM tunnel port used by the ICM server. The default 
port is 9505.
Note: To enable tunnelling, perform the following steps on 
the machine that hosts the ICM server:

1. Open the callerap.txt file in a text editor such as 
Notepad.

2. Make sure that the $tunnelEnabled parameter is 
set to True. 

Agent Server Port The default port is 9501.

Caller Port The default port is 9502.

ICMBridge Port The default port is 9503.

Util Port The default port is 9504.

Parameter Description
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7. Select OK.

8. Restart the ICM server.

Configuring the Central Internet Routing service
If your Avaya IC system includes multiple ICM servers, you must configure a Central 
Internet Routing service (CIRS server) to balance the load between the ICM servers. 
Repeat the following steps for each CIRS server in your Avaya IC system.

The CIRS server does not run in IC Manager. For information about how to stop and 
restart the CIRS server, see Starting and stopping Avaya IC services on page 154.

! Important:! Important:
Important: The steps in Configuring the Central Internet Routing service are optional. 

Do not perform these steps if the CIRS server requires only the default 
functionality. For example, perform these steps if you want to increase the 
logging level from the default logging level of "1".

To configure the CIRS server:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Chat > CIRS.

3. Select New.

Enable Transcript 
Added Flow

Only check this box if your Avaya IC system includes 
integration with another system. When you check this box, 
the ICM server runs the workflow from the Transcript Added 
Flow Name field when Avaya IC processes chat transcripts.

Transcript Added 
Flow Name

Name of the workflow to run when Avaya IC processes the 
chat transcript. Use the format project_name.flow_name 
in this field.

Transcript Added 
Flow Event

Name of the event to send in the WorkFlow.Run request 
when the server processes the chat transcript.

Parameter Description
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4. In the right pane, type a name for the CIRS server in the Global CIRS Name field.

If your Avaya IC system includes multiple CIRS servers, type a name that allows you to 
easily identify this CIRS server. For example, for a CIRS server on the TESTBOX 
machine, type cirs_TESTBOX.

The CIRS server uses the global name to determine which CIRS record to read for 
configuration. The global name in this field must match the dsObjectName parameter 
in the etc/cirsSystemParms.txt file.

5. In the right pane, review the fields as shown in the following table.

Note:
Note: Do not enter a value or change the default values in these fields unless a 

property needs to be explicitly changed from the default value calculated by 
the CIRS server during its initialization. Most Avaya IC systems do not 
require changing any of these fields.

6. Right-click in the right pane, check the box next to Show Advanced Properties then 
review the fields as shown in the following table.

Note:
Note: Do not change the default or complete the Advanced properties unless a 

property needs to be explicitly changed from the default value calculated by 
CIRS server during its initialization. Most Avaya IC systems do not require 
setting any of the advanced properties.

Parameter Description

CIRS Active External clients use this parameter to determine which 
ICMs to use.
This box must be checked for the CIRS server to function.

IC Site Automatically lists all sites in your Avaya IC system. This 
field contains the site where this CIRS server is located.

Parameter Description

CIRS Servlet Port The default port is 9508.
This is the CIRS service - CIRS caller referred to in Ports 
used by Avaya IC components on page 28,

CIRS Hostname The name and domain of the machine that hosts the CIRS 
server. For example, TESTBOX.xyzcorp.com.

CIRS Port The default port is 9506.
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7. Select OK.

8. Restart the CIRS server.

Configuring the Website
Before you configure the website, create the website application in the Configuration Tool. 
For more information, see Configuring Web Management services on page 257.

If you are configuring a localized version, you can specify a supported language for the 
Website. For more information, see Configuring the Website for supported languages on 
page 550.

! Important:! Important:
Important: The steps in Configuring the Website are optional. Do not perform these 

steps if the Website requires only the default functionality. For example, 
perform these steps if you want to create a separate administration Website 
and you want to disable access to the administration pages on the customer 
Website.

To configure the Website:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in the left pane, select Website > Website Context.
3. Select New.

4. In the right pane, type a name for the Website in the Global Name field.

Type a name that allows you to easily identify the Website. For example, for a Website 
on the TESTBOX machine, type website_TESTBOX.

The Website uses this parameter to determine which website context record to read. 
This value must match the dsObject parameter in the following file: 
IC_INSTALL_DIR\IC61\comp\website\WEB-INF\web.xml

No Resource URL. This is the URL used if no resources are available.

Util Port The default port is 9507. 
This port is used to monitor the CIRS server. 

Parameter Description
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5. In the right pane, review the fields as shown in the following table.

Note:
Note: Do not enter a value or change the default values in these fields unless a 

property needs to be explicitly changed from the default value calculated by 
the Website during its initialization. Most Avaya IC systems do not require 
changing any of these fields.

Parameter Description

Context Active External clients use this parameter to determine which 
website context to use.
This box must be checked for the Website to function.

CIRS Name This is the CIRS server to which the ICM CIRS servlet 
connects to perform load-balancing for chat contacts.

Website Debug Level A number from 0 to 4 that represents the debug level for the 
website. Level 0 provides no debugging information in the 
logs, and level 4 provides full debugging information. 

Default hostname for 
context

The name of the machine that hosts the Website.
Used by external clients to determine the location of your 
customer-facing Website. 
If you enter a value in this field, Web Management uses this 
as the default machine_name in the URL for the customer-
facing Website. 
If you leave this field blank, Web Management uses the 
value that you use in the URL when you access the 
customer-facing website for the first time. For example, if 
you use localhost in the URL the first time, the URL will be 
http://localhost/website/public. 

IC Site This property is not currently used.

Servlet context name The name of your Website servlet. For example, website.
This is the web application name in the Tomcat server. 
Used by external clients to determine website context 
name.
This value is part of the URL used to access the customer-
facing Website. For example, if you enter support for a 
customer support Website, the URL will be: 
http://<hostname>/support/public

Default internet 
protocol

Either HTTP or HTTPS protocol. 
Used by external clients to determine website protocol.

Default port for 
context

This is the HTTP connection port that the website uses. 
The defaults are:
● 80 for HTTP
● 443 for HTTPS
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6. Right-click in the right pane, check the box next to Show Advanced Properties then 
complete the fields as shown in the following table.

Note:
Note: Do not change the default or complete the Advanced properties unless a 

property needs to be explicitly changed from the default value calculated by 
Website during its initialization. Most Avaya IC systems do not require 
setting any of the advanced properties.

Parameter Description

Admin Pages Active Used by Website administration pages to determine if the 
administration pages should be accessible.

Public Pages Active Used by Website administration pages to determine if the 
public pages should be accessible.

ICM Servlets Active Used by ICM servlets to determine if they should be 
accessible.

ICM CIRS Servlet 
Active

You must check ICM Servlets Active to use this field.
Used by ICM CIRS servlet to determine if it should be 
accessible.

ICM Tunnel Servlet 
Active

You must check ICM Servlets Active to use this field.
Used by ICM Tunnel servlet to determine if it should be 
accessible.

ICM Tunnel Servlet 
Host

The name of the machine that hosts the ICM server. When 
this field is empty, the website determines the URL from the 
chat escalation request. Used by ICM applet to construct 
tunneling URL.

ICM Tunnel Servlet 
Polling Interval 
(msec)

The number of milliseconds that the CIRS server should 
wait between ICM applet tunnel requests.

Time to wait before 
tunneling (sec)

The number of seconds that the ICM chat applet will wait 
before attempting to tunnel.

Maximum website 
debug file length (KB)

Log size for the website debug file.

Toolkit Debugging 
Level for Website

A number from 0 to 4 that represents the debug level for 
website components.

Path to PDM 
metadata file

The directory path and file name of the pdm.xml metadata 
file. The default path and file name are: 
IC_INSTALL_DIR\IC61\etc\pdm.xml
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7. Select OK.

8. Restart the Tomcat server that hosts the Website, as shown in the following table:

Refreshing the Directory server
After you configure the Website, you must refresh the Directory server. The refresh 
ensures that the Directory server is updated with the new information from the 
Configuration tab.

To refresh the Directory server:

● In IC Manager, select Manager > Refresh.

If you do not receive a Success message, perform the steps in Troubleshooting the refresh 
in IC Manager on page 510.

Attribute Server This is the Attribute server to which the website connects to 
send or receive property management and self-service 
FAQ updates. This field contains the same Attribute server 
that you use in the ICM server configuration. 
If you leave this blank, the Website tries to locate the 
Attribute server.

WebACD URL The URL that an Administrative website uses to access the 
WebACD Administration pages.
If you leave this field blank, the Website determines the 
URL from the WebACD server.

ICM Tunnel Servlet 
Maximum Request 
Length (bytes)

The maximum length in bytes for ICM applet tunnel 
requests.

Operating system Step

Windows From the Services Control Panel, restart the Tomcat 
server.

Solaris Run the following command:
./ictomcat.sh start

AIX Run the following command:
./ictomcat.sh start

Parameter Description
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Configuring HTTP(S) tunneling (optional)
By default, the Web Management chat applet is not enabled for HTTP or HTTPS tunneling. 
You can configure the chat applet to try to tunnel if the applet cannot make a direct 
connection to the ICM server.

To configure HTTP(S) tunneling, perform the steps in the following topics:

● Modifying the chat applet template file on page 292.

● Testing the configuration on page 293.

● Optional configuration for tunneling on page 293.

Modifying the chat applet template file
To modify the chat applet template file.

1. In a text editor, open the chat applet template file, callerap.txt. 

The version of this file can vary, depending upon the tenant and language of the 
contact. The following table describes the default versions and locations of this.

 

2. Scroll down to the line in the file that reads:

appletCode += "<param name=\"tunnelEnabled\" 
value=\"$tunnelEnabled$\">";

3.  Change this line to read:

appletCode += "<param name=\"tunnelEnabled\" value=\"true\">";

You must preserve the backslashes that occur before the double quotation marks.

Note:
Note: You can customize the Website application to automatically populate the 

$tunnelEnabled$ template variable with "true" or "false" according to 
unique business logic. Contact your Avaya technical representative if you 
want to use this type of customization.

4. Save the chat client template file (callerap.txt).

Operating system File location

Windows IC_INSTALL_DIR\IC61\comp\icm\default\cal
lerap.txt

Solaris and AIX IC_INSTALL_DIR/IC61/comp/icm/default/cal
lerap.txt
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Testing the configuration

Note:
Note: The chat client will not use tunneling if the client is able to make a 

connection on the configured ICM chat client port (default 9502). The client 
only uses tunneling if a direct connection cannot be made. To test tunneling, 
configure the applet to use an invalid port to connect to the ICM server.

To test the configuration of HTTP(S) tunneling:

1. Open the chat applet template file.

2. Change the default port in the chat applet template file:

a. Open the file as described in Modifying the chat applet template file on page 292.

b. Scroll down to the line that reads:

appletCode += "<param name=\"CallerPort\" value=\"9502\">";

c. Change this line to something like the following:

appletCode += "<param name=\"CallerPort\" value=\"9999\">"; 

d. Save the chat applet template file.

3. Start a new chat.

After you complete the test, re-open the chat applet template file and set the line back 
to the original port value.

Optional configuration for tunneling
In addition to modifying the caller applet template file, you can also perform the optional 
configuration in this topic. The optional configuration uses the Advanced Properties for the 
Website. For more information about the Advanced Properties, see Configuring the 
Website on page 288.

You can also include the following optional configuration for tunneling:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Website > Website Context.
3. In the right pane, select the entry for the website and select Edit.
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4. To enable the Tunneling servlet.

a. Right-click in the right pane, and check the box next to Show Advanced 
Properties.

b. Select the ICM Tunnel Servlet Active check box.

If you check this box, the Tunnel servlet will accept tunnel requests.

c. Select Apply.

5. To configure the server name used by the Tunneling Servlet to connect to the ICM 
server:

a. Right-click in the right pane, and check the box next to Show Advanced 
Properties.

b. In the ICM Tunnel Servlet Host field, leave this field empty or type the fully-
qualified domain name of the server that hosts the ICM server.

For example, type myserver.mydomain.com.

Avaya recommends that you do not complete this field. If you leave the field empty, 
the Tunneling servlet automatically determines the location of the ICM server.

c. Select Apply.

6. To configure the polling interval used by the chat client.

a. Right-click in the right pane, and check the box next to Show Advanced 
Properties.

b. In the ICM Tunnel Servlet Polling Interval field, type the number of milliseconds 
between tunneling requests. 

For example, type 4000.

If you leave this field empty, the Tunneling servlet uses an 8000 milliseconds 
interval between tunneling requests. An interval greater than 8000 milliseconds 
results in slower chat updates. An interval less than 8000 milliseconds results in a 
greater load on the Tunneling servlet.

c. Select Apply.

7. To configure the time to wait before trying to use tunneling after a direct connection to 
the ICM server fails:

a. Right-click in the right pane, and check the box next to Show Advanced 
Properties.

b. In the Time to wait before tunneling field, type the number of seconds before the 
servlet makes a tunneling request.

For example, type 4.

If you leave this field empty, the Tunneling servlet waits 10 seconds before making a 
tunneling request. If you expect most users to tunnel, use 2 seconds or 3 seconds.

c. Select Apply.
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Configuring SSL security for Web servers (optional)
You can configure Web Management and Email Management to work with Secure Sockets 
Layer (SSL) to provide secure Internet sessions. SSL is optional.

SSL connections require additional work for the Web servers, because they encrypt and 
decrypt all communications. Therefore, if your system includes SSL, install an ICM server 
on a machine dedicated to text conferencing. If desired, this ICM server can be a second 
ICM server. To install a second ICM server, see Installing and configuring a second ICM 
server on page 468.

If all tenants will be using SSL, you can host all Web Management servers on one 
machine, but should still host the ICM server on a dedicated machine.

To configure SSL, perform the steps in the following topics:

1. Prerequisites for configuring SSL on page 295.

2. Modifying the Website configuration on page 296.

3. Configuring the WebACD server on page 296.

4. Editing the configuration file on page 297.

5. Modifying the SSL properties on page 297.

6. Configuring SSL for specific tenants on page 298.

Prerequisites for configuring SSL
Before you configure Web Management or Email Management to use SSL, you must 
complete the following steps:

● Install and properly configure SSL. This step requires you to obtain SSL authentication 
keys from a certifying authority such as VeriSign, Thawte, or GTE CyberTrust.

● If your Avaya IC system includes a second Web Management server for SSL, configure 
SSL on the secure server and the machine that hosts the ComHub server.

● Install, configure, and test one of the following on the secure server machine:

- A full set of Web Management servers or Email Management servers

- A second ICM server
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Modifying the Website configuration
You must modify the configuration of the website to use SSL values.

To modify the website configuration:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Website > Website Context.
3. In the right pane, select the entry for the website and select Edit.
4. Update the values as shown in the following table:

5. Select OK.

6. Select Manager > Refresh.

Configuring the WebACD server
To configure the WebACD server:

1. In IC Manager, double-click the WebACD server in the lists of servers.

2. Select the WACD tab.

3. In the WACD Webserver field, update the values as shown in the following table:

4. Select OK.

Property Recommended entry

Default internet protocol Select https from the drop-down list

Default port for context Type 443.

Property Recommended entry

Default internet protocol Select https from the drop-down list

Default port for context Type 443.
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Editing the configuration file
To edit the configuration file:

1. In Notepad or another text editor, open webadmin.cfg. 

2. Change the value of the attribute serverPort to 443.

3. Add the new attribute-value pair shown in the following table:

4. Save and close the file.

Modifying the SSL properties
To modify the SSL properties:

1. In IC Manager, select Tools > Groups.

2. Select the Properties tab.

3. Select IC in the left pane of the Group Manager.
4. Select System/Configuration in the Sections list. 

5. Select the following properties.

6. Select Edit and set values for the properties, as shown in the following table:

7. Select OK.

Attribute Value

protocol https://

Property Recommended entry

ChatLoginServerProtocol Type https.

ChatLoginServerPort Type 443.
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Configuring SSL for specific tenants
The values that you set in the previous steps become the default values for all tenants. All 
tenants are not configured for SSL by default. You can override this default behavior by 
setting a tenant specific property. 

To set the website.pages.public property:

1. In IC Manager, select Services > MultiTenancy Administration.

2. Select Tenant Properties in the Tenant Admin menu.

3. Select the tenant you want to customize from the Select a Tenant drop-down list.

4. Select Customize Tenant. 
5. In the Customize Tenant page, select the language properties you want to set from 

the Select Language drop-down list at the top of the page.

6. Select the website properties. 

7. Change the website.pages.public property to an absolute URL with the protocol 
specified as http for non SSL and https for SSL.

For example, to set SSL for a website, 
https://mymachine.company.com/website/public.

8. Select Update Data at the bottom of the page.

Setting up a separate administration Website 
(optional)

You can configure a web server to serve as an administration website only. The 
administration Website will not contain any accessible external or customer-facing content, 
and the chat functions will be disabled.

These instructions assume that you have already configured Web Management.

Note:
Note: If your Avaya IC system includes multiple Attribute servers, all websites and 

ICM servers must use the same Attribute server, so that their Tenant 
customization properties remain synchronized.
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To set up a separate administration website, complete the steps in the following topics:

1. Creating the Web application for the administration website on page 299.

2. Configuring an administration Website on page 299.

3. Configuring the WebACD server on page 300.

4. Integrating the administration Website on page 301.

Creating the Web application for the administration website
Create the Web application for the administration website, as described in Configuring 
Web Management services on page 257.

Configuring an administration Website
Create a separate entry for the administration Website in IC Manager.

To configure the administration website:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Website > Website Context.
3. Select New.

4. Right-click in the right pane, and check the box next to Show Advanced Properties.

5. Complete the fields in the right pane, as shown in the following table:

For more information about these fields, see Configuring the Website on page 288

6. Select OK.

7. Select Manager > Refresh.

8. Restart the Tomcat server that hosts the Administration website.

Field Recommended entry

Global Name Type a name for the website, for example, 
type AdminWebsite.

Context Active Check this box.

Admin Pages Active Check this box.

Public Pages Active Check this box.

ICM Servlets Active Do not check this box.
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Configuring the WebACD server
The administration and customer websites share the WACD Webserver property in the 
WebACD server. If you install separate administration and customer websites, you must 
configure this property and create a new name-value pair in the WebACD server for 
Collaboration and Sametime to function correctly.

For information on how to set up Sametime, see IC Administration Volume 2: Agents, 
Customers, & Queues.

To configure the WebACD server for the administration website:

1. In IC Manager, double-click the WebACD server in the lists of servers.

2. Select the WACD tab.

3. In the WACD Webserver field, type the fully-qualified domain name of the machine 
that hosts the administration website.

4. Select Apply.

5. Select the Configuration tab.

6. Select New 

7. In the CTI Type Editor dialog box:

a. Complete the fields as shown in the following table:

These entries are case-sensitive.

b. Select OK.

8. If your Web Management system includes the Sametime feature:

a. Select New.

b. In the CTI Type Editor dialog box, complete the fields as shown in the following 
table:

Field Recommended entry

CTI Type Couple

Name collaborationRootURL

Value http://<customer_webserver>/icm/aimagentcl.hta

Field Recommended entry

CTI Type Couple
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c. Select OK.

You do not need to complete this step if your Web Management system does not 
include the Sametime feature.

9. Select OK.

Integrating the administration Website
To integrate the administration website:

1. In IC Manager, select Tools > Groups.

2. Select the Properties tab.

3. Select IC in the left pane of the Group Manager.
4. Select System/Configuration in the Sections list. 

5. Select the following properties:

a. Select Edit.
b. Set values for the properties, as shown in the following table:

Note:
Note: If the columns in the right pane are Name, Entity, Value, and Overridable, 

select the - (minus) button on the toolbar to view and edit these properties.

6. Select OK.

Name  sametimeurl

Value http://<customer_webserver>/website/sametime/
kickoffsametime.jsp

Field Recommended entry

Property Recommended entry

ChatLoginServer Type the fully-qualified domain name of the 
machine that hosts the administration website.

ChatLoginServerWebsite Type the servlet context name that you gave to 
this website in Configuring an administration 
Website on page 299.
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Setting up a separate customer Website (optional)
You can configure a web server to serve as a customer Website only. The customer 
Website will not contain any accessible administration functions. These instructions 
assume that you have already configured Web Management.

Note:
Note: If the Avaya IC system includes multiple Attribute servers, all Websites and 

ICM servers must use the same Attribute server, so that their Tenant 
customization properties remain synchronized.

To set up a separate customer Website, complete the steps in the following topics:

1. Creating the Web application for the customer Website on page 302.

2. Configuring the customer Website on page 302.

3. Configuring the WebACD server on page 303.

Creating the Web application for the customer Website
Create the Web application for the customer website, as described in Configuring Web 
Management services on page 257.

Configuring the customer Website
Create a separate entry for the customer website in IC Manager.

To configure the customer Website:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Website > Website Context.
3. Select New.

4. Right-click in the right pane, and check the box next to Show Advanced Properties.

5. Complete the fields in the right pane, as shown in the following table:

Field Recommended entry

Global Name Type a name for the Website, for example, 
type CustomerWebsite.

Context Active Check this box.
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For more information about these fields, see Configuring the Website on page 288

6. Select OK.

7. Select Manager > Refresh.

8. Restart the Tomcat server that hosts the customer website.

Configuring the WebACD server
If you install separate administration and customer websites, you must configure this 
property and create a new name-value pair in the WebACD server for Collaboration and 
Sametime to function correctly. These entries are case-sensitive.

To configure the WebACD server for the customer website:

1. In IC Manager, double-click the WebACD server in the lists of servers.

2. Select the Configuration tab.

3. Select New.

4. In the CTI Type Editor dialog box:

a. Complete the fields as shown in the following table:

These entries are case-sensitive.

b. Select OK.

Admin Pages Active Do not check this box.

Public Pages Active Check this box.

ICM Servlets Active Check this box.

Field Recommended entry

Field Recommended entry

CTI Type Couple

Name collaborationRootURL

Value http://<customer_webserver>/icm/aimagentcl.hta
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5. If your Web Management system includes the Sametime feature:

a. Select New.

b. In the CTI Type Editor dialog box, complete the fields as shown in the following 
table:

c. Select OK.

You do not need to complete this step if your Web Management system does not 
include the Sametime feature.

6. Select OK.

Field Recommended entry

CTI Type Couple

Name  sametimeurl

Value http://<customer_webserver>/website/sametime/
kickoffsametime.jsp
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Chapter 11: Configuring Voice Chat

Avaya� Interaction Center (Avaya IC) installations can include Voice Chat. Voice Chat is a 
component of Web Management that includes the following features:

Chat and VOIP - Voice chat contact is initiated from a chat session. The customer uses 
VOIP, and the agent uses a telephone.

Chat and Phone - Voice chat contact is initiated from a chat session. The customer and 
the agent use a telephone.

To set up both types of Voice Chat, perform the steps in the following topics:

1. Prerequisites for Voice Chat on page 306.

2. Configuring the Workflow server for Voice Chat on page 306.

3. Building and loading workflows for Voice Chat on page 309.

4. Running the VMM setup script for Solaris on page 312.

5. Configuring the Voice Chat gateway on page 312.

6. Configuring the Voice Media Manager server on page 314.

7. Configuring the Voice Chat workflow table on page 315.

8. Setting startup options for the VMM server on page 316.
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Prerequisites for Voice Chat
Before you configure Voice Chat, you must:

1. Install and configure your Telephony switch and other hardware, including the 
following:

● Install and configure a supported IP Gateway

● Create a separate route point (VDN) for Voice Chat

● Direct all calls on the Voice Chat route point to the PBXLink (TS) using the Adjunct 
Route

For information about supported Telephony switches, see IC Installation Planning and 
Prerequisites. For information about your Telephony switch, see the switch 
documentation.

2. Install and configure Telephony, including an ACD. For more information, see 
Configuring Telephony on page 191.

3. Install and configure Web Management. For more information, see Configuring Web 
Management on page 245.

4. Confirm that the Avaya Voice Media Manager (VMM) is installed and running. The 
Voice Media Manager does not run in IC Manager. On a Windows machine, you can 
view and start the Voice Media Manager in the Services Control Panel. 

Avaya IC installs the VMM with the Avaya IC servers.

Configuring the Workflow server for Voice Chat
To configure the Workflow server for Voice Chat, perform the steps in the following topics:

1. Adding a semaphore for the Voice Chat workflow on page 307.

2. Creating the Voice Chat channel for the Workflow server on page 307.

3. Restarting the Workflow server on page 309.

Note:
Note: This section assumes that you will use an existing Workflow server to 

handle Voice Chat contacts. If the Avaya IC system includes a separate 
Workflow server for Voice Chat, see Creating a Workflow server on 
page 135,
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Adding a semaphore for the Voice Chat workflow
You must add a semaphore to all Workflow servers that process voice chat contacts and 
are in the same domain as the icmbridge account. The Attribute server uses the ICM 
account to log in to the ICM server. You entered this account in the IC Login field of the 
Attribute server configuration. For more information about the icmbridge account, see 
Creating the Attribute server on page 252 and Using administrative accounts for non-
human users on page 120.

To add the semaphore for the Voice Chat workflow:

1. In IC Manager, double-click the Workflow server.

2. Select the Workflow tab.

3. Select the Ellipsis (�) button next to Semaphores.

4. In the Semaphores dialog box:

a. Select New.

b. Select in the new row and type ivchat.ivchat_key.

c. Select OK.

5. Select OK.

Creating the Voice Chat channel for the Workflow server
If your Avaya IC system includes multiple Workflow servers, perform these steps on the 
Workflow server that processes voice contacts.

To create the voice chat channel for the Workflow server:

1. In IC Manager, double-click the Workflow server that processes voice contacts.

2. Select the Channels tab.

3. Select New Channel.
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4. In the Channel Editor dialog box, complete the fields as shown in the following table. 
Select OK.

5. Select the channel that you created in the step above.

6. Select New Association.

Field Recommended entry Notes

Global Do not check this field. Do not check this field to create a 
create a channel for a specific server 
or media, such as Voice Chat.

By Server ● Do not check this field if 
you want this channel to 
handle events from all 
servers of the type that 
you select from the 
Service drop-down list.

● Check this field if you want 
this channel to handle 
events from only one 
specific server that you 
select from the Service 
drop-down list.

If you check this field, and you need 
this Workflow server to communicate 
with more than one server, you must 
create another channel for that 
server.
Warning: If you check this field and 
the Telephony server is named "TS", 
the Workflow server will not be able 
to communicate with the Telephony 
server.

Channel Range No entry necessary. Completed by IC Manager

● If you did not check the By Server 
field, select TS.

● If you checked the By Server 
field, select the Telephony server 
with which you want this Workflow 
server to communicate.

*r<VDN_for_Voice_Chat>
For example, *r57001.

Service Select TS or a specific 
Telephony server from the 
drop-down list.

Whether you can select a server or a 
type of server, depends up whether 
or not you checked the By Server 
field.

Criteria Type 
*r<VDN_for_Voice_Chat>

For example, type *r57001.
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7. In the Channel Association dialog box, complete the fields as shown in the following 
table. Select OK.

8. Select OK.

Restarting the Workflow server
To restart the Workflow server:

1. In IC Manager, select the Workflow server that handles voice contacts.

2. Right-click the Workflow server and select Stop.

3. After the Alarm Monitor at the bottom of IC Manager displays a message confirming 
that the Workflow server has stopped, right-click the Workflow server and select Start.

Building and loading workflows for Voice Chat
Voice Chat uses the following sample workflows:

● Incoming Voice Chat workflow in the TS project

● Voice Chat workflow in the ivchat project

● Telephony workflows, see Building and loading workflows for Telephony on page 214

The Avaya IC seed data does not include a compiled sample Voice Chat or a compiled 
sample Incoming Voice Chat workflow. You must build and load these workflows.

Field Recommended entry

Channel Range Completed by IC Manager

Service Interface Completed by IC Manager

Event TS.IncomingCall
Note: This field is case-sensitive.

Flow <project_name>.<flow_name>
For example, type ts.incoming_ivchat
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! CAUTION:
CAUTION: By default, the Qualify Chat workflow assumes that you will create a 

WebVoice workgroup that includes agents who are configured to receive 
contacts from the voice and chat channels. If you do not intend to create this 
workgroup, you must customize the IVChatWorkgroup and 
PVChatWorkgroup properties in the Set Route Parameter blocks. The value 
of these properties must be the name of a valid workgroup. The workgroup 
must include agents who can handle contacts from the voice and chat 
channels. If you change these blocks, you must build and load the Qualify 
Chat workflow.

For more information about voice chat workflows and Workflow Designer, see Avaya 
Workflow Designer User Guide.

To load the Voice Chat workflows, complete the steps in the following topics:

1. Building the Incoming Voice Chat workflow on page 310.

2. Building the Voice Chat workflow on page 311.

Building the Incoming Voice Chat workflow
To build the Incoming Voice Chat workflow:

1. In Workflow Designer, select File > Open Project and open the TS project.

You can find the TS project in the following directory: 
IC_INSTALL_DIR\IC61\design\IC\Flows\Avaya\TS\TS.prj

2. Double-click incomingivchat.qfd in the Project pane.

3. Select Project > Settings. 

4. Select the Database tab and type the following values:

● Interaction Center Data Source name in the IC Data Source field

● Valid Avaya IC Administrator account in the Login ID field

The default account is Admin.

● Password for the account in the Password field

5. Select OK.

6. Select Build > Build Flowset.
Workflow Designer verifies and compiles the flows. All error messages, including the 
block name, script name, and offending line, are displayed in the Output bar.

7. Select File > Exit to exit Workflow Designer.
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Building the Voice Chat workflow
To build the voice chat workflow:

1. In Workflow Designer, open the Voice Chat workflow located in the following directory: 
IC_INSTALL_DIR\IC61\design\IC\flows\Avaya\ivchat\ivchat.qfd

2. Select Project > Settings. 

3. Select the Database tab and type the following values:

● Interaction Center Data Source name in the IC Data Source field

● Valid Avaya IC Administrator account in the Login ID field

● Password for the account in the Password field

4. Select OK.

5. Select Build > Build Flowset.
Workflow Designer verifies and compiles the flows. All error messages, including the 
block name, script name, and offending line, are displayed in the Output bar.

Configuring the Telephony server for Voice Chat
You must configure the Telephony server to ensure that the agent is not placed in a Busy 
state and can receive a voice chat contact.

To configure the Telephony server for Voice Chat:

1. In IC Manager, double-click the Telephony server.

2. Select the TS tab.

3. Right-click in the background and check the box next to Show Advanced Properties.

4. Check the Dial By Equipment box.

You might need to scroll down to see this box.

5. Select OK.
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Running the VMM setup script for Solaris
If you host your Avaya IC servers on Solaris, you must run the VMM setup script to start 
and configure the Voice Media Manager (VMM) for Voice Chat. The VMM setup script 
configures the VMM to start automatically.

! Important:! Important:
Important: You only must perform this step if you host your Avaya IC servers on Solaris. 

Do not perform this step if you host your servers on Windows machines. 

To run the VMM setup script and start the VMM on Solaris:

1. Navigate to the following directory: IC_INSTALL_DIR/IC61/bin

2. Run ./vmm_setup start

To stop the VMM on Solaris:

1. Navigate to the following directory: IC_INSTALL_DIR/IC61/bin

2. Run ./vmm_setup stop

Configuring the Voice Chat gateway
You must configure one Voice Chat gateway for each CLAN/Prowler card. Repeat the 
following steps for each gateway.

To configure the Voice Chat gateway:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Voice Chat > IPGateway.

3. Select New.

4. Complete the following fields in the right pane:

Field Recommended entry Description

Name Type a unique name for the 
gateway.

For example, type the node 
name of the CLan card.

IP Address Type the IP Address of the 
CLAN card.
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5. Select OK. 

Port Type the near end listening 
port of the CLAN card. 

ACD Name Select the name of the ACD 
from the drop-down list.

Select the same ACD that you 
configured for the Telephony 
server.

Site Select the site from the drop-
down list.

For example, select DefaultSite.

RoutePoint Type the VDN that you set up 
in the switch to receive voice 
chat calls.

Capacity Type the number of calls 
which this gateway can 
handle.

For example, the default 
capacity is 31. Check your 
switch documentation for more 
information.

Active Check this box if you want 
voice chat to be able to use 
the gateway.

Gateways should always be 
active unless there is a problem 
with the gateway, or you must 
perform maintenance on the 
machine.
If there is a problem with a 
gateway, uncheck this box 
immediately to ensure the 
gateway cannot be used for 
subsequent calls.
Before you bring the machine 
that hosts the gateway down for 
maintenance, make the 
gateway inactive so that it will 
not be used for subsequent 
calls. You can bring the 
machine down as soon as there 
are no more calls on the 
gateway. 

Field Recommended entry Description
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Configuring the Voice Media Manager server
Avaya IC installs the Voice Media Manager (VMM) server when you install Avaya IC 
servers on a machine. You can configure and run more than one VMM server in an Avaya 
IC system. 

Avaya IC uses a round robin algorithm to select a VMM server from an available list of 
VMMs to handle a voice chat.

To configure the VMM Server:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Voice Chat > VMM.

3. Select New.

4. Complete the following fields in the right pane:

Field Recommended entry Description

Name Type the name of the 
machine that hosts the VMM 
server.

For example, if host the VMM 
server on testbox.xyzcorp.com, 
type "testbox" as the name of 
that VMM server. 

IP Address Type the IP Address of the 
machine that hosts the VMM 
server.

Port Accept the default of 8120.
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5. Select OK.

6. Select Manager > Refresh.

If you do not receive a Success message, perform the steps in Troubleshooting the 
refresh in IC Manager on page 510.

Configuring the Voice Chat workflow table
To configure the Voice Chat workflow table:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Workflow > VoiceChat.
3. Select New.

Site Select the site from the drop-
down list.

For example, select DefaultSite.

Active Check this box. A VMM server should always be 
active unless there is a problem 
with the VMM server, or you 
must perform maintenance on 
the machine.
If there is a problem with a VMM 
server, uncheck this box 
immediately to ensure the VMM 
server cannot be used for 
subsequent calls.
Before you bring the machine 
that hosts the VMM server down 
for maintenance, make the 
VMM server inactive so that it 
will not be used for subsequent 
calls. You can bring the 
machine down as soon as there 
are no more calls on the VMM 
server. 

Field Recommended entry Description
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4. Complete the following fields in the right pane:

5. Select OK.

6. Select Manager > Refresh.

If you do not receive a Success message, perform the steps in Troubleshooting the 
refresh in IC Manager on page 510.

Setting startup options for the VMM server
You must set the VMM server to autostart, as described in the following topics:

● Setting startup options for the VMM server on Windows on page 316

● Setting startup options for the VMM server on Solaris on page 317

Setting startup options for the VMM server on Windows
To set startup options for the VMM server on Windows:

1. In the Services control panel, right-click on Avaya Voice Media Manager and select 
Properties.

2. Select Automatic from the Startup Type drop-down list. 

3. Select OK.

Parameter Recommended entry Description

Name Type the name of the IV 
chat workflow.

For example, type ivchat.

Timeout (sec) Type the number of 
seconds that the workflow 
should wait before it times 
out.

This entry represents how 
many seconds a gateway 
should have to respond to a 
MakeCall request.
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Setting startup options for the VMM server on Solaris
You do not need to perform this step if you have already run the VMM setup script, as 
described in Running the VMM setup script for Solaris on page 312.

To configure the VMM server to start automatically on Solaris:

1. Navigate to the following directory: IC_INSTALL_DIR/IC61/bin

2. Run ./vmm_setup start

To stop the VMM server on Solaris:

1. Navigate to the following directory: IC_INSTALL_DIR/IC61/bin

2. Run ./vmm_setup stop
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Chapter 12:Configuring Email Management

Email Management is part of the email channel for Avaya� Interaction Center (Avaya IC). 

To configure Email Management, perform the steps in the following topics:

1. Prerequisites for configuring the email channel on page 320.

2. Creating a secondary server environment for Email Management on page 320.

3. Configuring an IC Email server on page 321.

4. Configuring Email Template Administration on page 328.

5. Configuring a Workflow server for Email Management on page 336.

6. Using workflows for Email Management on page 341.

7. Creating routing hints for email workflows on page 343.

8. Configuring the WebACD server for Email Management on page 345.

9. Integrating Email Template Administration on page 346.

10. Configuring email accounts on page 348.

11. Creating an email status on page 351.

Your Avaya IC system can also include optional Email Management features, such an 
approval process or email message loop detection. For more information on how to 
configure these features, see IC Administration Volume 1: Servers & Domains.

For information on how to set up RONA for Email Management, see IC Administration 
Volume 2: Agents, Customers, & Queues
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Prerequisites for configuring the email channel
Before you configure the email channel, you must:

1. Install and configure all prerequisite software and hardware. Depending on which 
Avaya IC servers you plan to configure, the prerequisites can include one or more of 
the following:

● Database
● POP3 and SMTP email servers and environment
● JDK
● Web servers
For information on which prerequisites you need for each machine, see IC Installation 
Planning and Prerequisites

2. Verify that all required third party software, including SMTP servers, POP3 servers, 
and email accounts are installed and configured and accessible through the network. 
For more information, see IC Installation Planning and Prerequisites.

3. Copy the server files to the machines where you plan to run the Avaya IC servers, 
described in Installing Avaya IC servers on page 49

4. Install the Avaya IC design and administration tools

5. Perform all the steps to configure the Avaya IC servers, databases, and related 
components, described in Configuring core servers on page 113

6. Configure Web Management, as set out in Configuring Web Management on 
page 245.

Creating a secondary server environment for Email 
Management

You must create a secondary server environment, including a secondary ORB server, if 
you host the servers that you need to configure for Email Management on a different 
machine than the machine that hosts the primary ORB server. 

For more information about how to create a secondary server environment, see 
Configuring secondary servers on page 161.



Configuring an IC Email server

Issue 2.0 June 2004 321

Configuring an IC Email server
The IC Email server interacts with SMTP and POP3 servers. This server also manages all 
polling and forwarding of emails into the Avaya IC system from customer to agent. Through 
workflows, this server also handles the filtering of spam, the delivery of automatic replies, 
and the management of traffic flow to external agents and approval agents. 

This section includes the following topics:

● Guidelines for an IC Email server on page 321.

● Creating the IC Email server on page 321.

Guidelines for an IC Email server
Ensure that the failover strategy for your Avaya IC domains includes the following:

IC Email server failover - The domain that includes your IC Email server must failover to 
the domain that includes your WebACD server

WebACD server failover - The domain that includes your WebACD server must failover 
to the domain that includes your IC Email server

Creating the IC Email server
The Avaya IC installation program does not automatically add this server. Email 
Management requires this server.

To create the IC Email server:

1. Select Server > New in IC Manager.

2. Select Email from the list of servers. Select OK.

3. Select the General tab and complete the fields in the following table.

Field Recommended entry Notes

Name Email_<domain> Include the domain in the server 
name to identify the server.
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4. Select the ICEMail tab and complete the fields in the following table.

Domain Select the Avaya IC domain for the 
server from the drop-down list.

For example, select Email from 
the drop-down list if the server 
is in the Email domain.

Host Select the machine�s IP address 
from the drop-down list, or enter 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

IC Data Source Select the Interaction Center 
Data Source.

If you used the default name, 
select interaction_center.

SMTP Server 
Name

Enter the name of the 
machine that hosts the SMTP 
server.

This is the IC Email server that 
Avaya IC uses for outbound email. 
For example, enter 
MailSrvExchange.

SMTP Helo 
Domain Name

Enter the domain of the 
machine that hosts the SMTP 
server.

For example, enter xyzcorp.com.

HTTP Timeout 
(sec)

20 This is the number of seconds that 
the IC Email server waits for a 
response to an HTTP request 
before timing out.

Duplicate Message 
Checking

Check this field, if desired. Checks to make sure that 
duplicate messages are not 
received. Does not check 
outbound email contacts.
An incoming email contact is 
considered to be a duplicate if all 
of the following parts of the contact 
are identical to those in a previous 
contact: 
● From address
● To address
● Subject
● Body

Field Recommended entry Notes
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Maximum 
Messages 
Retrieved per 
POP3 Cycle

240 Determines the maximum number 
of email contacts retrieved from a 
POP3 server over a single 
connection. 
The default entry assumes that the 
server takes approximately 1 
second to download an email 
contact from the POP3 server. 
Thus, the server can process 240 
contacts before the next polling 
cycle, 240 seconds later. 

POP3 Cycle Wait 
Time (sec)

240 Specifies the default number of 
seconds that the server waits 
between checking for new 
contacts on a POP3 server. You 
can override this property per mail 
account. 
Increase this cycle if you expect to 
receive:
● Large email contacts that take 

longer to download, such as 
contacts with big attachments.

● A relatively low volume of email 
contacts to avoid an 
unnecessary drain on system 
and network resources.

If you increase wait time, there will 
be a delay in when agents receive 
email contacts, since contacts are 
downloaded less frequently.

Field Recommended entry Notes
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Detect Message 
Loops

Check this field, if desired. If you enable this field, the IC 
Email server cannot get into a loop 
if a customer has an auto-
response (such as an Out Of 
Office notification) configured for 
their email account.
It controls the use of email 
templates that the SmartAck block 
in the analyze workflow uses to 
send automatic responses to the 
sender, and it prevents the 
workflow from automatically 
sending a template 
acknowledgement to a customer.
If you check this field, the EDU for 
a contact will activate a variable 
that counts the number of smart 
acknowledgments sent to the 
email address in a 24 hour period. 
If you customize the workflow to 
use this variable, the workflow will 
not send another smart auto 
acknowledgement when the limit 
is reached. 

Message Loop 
Count

Accept the default or change, 
if desired.

The number of automated 
responses you want the customer 
to receive in a 24-hour period. 
Email Management will not 
automatically respond to 
messages that reach or exceed 
this count. 
For example, if you set this value 
to 5, Avaya IC returns the New 
Message template to the first five 
email contacts from the customer. 
The customer does not receive an 
acknowledgement for the sixth 
email contact.

Loop Detection 
Type

Select a number from the 
drop-down list.

Loop detection is based on 
"originator", "from address", "reply 
to address" or "both". 
You can select: 
● 0 for Originator (first looks for 

Reply-To, if not set then looks 
for "from")

● 1 for "from" address
● 2 for "reply to" address
● 3 for Both

Field Recommended entry Notes
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Loop Template Id Select the Ellipsis (�) button 
and navigate to the template 
ID you want to use.

ID of the template used to send a 
final message to a customer after 
the message loop count is 
exceeded.
Create this template in Email 
Template Administration. For 
details, see IC Administration 
Volume 1: Servers & Domains.

Blank Message 
Template Id

Select the Ellipsis (�) button 
and navigate to the template 
ID you want to use.

Determines the ID of the template 
that is sent when a blank message 
is received from a contact. 
Create this template in Email 
Template Administration. For 
details, see IC Administration 
Volume 1: Servers & Domains.

Bounced Message 
Email Address

Enter an email address. Determines the email address to 
which "bounce" messages are 
sent, including messages returned 
as undeliverable and messages 
bounced by Avaya IC workflows. 
For example, enter 
bounce@exchange.xyzcorp.com.
A supervisor or administrator 
should monitor this account.
Note: Make sure that the IC Email 
server does not poll this email 
address, or the server will retrieve 
all the bounce emails and enter 
them into the Avaya IC system.

Database Query 
Retries

Accept the default or change, 
if desired.

Determines the maximum number 
of times that the IC Email server 
will retry database queries if they 
fail. 
If this number of retries is 
exceeded, the IC Email server will 
shut itself down.

Field Recommended entry Notes
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Store All Messages Check this field, if desired. Determines whether Email 
Management stores the message 
body of acknowledgements 
initiated by workflows. Email 
Management stores these 
messages in the database, and 
agents can view them in the 
history browser. If you do not 
check this field, the agent can see 
that a message was sent, but 
cannot see the body of the 
message. 

Validate Agent 
Reply

Do not check this field. This field is no longer used.

Directory for Stored 
Messages

Enter a directory path. The directory that the IC Email 
server should use to store 
messages larger than 1 MB in 
size. (The file path must be 
relative to the machine that hosts 
the IC Email server.)
Note: If you do not specify a path, 
the files will be stored in 
IC_INSTALL_DIR\IC61\
MessageCenter\messages. 

Port for HTTP 
Requests

Accept the default of 19114. Specifies the port on which the 
built-in HTTP server will listen. 
This is the port that is used if the 
specific server ports are not set. If 
this value is 0, the port defaults to 
the value set in the advanced 
property: HTTP Port for Admin 
Interface. 
If you must change this port, see 
Port assignments on page 26 for a 
list of the default port numbers 
used by the other Avaya IC 
servers. Port conflicts can cause 
serious problems within the Avaya 
IC system.

Field Recommended entry Notes
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5. Select the Analysis tab and complete the fields in the following table.

Even if you check the fields in the Analysis tab, email analysis will not work if you do 
not perform the steps in the following topics:

● Configuring a Workflow server for Email Management on page 336

● Using workflows for Email Management on page 341

● Creating routing hints for email workflows on page 343

6. Select OK to save your configuration settings.

7. Right-click on the IC Email server and select Start.
For more information about the correct order for starting and stopping Avaya IC servers, 
see Starting and stopping Avaya IC servers on page 147.

Field Recommended entry Notes

Run Analyze 
Flow

Check this field. Check this field if you want:
● The IC Email server to invoke an 

email analysis workflow to assist 
in the routing of incoming email 
contacts.

● To use Analyze with Keywords or 
Content Analyzer to process 
incoming email.

You must also complete all steps to 
configure Email workflows to use 
email analysis. For details, see 
Using workflows for Email 
Management on page 341 and the 
Avaya IC Media Workflow 
Reference. 

Run Outbound 
Email Flow

For the initial installation of 
Avaya IC, clear this field.

Select this field if you want to:
● Have Avaya IC analyze outbound 

email.
● Have a supervisor approve 

outbound email.
● Use Analyze with Keywords or 

Content Analyzer to process 
outbound email.

You must also complete all steps to 
configure Email workflows to use 
email analysis.
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Configuring Email Template Administration
Email Template Administration requires a Web application. You configure Email Template 
Administration on the Web tab of the Avaya IC Configuration Tool. 

This section describes how to install and configure Email Template Administration for each 
operating system that Avaya IC supports. This section includes the following topics:

● Where to configure Email Template Administration on page 328.

● Hosting multiple Web applications on one machine on page 328.

● Advanced properties for Email Template Administration on page 329.

● Configuring Email Template Administration on Windows on page 329.

● Configuring Email Template Administration on Solaris on page 331.

● Configuring Email Template Administration on AIX on page 334.

! Important:! Important:
Important: The Configuration Tool overwrites all manual edits that you make to an 

Avaya IC configuration file.

Where to configure Email Template Administration
Configure Email Template Administration on the machine that hosts the templates for 
Email Management and the Web pages for Email Template Administration.

Hosting multiple Web applications on one machine
If the Avaya IC system includes more than one Web application on the same machine as 
the WebLM, Avaya recommends that you:

● Select Multiple for the Tomcat Setup option.

● Configure all of the Web applications on the target machine at the same time.

! Important:! Important:
Important: If you do not configure all of the Web applications simultaneously, leave the 

options for all Web applications on the target machine checked when you re-
run the Configuration Tool to create the new Web applications. If you do not 
leave the options for the previously created Web applications checked, the 
Configuration Tool may delete those Web applications from the machine.
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Advanced properties for Email Template Administration
The Web tab also includes advanced properties for the Java Virtual Machine. 

Only configure the advanced properties if you expect a high volume of access to Email 
Template Administration. For more information, see Advanced properties on the Web 
tab on page 501. 

Configuring Email Template Administration on Windows
Use these instructions if you plan to host Email Template Administration on a Windows 
machine.

You do not need to stop the IIS Web server on Windows machines.

To configure Email Template Administration to run on a Windows machine:

1. To start the Configuration Tool, select Start > Programs > Avaya Interaction Center 
6.1 > Configuration Tool.
If the Configuration Tool is already open, close and re-open it to ensure that the 
Configuration Tool includes all system changes, such as new servers.

2. Log in with your IC Manager login ID and password.

3. Complete the general fields in the following table.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple

JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

C:\jdk1.3.1_06



Configuring Email Management

330 Installation and Configuration

4. Check the Configure Email Template Administration box.

5. Select Apply Settings. 

6. Select OK in the Success dialog box.

7. Select Exit.

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600

IIS Website The name of the IIS Web server that the Web 
application will use. 
Tip: For a localized version of IIS, type the 
localized name for the IIS Web server.

Default Web Site

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct. 

xyzcorp.com

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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8. To complete the configuration, perform the following steps to ensure that Email 
Template Administration services start properly:

a. Open the Windows Services control panel.

b. Start the Tomcat NT services:

● For a multiple Tomcat setup, start Avaya IC Email Template Management Service 
6.1.

● For a single Tomcat setup, start Avaya IC Jakarta Service 6.1.

For more information about how to start and stop Web application services, see 
Starting and stopping Avaya IC services on page 154.

Configuring Email Template Administration on Solaris
Use these instructions if you plan to host Email Template Administration on a Solaris 
machine.

! Important:! Important:
Important: To configure Email Template Administration on Solaris, you must log in as a 

user with write permissions on the Web server directories and the Avaya IC 
installation directories. The root user usually has these write permissions.

To configure Email Template Administration to run on a Solaris machine:

1. Stop the Sun ONE server that hosts the Email Template Administration application with 
the stop script packaged with the Web server: 
<SunONE_install_dir>/servers/<my_ONE_server>/stop

2. Start the Configuration Tool:

a. Navigate to IC_INSTALL_DIR/IC61/bin 

b. Run ./configure

If the Configuration Tool is already open, close and re-open it to ensure that the 
Configuration Tool includes all system changes, such as new servers.

3. Log in with your IC Manager login ID and password.
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4. Complete the general fields in the following table.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple

JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

/opt/j2sdk1_3_1_06

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600

Web Server Home The installation path for the Sun ONE� Server 
that hosts the Web application.

/opt/iplanet

Web Server Name The root name of the server as found in the Sun 
ONE� Server home directory.
Note: Do not include https- in the Web server 
name.

testbox.xyzcorp.com

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct. 

xyzcorp.com

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80
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5. Check the Configure Email Template Administration box.

6. Select Apply Settings. 

7. Select OK in the Success dialog box.

8. Select Exit.
9. To complete the configuration, perform the following steps to ensure that all Email 

Template Administration services start properly:

a. In the Sun ONE Server installation directory:

● Open the https-admserv directory.

● If the directory includes a file called start-ICEnv.backup, execute the following 
command to rename the file:

mv start-ICEnv.backup oldstart-ICEnv

b. Start the Sun ONE server that hosts the Email Template Administration application 
with the following start script:

<SunONE_install_dir>/servers/<my_ONE_server>/start

c. Navigate to the IC_INSTALL_DIR/IC61/bin directory.

d. Use the following script to start Tomcat:

● If you selected Multiple in the Tomcat Setup field: 

./ictomcat.sh start all

● If you selected Single in the Tomcat Setup field:

./ictomcat.sh start rlmanager

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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Configuring Email Template Administration on AIX
Use these instructions if you plan to host Email Template Administration on an AIX 
machine.

! Important:! Important:
Important: To configure Email Template Administration on AIX, you must log in as a 

user with write permissions on the Web server directories and the Avaya IC 
installation directories. The root user usually has these write permissions.

To configure Email Template Administration to run on an AIX machine:

1. Stop the IBM HTTP Server that hosts the Website application with the stop script 
packaged with the Web server: 
./httpserver.sh stop

2. Start the Configuration Tool:

a. Navigate to IC_INSTALL_DIR/IC61/bin 

b. Run ./configure

If the Configuration Tool is already open, close and re-open it to ensure that the 
Configuration Tool includes all system changes, such as new servers.

3. Log in with your IC Manager login ID and password.

4. Complete the general fields in the following table.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple

JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

/usr/java131

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600
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5. Check the Configure Email Template Administration box.

6. Select Apply Settings. 

7. Select OK in the Success dialog box.

8. Select Exit.
9. To complete the configuration, perform the following steps to ensure that all Email 

Template Administration services start properly:

a. Start the IBM HTTP Server that hosts the Email Template Administration application 
with the following start script:

./httpserver.sh start

Web Server Home The installation path for the IBM HTTP server 
instance that hosts the Web application.

/usr/HTTPServer

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct. 

xyzcorp.com

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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b. Navigate to the IC_INSTALL_DIR/IC61/bin directory.

c. Use the following script to start Tomcat:

● If you selected Multiple in the Tomcat Setup field: 

./ictomcat.sh start all

● If you selected Single in the Tomcat Setup field:

./ictomcat.sh start rlmanager

Configuring a Workflow server for Email 
Management

To configure the Workflow server for Email Management, perform the steps in the following 
topics:

1. Creating a Workflow server for Email Management on page 336.

2. Creating the email channels for the Workflow server on page 337.

3. Starting the Workflow server on page 341.

If your Avaya IC system includes multiple Workflow servers, perform these steps on each 
Workflow server that handles pre-qualification for email contacts and routes email 
contacts.

Creating a Workflow server for Email Management
These instructions only provide information about those parameters you need to set when 
you create a Workflow server to handle email contacts. For more information about other 
parameters in the Workflow server, see Configuring multiple Workflow servers on 
page 135 and IC Administration Volume 1: Servers & Domains.

! CAUTION:
CAUTION: If you do not configure the Workflow server with synchronous startup flows, 

the Qualify Email workflow cannot resolve the pkey of the queue where a 
contact is to be routed. If this occurs, Avaya IC cannot route email contacts.

To create a Workflow server for Email Management:

1. In IC Manager, select Server > New.

2. Select Workflow from the list of servers. 

3. Select OK.



Configuring a Workflow server for Email Management

Issue 2.0 June 2004 337

4. Select the General tab, and complete the fields shown in the following table.

5. Select the Workflow tab.

6. From the IC Data Source drop-down list, select the Interaction Center data source.

The default name for this data source is interaction_center. This is the data source that 
you created in Generating the Interaction Center application on page 109.

7. Select Synchronous Startup Flows.
8. If the following rows do not exist, add them to the Synchronous Startup Flows:

a. Select New.

b. In the new row, type web_routing.update_qw_cache

c. Select OK.

9. Continue with Creating the email channels for the Workflow server on page 337.

Creating the email channels for the Workflow server
You must add email channels and associations with the workflows for each channel. You 
create separate channels for email qualification and for email analysis. If the Avaya IC 
system uses different Workflow servers to handle each task, create these channels in the 
appropriate Workflow server.

This section includes the following topics:

● Creating the email channel for email qualification on page 338.

● Creating the email channel for email analysis on page 339.

Field Recommended entry Notes

Name Workflow_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain for 
the server from the drop-down list.

For example, select Email to 
use the preconfigured domain 
for Email Management.

Host Select the machine�s IP address 
from the drop-down list, or type 
the IP address if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.
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Creating the email channel for email qualification

Perform these steps in each Workflow server that will run the Qualify Email workflow.

To create an email channel for a Workflow server that qualifies emails:

1. In the Server Editor for the Workflow server, select the Channels tab.

2. Select New Channel.
3. In the Channel Editor dialog box, complete the fields as shown in the following table. 

4. Select OK in the Channel Editor dialog box.

5. Select the channel that you created in the step above.

6. Select New Association.

7. In the Channel Association dialog box, complete the fields as shown in the following 
table.

Field Recommended entry Notes

Global Do not check this field. Do not check this field to create a 
create a channel for a specific server 
or media, such as Email.

By Server ● Do not check this field if 
you want this channel to 
handle events from all 
servers of the type that 
you select from the 
Service drop-down list.

● Check this field if you want 
this channel to handle 
events from only one 
specific server that you 
select from the Service 
drop-down list.

If you check this field, and you need 
this Workflow server to communicate 
with more than one server, you must 
create another channel for that 
server.
Warning: If you check this field and 
the WebACD server is named 
"WACD", the Workflow server will not 
be able to communicate with the 
WebACD server.

Channel Range No entry necessary. Completed by IC Manager

Service Select WACD or the 
WebACD server from the 
drop-down list.

Whether you can select a server or a 
type of server, depends up whether 
or not you checked the By Server 
field.

Criteria Type media=email

Field Recommended entry

Channel Range Completed by IC Manager

Service Interface Completed by IC Manager
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8. Select OK in the Channel Association dialog box.

9. Perform one of the following steps:

● Select OK in the Server Editor to complete the Workflow server configuration.

● If the Workflow server will also run email analysis workflows, continue with Creating 
the email channel for email analysis on page 339.

Creating the email channel for email analysis

Perform these steps in each Workflow server that will run the email analysis workflow.

To create an email channel for a Workflow server that analyzes emails:

1. In the Server Editor for the Workflow server, select the Channels tab.

2. Select New Channel.
3. In the Channel Editor dialog box, complete the fields as shown in the following table. 

Event WACD.QualifyEmail
Note: This field is case-sensitive.

Flow <flow_project>.<flow_name>
For example, type wacd.qualifyemail

Field Recommended entry

Field Recommended entry Notes

Global Do not check this field. Do not check this field to create a 
create a channel for a specific server 
or media, such as Email.

By Server ● Do not check this field if 
you want this channel to 
handle events from all 
servers of the type that 
you select from the 
Service drop-down list.

● Check this field if you want 
this channel to handle 
events from only one 
specific server that you 
select from the Service 
drop-down list.

If you check this field, and you need 
this Workflow server to communicate 
with more than one server, you must 
create another channel for that 
server.
Warning: If you check this field and 
the WebACD server is named 
"WACD", the Workflow server will not 
be able to communicate with the 
WebACD server.

Channel Range No entry necessary. Completed by IC Manager
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4. Select OK in the Channel Editor dialog box.

5. Select the channel that you created in the step above.

6. Select New Association.

7. In the Channel Association dialog box, complete the fields as shown in the following 
table to create an inbound and an outbound association for the email channel.

Service Select WACD or the 
WebACD server from the 
drop-down list.

Whether you can select a server or a 
type of server, depends up whether 
or not you checked the By Server 
field.

Criteria Type *.

Channel or 
Association

Field Recommended entry

Association 1 Channel Range Completed by IC Manager

Service Interface Completed by IC Manager

Event ICEmail.Analyze
Note: This field is case-sensitive.

Flow <flow_project>.<flow_name
>
For example, enter one of the 
following:
● icemail.analyzenoca if your 

system does not include 
Content Analyzer

● icemail.analyzeca if your 
system includes Content 
Analyzer

Field Recommended entry Notes
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8. Select OK in the Channel Association dialog box.

9. Select OK in the Server Editor to complete the Workflow server configuration.

Starting the Workflow server
To start the Workflow server:

1. In IC Manager, select the Workflow server that handles email contacts.

2. Right-click the Workflow server and select Start.

Using workflows for Email Management
You can use the sample workflows to configure and test your Email Management servers. 
The Avaya IC seed data includes compiled sample workflows. When you imported seed 
data into the CCQ database, you stored the compiled workflows in the database. 

Email Management uses the following sample workflows:

● An incoming and outbound Email Analysis workflow from the ICEmail project

● The Qualify Email workflow in the WACD project

● All Web Management workflows, see Using workflows for Web Management on 
page 277

Association 2 Channel Range Completed by IC Manager

Service Interface Completed by IC Manager

Event ICEmail.OutboundEmail
Note: This field is case-sensitive.

Flow <flow_project>.<flow_name>
For example, enter one of the 
following:
● icemail.outboundnoca if your 

system does not include 
Content Analyzer

● icemail.outboundca if your 
system includes Content 
Analyzer

Channel or 
Association

Field Recommended entry
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Before your Avaya IC system moves into production, you can modify the properties of the 
sample workflows to meet your contact center�s needs. For example, you can route an 
outbound email to an approval queue or to an approving agent.

For a complete list of the workflows in these projects, including the directories where 
Avaya IC installs the workflows, see Avaya IC Media Workflow Reference.

Configuring Outbound Email Analysis workflows
The ICEmail project contains two sample Outbound Email Analysis flows. The sample 
Outbound with Keywords workflow (outboundnoca) performs analysis on outbound email 
in Avaya IC systems that do not include Content Analyzer. The sample Outbound with 
Content Analyzer workflow (outboundca) performs analysis on outbound email in Avaya IC 
systems with Content Analyzer. 

The sample Outbound Email Analysis flows depend on settings in the following:

● Outbound settings in the IC Email server

● Email channel in the Workflow server

● Group properties in IC Manager

● Blocks in the Qualify Email workflow

● Blocks in the Outbound Email Analysis workflow

You must know the configuration of your production environment before you can configure 
the Outbound Email Analysis flows to work in your Avaya IC system. Therefore, until you 
have tested your Email Management system and know the configuration of your 
production environment, you should not run any Outbound Email Analysis flows. For more 
information on this setting, see Creating the IC Email server on page 321.

If you want to run an Outbound Email Analysis workflow in your Email Management 
system, you must configure and test your system carefully. 

To configure Outbound Email Analysis:

1. In Workflow Designer, open the appropriate Outbound Email Analysis workflow in the 
ICEmail project, as shown in the following table:

Workflow Avaya IC system configuration

outboundca Avaya IC systems with Content Analyzer.

outboundnoca Avaya IC systems without Content Analyzer.
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2. Double-click the GetAgentQuota block and in the Property Sheet:

a. Select the Basic tab.

b. Set the value of DefaultQuotaValue to 0 (zero).

The default value is 0 (zero), no review of outbound email contacts.

3. Save and recompile the workflow.

4. In IC Manager, set the group properties for agents

a. Select Groups > Properties to open the Group Properties dialog box:

b. Select Email/Agent and set the value of the ReviewQuota property.

The default value is 0 (zero), no review of outbound email contacts.

c. Apply and save the changes. 

For more detailed instructions, see Setting global properties for all agents on 
page 389.

5. In IC Manager, if you configured any agents not to cascade their properties from the 
global properties, set the value of ReviewQuota to 0 (zero) for those agents also. For 
more detailed instructions, see Setting properties for individual agents on page 389.

Creating routing hints for email workflows
The sample email workflows contain blocks that use routing hints from the RoutingHint 
table in the Directory server to analyze and route email contacts. These blocks include:

● Fetch Routing Hints (email) block in the Qualify Email workflow

● Set Routing Hint blocks in each of the Email Analysis workflows

! Important:! Important:
Important: Routing hints must be in lower case. Do not use mixed upper and lower 

case in your routing hints. If the routing hint is not in all lower case, the 
workflow cannot locate the routing hint, and Avaya IC cannot correctly route 
the contact. 

For more information about the sample email workflows and how the workflows use routing 
hints, see Avaya IC Media Workflow Reference.

The email workflows use hints from the RoutingHint table to route email contacts.

Each row in the routing hint table contains the following:

● A routing hint

● The IDs of the queues where contacts that match the routing hint should be routed
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Tip:
Tip: The default email queue is DefaultEmailQueue@DefaultTenant. You can 

create and use additional email queues for routing email contacts. For more 
information, see IC Administration Volume 2: Agents, Customers, & 
Queues.

The routing hints that you need to create for the sample email workflows depend upon your 
Avaya IC system. The following table describes the routing hints required by the different 
sample email workflows.

To create routing hints:

1. In IC Manager, select the Configuration tab.

2. In the left pane, select Tables > Workflow > RoutingHint. 
3. Select New.

Avaya IC deployment Email workflow Routing hints

Email contact routing wacd.qualifyemail If deployment includes email analysis, 
no additional hints required.
If no email analysis, create a routing 
hint for the To address of email. For 
example,
● incomingemail@ic.avaya.com

Email Analysis with 
Keywords

icemail.analyzenoca Create a routing hint with a value such 
as:
● sales
● support
● printers

icemail.outboundnoca Create a routing hint with a value of:
● approvalrequired

Email Analysis with 
Content Analyzer

icemail.analyzeca Create a routing hint with a value such 
as:
● home computing
● desktop
Also, create routing hints for language 
with an ISO-639-1 value such as:
● en
● sp
● fr
● de
● zh

icemail.outboundca Create a routing hint with a value of:
● approvalrequired
● suspectcontent
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4. In the right pane, complete the fields shown in the following table:

5. Select OK. 

6. Select Apply.

Repeat Steps 3 through 6 until you create all required routing hints.

7. Select Manager > Refresh.

Configuring the WebACD server for Email 
Management

If you install the WebACD server and IC Email server on different machines, you must 
configure the WebACD server for Email Management.

To configure the WebACD server for Email Management:

1. In IC Manager, double-click the WebACD server in the lists of servers.

2. Select the Configuration tab.

3. Select New.

Parameter Recommended entry Description

Routing Hint Type a routing hint. Type the name of a routing hint required 
by a sample email workflow.
The routing hint must be a single word in 
all lower case, and cannot contain any 
special characters.

Email Queue ID Type 
DefaultEmailQueue@Default
Tenant. 

DefaultEmailQueue@DefaultTenant is the 
default email queue. For more information 
about email queues, see IC 
Administration Volume 2: Agents, 
Customers, & Queues.

Category/Qualifier Leave this field blank.

Tenant Select DefaultTenant from the 
queue from the drop-down list.

Select the tenant used by the queue. 
For the DefaultEmailQueue, select 
DefaultTenant to ensure that the routing 
hint uses the correct queue.
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4. In the CTI Type Editor dialog box:

a. Complete the fields as shown in the following table:

b. Select OK.

5. Select OK.

6. Stop and restart the WebACD server.

Integrating Email Template Administration
You must configure Email Template Administration to launch the Email Template 
Administration Tool from IC Manager.

Note:
Note: You only need to complete those properties listed in this section to integrate 

Email Management administration. You do not need to complete the other 
properties available in the System/Configuration list. 

To configure Email Template Administration:

1. In IC Manager, select Tools > Groups.

2. Select the Properties tab.

3. Select IC in the left pane of the Group Manager.
4. Select System/Configuration in the Sections list. 

Field Recommended entry

CTI Type Couple

Name  emailservername
This field is case-sensitive.

Value Fully-qualified domain name or IP address of the 
machine that hosts the IC Email server. 
Make sure this name can be resolved to the correct 
machine from all agent machines. 
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5. Select the following properties:

a. Select Edit.
b. Set values for the properties, as shown in the following table:

If one of these properties is not available, select Property Insert and select the 
property name from the drop-down menu.

Note:
Note: If the columns in the right pane are Name, Entity, Value, and Overridable, 

select the - (minus) button on the toolbar to view and edit these properties.

6. Select Apply.

7. Select OK.

8. Start the IC Email server, if necessary.

Property Recommended entry

EmailLoginServer Type the fully-qualified domain name of the 
server that hosts the Email Template 
Administration pages. For example, type 
ICEmail.xyzcorp.com.

EmailLoginServerPort Type the IC Email server web port. For example, 
the default port is 80.

EmailLoginServerWebsite Type rlmanager as the name of the Response 
Library Manager web application. 
The Configuration Tool defined this application 
name when you configured Email Template 
Administration.

EmailServer Type the fully-qualified domain name of the 
machine that hosts the IC Email server.

EmailServerPort Type the IC Email server HTTP port. For 
example, the default is 19114.
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Configuring email accounts
You must configure Email Management to use your mail accounts to:

● Retrieve inbound email from customers

● Send outbound agent replies

The following table describes the email accounts that must exist before you configure 
Email Management to use email accounts.

Email Management can manage mailboxes in any number of domains so long as it has the 
necessary information to log onto the POP3 server.

Required email accounts Description

Email Management mail accounts These accounts must exist as mailboxes on the 
POP3 server. 
Note the login ID and password. IC Manager can 
only link to an existing mailbox. IC Manager 
cannot create mailboxes on a POP3 server.

At least one email account for the 
Customer account for inbound 
customer messages

Web Management uses customer email accounts 
to send email from the Customer Web site to your 
contact center. Use this email address for mailto: 
links on your website and wherever you plan to 
make email addresses available to customers.

Bounced email account Email Management uses this account as the 
destination address for emails sent by the IC 
Email server that the SMTP server bounces or 
rejects. All filtered spam and other junk emails 
also get forwarded to this bounced email. 
You include this account in your IC Email server 
configuration.

Disabled accounts (optional) You can set up Disabled accounts to test or 
troubleshoot the following servers:
● Web Management servers
● IC Email server
● Tomcat server where you install the website 

application
Email Management does not retrieve messages 
for disabled accounts.
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Tip:
Tip: The IC Email server generates the "to address" for an incoming email from 

the Name and Domain fields on the General tab of the server. As a result, 
the logon account does not need to match the first part of the email address, 
and the "to address" is independent of the logon account used to poll the 
POP3 server.

To add a POP3 email account to Email Management:

1. In IC Manager, select Services > Email Accounts. 

2. In the Email Accounts dialog box, select New.

3. In the New Email Account property sheet, complete the fields as shown in the 
following table.

Tab Field Description

General tab Name Type the mailbox name exactly as it is configured 
in your POP3 server. For example, type agent.

Domain Type the mailbox domain exactly as it is 
configured in your POP3 server. For example, 
type xyzcorp.com.

Tenant Select the tenant that should be associated with 
this email account from the drop-down list.

Return address This address appears in the "From" field in an 
email response sent to the customer from this 
account. IC Manager automatically completes 
this field with name@domain. To use a different 
return address, select it from the Return Address 
drop-down list.

Server tab Outgoing Email Type the network address for the SMTP email 
server you would like to use here.

Incoming Email Type the network address of the POP3 server 
where the email accounts are configured, the 
logon account, and password in the appropriate 
field. 
Note: If any of these settings are incorrect, Email 
Management will not be able to connect to the 
POP3 email server.

Log on using 
Secure 
Password 
Authentication

Secure Password Authentication is a challenge-
response protocol used by the Windows security 
subsystem to prevent passwords from being sent 
through the network in plain text. Your POP3 
server must support Secure Password 
Authentication to use this option.
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4. Select Test to test your incoming and outbound accounts with your POP3 server or 
SMTP server.

5. Select OK.

For more information about how to create Avaya IC email accounts, see IC Administration 
Volume 1: Servers & Domains.

Templates tab � The Templates tab allows you to specify the 
following templates:
● Header template specifies the text to be 

inserted at the top of any email to a customer.
● Footer template specifies the text to be 

appended to the end of any email to a 
customer.

● New Message template specifies the text to be 
be automatically sent to a customer when a 
new email is received from that customer.

● Follow Up template specifies the basic 
acknowledgement message to be sent when a 
customer replies to a message sent from 
Avaya IC. Email Management sends this 
template whether the message to the 
customer was an automated outbound or an 
agent reply.

Create these templates in Email Template 
Administration.

Miscellaneous 
tab

Validate 
incoming email 
addresses 

Select this check box if you want to limit the 
addresses that can send email to this account.

Valid email 
addresses

Select the button following this field to specify 
which addresses can send email to this account. 
If a message comes in from a different email 
address, it will be rejected by Email Management.
You must check Validate incoming email 
addresses to use this field.

Override global 
email checking 
scheduler

Check this box if you want this account to check 
for new messages either more or less frequently 
than the global setting that was specified for the 
IC Email server.

New email 
check 
frequency

Type the number of seconds between email 
checks in this field.
You must check Override global email 
checking scheduler to use this field.

Tab Field Description
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Creating an email status
An agent can select an email status from a scrollable list in Avaya Web Agent. The agent 
selects a status to resolve an email contact. You use IC Manager to create the different 
types of email status that appear in the list.

! Important:! Important:
Important: You must create at least one email status of Dismiss and check the 

Messages set to this status should be treated as answered field for that 
status. Email Management requires this Dismiss status when tasks are 
cancelled in IC Website Administration Tool. If you do not create a Dismiss 
status, and a task is cancelled from IC Website Administration Tool, the IC 
Email server server will generate an alarm.

For more information on how to create an email status, see IC Administration Volume 1: 
Servers & Domains.

To create an email status:

1. In IC Manager, select Services > Mail Template Administration.

If prompted, log in to Email Template Administration with the same login ID and 
password that you used for IC Manager.

2. Select New.

3. Select New Status.

4. In the New Status Properties dialog box, complete the following fields:

a. Type a brief description of the status in the Description field.

This text is displayed on the list of statuses available to agents in Avaya Agent.

b. Check the boxes shown in the following table, if desired:

5. Select OK to close the Status Properties dialog box.

Check box Recommended entry

Messages set to this status 
should be treated as 
answered

Check this box if the status indicates a 
resolution of the issue that requires no 
further action by the agent.

Send template for this status Check this box if you want to send an 
auto-response message to the user when 
an agent assigns this status to a 
message. Choose a template to send. If 
you do not know the location of the 
template, select Browse and navigate to 
the desired template.
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Chapter 13:Configuring agent applications

Perform the steps in the following topics to configure Avaya� Interaction Center (Avaya IC) 
agent applications: 

1. Required privileges and permissions on page 353.

2. Creating installation files for agent applications on page 355.

3. Preparing for installation by agents on page 370.

4. Configuring automatic updates for agent applications on page 376.

5. Cautions and tips for creating agent accounts on page 379

6. Creating test agents on page 381.

7. Configuring agents for Outbound Contact on page 390.

8. Configuring the Unified Agent Directory on page 393.

9. Configuring the Citrix integration on page 398.

! Important:! Important:
Important: Read the Avaya IC Readme file and IC Installation Planning and 

Prerequisites before you begin the agent desktop application installation.

Required privileges and permissions
Avaya IC users require different levels of privileges and permissions for the operating 
system, depending on the tasks that the users perform. 

This section describes the privileges and permissions required for users who perform tasks 
related to agent desktop applications. Topics include:

● Required permissions for agents on page 354.

● Required privileges for agent installer on page 354.
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Required permissions for agents
Agents can run Avaya IC agent desktop applications with limited permissions over certain 
directories on their desktops. Agents do not require administrator privileges. 

Windows XP and the NTFS file system have more security control. Windows XP is more 
restrictive by default.

The following table describes the permissions and allowable restrictions on Avaya IC 
directories for agent desktop applications. 

Required privileges for agent installer
All Avaya IC users who create agent installers and who install or configure Avaya IC 
components require the administrator privileges in the following table.

Directory Required permissions Allowable restrictions

IC_INSTALL_DIR
\IC61\bin

Modify permissions
(also includes Read, Write, Execute)

Delete

IC_INSTALL_DIR
\IC61\etc

Modify permissions
(also includes Read, Write, Execute)

Delete

IC_INSTALL_DIR
\IC61\apps

Modify permissions
(also includes Read, Write, Execute)

Delete

IC_INSTALL_DIR
\IC61\logs

Modify permissions
(also includes Read, Write, Execute)

Delete

Operating system Required administrator privileges

Windows An Administrator login or a login with administrator 
privileges

Solaris Sun ONE administrator rights

AIX IBM http server administrator rights
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Creating installation files for agent applications
To create installation files for agent applications, perform the steps in the following topics:

1. Cautions and tips for installation files on page 355

2. Required information for the Agent Site Preparation wizard on page 357.

3. Running the Agent Site Preparation wizard on page 361.

4. Copying the server implementation file on page 366.

5. Mapping a virtual directory to a Web server installation directory on page 367.

Cautions and tips for installation files
Before you run the Agent Site Preparation wizard, note the cautions and tips in the 
following topics:

● Stopping agent desktop applications on page 355.

● Installation path for agent desktop applications on page 356.

● Size of agent installer directory on page 356.

● Installer directory availability on page 356.

● Location for Avaya Agent installation on page 356.

● Size of Avaya Agent installation directory on page 356.

● IIS Web servers on page 357.

● Solaris server machine on page 357.

● Telephone settings for Outbound Contact on page 357.

Stopping agent desktop applications

Before you or an agent runs the Agent Installer on an agent desktop machine, confirm that 
there are no Avaya IC agent desktop applications or qui.exe processes running on the 
agent machine. The Agent Installer may stop responding or pause indefinitely if an agent 
desktop or qui.exe process is still running. 
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Installation path for agent desktop applications

The agent installer automatically adds the following to the installation path for agent 
desktop applications: \apps\<application_name>

When you specify the initial section for the installation path, do not include any duplication 
of the directories. If you include a duplicate directory, the -d parameter in the shortcut 
cannot find the working directory for the applications.

For example, if you specify C:\apps as the installation path for agent desktop 
applications, the -d parameter cannot locate the apps directory, as it is duplicated in the 
installation path of C:\apps\Avaya\IC61\apps\interaction_center

Size of agent installer directory

Select a network share or web location with at least 110MB of available disk space for 
each agent installer directory.

Installer directory availability

Make sure that each web server or network machine is online when you run the Agent Site 
Preparation wizard.

Location for Avaya Agent installation

Select the directory path for the Avaya Agent installation on the desk top machines.

Size of Avaya Agent installation directory

Make sure that the agent desktop machines have at least 350 MB of available disk space. 
Approximately 220 MB of the required available space must be in a temp directory. The 
agent installer deletes the files in the temp directory when you reboot the agent machine.
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IIS Web servers

If your Avaya IC system uses IIS and you plan to place the agent installer on a Web server, 
you must create a separate virtual directory in IIS for the agent installer. The agent installer 
requires different permissions than the virtual directory used by the Avaya IC server 
applications.

The IIS virtual directory used by the agent installer must have the following properties:

After you create the IIS virtual directory, review the Properties of the directory and confirm 
that the value of the Execute Permissions field is Scripts only (not Scripts and 
Executables).

Solaris server machine

If you plan to host agent installer on a Solaris machine, run the Agent Site Preparation 
wizard on a Windows machine, then transfer the files to the Solaris machine.

Telephone settings for Outbound Contact

Configure the telephone to auto-answer for all agents who will work with Outbound Contact 
in predictive mode.

Required information for the Agent Site Preparation wizard
Before you complete the required information, you must know how many different agent 
configurations your contact center requires. If you must create multiple agent 
configurations, you must run the Agent Site Preparation wizard for each configuration. 

You must plan your agent desktop configuration before you run the Agent Site Preparation 
wizard. The tables in each section provide examples of the kind of planning and 
information that you must complete before you run the Agent Site Preparation wizard. You 

Property Recommended entry

Alias AgentInstaller

Directory Path to the location of the agent installer. For example, 
C:\Program Files\Avaya\IC613\AgentInstaller

Access Permissions Check the following boxes:
● Read
● Run scripts (such as ASP)
Caution: Do not check the following box: 
Execute (such as ISAPI applications or CGI). 
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can fill out your configuration information in these tables, or create similar tables of your 
own.

This section includes the following topics:

● Path for agent installers on page 358.

● Directory on agent desktop on page 358.

● Applications to be installed on page 359.

● Switch type on page 360.

● Automatic updates on page 360.

● Automatic reboot on page 360.

Path for agent installers

The directory path for the folder where you place the agent installer and configuration data 
for each agent configuration. 

The default directory is: C:\Program Files\Avaya\IC61\AgentInstaller. You can 
copy the installation files to another location, such as a Web server, after you create the 
agent installer. If you intend to make the Agent Installer available on a Web server, create a 
virtual directory that points to the installation directory for each agent configuration. 

Directory on agent desktop

The name and directory path for the agent configuration on each agent desktop. Use a 
drive and directory that is valid on all agent desktop machines. The agent installer will 
present this directory to all agents during the installation. If desired, you can let agents 
override the default installation directory and select their own installation directory.

Agent Configuration Path to Installer
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For example, the default directory and path for installing agent desktop applications is: 
C:\Program Files\Avaya\IC61\

Applications to be installed

The agent applications that you plan to include in each agent configuration. With a single 
configuration, check the desired applications in the following table. With multiple 
configurations, write the name of each configuration group that uses an application. For 
more information about the applications that are available for agent desktops, see IC 
Installation Planning and Prerequisites.

Agent Configuration Directory Path Override?

Agent Applications Agent Configurations

Contact-based CallCenterQ

Contact-based CallCenterQ for 
Consumer Relations

Request-based CallCenterQ

Request-based CallCenterQ for 
Consumer Relations

CustomerQ

HRQ

Report Wizard
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Switch type

If your Avaya IC system includes Telephony, you must know the type of telephony switch 
used in your contact center. 

Automatic updates

Update agent configurations to the latest version whenever agents log in. For more 
information, see Configuring automatic updates for agent applications on page 376.

Automatic reboot

Whether the agent desktop machine will automatically reboot when the installation is 
complete.

ListQ

Custom application, such as Siebel 
Report Wizard

Agent Applications Agent Configurations

Agent Configuration Automatic Updates?

Agent Configuration Automatic Reboot?
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Running the Agent Site Preparation wizard
Repeat this entire procedure for each agent configuration that you must create.

! CAUTION:
CAUTION: The InstallShield application used for the Agent Site Preparation Wizard fails 

if you use the Back button when you select whether to use the Web server 
or network drive installation. If the Agent Site Preparation Wizard fails, 
delete all InstallShield temporary files from the %TEMP% directory and re-run 
the Agent Site Preparation Wizard.

By default, the Agent Site Preparation Wizard places the agent installer in a directory path 
that includes IC613 to ensure that you do not overwrite an IC 6.1 version of the agent 
installer. The default directory path is C:\Program Files\Avaya\IC613\AgentInstaller. 
By default, the agent installer places the agent desktop applications in a directory path that 
includes IC 6.1, to ensure that the agent applications are correctly updated.

To run the Agent Site Preparation Wizard:

1. Log in to the machine as an Administrator or user with administrator privileges and 
insert the Avaya Interaction Center 6.1.3 CD-ROM.

2. Select Agent Site Preparation Wizard.

3. In the Welcome window, select Next.
4. In the Avaya Agent Installation Area window, accept the default or type the path to 

the directory where you want to install the agent installer files. Select Next.
The default directory is: C:\Program Files\Avaya\IC613\AgentInstaller. If 
you do not want to use the default directory and do not know the path to the correct 
directory, select Browse and navigate to the desired location. If the directory is on a 
network drive, you must map that directory on the current machine.

5. In the Avaya Agent Installation Folder window, accept the default, or type the 
directory where the agent installer installs the application files on each agent desktop. 
Select Next.
The default directory and path is: C:\Program Files\Avaya\. To use a different 
directory, select Browse and navigate to the desired location.

Agent Configuration Automatic Reboot?
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Note:
Note: Do not use apps in the installation path for agent desktop applications. If 

you do, the -d parameter cannot locate the apps directory and start the 
application.

6. In the Installation Folder Override window, shown in the following figure:

a. Select one of the options in the following table:

b. Select Next.

Option Purpose

Yes, allow agents to choose an 
alternate folder

To allow agents in this configuration to 
choose an alternate folder in which to 
install the agent application files.

No, always use the pre-defined 
folder

To ensure that you know where 
agents in this configuration install their 
agent application files.
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7. Select the agent desktop applications required by agents who use this configuration in 
the Default Business Applications window, shown in the following figure. Select 
Next.

8. In the Custom Business Applications dialog box, select one of the buttons in the 
following table:

9. In the Custom Business Applications screen, shown in the following figure, if you 
chose to include a custom Business Application in your agent installer:

a. Complete the fields as shown in the following table:

Button Purpose

Yes To add a custom Business Application.

No To proceed to the next step without adding a custom 
Business Application.

Field Recommended entry

DB Name Type the name of the database that you created for 
your custom application.

Shortcut Type the name to give to the shortcut in the Start 
menu on the agent desktop machine.
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b. Select Next.
The Site Preparation wizard allows you to select another custom Business 
Application. If you must include a second custom Business Application, repeat steps 
8 and 9.

10. Select the type of phone switch to use with Avaya Agent in the Phone Switch window, 
shown in the following figure.

If this configuration does not include Telephony, select None.
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11. In the Avaya Agent Automatic Update window, shown in the following figure:

a. Select one of the options in the following table:

b. Select Next.

12. In the Query Reboot window:

a. Select one of the options in the following table:

b. Select Next.

Option Purpose

Yes, allow Avaya Agent to 
perform updates automatically

To have Avaya Agent automatically 
check for and apply updates each 
time an agent logs in.

No, updates will be done 
manually

To require agents to apply updates 
manually when you notify them that an 
update is available.

Option Purpose

Yes, offer the agent the choice 
to reboot now or later

To allow an agent to choose to 
continue with the previous 
configuration and install the update at 
a later time.

No, reboot after informing the 
agent that a reboot will occur

To force a reboot and install the 
update immediately.
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13. In the Citrix Server window, shown in the following figure, select one of the options in 
the following table.

The Agent Site Preparation Wizard creates the agent installer.

14. Select Finish in the Site Prep Wizard Complete window to complete the installation.

Copying the server implementation file
The agent installer requires access to the vesp.imp server implementation file from the 
machine that hosts the primary ORB server. You must copy this file to a location where the 
agent installer has access.

To copy the server implementation file.

1. Navigate to the following directory where the vesp.imp file is located:

IC_INSTALL_DIR\IC61\etc

2. Copy the vesp.imp file to the following directory on the machine that hosts the agent 
installer: 

IC_INSTALL_DIR\IC61\AgentInstaller\config

Note:
Note: Do not copy the vesp.imp file to the IC_INSTALL_DIR\IC61\bin 

directory. The vesp.imp file cannot function properly from this directory.

Option Purpose

Yes If the Avaya IC agent desktop applications will be 
hosted on a Citrix server.

No If the Avaya IC agent desktop applications will be 
hosted on an agent workstation.
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Mapping a virtual directory to a Web server installation 
directory

If you selected a location on a web server in the Agent Site Preparation wizard, you must 
map a virtual directory for each agent installer directory. 

To map the virtual directory to an agent installer directory, complete the steps in one of the 
following topics, depending on which operating system and Web server you use in your 
Avaya IC system:

● Mapping a virtual directory to an agent installer directory on Windows on page 367

● Mapping a virtual directory to an agent installer directory on Solaris on page 368

● Mapping a virtual directory to an agent installer directory on AIX on page 369.

Mapping a virtual directory to an agent installer directory on Windows

Repeat these instructions for each Web site agent installer that you create with the Agent 
Site Preparation wizard.

To map a virtual directory to an agent installer directory on Windows:

1. In IIS Internet Service Manager, select a Web site, such as Default Web Site.

2. Right-click on the Web site and select New > Virtual Directory.

3. Complete the Virtual Directory Creation wizard, as shown in the following table:

4. Repeat these instructions for each Web site agent installer you created with the Agent 
Site Preparation wizard.

Field Recommended entry Description

Alias Type a name for the virtual 
directory. 

Use the same naming 
convention as for directories. 
For example, AgentInstaller.

Directory path Type or navigate to the 
directory where the Agent 
Site Preparation wizard 
placed the agent installer. 

The default directory is: 
C:\Program Files\Avay
a\IC61\AgentInstaller

Permissions Check the desired access 
permissions for the virtual 
directory.

CAUTION: Do not give 
Execute permissions. If an 
agent exercises Execute 
permission, the executable 
runs on the server, cannot 
connect to the client 
machine, and can cause 
serious resource problems.



Configuring agent applications

368 Installation and Configuration

Mapping a virtual directory to an agent installer directory on Solaris

If you selected a location on a web server in the Agent Site Preparation wizard, you must 
map a virtual directory for each agent installer directory. A sample virtual directory entry 
has been provided in a commented-out line in the obj.conf file of your Web server.

Repeat these instructions for each Web site agent installer that you create with the Agent 
Site Preparation wizard. 

To create more than one virtual directory on the same web server, duplicate the virtual 
directory stanza in the obj.conf file and update with that information.

You can use Sun ONE�s administrative interface to create this virtual directory. However, 
check your obj.conf file to make sure the virtual directory has a similar format to the 
example virtual directory.

! Important:! Important:
Important: The Configuration Tool overwrites the contents of the obj.conf file. If you 

host the agent installer on an Avaya IC Website, you must reconfigure 
obj.conf every time you run the Configuration Tool.

To map a virtual directory to an agent installer directory on Solaris:

1. Open the following file:

<Sun_ONE_install_dir>/servers/https-<server_name>/config
/obj.conf

Note:
Note: To create more than one virtual directory on the same Web server, duplicate 

the virtual directory section in the obj.conf file and update the duplicate 
stanza with the information below.

2. Scroll down to the following line: 

#AgentGuard#NameTrans fn="pfx2dir" from="/AgentInstaller" 
dir="IC_INSTALL_DIR/IC613/AgentInstaller" name="send_exe"

3. Make the following changes to that line:

a. Delete #AgentGuard#

b. Replace /AgentInstaller with the name of the virtual directory that you 
specified in the Agent Site Preparation wizard.

c. Replace IC_INSTALL_DIR/IC613/AgentInstaller with the correct path to the 
agent installer files.

4. Check the desired access permissions for the virtual directory.
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! CAUTION:
CAUTION: Do not give Execute permissions. If an agent exercises Execute permission, 

the executable runs on the server, cannot connect to the client machine, and 
can cause serious resource problems.

5. If desired, perform one of the steps in the following table to restrict access to the agent 
installer:

6. Save and close the obj.conf file.

Mapping a virtual directory to an agent installer directory on AIX

If you selected a location on a Web server on an AIX machine, map a virtual directory for 
each agent installer directory. The obj.conf file includes an entry for a sample virtual 
directory. 

Repeat these instructions for each Web site agent installer that you create with the Agent 
Site Preparation wizard. 

To map a virtual directory to an agent installer directory on AIX:

1. In a text editor, such as Notepad, open 
IC_INSTALL_DIR/IC61/etc/ictomcat.cfg 

2. Scroll down to the following lines 

#Begin Agent installer configuration 
# Uncomment the following lines  and add the IP address of the 

Access Restriction Steps

Restrict access by IP To restrict access by IP:
1. Remove #AgentGuard# from the following:

- #AgentGuard#<Client 
ip="your_host_ip_range">

- #AgentGuard#</Client>
2. Replace your_host_ip_range with the 

desired IP range.

Restrict access by domain To restrict access by domain:
1. Remove #AgentGuard# from the following:

- #AgentGuard#<Client 
dns="*.your_domain">

- #AgentGuard#</Client>
2. Replace *.your_domain with the desired 

domain.
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client machines - 
# in allow list to grant access to the AgentInstaller download 

#Alias /AgentInstaller  "%AVAYA_IC_HOME%/AgentInstaller 

#<Location /AgentInstaller> 
#    order deny,allow 
#    deny from all 
#    allow from  IPADDRRESS1 IPADDRESS2 
#</Location> 

#End Agent installer configuration 

3. Uncomment the 6 lines from the following sections:

● Alias

● <Location ....</Location>

4. Replace the following entries with the IP addresses of the client machines that you 
want to have access to the agent installer on the Web server:

● IPADDRRESS1

● IPADDRESS2

To add additional IP addresses or the fully-qualified domain names of the client 
machines, separate the entries with spaces. You can use wildcards in the entries.

5. Save and close the ictomcat.cfg file.

Preparing for installation by agents
As you complete these procedures, refer to the following table for the directories and files 
in the Avaya Agent installer directory.

Directory Contents

<agent_installdir>\config This directory contains the files that agents install 
to update Avaya Agent.

<agent_installdir>\update This directory contains updates that you make 
available to the agent applications.



Preparing for installation by agents

Issue 2.0 June 2004 371

To prepare an agent installer for installation by agents, perform the steps in the following 
topics:

1. Testing the agent installer on page 371.

2. Creating installation instructions for agents on page 375.

3. Configuring automatic updates for agent applications on page 376.

Testing the agent installer
You must test the agent installer to make sure that:

● The agent installer works properly.

● The correct installation options are available for agents when they install the agent 
configuration.

● The agents can access the agent installer through a shared network drive.

Note:
Note: Before you install Avaya IC agent applications, configure all agent 

workstations with restore points. The agent installer replaces some system 
files during the installation. If software conflicts arise, restore points allow 
easy rollback after you uninstall Avaya IC. See the Windows documentation 
or third-party guides for procedures on enabling such functionality.

To test the installation, perform the steps in the following topics, according to where you 
placed the agent installer:

● Testing the agent installer from a network drive on page 372

● Testing the agent installer from a Web server on page 374

<agent_installdir>\default.
htm

If you store the installation files on a Web site, 
this file is the Web page that an agent sees. You 
can modify this file to add custom notes and 
instructions for your agents. By default, this page 
contains only a link to the AgentInstaller.exe file.

<agent_installdir>\AgentIns
taller.exe

The executable that runs the installation of an 
agent configuration on the machine of any agent 
who clicks on the mapped URL.

Directory Contents
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Testing the agent installer from a network drive

If you placed the agent installer on a shared network drive, you can have agents copy the 
folders to their machines, or run the agent installer across the network. 

If the agents will run the agent installer across the network, they must be able to access the 
shared network drive from their machines. Agents cannot use the Run dialog box on the 
Start menu to run the agent installer. 

! Important:! Important:
Important: The Back button can cause unpredictable results. If you use the Back 

button and the agent installer adds garbage characters to the fields in the 
window, delete those characters and re-type the correct information.

To test the agent installer from a network drive:

1. Close down all Windows applications.

2. Use Windows Explorer to navigate to the folder, then double-click 
AgentInstaller.exe.

The agent installer verifies the agent�s operating system and browser. If the computer 
is missing the required version of either, the installation terminates with a warning to 
the agent. If the supported operating system includes a service pack that is later than 
the service pack certified by Avaya, the agent installer issues a warning and asks if you 
would like to continue.

The agent installer also checks whether the computer already has Avaya IC agent 
applications installed. If Avaya IC files already exist, the agent installer warns you.

The agent installer extracts the files, then starts the installation.
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3. In the Select Access Method window, shown in the following figure:

a. Select Network Share. 

b. Select Next.

4. Type the path to the directory where you placed the agent installer in the Agent 
Installation Network Location window. Select Next.
If you do not know the location of the agent installer, select Browse to navigate to the 
directory.

5. If the agent configuration allows the agent to override the default installation folder, 
accept the default location in the Agent Installation Folder window or browse to an 
alternate location. Select Next. 
The agent installer installs the agent desktop applications on the target machine.

6. After the installation completes, the agent installer prompts you to either: 

● Choose whether to reboot the machine now, then select Finish.

● Select OK in a window that states that the machine is about to restart.

After the machine reboots, the installer registers all necessary DLLs and OCXs.
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Testing the agent installer from a Web server

! CAUTION:
CAUTION: Do not run the agent installer across the network from a Web server. The 

installer does not function correctly across the network.

The Back button can cause unpredictable results. If you use the Back button and the 
agent installer adds garbage characters to the fields in the window, delete those characters 
and re-type the correct information.

To test the agent installer from a web server:

1. Close down all Windows applications.

2. Start the agent installer:

a. Use an internet browser to navigate to the following URL:

http://<machine_name>.<domain_name>/<Agent_Installer_Virtual_Direc
tory>/default.htm

b. When the default page opens, select Install Avaya Agent.
c. Select Save to file and save the agent installer to the agent desktop. 

d. After the agent installer downloads to the desktop, select Open to run the agent 
installer.

The agent installer verifies the agent�s operating system and browser. If the 
computer is missing the required version of either, the installation terminates with a 
warning to the agent. If the supported operating system includes a service pack that 
is later than the service pack certified by Avaya, the agent installer issues a warning 
and asks if you would like to continue.

The agent installer also checks whether the computer already has Avaya IC agent 
applications installed. If Avaya IC files already exist, the agent installer warns you.

3. If you see a Security Warning window that asks if you want to install and run 
Agent.exe, select Yes.

The agent installer extracts the files, then starts the installation.

If the Installation Folder Override was enabled during the running of the Agent Site 
Preparation wizard, the Avaya Agent Installation Folder screen is displayed. 

4. In the Select Access Method window, shown in the following figure:

a. Select Web Server.
b. Select Next.

5. Type the URL to the web server where you placed the agent installer in the Agent 
Installer Web Address window. Select Next.
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6. If the agent configuration allows the agent to override the default installation folder, 
accept the default location in the Agent Installation Folder window or browse to an 
alternate location. Select Next. 
The agent installer installs the agent desktop applications on the target machine.

7. After the installation completes, the agent installer prompts you to either: 

● Choose whether to reboot the machine now, then select Finish.

● Select OK in a window that states that the machine is about to restart.

After the machine reboots, the installer registers all necessary DLLs and OCXs.

Creating installation instructions for agents
Follow these steps to send the URL or directory path and other instructions to all agents 
who must install a specific agent configuration.

To send instructions to your agents:

1. Create instructions for agents that include the following:

● URL to the web server directory or directory path to the network drive

● Instructions to close all applications before starting the installation

● Instructions not to use the Back button in the agent installer, as the Back button can 
cause unpredictable results

● Instructions to delete garbage characters from fields, if Back button used, and re-
type the correct information

● Any other special instructions, such as whether they can select their own installation 
directory or can choose to reboot the machine at a later time

● The name of a person to contact if they have problems

2. If you placed the agent installer on a web server, you can customize default.htm in 
an HTML Editor or a text editor, such as Notepad, with any information or instructions 
you want to provide to the agents. You can find default.htm in the Agent Installer 
virtual directory.

3. If you are installing the localized version of Avaya IC, you must include instructions for 
the agents to apply the language packs. You can install the language packs through an 
automatic update. For more information, see Configuring automatic updates for agent 
applications on page 376.
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Configuring automatic updates for agent 
applications

Avaya IC allows you to make different types of updates to agent desktop applications. If 
you enable more than one type of update, Avaya IC applies the updates in the following 
order:

Language pack updates - Install updated language packs for all supported languages

Service pack updates - Install updated application files on the agent desktop

Point patch updates - Install patch updates to the application files

Note:
Note: For any type of automatic update to work correctly, the agents must have 

Read access to the version.html file and to the updates. For example, if 
you install the language pack update on a network server, each agent that 
logs in must have Read permissions for the directory. 

If you enabled Automatic Updates in the Agent Site Preparation wizard:

1. When an agent logs in, Avaya IC reads the version.html file from 
<agent installdir>\config.

2. Avaya IC compares the values for the following fields against the values in the agent 
machine�s registry at HKLM\Software\Avaya\IC\6.1\Agent:

● majorversion
● minorversion
● patchversion
● servicepackversion
● languagepackversion

3. If the following is true, then Avaya IC invokes the automatic updates:

● Value of icagent in the version.html file is "1" 

● Values for majorversion and minorversion in the downloaded 
version.html file on the agent machine match the values in the agent registry

● Values for patchversion, servicepackversion, or languagepackversion 
are greater than the values in the agent registry

4. When the automatic update is invoked: 

a. A message is displayed to the agent.

b. The agent application exits.

c. Avaya IC updates the agent applications on the agent desktop.
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Updating the version.html file
You must update the version.html file in the agent installer directory with new values to 
invoke automatic updates of the agent applications. The version.html file contains the 
following fields. You can update the highlighted section.

To update the version.html file:

1. Open the version.html file in a text editor.

2. In the version.html file, increase the value of one or more of the fields as shown in 
the following table by one. For example, if the value of a field is currently 1, increase 
the value to 2.

Do not change the majorversion and minorversion values unless specifically 
instructed.

<versioninfo>
<remote>

<client>
<icagent enabled="1" majorversion="6" minorversion="0" patchversion="0"
patchpath="%VALUE%" servicepackversion="0" servicepackpath="%VALUE%"
languagepackversion="0" languagepackpath="%VALUE%"/>

</client>
<server>
</server>

</remote>
<local>

<client>
<icagent regkeyname="Agent"/>

</client>
<server>
</server>

</local>
</versioninfo>

Field Purpose

languagepackversion Increase the value of this field for a 
language pack update.

servicepackversion Increase the value of this field for a service 
pack update.

patchversion Increase the value of this field for a patch 
update.
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3. In the version.html file, type the location of the agent installer files in one or more of 
the following fields. The shared network directory or Web site must be available from 
the agent desktop.

Avaya IC checks this field before it downloads the files from that location. If the URL or 
network directory is not valid, an error message is displayed to the agent. After the 
agent selects OK, the agent applications are launched without being updated.

4. Save the version.html file.

5. Repeat these steps for every Avaya Agent configuration.

Temporarily disabling automatic updates
In some cases, you may want to disable your Automatic Update option temporarily and 
allow agents to log in without waiting for the Automatic Update to complete.

To disable Automatic Updates:

1. Open the version.html file in the <agent_installdir>\config directory.

2. Change the value of the icagent enabled field to 0. 

3. Save the file.

Field Purpose

languagepackpath Type the location in this field for a language 
pack update.

servicepackversion Type the location in this field for a service 
pack update.

patchversion Type the location in this field for a patch 
update.
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Cautions and tips for creating agent accounts
You must create an account in IC Manager for all agents, supervisors, and other Avaya IC 
users. Each agent and other user account requires that you configure permissions, media 
channels, and other requirements for the account. 

This manual contains only the information that you require to create agent and other user 
accounts for testing, including the minimal permissions and configuration settings. For 
more detailed information, see IC Administration Volume 2: Agents, Customers, & Queues.

This section includes some important cautions and tips that you need to consider when 
you create agents for your Avaya IC system. Before you plan the tenants, workgroups, and 
agents that you need for your production system, carefully review the information in IC 
Administration Volume 2: Agents, Customers, & Queues.

This section includes the following topics:

● Systems with Business Advocate and Outbound Contact on page 379.

● Agent domains on page 379.

● Agent workgroups and tenants on page 380.

● Agent login IDs on page 380.

Systems with Business Advocate and Outbound Contact
If your Avaya IC system includes agents that use Business Advocate and Outbound 
Contact, each of those agents must have a separate login for Business Advocate and for 
Outbound Contact. The agent cannot use both components simultaneously.

Agent domains
All Avaya IC agent accounts must belong to a User domain. You must create all User 
domains before you create your agents. If you create agents first, you must assign all 
agents to the Default domain, and then create the User domains and reassign the agents. 

If your User domain does not include a secondary ORB server, the domain must failover to 
a domain that includes an ORB server, such as the Default domain.
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Agent workgroups and tenants
Avaya strongly recommends that you organize your agent population into sets of tenants 
and workgroups that mirror the organization of your contact center. A tenant is a set of 
workgroups that fulfill a particular business function. You can use tenants to define the 
security and administrative boundaries around data, queues, and content resources. A 
workgroup is a set of agents or queues that form a logical grouping. 

A workgroup can only belong to one tenant. However, you can share agents across 
tenants by assigning them to multiple workgroups. If you use workgroups, you must create 
workgroups and tenants before you create agents. 

Tenants, workgroups, and agents inherit properties from parent to child entities. By default, 
if you assign a property value to a tenant, the workgroups in that tenant inherit that 
property value from the tenant, and the agents in the workgroups inherit the property value 
from the workgroups. When you assign agents to workgroups, and workgroups to agents, 
you can specify the order of inheritance. The inheritance order controls which property 
value IC Manager uses for an agent if an entity inherits multiple values for the same 
property.

Agent login IDs
Each agent must have a separate and unique login ID. 

To monitor multiple devices, the agent or supervisor can login to more than one 
workstation simultaneously. However, Avaya does not recommend simultaneous logins 
with the same login ID. Avaya recommends that the agent or supervisor uses a separate 
login ID for each machine.

! Important:! Important:
Important: Simultaneous logins with the same login ID can impact migration scripts.

Avaya IC does not recommend:

● Two agents logging in with the same login ID.

● One agent simultaneously logging in to more than one machine with the same login ID.
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Creating test agents
You must create at least one test agent account to make sure that your Avaya IC system 
handles tasks correctly. This test agent account should be in the User domain. Your Avaya 
IC system includes a preconfigured User1 domain. 

Add a test agent to each User domain, and configure the agent to handle the media 
channels in the Avaya IC system.

Agents can belong to multiple workgroups. However, all agents who work in Web 
Management and Email Management must have the Default workgroup as their primary 
workgroup. 

The procedures in this section contain information on how to set basic properties for agent 
accounts, so you can test your system. If you want to set additional properties for your test 
agents, see IC Administration Volume 2: Agents, Customers, & Queues.

To create a test agent, perform the tasks in the following topics:

1. Creating a test agent account on page 381.

2. Configuring the media channels for a test agent on page 383.

3. Setting properties for a test agent on page 386.

Creating a test agent account
To create a test agent account:

1. In IC Manager, select the Agent tab.

2. Expand the DefaultTenant node in the left pane.

3. Select Agent > New.

4. Select the General tab and complete the fields as shown in the following table:

Field Description

First Name Required field
Type agent�s first name.

Last Name Required field
Type agent�s last name.

Preferred Name Required field
Type agent�s preferred name.

Employee ID Type the agent�s company employee ID (if available).
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5. In the System Information group of the General tab, complete the fields as shown in 
the following table:

Domain Required field
Select domain for the agent from the list.
Note: If the agent will handle chat contacts, the agent 
domain must failover to the domain that includes the 
Paging server.

Site Select a site from the drop-down list.
Note: Avaya IC uses the Site to compile statistics for 
groups or agents or queues.

Field Description

Login ID Required field
Type a login ID that the agent uses for all Avaya IC 
applications.
Each agent account must have a separate and unique 
login ID. For more information, see Agent login IDs on 
page 380.

Options 1. Select the Ellipsis (�) button next to Options.
2. Check the User Addressable box to make the 

agents visible for transfers. 
3. Select OK.

Task Load Required field
Set this field to no more than 6 concurrent tasks.
Use the arrow keys to set the maximum number of 
contacts that the agent can handle concurrently. These 
contacts can come from any of the media channels used 
by the agent.
For example, if you plan to configure the test agent to 
use Email and Voice media channels, and to set the task 
load on Email to 2 and the task load on Voice to 1, set 
this Task Load property to 3.

Task Ceiling Required field.
Use the arrow keys to set the limit of the task load across 
all of the media channels. The task load must be less 
than or equal to the task ceiling.
Note: The Task Load can vary according to your system 
conditions, such as number of tasks, agents, or time of 
day. The Task Ceiling is an upper limit on the Task Load.

Field Description



Creating test agents

Issue 2.0 June 2004 383

6. In the Membership Information group of the General tab, complete the fields as 
shown in the following table:

Tip:
Tip: If you want this agent to be a Supervisor who can monitor chats between 

other agents and customers, configure this agent as the Supervisor for the 
Workgroup.

7. Select the Security tab and complete the fields as shown in the following table to set 
agent security:

8. Select OK.

Configuring the media channels for a test agent
When you set Task Load and Task Ceiling for the media channels, make sure that:

● The total of all Task Load values does not exceed the Task Load that you set for the 
agent on the General tab

● The total of all Task Ceiling values does not exceed the Task Ceiling set on the General 
tab

Field Recommended entry

Domain Required field
Select your User domain from the drop-down list.

Workgroup 1. Select the Ellipsis (�) button next to Workgroup.
2. Expand the DefaultTenant node in the Workgroups list. 
3. Select the Default workgroup.
4. Select >> to add the agent to the Default workgroup.
5. Select OK.

Site Select a site from the drop-down list.
Note: Avaya IC uses the Site to compile statistics for groups 
or agents or queues.

Field Recommended entry

Password Type the password that the agent uses to log in to Avaya IC 
applications. 
For example, type agent1.

Confirm Type the password a second time to confirm.

Roles Check one or more boxes to select the agent�s security level.
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This step continues from the previous step and assumes that the agent account remains 
open in IC Manager.

To configure the media channels for a test agent:

1. Select the Channels tab.

2. To enable the agent to receive chat contacts and voice chat contacts:

a. Select Chat from the Channel drop-down list.

b. Complete the fields as shown in the following table:

c. Select Apply.

3. To enable the agent to receive email contacts:

a. Select Email from the Channel drop-down list.

b. Complete the fields as shown in the following table:

c. Select Apply.

Field Recommended entry

Disable Chat 
Channel

Clear this box.

Task Load Set the maximum number of chat contacts an 
agent can handle at one time.

Task Ceiling Set the maximum value for the chat Task Load.

Field Recommended entry

Disable Email 
Channel

Clear this box.

Show Full Headers Check this box if you want the agent to see the 
full header of each email contact.

From Address Type the email address that you want recipients 
to see in emails from this agent.

Task Load Set the maximum number of email contacts an 
agent can handle at one time.

Task Ceiling Set the maximum value for the email Task Load.
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4. To enable the agent to receive voice contacts, send outbound voice contacts, or 
receive voice chat contacts:

a. Select Voice from the Channel drop-down list.

b. Complete the fields as shown in the following table:

c. Select Apply.

5. Select the General tab. 

Field Recommended entry

Disable Voice 
Channel

Clear this box.

Phone ID Type the logical extension number for the agent�s 
phone. For example, type 34181.

Password Type the password for agent login to the ACD.

Phone Type Type the type of phone that the agent uses.
The switch requirement for agent login 
determines the phone type. Some supported 
switches support both phone types. Other 
supported switches only support one phone type.
● Type EAS if the configuration controls the 

queue structure. You can only type EAS for 
Avaya DEFINITY/Communication Manager, or 
Aspect.

● Type ACD if the switch requires a queue. You 
can type ACD for all supported switches.

Equipment Type the physical extension number for the 
agent�s phone. 
For example, type 24181.

Queue Type the default voice queue for this agent.

Task Load Set the maximum number of voice contacts an 
agent can handle at one time.

Task Ceiling Set the maximum value for the voice Task Load.
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6. Select the Email tab in the center of the General tab.

a. Complete the fields as shown in the following table:

7. Select OK.

Setting properties for a test agent
You must configure a minimum number of agent properties for your test agents to ensure 
that the agent applications function correctly. For information about the remaining agent 
properties or how to enable other features, see IC Administration Volume 2: Agents, 
Customers, & Queues.

If you want your agent desktop applications to include wrapup functionality, configure 
agents for wrapup and create reason codes. For more information, see IC Administration 
Volume 2: Agents, Customers, & Queues.

To prevent access to Avaya IC by unauthorized users, agents are assigned passwords that 
are required when they log into Avaya IC.

Tip:
Tip: Password requirements (such as the required length and duration) are 

controlled by the properties in the Agent/Security section. For information 
about these properties, see Agent/Security on page 388.

Field Recommended entry

Primary Type the email address assigned to the agent by 
the contact center. This address is configured at 
the mail server.
If you specify that the agent is user addressable 
on the System tab, Avaya IC lists this email 
address for the agent in the Agent Directory.

Internal Type the email address assigned to the agent for 
internal email messages only. This address is not 
intended to be used outside of the contact center.

Personal Type the email address assigned to the agent for 
personal, non-business communication from the 
agent.

Mobile Device Type the email address assigned to the agent for 
use with their mobile device.
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Set the properties in the following table for your test agents. Follow the steps in the 
following topics to apply these properties to agents:

● Setting global properties for all agents on page 389

● Setting properties for individual agents on page 389

For information about properties for Outbound Contact, see Configuring agents for 
Outbound Contact on page 390.

Section Property Recommended 
entry

Notes

Agent UILanguage Select a language 
code from the drop-
down list.

Specifies the language in 
which the agent desktop 
displays the interface of 
the agent application. For 
more information, see 
Setting language 
properties for agents on 
page 551.

Agent/Desktop ScreenPopEnabled Yes Allows agents to receive 
screen pops.

WrapupEnabled Yes Allows agents to wrapup 
contacts.

Layout Leave blank if you 
do not want this 
agent to use Avaya 
Agent.
Default layout is 
avaya_agent_en

Specifies the Avaya Agent 
layout. If your Avaya IC 
system includes a 
customized Avaya Agent 
layout, type the name of 
that layout. 
If you type a layout here, 
you must include an Avaya 
Agent with all agent 
applications used by this 
agent, including Report 
Wizard.
Note: Do not include the 
.cdl extension.

Agent/Desktop/Directory ShowAgentsOn
Startup

Yes Adds agents to the Unified 
Agent Directory

Agent/Desktop/
ScreenPop

PopOnAllArrivingCo
ntacts

Yes

PopOnContactActiva
tion

Yes
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Agent/Desktop/Prompter WrapupFlowset prompter The name of the flow set 
that includes the Prompter 
wrapup workflow. 
For example, the name of 
the sample Prompter flow 
set is prompter.

WrapupFlow wrapup The name of the wrapup 
workflow.
For example, the name of 
the sample Prompter 
workflow is 
sample_wrapup.

Agent/Desktop/WrapupD
ialog

DefaultCategory
Group

CategoryGroup1

DefaultTenant DefaultTenant

Agent/Desktop/WAC HomeDir Installation 
directory for the 
agent.

Ensures that the Web 
Agent is visible in the 
agent desktop. Required 
for the chat and email 
channels.

Agent/Security PasswordChange
Duration

30 The maximum number of 
days during which an 
agent can use his or her 
password. After this limit is 
exceeded, Avaya IC forces 
the agent to change their 
password the next time 
that they log in.
To let agents keep the 
same password all the 
time, set this property to 0 
(zero).
Note: By default, Avaya IC 
does not track what 
passwords an agent has 
used in the past. Therefore 
agents can reuse 
passwords as desired.

Section Property Recommended 
entry

Notes
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Setting global properties for all agents

To set global properties that affect all test agents in Avaya IC:

1. In IC Manager, select Tools > Groups.

2. Select the Properties tab.

3. Select the IC node in the left pane.

4. In the Sections list, select the desired property section.

If this property section does not exist, select Add Property and select that property 
from the Assign Property dialog box.

5. In the Edit Property dialog box, select the setting that you require for this property.

6. Select Apply.

7. Select OK.

Setting properties for individual agents

To set properties for individual test agents:

1. In IC Manager, select the Agent tab.

2. Double-click the agent in the list of agents.

3. Select the Properties tab.

4. In the Sections list, select the desired property section.

If this property section does not exist, select Add Property and select that property 
from the Assign Property dialog box.

5. In the Edit Property or Assign Property dialog box, complete the following fields:

a. From the Property drop-down list, select the desired property.

b. From the Property Value drop-down list, select the desired value.

c. Select OK.

6. Select Apply.

7. Select OK.
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Configuring agents for Outbound Contact
You must perform the steps in the following topics for each agent that works on Outbound 
Contact.

Perform the following steps to configure agents for Outbound Contact:

1. Defining agent skills for Outbound Contact on page 390.

2. Creating properties for Web scheduled calls on page 391.

3. Adding Outbound Contact properties for agents on page 392.

Defining agent skills for Outbound Contact
Outbound Contact uses the agent skills to:

● Match an agent to outbound jobs

● Specify an agent�s dialing mode

When an agent logs in, the agent can only see jobs that match the agent�s skills. If you 
want an agent to join a job, you must assign the required skills to the agent in IC Manager.

To define outbound skills:

1. In IC Manager, select the Agent tab.

2. Select Tools > Skills.

3. Confirm whether the Skills list includes the following outbound skills:

● Auto
● Predictive
● Preview

If the skills do not exist, repeat the following steps to add each skill:

4. Select New.

5. Type Outbound in the Add to Skills field.

6. Select Outbound.

7. Select New to add the following skills in the Add to Outbound Skills field.

● Auto
● Predictive
● Preview

8. Select OK.
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Creating properties for Web scheduled calls
If your Avaya IC system includes Web Scheduled Calls, you must configure Outbound 
Contact for that feature.

To create properties for Web Scheduled Calls:

1. In IC Manager, select Tools > Property Declarations.

2. Double-click System/Configuration in the Property Section list in the Property 
Declarations dialog box.

3. Select each Web Scheduled Call property and set the values in the following table:

4. Select OK in the Property Declarations dialog box.

Property Tab Name

WebServerPort Settings Check the following boxes under 
Applicable Property Levels:
● IC (Root node)
● Workgroups
● Individual Agents

Value Select New and add the following value:
● For Name, type 80.
● For Description, type Port value.

WebServerWebsite Settings Check the following boxes under 
Applicable Property Levels:
● IC (Root node)
● Workgroups
● Individual Agents

Value Select New and add the following value:
● For Name, type website.
● For Description, type Website value.

WebServerProtocol Settings Check the following boxes under 
Applicable Property Levels:
● IC (Root node)
● Workgroups
● Individual Agents

Value Select New and add the following value:
● For Name, type http.
● For Description, type Protocol value.
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Adding Outbound Contact properties for agents
You must add properties for all agents who work on outbound jobs for Outbound Contact. 
These steps assume that you have created all agents for your Avaya IC system in IC 
Manager.

To configure Outbound Contact properties for agents:

1. In IC Manager, select the Agent tab.

2. Double-click the agent in the list of agents.

3. Select the Channel tab and make sure Voice is enabled and configured for the agent.

If you have not enabled Voice, see Configuring the media channels for a test agent on 
page 383 and IC Administration Volume 1: Servers & Domains.

4. Select the Skills tab and perform the following steps:

a. Double-click each desired outbound skill in the left pane. 

b. Select Apply.

5. Select the Properties tab and perform the following steps:

a. In the Sections list, set values for the properties in the following table:

b. Select Apply.

6. Select OK.

Repeat these steps for each agent who will work with Outbound Contact.

Property Name Value

Agent\Desktop\ScreenPop PopOnAllArrivingContacts Yes

Agent\Desktop\Softphone SwapHeldEnabled Yes
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Configuring the Unified Agent Directory
The Unified Agent Directory contains resources for your contact center, including:

● Queues

● Agents

● Supervisors

● Subject Matter Experts

● Non-human resources, such as Interactive Voice Response units (IVRs)

You must configure queues and agents as Addressable if you want them to be visible in the 
Unified Agent Directory. For agents, set the ShowAgentsOnStartup property to be True to 
display the Directory tab in the Unified Agent Directory. Agents use the Directory tab to 
view individual agents in the contact center.

Agents can filter their view of the Unified Agent Directory to see only agents or queues that 
meet specified criteria. You can change this setting to force agents to view all of the agents 
and queues in your contact center, if desired. 

For information on how to set other properties related to the Unified Agent Directory, see IC 
Administration Volume 2: Agents, Customers, & Queues. For information on how to use 
the Unified Agent Directory, see Avaya Agent User�s Guide.

To configure the Unified Agent Directory, perform the steps in the following topics:

1. Configuring a Workflow server for the Unified Agent Directory on page 393.

2. Configuring agents for the Unified Agent Directory on page 395.

Configuring a Workflow server for the Unified Agent Directory
Configure every Workflow server in a user domain for the Unified Agent Directory. Without 
this configuration, agents may not be able to access the Unified Agent Directory and will 
not be able to transfer contacts to virtual queues.

! Important:! Important:
Important: After you create a virtual queue, to allow agents to transfer contacts to the 

new queues, do one of the following for every Workflow server in a user 
domains that runs workflows for the Unified Agent Directory: 

● Manually run the sys_transfer.update_vq_cache workflow

● Restart each Workflow server
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The following table describes the required configuration parameters for these Workflow 
servers.

The Avaya IC seed data includes these workflows. When you created the CCQ database, 
you imported the compiled workflows with the seed data and stored them in the database. 
However, you must still associate these workflows with the Workflow server.

If your Avaya IC system includes multiple Workflow servers, perform these steps on every 
Workflow server in a user domain and every Workflow server that handles agent searches 
and transfers between agents.

Tip:
Tip: In IC Manager, the New button that you use to add new items, such as new 

records to a table or new properties to a server or agent, is on the toolbar. 
The following figure shows the New button.

To configure the Workflow server for the Unified Agent Directory:

1. In the Server tab of IC Manager, double-click a Workflow server in a user domain.

2. Select the Workflow tab.

3. Confirm that the Workflow server includes the following required semaphore: 
agentsearch.update_searchresult

a. Select the Ellipsis (�) button next to Semaphores.

b. If the rows do not include the required semaphore:

● Select New.

● In the new row, type agentsearch.update_searchresult

● Select OK.

Configuration parameter Value

Semaphore agentsearch.update_searchresult

Synchronous Startup Flow ● sys_transfer.update_vq_cache
● sys_transfer.transfertovq

Startup Flow sys_agentsearch.update_agentstate_cache
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4. Confirm that the Workflow server includes the required synchronous startup flows:

a. Select the Ellipsis (�) button next to Synchronous Startup Flows.

b. If the rows do not include the following required synchronous startup flow: 
sys_transfer.update_vq_cache

● Select New.

● In the new row, type sys_transfer.update_vq_cache.

● Select OK.

c. If the rows do not include the following required synchronous startup flow: 
sys_transfer.transfertovq

● Select New.

● In the new row, type sys_transfer.transfertovq.

● Select OK.

5. Confirm that the Workflow server includes the following required startup flow:

a. Select the Ellipsis (�) button next to Startup Flows.

b. If the rows do not include the following required startup flow: 
sys_agentsearch.update_agentstate_cache

● Select New.

● In the new row, type sys_agentsearch.update_agentstate_cache.

● Select OK.

6. Select Apply.

7. Select OK.

8. Stop and restart the Workflow server. 

Repeat these steps for every Workflow server in a user domain.

Configuring agents for the Unified Agent Directory
To configure agents for the Unified Agent Directory, perform the steps in one of the 
following topics:

● Configuring all agents for the Unified Agent Directory on page 396

OR

● Configuring an agent for the Unified Agent Directory on page 396
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Configuring all agents for the Unified Agent Directory

Follow these steps to configure all agents for the Unified Agent Directory. 

To configure all agents for the Unified Agent Directory:

1. In IC Manager, select Tools > Groups.

2. Select the Properties tab.

3. Select the IC node in the left pane.

4. In the Sections list, select Agent/Desktop/Directory.

5. Select Add Property, and in the Assign Property dialog box: 

a. Select ShowAgentsOnStartup from the Property drop-down list.

b. Select Yes from the Property Value drop-down list. 

c. Select OK.

6. Select Add Property, and in the Assign Property dialog box:

a. Select WorkflowServerName from the Property drop-down list.

b. Type the name of the Workflow server that runs the workflows for the Unified Agent 
Directory in the Property Value field. 

You must enter the name of the Workflow server where you added the semaphore in 
Configuring a Workflow server for the Unified Agent Directory on page 393.

c. Select OK.

7. Select Apply. 

8. Select OK.

Configuring an agent for the Unified Agent Directory

Follow these steps to configure individual agents for the Unified Agent Directory.

To configure agents for the Unified Agent Directory:

1. In IC Manager, double-click the agent in the list of agents.

2. Select the Properties tab.

3. In the Sections list, select Agent/Desktop/Directory.

4. Select Add Property.
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5. In the Assign Property dialog box, select one of the following properties from the 
Property drop-down list, select the appropriate value from the Property Value drop-
down list, and Select OK. Repeat these steps for each property.

6. Select OK.

Property Recommended Property 
Value

Notes

ShowAgentsOnStartup Yes Adds the Directory Tab to the 
Unified Agent Directory.

ShowAgentState Yes Displays agent�s state in the 
Directory tree of the Unified 
Agent Directory.

ShowAllAgents Yes Shows the entire Directory tree 
for agents in the Unified Agent 
Directory.

SkillsSupport Yes Lets agents use skills as search 
criteria in the Unified Agent 
Directory.

TransferFlowName Type the name of the 
workflow that retrieves the 
destination from the virtual 
queue.

WorkflowServerName Name of the Workflow 
server that runs the 
workflows for the Unified 
Agent Directory.

Use the Workflow server where 
you added the semaphore in 
Configuring a Workflow server for 
the Unified Agent Directory on 
page 393.

UADStringFormat Select the desired string 
format.

Determines how agents are 
displayed in the Unified Agent 
Directory. When you choose a 
string format, the Unified Agent 
Directory displays the following 
information in IC Manager:
● Standard string format 

displays the Display Name for 
an agent.

● ASCII string format displays 
the Full Name for an agent.

● LoginID string format displays 
the Login Name for an agent.
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Configuring the Citrix integration
The Citrix client interface with the seamless window causes issues with the login behavior 
and the appearance of the Avaya IC agent desktop applications. Avaya provides two tools 
that prevent these potential issues. For more information, see IC Installation Planning and 
Prerequisites.

You do not need to perform additional steps if the Avaya IC uses the Citrix Web interface.

For this configuration, the Citrix integration requires some additional steps to ensure that 
the agents can connect to the agent desktop applications and that the agent desktop 
applications function correctly in the Citrix interface. 

This section includes the following topics:

● Installing the agent applications on the Citrix server on page 398.

● Locating the files for the tools on page 399.

● Configuring the Avaya Agent INI file on page 399.

● Configuring the Avaya IC Web browser tool on page 400.

● Configuring the executable tool on page 402.

For more detailed information about the Avaya IC tools and the Citrix integration with 
Avaya IC, see IC Installation Planning and Prerequisites.

Installing the agent applications on the Citrix server
To install the agent desktop applications on a Citrix server, follow the procedures in Testing 
the agent installer on page 371. You do not have to perform any additional steps during the 
installation.

Depending upon the environment, you may need to adjust the size of the Avaya Agent 
framework then re-create the agent installer. For more information on how to customize the 
framework size, see Avaya Agent Integration.

Note:
Note: You cannot install the agent desktop applications in a Citrix environment if 

you do not select the Citrix installation option in the Agent Site Preparation 
Wizard. For more information, see Running the Agent Site Preparation 
wizard on page 361.
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Locating the files for the tools
The files for the tools are located in the following directory on the Avaya IC Windows CD-
ROM 1:

<CD-ROM_drive>\Utils\Citrix

Configuring the Avaya Agent INI file
If the Avaya IC system includes agents accessing the Citrix client interface with the 
seamless window, you must configure the Avaya Agent INI file on each of the Citrix server 
machines that hosts Avaya IC agent desktop applications.

! CAUTION:
CAUTION: Do not create or configure the Avaya Agent INI file on any machine except a 

Citrix server that an agent will access through the Citrix client interface with 
the seamless window. The parameter needed for the seamless window can 
cause undesirable formatting and sizing of the Avaya Agent in other 
deployments.

To configure the Avaya Agent INI file:

1. In Notepad or another text editor, open a new document.

2. Type the following information into the document:

3. Save the file with the following name: qui.ini

4. Install the file in the Windows installation directory on each Citrix server that hosts 
Avaya IC agent desktop applications.

For example, the Windows installation directory is typically either C:\Winnt or 
C:\Windows.

[QConsole]
ResizeDesktop=FALSE
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Configuring the Avaya IC Web browser tool
To use the Avaya IC Web browser tool to access the agent desktop applications on the 
Citrix server:

1. Configure the Avaya IC Web browser tool.

2. Copy the files to the machine that hosts the Web server used by Avaya IC. 

This section includes the following topics:

● Components of the Web browser tool on page 400.

● Updating the HTML page for the Web browser tool on page 401.

● Installing the Web browser tool on page 402.

● Accessing more than one Citrix server on page 402.

Components of the Web browser tool

The Avaya IC Web browser tool includes the files listed in the following table.

File Description

ActiveX control SetupLocalDesktopForAgentViaCitrixCtr.CAB
Digitally signed ActiveX control with unique class ID

HTML access page BasicStartAgent.htm
After you update this page:
● Specifies the URL to the agent desktop applications on the 

Citrix server.
● Determines the text that the agent sees on the links. You can 

customize this text to suit the needs of the contact center and 
to match the corporate style.
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Updating the HTML page for the Web browser tool

The following table describes the parameters that you can configure and update in the 
HTML page. The only required parameter is the URL for the agent desktop applications on 
the Citrix server.

! CAUTION:
CAUTION: Do not delete or change the javascript or other code in the HTML page.

In addition to the parameters in the above table, you can also customize the HTML page as 
follows:

● Add a corporate logo, a graphic for the background, or otherwise customize the 
appearance of the HTML page.

● Add one or more of the properties in the Application or Desktop sections of the INI file 
for the executable tool, as described in Updating the INI file for the executable tool on 
page 403.

Note:
Note: You cannot add properties from the GUI section of the INI file for the 

executable tool.

Property Description

CitrixClientURL Specifies the location of the startup link for the Avaya IC agent 
desktop applications on the Citrix server. The value for the 
property must be a valid URL.
For example: 
CitrixClientURL="http://server_name.com/ICAgent/
ICAgentAppMode.ica"

<A href="javascript:
Main.SetDesktopForICAgent()"> 
Start Avaya Agent</A>

Specifies the text on the link that the agent clicks to access the 
agent desktop applications on the Citrix server.

<A href="javascript:
Main.ResetDesktop();window.clos
e()">EXIT</A>

Specifies the text on the link that the agent clicks to close the 
interface with the agent desktop applications on the Citrix server.

<A href="javascript:
Main.ForcedResetDesktop()">For
ce Reset</A>

Specifies the text on the link that the agent clicks to force a reset 
of the interface with the agent desktop applications on the Citrix 
server in the event of a failure.
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Installing the Web browser tool

After you update the HTML access page, you can install the Web browser tool.

To install the Web browser tool, copy the following files to the machine that hosts the Web 
server used by the Avaya IC system:

● SetupLocalDesktopForAgentViaCitrixCtr.CAB

● BasicStartAgent.htm

For example, if the Avaya IC system uses the Microsoft IIS as the Web server, copy the 
files to the machine that hosts that Web server.

Accessing more than one Citrix server

If the agents need to access the agent desktop applications on more than one Citrix 
server:

1. For each Citrix server that hosts agent desktop applications, configure the files for a 
Web browser tool.

2. Install the following files in the same folder on the machine that hosts the Web server:

● One copy of the ActiveX control: 
SetupLocalDesktopForAgentViaCitrixCtr.CAB

● For each Citrix server that the agents need to access, one copy of 
BasicStartAgent.htm

3. Create a desktop icon or an item in the Internet Explorer Favorites menu for each 
Web browser tool.

Configuring the executable tool
To use the Avaya IC executable tool to access the agent desktop applications on the Citrix 
server:

1. Configure the Avaya IC executable tool.

2. Copy the files to either the agent workstations or to a network share that can be 
accessed by all agents.

This section includes the following topics:

● Components of the executable tool on page 403.

● Updating the INI file for the executable tool on page 403.

● Installing the executable tool on page 405.

● Accessing more than one Citrix server on page 405.
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Components of the executable tool

The Avaya IC executable tool includes the files listed in the following table.

Updating the INI file for the executable tool

The following table describes the parameters that you can configure and update in the INI 
file. The only required parameter is the directory path for the agent desktop applications on 
the Citrix server.

File Description

Executable file SetupLocalDesktopForAgentViaCitrix.exe
Launches the dialog box used by agents to access the Citrix 
server that hosts the agent desktop applications.

INI file AgentDesktopCtr.ini
After you update this file:
● Specifies the directory path to the agent desktop applications 

on the Citrix server.
● Determines the text on the buttons in the dialog box. You can 

customize this text to suit the needs of the contact center and 
to match the corporate style.

Section Property Description

APPLICATION CitrixClientURL Specifies the location of the startup link for the Avaya 
IC agent desktop applications on the Citrix server. 
The value for the property must be a valid URL.
For example: 
CitrixClientURL="http://server_name.com/
ICAgent/ICAgentAppMode.ica"

DontStartMultipleInstances
OfAgent 

Controls whether the agent can open more than one 
interface to the same Citrix server from the Start 
button. 
If set to false or not present, the agent can open 
more than one interface. 
For example, 
DontStartMultipleInstancesOfAgent=TRUE

AgentAlreadyRunningMsg Specifies the message displayed to the agent if an 
interface is already open and you set 
DontStartMultipleInstancesOfAgent is set to TRUE.
For example, AgentAlreadyRunningMsg=The 
Avaya agent was already started



Configuring agent applications

404 Installation and Configuration

DESKTOP ClientBarHight Controls the desktop area reserved for the bottom of 
the Avaya Agent framework. The default value is 125 
pixels.
For example, ClientBarHight= 151

ClientBarWidth Controls the desktop area reserved for the left side 
bar of the Avaya Agent framework. The default value 
is 200 pixels.
For example, ClientBarWidth=201

GUI Caption properties The following caption properties allow you to specify 
the text for the dialog box:
● WindowCaption="Avaya Agent Desktop 
Control (customize me)"

● StopButtonCaption="Exit Avaya Agent 
(customize me)"

● StartButtonCaption="Start Avaya Agent 
(customize me)"

● ResetButtonCaption="Reset Desktop 
(customize me)"

● ApplicationFrameCaption="Application 
Controls (customize me)"

● ResetFrameCaption="Emergency Control 
(customize me)"

MinimizeWindowOnLanch
edAppStart 

Automatically minimizes the interface after the agent 
accesses the agent desktop applications on the Citrix 
server.
For example, 
MinimizeWindowOnLanchedAppStart=TRUE

MaximizeWindowOnLanch
edAppExit

Automatically maximizes the interface after the 
agents starts the agent desktop applications on the 
Citrix server. Only set this property to TRUE if you 
also set AutoResetOnExit to TRUE.
For example, 
MaximizeWindowOnLanchedAppExit=TRUE

DisableStartButtonAfterFir
stClick

Automatically disables the Start button on the dialog 
box after the agent starts the agent desktop 
applications on the Citrix server. 
For example, 
DisableStartButtonAfterFirstClick=FALSE

AskForExitConformation Ensures that the interface asks the agent to confirm 
before exiting the interface to the Citrix server.
For example, AskForExitConformation=TRUE

Section Property Description



Configuring the Citrix integration

Issue 2.0 June 2004 405

Installing the executable tool

You can install the executable in either of the following locations:

● On a network share that is accessible to all agents who need to use the executable tool.

● Every agent workstation used by an agent who needs to use the executable tool.

To install the executable tool, copy the following files to the desired location:

● SetupLocalDesktopForAgentViaCitrix.exe

● AgentDesktopCtr.ini

Accessing more than one Citrix server

If an agent needs to access the agent desktop applications on more than one Citrix server:

1. For each Citrix server that hosts agent desktop applications, configure the files for a 
executable tool.

2. Install a executable tool for each Citrix server in separate folders on the agent 
workstation.

3. Create a desktop icon or Start menu item for each executable tool.
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Chapter 14:Configuring Avaya Full Text 
Search Engine

This section describes how to configure Avaya FTSE. You must configure Avaya FTSE 
after complete the configuration of the Avaya IC system. For more information, see 
Installation order on page 23.

This section includes the following topics:

● Configuring Avaya FTSE on Microsoft Windows on page 407.

● Configuring Avaya FTSE for Sun Solaris on page 411.

● Configuring Avaya FTSE for IBM AIX on page 414.

Configuring Avaya FTSE on Microsoft Windows
Configure Avaya FTSE after you complete the configuration of the Avaya IC system. You 
can create and configure Avaya IC agents after you configure Avaya FTSE.

To configure Avaya FTSE on Windows machines, perform the steps in the following topics:

1. Windows services for Avaya FTSE on page 408.

2. Running the QKnowledge Configuration Tool on page 408.

3. Running the Web Self-Service Configuration Tool on page 409.

4. Configuring full text searches for Microsoft Windows on page 409.

5. Updating the full text indices on Microsoft Windows on page 410.
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Windows services for Avaya FTSE
The following are the Windows services created by the QKnowledge Configuration Tool:

● IC Knowledgebase Service 6.1

● AIC FTSE Connector v1.0

● AIC FTSE Connector v1.0 Manager

● AIC FTSE for Java v1.0

● AIC FTSE STR Service v1.0

These Windows services use the local system account as their log on user.

Running the QKnowledge Configuration Tool
To run the QKnowledge Configuration Tool:

1. Open a DOS command prompt window.

2. In the command prompt window, navigate to the following directory: 
IC_INSTALL_DIR\IC61\bin

3. Execute the following batch file: configFTSEQK.bat

4. In the Log In dialog box:

a. Type a valid Avaya IC user name with administrator privileges.

b. Type the password for that account.

c. Select OK.

The Avaya FTSE Configuration Tool configures QKnowledge. The Configuration Tool 
outputs any stack trace errors to the Console window. For some suggested resolutions 
for these errors, see Troubleshooting QKnowledge on page 533.

5. Exit from the Console window.

6. In the Windows Services Control Panel, start the following Windows services:

● Avaya IC Knowledgebase service 6.1

● AIC FTSE for java v 1.0
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Running the Web Self-Service Configuration Tool
The Web Self-Service database includes the FAQs and Suggested Email Responses.

To run the Web Self-Service Configuration Tool:

1. Open a DOS command prompt window.

2. In the command prompt window, navigate to the following directory: 
IC_INSTALL_DIR\IC61\bin

3. Execute the following batch file: ConfigFTSEWRU.bat

4. In the Log In dialog box:

a. Type a valid Avaya IC user name with administrator privileges.

b. Type the password for that account.

c. Select OK.

The Avaya FTSE Configuration Tool configures Web Self-Service. The Configuration 
Tool outputs any stack trace errors to the Console window. For some suggested 
resolutions for these errors, see Verifying the Web Self-Service configuration on 
Microsoft Windows on page 531.

5. Exit from the Console window.

6. If you are migrating from an earlier release of Avaya IC:

a. Run updatewru.bat. 

b. Navigate to IC_INSTALL_DIR\IC61\tomcat\work and delete all of the files and 
subdirectories in that directory

Configuring full text searches for Microsoft Windows
To configure full text searches for Microsoft Windows:

1. If the Website Tomcat service is running, restart this service before you configure full 
text searches.

2. Open a DOS command prompt window.

3. In the command prompt window, navigate to the following directory: 
IC_INSTALL_DIR\IC61\etc\wru_sql\
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4. Run the set up command for your database:

● SQL Server:

fulcrum_setup.cmd sqlserver <ccq_database_username> 
<ccq_database_password>

● Oracle:

fulcrum_setup.cmd oracle <ccq_database_username> 
<ccq_database_password>

After the set up command executes, continue with Step 4.

5. Check the IC_INSTALL_DIR\IC61\etc\wru_sql\wru_createview.err file for 
errors.

If the file is not present or is empty, the set up command executed correctly. Some 
messages that you might see in the error file do not indicate a problem. For more 
information, see Troubleshooting full text searches on page 530.

6. Check the IC_INSTALL_DIR\IC61\etc\wru_sql\fulcrum.err file for errors. 

If the file is empty, the set up command executed correctly. All messages in this file 
indicate errors. Correct these errors as indicated in the message and as required by 
the database, then re-run the set up command.

Updating the full text indices on Microsoft Windows
If you host your customer Website and WebACD server on different machines, or if your 
Avaya IC configuration includes multiple Websites, you must update the full text indices on 
those machines. The update ensures that the indices on these machines include all 
documents that you have added to the index.

You can run the update command as needed or schedule them to run at regular intervals. 
If you schedule an update to run at regular intervals, do not run the update more frequently 
than once per hour. 

You must run this update command on every machine that hosts one or more of the 
following:

● Customer-facing Website
● WebACD server

! Important:! Important:
Important: Do not run this update command on the machine that hosts the 

administrative Website. That machine automatically updates its own index. 
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To update the full text indices:

1. Open a DOS command prompt window.

2. In the command prompt window, navigate to the following directory: 
IC_INSTALL_DIR\IC61\etc\wru_sql

3. Run the following update command: fulcrum_updatendx.cmd

4. Check the IC_INSTALL_DIR\IC61\etc\wru_sql\fulcrum_updatendx.err file 
for errors. 

If the file is empty, the set up command executed correctly. All messages in this file 
indicate errors. Correct these errors as indicated in the message and as required by 
the database, then re-run the set up command.

Configuring Avaya FTSE for Sun Solaris
To configure Avaya FTSE and full text searches on Solaris machines, perform the steps in 
the following topics:

1. Changing ownership for the full text search directory on page 411.

2. Configuring Web Self-Service on Sun Solaris on page 412.

3. Configuring full text searches on Sun Solaris on page 413.

4. Updating full text indices on Sun Solaris on page 413.

Changing ownership for the full text search directory
Only the root user has read permissions for some of the files in the following directory: 
IC_INSTALL_DIR/IC61/etc/wru_sql

You must change the ownership for this directory if you plan to run the Avaya FTSE 
components as a non-root user on any machine that hosts a Website or the WebACD 
server.
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To change ownership for the full text search directory:

1. Log in as root user.

2. Navigate to IC_INSTALL_DIR/IC61/etc

3. Execute the following command: 

chown -R <userid> wru_sql

where <userid> represents the non-root user that you use to run the Avaya FTSE 
components.

Configuring Web Self-Service on Sun Solaris
Web Self-Service includes the Web Self-Service FAQ database and Suggested Email 
Responses.

To configure Web Self-Service on Sun Solaris:

1. Navigate to the following folder: IC_INSTALL_DIR/IC61/bin

2. Execute the following shell script: ./configftse

3. In the Log In dialog box:

a. Type a valid Avaya IC user name with administrator privileges.

b. Type the password for that account.

c. Select OK.

The Avaya FTSE Configuration Tool configures Web Self-Service. The Configuration 
Tool outputs any stack trace errors to the Console window. For some suggested 
resolutions for these errors, see Verifying the Web Self-Service configuration on Sun 
Solaris on page 532.

4. If you are migrating from an earlier release of Avaya IC:

a. Execute the following command: ./icenv ./updatewru.sh

b. Navigate to IC_INSTALL_DIR/IC61/tomcat/work and delete all of the files and 
subdirectories in that directory
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Configuring full text searches on Sun Solaris
You must configure full text searches on every machine that hosts one or more of the 
following:

● Customer-facing Website
● Administrative Website
● WebACD server
To set up full text searches on Sun Solaris:

1. Navigate to the following directory: IC_INSTALL_DIR/IC61/etc/wru_sql

2. Run the following command to create the indices for full text searching:

./fulcrum_setup.sh <database_username> <database_password>

When this command executes, you may see the following output:

ERROR at line 1:
ORA-00955: name is already used by an existing object

You can ignore this error. It indicates that the view already exists.

3. Check the IC_INSTALL_DIR/IC61/etc/wru_sql/fulcrum.err file for errors. 

If the file is not present or is empty, the set up command executed correctly. Some 
messages that you might see in the error file do not indicate a problem. For more 
information, see Troubleshooting full text searches on page 530.

4. Verify that the command did not create a file with a DIL extension in the 
IC_INSTALL_DIR/IC61/etc/wru_sql/ directory.

If such a file exists, check the contents for errors. If it contains errors, check the 
contents of fulcrum_odbctrace.out to see what went wrong. If there were 
problems with the database connection, confirm that the entries in the odbc.ini file 
are correct and that you invoked fulcrum_setup.sh with a valid username and 
password.

After you correct all errors, re-run the fulcrum_setup.sh command.

Updating full text indices on Sun Solaris
If you host your customer Website and WebACD server on different machines, or if your 
Avaya IC configuration includes multiple Websites, you must update the full text indices on 
those machines. The update ensures that the indices on these machines include all 
documents that you have added to the index.

You can run the update command as needed or schedule them to run at regular intervals. 
If you schedule an update to run at regular intervals, do not run the update more frequently 
than once per hour.
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You must run this update command on every machine that hosts one or more of the 
following:

● Customer-facing Website
● WebACD server 
Do not run this update command on the machine that hosts the administrative Website. 
That machine automatically updates its own index. 

To update the full text indices:

1. Navigate to the following directory: IC_INSTALL_DIR/IC61/etc/wru_sql

2. Run the following update command: 

./fulcrum_updatendx.sh

3. Check the IC_INSTALL_DIR/IC61/etc/wru_sql/fulcrum_updatendx.err file 
for errors. 

If the file is empty, the set up command executed correctly. All messages in this file 
indicate errors. Correct these errors as indicated in the message and as required by 
the database, then re-run the set up command.

Configuring Avaya FTSE for IBM AIX
To configure Avaya FTSE full text searches on AIX machines, perform the steps in the 
following topics:

1. Changing ownership for the full text search directory on page 414.

2. Configuring Web Self-Service on IBM AIX on page 415.

3. Configuring full text searches on IBM AIX on page 415.

4. Updating the full text search indices on IBM AIX on page 417.

Changing ownership for the full text search directory
Only the root user has read permissions for some of the files in the following directory: 
IC_INSTALL_DIR/IC61/etc/wru_sql

You must change the ownership for this directory if you plan to run the Avaya FTSE 
components as a non-root user on any machine that hosts a Website or the WebACD 
server.
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To change ownership for the full text search directory:

1. Log in as root user.

2. Navigate to IC_INSTALL_DIR/IC61/etc

3. Execute the following command: 

chown -R <userid> wru_sql

where <userid> represents the non-root user that you use to run the Avaya FTSE 
components.

Configuring Web Self-Service on IBM AIX
Web Self-Service includes the Web Self-Service FAQ database and Suggested Email 
Responses.

To configure Web Self-Service:

1. Navigate to the following folder: IC_INSTALL_DIR/IC61/bin

2. Execute the following shell script: ./configftse

3. In the Log In dialog box:

a. Type a valid Avaya IC user name with administrator privileges.

b. Type the password for that account.

c. Select OK.

The Avaya FTSE Configuration Tool configures Web Self-Service. The Configuration 
Tool outputs any stack trace errors to the Console window. For some suggested 
resolutions for these errors, see Verifying the Web Self-Service configuration on IBM 
AIX on page 532.

4. If you are migrating from an earlier release of Avaya IC:

a. Execute the following command: ./icenv ./updatewru.sh

b. Navigate to IC_INSTALL_DIR/IC61/tomcat/work and delete all of the files and 
subdirectories in that directory

Configuring full text searches on IBM AIX
You must configure full text searches on every machine that hosts one or more of the 
following:

● Customer-facing Website
● Administrative Website
● WebACD server
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To configure full text searches on IBM AIX:

1. Navigate to the following directory: IC_INSTALL_DIR/IC61/etc/wru_sql

2. Run the following command to create the indices for full text searching:

./fulcrum_setup.sh

When this command executes, you may see the output specified in the following table.

3. Check the IC_INSTALL_DIR/IC61/etc/wru_sql/fulcrum.err file for errors. 

If the file is not present or is empty, the set up command executed correctly. Some 
messages that you might see in the error file do not indicate a problem. For more 
information, see Troubleshooting full text searches on page 530.

Error message Description

DB21034E The command was 
processed as an SQL statement 
because it was not a valid Command 
Line Processor command. During SQL 
processing it returned: SQL0601N The 
name of the object to be created is 
identical to the existing name 
"CCQ.WRU_VIEW" of type "VIEW". 
SQLSTATE=42710

This message is created when the 
command tries to create a view on the 
DB2 database. You can ignore this error. 
This message indicates that the view 
already exists.

"Error : 666" This error indicates a problem in the 
odbc.ini file. This error results from the 
bind18 command used to create bind 
packages for the ODBC drivers. 
Verify that the entries in the odbc.ini file 
for the ccq datasource are correct. 
Incorrect values in this file typically result 
from incorrect values entered in the 
Configuration Tool. 
Repeat the configuration of Web 
Self-Service.

execsql: execute failed 
SQLSTATE: SGS00, Native error: 0, 
error text [Hummingbird][SearchServer]
Invalid table name

You may see this error message twice in 
fulcrum.err. This error occurs because 
the script is attempting to drop a table 
that does not yet exist. 
You can ignore this error when you run 
the fulcrum_setup command for the 
first time on a machine. However, if you 
receive this error when you repeat the 
command on a machine, investigate why 
the script cannot access the database to 
perform the following tasks:
● unprotect table qw_wru_en
● drop table qw_wru_en
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4. Verify that the command did not create a file with a DIL extension in the 
IC_INSTALL_DIR/IC61/etc/wru_sql/ directory.

If such a file exists, check the contents for errors. If it contains errors, check the 
contents of fulcrum_odbctrace.out to see what went wrong. If there were 
problems with the database connection, confirm that the entries in the odbc.ini file 
are correct and that you invoked fulcrum_setup.sh with a valid username and 
password.

5. Verify that the wru_createview.sql script contains the correct values for username, 
password, and database name for the DB2 database. 

The Configuration Tool substitutes these values when you configure the Website Web 
application. Incorrect values in this file typically result from incorrect values entered in 
the Configuration Tool. If the file includes errors, re-configure the Website. For more 
information about how to configure the Website, see IC Installation and Configuration.

6. After you correct all errors, re-run the fulcrum_setup.sh command.

Updating the full text search indices on IBM AIX
If you host your customer Website and WebACD server on different machines, or if your 
Avaya IC configuration includes multiple Websites, you must update the full text indices on 
those machines. The update ensures that the indices on these machines include any 
documents you have added to the index.

You can run the update command as needed or schedule them to run at regular intervals. 
If you schedule an update to run at regular intervals, do not run the update more frequently 
than once per hour. You must run this update command on every machine that hosts one 
or more of the following:

● Customer-facing Website
● WebACD server 
Do not run this update command on the machine that hosts the administrative Website. 
That machine automatically updates its own index. 

To update the full text search indices:

1. Navigate to the following directory: IC_INSTALL_DIR/IC61/etc/wru_sql

2. Run the following update command:

./fulcrum_updatendx.sh

3. Check the IC_INSTALL_DIR\IC61\etc\wru_sql\fulcrum_updatendx.err file 
for errors. 

If the file is empty, the set up command executed correctly. All messages in this file 
indicate errors. Correct these errors as indicated in the message and as required by 
the database, then re-run the set up command.
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Chapter 15:Installing Business Advocate 
components

This section describes how to install Business Advocate for Avaya IC. This section 
includes the following topics:

● Required administrator privileges on page 419.

● Prerequisites for Business Advocate on page 420.

● Creating a secondary server environment for Business Advocate on page 420.

● First Logical Resource Manager on page 421.

● Standby Resource Manager server on page 431.

● Additional Logical Resource Manager on page 435.

● Business Advocate administration tools on page 444.

For information about Business Advocate components and how to configure Business 
Advocate, see IC Business Advocate Configuration and Administration.

! Important:! Important:
Important: The Resource Manager server and Resource Manager components support 

the Windows 2000 server operating system only. For more information, see 
IC Installation Planning and Prerequisites.

Required administrator privileges
All users who install Business Advocate components on server machines must use a 
Windows Active Directory Domain account with local administrator privileges on that 
machine. Avaya recommends that you use the Advocate user account that you used to 
install the Business Advocate components on the machine.
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Prerequisites for Business Advocate
If you do not perform all of the prerequisites for Business Advocate, including the 
installation of Avaya IC, you cannot install the Business Advocate components.

Before you install Business Advocate components, do the following:

1. Complete all prerequisites for the components in your Avaya IC system. For more 
information, see IC Installation Planning and Prerequisites.

2. Complete all prerequisites for Business Advocate, as described in IC Installation 
Planning and Prerequisites, including the following prerequisites on every machine 
that hosts a Resource Manager server:

● Set up the Active Directory domain.

● Install and configure the MSMQ service.

● Install the database client.

● Configure the RDBMS for Business Advocate.

3. Install the Avaya IC design and administration tools.

4. Install and configure all components of the Avaya IC system, including the Avaya IC 
servers, databases, media channels, and related components, described in earlier 
sections.

5. Install the Avaya IC server files to the machines where you plan to run the Business 
Advocate servers, described in Installing Avaya IC servers on page 49.

Creating a secondary server environment for 
Business Advocate

All machines that host Business Advocate servers require an ORB server. 

Tip:
Tip: If you host the other Avaya IC servers on Solaris or AIX machines, the 

Resource Manager machine still requires a secondary ORB server. The 
Resource Manager server cannot start without a secondary ORB server.

For more information about how to create a secondary server environment, see 
Configuring secondary servers on page 161.
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First Logical Resource Manager
This section explains how to install the first Logical Resource Manager in the Avaya IC 
system. This section includes the following topics that specify the steps you need to follow 
to install the first Logical Resource Manager:

1. Components of the first Logical Resource Manager on page 421.

2. Prerequisites for the first Logical Resource Manager on page 422.

3. Installing the first Logical Resource Manager on page 423.

4. Building the Business Advocate database schema on page 427.

Components of the first Logical Resource Manager
When you install the first Logical Resource Manager, you can install and configure the 
components in the following table.

Installation option Component Description

Server setup Logical Resource Manager files The components required to set up the 
first Logical Resource Manager. 

System store The schema for the system store 
dedicated to this Logical Resource 
Manager. This database stores 
administration information, such as:
● System parameters
● Initialization parameters
● Location of MSMQ queues
● Location of servers
● Roles of Resource Manager servers

Resource store The schema for the resource store. The 
resource store is shared by all Logical 
Resource Managers in the Avaya IC 
system. This database stores operation 
information, such as qualifiers, service 
classes, and agent records and the 
associated capability sets and profiles.
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Prerequisites for the first Logical Resource Manager
Before you install the first Logical Resource Manager, complete the following prerequisites:

1. Complete the following prerequisites, as described in IC Installation Planning and 
Prerequisites:

● Configure the MSMQ services on the machine that hosts this server to use Active 
Directory services.

● Configure an Active Directory Domain user account with "Logon as Service" 
privileges on the machine that hosts this Logical Resource Manager. 

● Create a dedicated Nethome network share directory. 

● Install the database client software for the RDBMS.

2. Create an Advocate database.

Administration clients Business Advocate 
administration tools

Optional.
The following administrative tools are 
required to configure and administer 
Business Advocate:
● Business Advocate Supervisor
● Component Manager
● Alarm Manager

Resource Manager 
service

Resource Manager server The files required for the Resource 
Manager server. The Resource Manager 
server is the primary server for Business 
Advocate.
The Business Advocate installation 
installs this as a primary, active Resource 
Manager server.

Installation option Component Description
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Installing the first Logical Resource Manager
Install the Logical Resource Manager on a Windows machine.

! CAUTION:
CAUTION: Do not repeat the steps in this section on another machine. Business 

Advocate can only have one first Logical Resource Manager. For an 
additional Logical Resource Manager, follow the instructions in Additional 
Logical Resource Manager on page 435.

To install the first Logical Resource Manager:

1. Log in to the machine with an Active Directory Domain account that has the required 
local administrator privileges.

2. Insert the Business Advocate CD-ROM.

The Business Advocate installer starts automatically.

3. In the Welcome window, select Next.
4. In the Avaya Business Advocate Licensing Agreement window, read the entire 

license agreement carefully, then select one of the following buttons:

● Yes, if you agree to the terms of the agreement. The Business Advocate installation 
continues.

● No, if you do not agree to the terms of the agreement. The Business Advocate 
installation exits.

5. In the Enter User Information window:

a. Complete the fields in the following table.

b. Select Next.

Field Recommended entry

Name Type your name.

Company Type the name of the company where you 
are installing Business Advocate.
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6. In the Please Select Installation Type window, shown in the following figure:

a. Select the First Logical Resource Manager Instance option.

b. Select Next.

7. In the Select Components window, shown in the following figure:

a. In the Components section, select one or more of the options to determine which 
components to install. 

For more information about the options, see Components of the first Logical 
Resource Manager on page 421.

b. In the Destination Folder section, accept the default destination for installation or 
select Browse and navigate to the desired installation destination.

c. In the Disk Space section, review the Space Required and the Space Available to 
ensure that there is enough space on the destination disk for the selected Business 
Advocate components. 

Select Disk Space to view the disk space of all configured disks on the machine.
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d. Select Next.

8. In the Specify Avaya Business Advocate Network Home Path window, shown in 
the following figure:

a. Type the path for the shared network home directory in UNC format. 

UNC format is \\<machine_name>\nethome

The network home directory is the shared directory on the network that you created 
when you completed the Business Advocate prerequisites.

If you do not know the path, select Browse and navigate to the directory through 
Network Neighborhood. If the shared network home directory is on the same 
machine, do not select the local machine directly. You must navigate through 
Network Neighborhood to ensure that the Browse function uses UNC format.

b. Select Next.
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9. In the NT Service Login Account window, shown in the following figure:

a. In the Login field, type the Active Directory user account that you created to run 
Business Advocate services in the following format: 
<Active_Directory_domain>\<advocate_administrative_account>

b. In the Password field, type the password for the Active Directory user account.

c. In the Confirm field, re-type the password.

d. Select Next.

10. In the Review Add/Patch/Remove Components List window, review the 
components to be installed, then select Next.
The Business Advocate installation installs the Business Advocate components that 
you selected. After the installation completes, review the log file to make sure that the 
installation did not encounter problems.

11. In the Setup Complete window:

a. Select the Yes, I want to restart my computer now option.

b. Select Finish.

Continue with Building the Business Advocate database schema on page 427.
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Building the Business Advocate database schema
After you install the files for the first Logical Resource Manager, the Business Advocate 
installer builds the schema for the system store and resource store. 

After the machine reboots, the Business Advocate installation registers the files, then 
opens the Build Database Schema window.

To build the Business Advocate database schema, follow the steps in one of the following 
topics:

● Building the Business Advocate database schema for SQL Server on page 427.

● Building the Business Advocate database schema for Oracle on page 429.

Building the Business Advocate database schema for SQL Server

The following figure shows the Build Database Schema window for SQL Server.
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To build the Business Advocate database schema for SQL Server:

1. In the Build Database Schema window, complete the fields in the following table.

2. Check the Build box next to the Local System Store field, and complete the fields in 
the following table.

Field Recommended entry Notes

Select a DBMS Select SQL Server. Business Advocate databases 
do not support DB2. For 
Oracle, see Building the 
Business Advocate database 
schema for Oracle on 
page 429.

Username Type a DBA user name for the 
Business Advocate databases.

For example, a DBA user 
name for SQL Server is sa.

Password Type the password for the 
DBA user name.

Do not leave your DBA 
password blank.

Field Recommended entry Notes

Schema file Accept the default. Business Advocate 
automatically completes this 
field with the network home 
directory that you specified 
during installation.

Database Server Type the name of the machine 
that hosts the database.

The database server is the 
machine that hosts the 
advocate database you 
created when you completed 
prerequisites.

Database Name Type advocate. The database name is the 
Advocate database you 
created when you completed 
prerequisites.
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3. Check the Build box next to the Shared Resource Store field, and complete the fields 
in the following table.

4. Select Create Schema.

This process can take a few minutes to complete the installation and configuration of 
the database schema. Monitor the messages on the status line at the bottom left of the 
Build Database Schema window. If desired, select View Log File to view the log file.

If this Logical Resource Manager includes a second, standby Resource Manager 
server, continue with Standby Resource Manager server on page 431.

Building the Business Advocate database schema for Oracle

The following figure shows the Build Database Schema window for Oracle.

Field Recommended entry Notes

Schema file Accept the default. Business Advocate 
automatically completes this 
field with the network home 
directory that you specified 
during installation.

Database Server Type the name of the machine 
that hosts the database.

The database server is the 
machine that hosts the 
advocate database you 
created when you completed 
prerequisites.

Database Name Type advocate. The database name is the 
Advocate database you 
created when you completed 
prerequisites.
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To build the Business Advocate database schema for Oracle:

1. In the Build Database Schema window, complete the fields in the following table.

2. Check the Build box next to the Local System Store field, and complete the fields in 
the following table.

Field Recommended entry Notes

Select a DBMS Select Oracle. Business Advocate databases 
do not support DB2. For 
Oracle, see Building the 
Business Advocate database 
schema for Oracle on 
page 429.

Username Type a DBA user name for the 
Business Advocate databases.

For example, a DBA user 
name for Oracle is system.

Password Type the password for the 
DBA user name.

Do not leave your DBA 
password blank.

Field Recommended entry Notes

Schema file Accept the default. Business Advocate 
automatically completes this 
field with the network home 
directory that you specified 
during installation.

Database Server Type the name of the machine 
that hosts the database.

The database server is the 
machine that hosts the 
advocate database you 
created when you completed 
prerequisites.

Service Type the Oracle Local Net 
Service for the machine.

For information on how to 
identify the Oracle Local Net 
Service, see the 
documentation provided by 
Oracle.
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3. Check the Build box next to the Shared Resource Store field, and complete the fields 
in the following table.

4. Select Create Schema.

This process can take a few minutes to complete the installation and configuration of 
the database schema. Monitor the messages on the status line at the bottom left of the 
Build Database Schema window. If desired, select View Log File to view the log file.

If this Logical Resource Manager includes a second, standby Resource Manager 
server, continue with Standby Resource Manager server on page 431.

Standby Resource Manager server
A Logical Resource Manager can include two Resource Manager servers. Each Resource 
Manager server resides on a different machine.

The primary, active Resource Manager server is installed when you install the files for the 
first Logical Resource Manager. You need to run the Business Advocate installation again 
to install the files required to support the standby Resource Manager server.

This section includes the following topics that describe how to install a standby Resource 
Manager server:

1. Prerequisites for a Standby Resource Manager server on page 432.

2. Installing a Standby Resource Manager server on page 432.

3. Assigning a role to the standby Resource Manager server on page 434.

Field Recommended entry Notes

Schema file Accept the default. Business Advocate 
automatically completes this 
field with the network home 
directory that you specified 
during installation.

Database Server Type the name of the machine 
that hosts the database.

The database server is the 
machine that hosts the 
advocate database you 
created when you completed 
prerequisites.

Service Type the Oracle Local Net 
Service for the machine.

For information on how to 
identify the Oracle Local Net 
Service, see the 
documentation provided by 
Oracle.
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Prerequisites for a Standby Resource Manager server
Before you install a standby Resource Manager server, complete the following 
prerequisites:

1. Install the Logical Resource Manager for this standby Resource Manager server, 
including all prerequisites for that Logical Resource Manager.

2. Complete the following prerequisites, as described in IC Installation Planning and 
Prerequisites:

● Configure the MSMQ services on the machine that hosts this server to use the 
same Active Directory services as the Logical Resource Manager for this standby 
Resource Manager server.

● Configure the same user account that you used to configure the Logical Resource 
Manager with "Logon as Service" privileges on the machine that hosts this server.

● Install the database client software for the RDBMS.

Tip:
Tip: You do not need to create a separate Advocate database for this Resource 

Manager server. 

Installing a Standby Resource Manager server
Install the standby Resource Manager server on a Windows machine.

Do not start this procedure until you have completed the installation of the first Logical 
Resource Manager.

To install the standby Resource Manager server:

1. Log in to the machine with an Active Directory Domain account that has the required 
local administrator privileges. 

2. Insert the Business Advocate CD-ROM.

The Business Advocate installer starts automatically.

3. In the Welcome window, select Next.
4. In the Avaya Business Advocate Licensing Agreement window, read the entire 

license agreement carefully, then select one of the following buttons:

● Yes, if you agree to the terms of the agreement. The Business Advocate installation 
continues.

● No, if you do not agree to the terms of the agreement. The Business Advocate 
installation exits.
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5. In the Enter User Information window:

a. Complete the fields in the following table.

b. Select Next.
6. In the Please Select Installation Type window, shown in the following figure:

a. Select the Standby Resource Manager Service option.

b. Select Next.

7. In the Choose Destination Location window:

a. In the Destination Folder section, accept the default destination for installation or 
select Browse and navigate to the desired installation destination.

b. Select Next.
8. In the Specify Avaya Business Advocate Network Home Path window:

a. Type the path for the shared network home directory in UNC format. 

UNC format is \\<machine_name>\nethome

Use the same network home directory as you used when you installed the Logical 
Resource Manager for this standby Resource Manager server.

If you do not know the path, select Browse and navigate to the directory through 
Network Neighborhood. If the shared network home directory is on the same 

Field Recommended entry

Name Type your name.

Company Type the name of the company where you 
are installing Business Advocate.
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machine, do not select the local machine directly. You must navigate through 
Network Neighborhood to ensure that the Browse function uses UNC format.

b. Select Next.
9. In the NT Service Login Account window:

a. In the Login field, type the Active Directory user account that you used when you 
created the Logical Resource Manager for this standby Resource Manager server.

Use the following format when you type the user account: 
<Active_Directory_domain>\<advocate_administrative_account>

b. In the Password field, type the password for the Active Directory user account.

c. In the Confirm field, re-type the password.

d. Select Next.
10. In the Review Add/Patch/Remove Components List window, review the 

components to be installed, then select Next.
The Business Advocate installation installs the Business Advocate components that 
you selected. After the installation completes, review the log file to make sure that the 
installation did not encounter problems.

11. In the Setup Complete window:

a. Select the Yes, I want to restart my computer now option.

b. Select Finish.

Continue with Assigning a role to the standby Resource Manager server on page 434.

Assigning a role to the standby Resource Manager server
To assign a role to the standby Resource Manager server:

1. In the console tree of Advocate Administration, expand Advocate Component 
Manager.

2. Select the machine which hosts the Resource Manager server.

3. In the results pane, right-click the entry for the machine and select Availability Config.

4. In the High Availability Config dialog box:

a. Select the Secondary option.

b. Select OK.

5. Right-click the entry for the machine and select Properties.
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6. In the Component Properties dialog box:

a. Check the Enable box.

b. Select OK.

7. Close the Component Manager.

Additional Logical Resource Manager
This section describes how to install additional Logical Resource Managers in an Avaya IC 
deployment that includes multiple Logical Resource Managers. 

This section includes the following topics that specify the steps you need to follow to install 
an additional Logical Resource Manager:

1. Components of an additional Logical Resource Manager on page 435.

2. Prerequisites for an additional Logical Resource Manager on page 436.

3. Installing an additional Logical Resource Manager on page 437.

4. Building the Business Advocate database schema on page 439.

Components of an additional Logical Resource Manager
The following table describes the components installed with the options for an additional 
Logical Resource Manager.

Installation option Component Description

Server setup Logical Resource Manager files The components required to set up the 
additional Logical Resource Manager. 

System store The schema for the system store 
dedicated to this Logical Resource 
Manager. This database stores 
administration information, such as:
● System parameters
● Initialization parameters
● Location of MSMQ queues
● Location of servers
● Roles of Resource Manager servers
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Prerequisites for an additional Logical Resource Manager
Before you install an additional Logical Resource Manager, complete the following 
prerequisites:

1. Install the first Logical Resource Manager, including all prerequisites for that Logical 
Resource Manager. For more information, see First Logical Resource Manager on 
page 421.

2. Create a dedicated Advocate database for this Logical Resource Manager. You can 
create this database in either of the following locations:

● The same database instance where you created the Advocate database for the first 
Logical Resource Manager

● A different database instance than the instance where you created the Advocate 
database for the first Logical Resource Manager

3. Complete the following prerequisites, as described in IC Installation Planning and 
Prerequisites:

● Configure the MSMQ services on the machine that hosts this server to use the 
same Active Directory services as the first Logical Resource Manager.

● Configure the same user account that you used to configure the first Logical 
Resource Manager with "Logon as Service" privileges on the machine that hosts 
this server.

● Create a dedicated Nethome network share directory for this Logical Resource 
Manager.

● Install the database client software for the RDBMS.

Administration clients Business Advocate 
administration tools

Optional.
The following administrative tools are 
required to configure and administer 
Business Advocate:
● Business Advocate Supervisor
● Component Manager
● Alarm Manager

Resource Manager 
service

Resource Manager server The files required for the Resource 
Manager server. The Resource Manager 
server is the primary server for Business 
Advocate.
The Business Advocate installation 
installs this as a primary, active Resource 
Manager server.

Installation option Component Description
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Installing an additional Logical Resource Manager
Install the Logical Resource Manager on a Windows machine.

! CAUTION:
CAUTION: Do not follow the steps in this section if you have not yet completed the 

installation of a Logical Resource Manager on another machine. If this is the 
first Logical Resource Manager, follow the instructions in First Logical 
Resource Manager on page 421.

To install an additional Logical Resource Manager:

1. Log in to the machine with an Active Directory Domain account that has the required 
local administrator privileges. 

2. Insert the Business Advocate CD-ROM.

The Business Advocate installer starts automatically.

3. In the Welcome window, select Next.
4. In the Avaya Business Advocate Licensing Agreement window, read the entire 

license agreement carefully, then select one of the following buttons:

● Yes, if you agree to the terms of the agreement. The Business Advocate installation 
continues.

● No, if you do not agree to the terms of the agreement. The Business Advocate 
installation exits.

5. In the Enter User Information window:

a. Complete the fields in the following table.

b. Select Next.

Field Recommended entry

Name Type your name.

Company Type the name of the company where you 
are installing Business Advocate.
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6. In the Please Select Installation Type window, shown in the following figure:

a. Select the Additional Logical Resource Manager Instance option.

b. Select Next.

7. In the Select Components window:

a. In the Components section, select one or more of the options to determine which 
components to install. 

For more information about the options, see Components of an additional Logical 
Resource Manager on page 435.

b. In the Destination Folder section, accept the default destination for installation or 
select Browse and navigate to the desired installation destination.

c. In the Disk Space section, review the Space Required and the Space Available to 
ensure that there is enough space on the destination disk for the selected Business 
Advocate components.

Select Disk Space to view the disk space of all configured disks on the machine.

d. Select Next.
8. In the Specify Avaya Business Advocate Network Home Path window:

a. Type the path for the shared network home directory in UNC format. 

UNC format is \\<machine_name>\nethome

Do not use the same network home directory that you used for the first Logical 
Resource Manager.

If you do not know the path, select Browse and navigate to the directory through 
Network Neighborhood. If the shared network home directory is on the same 
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machine, do not select the local machine directly. You must navigate through 
Network Neighborhood to ensure that the Browse function uses UNC format.

b. Select Next.
9. In the NT Service Login Account window:

a. In the Login field, type the Active Directory user account that you used when you 
created the first Logical Resource Manager.

Use the following format when you type the user account: 
<Active_Directory_domain>\<advocate_administrative_account

b. In the Password field, type the password for the Active Directory user account.

c. In the Confirm field, re-type the password.

d. Select Next.
10. In the Review Add/Patch/Remove Components List window, review the 

components to be installed, then select Next.
The Business Advocate installation installs the Business Advocate components that 
you selected. After the installation completes, review the log file to make sure that the 
installation did not encounter problems.

11. In the Setup Complete window:

a. Select the Yes, I want to restart my computer now option.

b. Select Finish.

Continue with Building the Business Advocate database schema on page 427.

Building the Business Advocate database schema
After you install the files for the additional Logical Resource Manager, the Business 
Advocate installer builds the schema for the system store. This Logical Resource Manager 
uses the same resource store as the first Logical Resource Manager. 

After the machine reboots, the Business Advocate installation registers the files, then 
opens the Build Database Schema window.

To build the Business Advocate database schema, follow the steps in one of the following 
topics:

● Building the Business Advocate database schema for SQL Server on page 440.

● Building the Business Advocate database schema for Oracle on page 442.
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Building the Business Advocate database schema for SQL Server

The following figure shows the Build Database Schema window for SQL Server.

To create the Business Advocate database schema:

1. In the Build Database Schema window, complete the fields in the following table.

2. Type the location of the shared network home directory that you created for the first 
Logical Resource Manager. 

Use UNC format, for example, \\<machine_name>\nethome

If you do not know the path, select Browse and navigate to the directory through 
Network Neighborhood. If the shared network home directory is on the same machine, 
do not select the local machine directly. You must navigate through Network 
Neighborhood to ensure that the Browse function uses UNC format.

Field Recommended entry Notes

Select a DBMS Select SQL Server. Business Advocate databases 
do not support DB2. For 
Oracle, see Building the 
Business Advocate database 
schema for Oracle on 
page 429.

Username Type a DBA user name for the 
Business Advocate databases.

For example, a DBA user 
name for SQL Server is sa.

Password Type the password for the 
DBA user name.

Do not leave your DBA 
password blank.
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3. Check the Build box next to System Store, and complete the fields in the following 
table.

4. Select Create Schema.

Monitor the messages on the status line at the bottom left of the Build Database 
Schema window. If desired, select View Log File to view the log file.

5. Select Close.

6. Select OK for each of the dialog boxes displayed by the Business Advocate 
installation.

This process can take a few minutes to complete the installation and configuration of 
the database schema.

If this Logical Resource Manager includes a second, standby Resource Manager 
server, continue with Standby Resource Manager server on page 431.

Field Recommended entry Notes

Schema file Accept the default. Business Advocate 
automatically completes this 
field with the network home 
directory that you specified 
during installation.

Database Server Type the name of the machine 
that hosts the database.

The database server is the 
machine that hosts the 
advocate database you 
created when you completed 
prerequisites.

Database Name Type advocate. The database name is the 
Advocate database you 
created when you completed 
prerequisites.
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Building the Business Advocate database schema for Oracle

The following figure shows the Build Database Schema window for Oracle.

To create the Business Advocate database schema:

1. In the Build Database Schema window, complete the fields in the following table.

2. Type the location of the shared network home directory that you created for the first 
Logical Resource Manager. 

Use UNC format, for example, \\<machine_name>\nethome

If you do not know the path, select Browse and navigate to the directory through 
Network Neighborhood. If the shared network home directory is on the same machine, 

Field Recommended entry Notes

Select a DBMS Select Oracle. Business Advocate databases 
do not support DB2. For 
Oracle, see Building the 
Business Advocate database 
schema for Oracle on 
page 429.

Username Type a DBA user name for the 
Business Advocate databases.

For example, a DBA user 
name for Oracle is system.

Password Type the password for the 
DBA user name.

Do not leave your DBA 
password blank.
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do not select the local machine directly. You must navigate through Network 
Neighborhood to ensure that the Browse function uses UNC format.

3. Check the Build box next to System Store, and complete the fields in the following 
table.

4. Select Create Schema.

Monitor the messages on the status line at the bottom left of the Build Database 
Schema window. If desired, select View Log File to view the log file.

5. Select Close.

6. Select OK for each of the dialog boxes displayed by the Business Advocate 
installation.

This process can take a few minutes to complete the installation and configuration of 
the database schema.

If this Logical Resource Manager includes a second, standby Resource Manager 
server, continue with Standby Resource Manager server on page 431.

Field Recommended entry Notes

Schema file Accept the default. Business Advocate 
automatically completes this 
field with the network home 
directory that you specified 
during installation.

Database Server Type the name of the machine 
that hosts the database.

The database server is the 
machine that hosts the 
advocate database you 
created when you completed 
prerequisites.

Service Type the Oracle Local Net 
Service for the machine.

For information on how to 
identify the Oracle Local Net 
Service, see the 
documentation provided by 
Oracle.
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Business Advocate administration tools
The Business Advocate administration tools include the Business Advocate Supervisor.

Perform this step only if you want to host Business Advocate Supervisor on a separate 
administration machine. The Business Advocate installation automatically installs 
Business Advocate Supervisor with the first Logical Resource Manager.

! Important:! Important:
Important: To use the Business Advocate administration tools, log in to the machine 

with an Active Directory Domain account that has local administrator 
privileges.

This section includes the following topics that describe how to install the administration 
tools on a separate administration machine, rather than with a Logical Resource Manager. 

1. Prerequisites for the administration tools on page 444.

2. Installing the administration tools on page 445.

Prerequisites for the administration tools
Before you install the administration tools, complete the following prerequisites:

1. Install the first Logical Resource Manager, including all prerequisites for that Logical 
Resource Manager. For more information, see First Logical Resource Manager on 
page 421.

2. Configure the MSMQ services on the machine that hosts the administration tools to 
use the same Active Directory services as the first Logical Resource Manager.

3. Configure the same user account that you used to configure the first Logical Resource 
Manager with the following privileges on the machine that hosts the administration 
tools:

● Logon as Service privileges

● Local Administrator rights
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Installing the administration tools
You do not need to install the administration tools if you selected Administrative Clients 
when you installed a Logical Resource Manager. 

Install the administration tools on a Windows machine.

! CAUTION:
CAUTION: Do not follow the steps in this section if you have not yet installed a Logical 

Resource Manager on another machine. If this is the first Logical Resource 
Manager, follow the instructions in First Logical Resource Manager on 
page 421.

Do not start this procedure until you have completed the installation of the first Logical 
Resource Manager.

To install the Business Advocate administration tools:

1. Log in to the machine with the Active Directory Domain account that has the required 
local administrator privileges. 

2. Insert the Business Advocate CD-ROM.

The Business Advocate installer starts automatically.

3. In the Welcome window, select Next.
4. In the Avaya Business Advocate Licensing Agreement window, read the entire 

license agreement carefully, then select one of the following buttons:

● Yes, if you agree to the terms of the agreement. The Business Advocate installation 
continues.

● No, if you do not agree to the terms of the agreement. The Business Advocate 
installation exits.

5. In the Enter User Information window:

a. Complete the fields in the following table.

b. Select Next.

Field Recommended entry

Name Type your name.

Company Type the name of the company where you 
are installing Business Advocate.
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6. In the Please Select Installation Type window:

a. Select the Additional Logical Resource Manager Instance option.

b. Select Next.
7. In the Select Components window:

a. In the Components section:

● Select the Administrative Clients option.

● Do not select the other options.

b. In the Destination Folder section, accept the default destination for installation or 
select Browse and navigate to the desired installation destination.

c. In the Disk Space section, review the Space Required and the Space Available to 
ensure that there is enough space on the destination disk for the selected Business 
Advocate components.

Select Disk Space to view the disk space of all configured disks on the machine.

d. Select Next.
8. In the Specify Avaya Business Advocate Network Home Path window:

a. Type the path for the shared network home directory in UNC format. 

UNC format is \\<machine_name>\nethome

Do not use the same network home directory that you used for the first Logical 
Resource Manager.

b. Select Next.
9. In the Review Add/Patch/Remove Components List window, review the 

components to be installed, then select Next.
The Business Advocate installation installs the Business Advocate components that 
you selected. After the installation completes, review the log file to make sure that the 
installation did not encounter problems.

10. In the Setup Complete window:

a. Select the Yes, I want to restart my computer now option.

b. Select Finish.
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Chapter 16:Installing optional components

Perform the steps in the following topics to configure optional Avaya� Interaction Center 
(Avaya IC) components:

● Configuring Avaya Content Analyzer on page 447.

● Configuring WebQ on page 452.

● Configuring Letter Generator on page 453.

● Installing and configuring a second ICM server on page 468.

● Installing the SDK for Avaya IC servers on page 475.

For information on how to install and configure Avaya Operational Analyst, see Avaya 
Operational Analyst Installation and Configuration.

Configuring Avaya Content Analyzer
The Avaya IC server installation automatically installs Content Analyzer files on the server 
machine. For more information, see Installing Avaya IC servers on page 49.

Before you can configure and use Content Analyzer, you must create and configure the 
Content Analyzer servers.

To configure Content Analyzer, perform the steps in the following topics:

1. Creating the Administrative Content Analyzer server on page 448.

2. Creating the Operations Content Analyzer server on page 449.

3. Adding a Knowledge Base on page 450.

For more detailed information about Content Analyzer, see:

● Avaya Workflow Designer User Guide for an overview of Content Analyzer and 
information about how to customize workflows for Content Analyzer

● IC Administration Volume 1: Servers & Domains to administer Content Analyzer, 
including how to set up and maintain Knowledge Bases and how to train Content 
Analyzer



Installing optional components

448 Installation and Configuration

Creating the Administrative Content Analyzer server
For more information about the Administrative Content Analyzer server, see IC 
Administration Volume 1: Servers & Domains.

To create the Administrative Content Analyzer server:

1. Select Server > New in IC Manager.

2. Select CAAdmin from the list of servers. Select OK.

3. Select the General tab and complete the fields shown in the following table.

4. Select the CAAdmin tab and complete the fields shown in the following table.

5. Select OK.

6. Start the Administrative Content Analyzer server. 

Field Recommended entry Notes

Name CAADmin_<domain> Include the domain in the server name 
to identify the server.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

This server should be in the same 
domain as the IC Email server.
For example, select Email from the 
drop-down list if the server is in the 
Email domain.

Host Select the machine�s IP 
address from the drop-down 
list, or enter the IP address if 
it is not in the list.

When you select the host, IC Manager 
fills in the fields for Directory, Port, and 
Executable.

Field Recommended entry Notes

IC Data 
Source

Select the Interaction 
Center Data Source.

If you used the default name, select 
interaction_center. 

Path to 
NLP Data

Type the directory path 
to the NLP data.

Windows:
IC_INSTALL_DIR\IC61\oem\banter\nlp
data 

Solaris or AIX:
IC_INSTALL_DIR/IC61/oem/banter/NLP
Data/
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Creating the Operations Content Analyzer server
For more information about the Operations Content Analyzer server, see IC Administration 
Volume 1: Servers & Domains.

Note:
Note: Do not start the Operations Content Analyzer server. You must configure at 

least one trained and validated Knowledge Base before you start this server.

To create the Operations Content Analyzer server:

1. Select Server > New in IC Manager.

2. Select CAServer from the list of servers. Select OK.

3. Select the General tab and complete the fields shown in the following table.

4. Select the CA Server tab and complete the fields shown in the following table.

Field Recommended entry Notes

Name OperationCA_<domain> Include the domain in the server 
name to identify the server.

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

This server should be in the same 
domain as the IC Email server.
For example, select Email from the 
drop-down list if the server is in the 
Email domain.

Host Select the machine�s IP 
address from the drop-down 
list, or enter the IP address if 
it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.

Field Recommended entry Notes

IC Data 
Source

Select the Interaction 
Center Data Source.

If you used the default name, select 
interaction_center.
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5. Select OK.

Adding a Knowledge Base
Before you add a Knowledge Base to your Operations Content Analyzer server, perform 
the following steps in the Content Analyzer Administration tab:

1. Create the Knowledge Base.

2. Train the Knowledge Base.

3. Validate the Knowledge Base.

4. Save the trained and validated Knowledge Base.

For detailed information on how to perform these steps, see IC Administration Volume 1: 
Servers & Domains.

You need the following information about the Knowledge Bases before you add them to the 
Operations Content Analyzer server:

● Name
● File path
● Threshold
● Language codes
This information is available in IC Manager for all saved Knowledge Bases. You can find 
this information in the KB Management pane of the Content Analysis window.

To add a Knowledge Base to the Operations Content Analyzer server:

1. Double-click the Operations Content Analyzer server in the list of servers.

2. Select the CAServer tab.

3. Select the Ellipsis (�) button next to Knowledge Base.

Path to 
NLP Data

Type the directory path 
to the NLP data.

Windows:
IC_INSTALL_DIR\IC61\oem\banter\nlp
data 

Solaris or AIX:
IC_INSTALL_DIR/IC61/oem/banter/NLP
Data/

Knowledge 
Base

Type the name of the 
Knowledge Base 
associated with this 
server.

Select Knowledge Base to display the 
Knowledge Base dialog box. For details 
about entering a Knowledge Base, see below.

Field Recommended entry Notes
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4. In the Knowledge Base dialog box:

a. Select New.

b. Type the name of the Knowledge Base in the Name column.

This name must be the same as the name of the Knowledge Base in the KB Name 
column of the KB Management pane in the Content Analysis window.

c. Type the directory path to the Knowledge Base in the KB File Location column.

This path must be the same as the path in the File Path column of the KB 
Management pane in the Content Analysis window.

If the Administrative Content Analyzer server and the Operations Content Analyzer 
server are hosted on the same physical machine, this path must match the File 
Path column of the KB Management pane in the Content Analysis window.

If the Administrative Content Analyzer server and the Operations Content Analyzer 
server are hosted on different physical machines, make sure that this file path 
accesses the same Knowledge Base as the one pointed to by the File Path column 
of the KB Management pane in the Content Analysis window.

d. Type a threshold in the Threshold column, if desired.

You can leave this column blank or type the same threshold that you specified when 
you validated the Knowledge Base.

e. Select the Ellipsis (�) button in the Languages column.

5. In the Languages dialog box:

a. Select New.

b. Type a language code.

Repeat Steps a and b for each language code you want to add. All available 
language codes are in the Languages column of the KB Management pane in the 
Content Analysis window. The language codes are listed in a single string, 
separated by semicolons.

c. Select OK.

6. Select OK in the Knowledge Base dialog box.

7. Select OK in the CAServer tab.
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Configuring WebQ
WebQ provides HTML pages for CustomerQ and other Business Applications. Your 
customers and support agents can use WebQ to access your Avaya database remotely 
through an Internet browser. 

WebQ Router provides load balancing between active WebQ services and supports the 
SSL Internet security capability.

The following instructions provide an overview of how to configure WebQ for the 
CustomerQ application. For detailed instructions, see:

● WebQ Reference if you want to configure and deploy the application.

● IC Database Designer User Guide if you want to customize an ADL file.

● IC Administration Volume 1: Servers & Domains if you want to configure and deploy the 
WebQ server and WebQ Router.

To configure WebQ:

1. Confirm that your Data server and IIS server are up and running.

2. Open custq.adl in Database Designer.

3. Check the appropriate boxes for the application components to generate WebQ pages, 
and customize the ADL file, if desired.

4. Select File > Generate Web Application and generate the WebQ application. 

5. Copy the WebQ application directory to the machine that hosts the WebQ server and 
WebQ Router.

6. Copy the WebQ help directory from the machine that hosts your Design & 
Administration Tools to the machine that hosts your WebQ server. The WebQ help 
directory is located at IC_INSTALL_DIR\IC61\help\WebQ

7. Create a directory called webq under the IIS Server�s root directory of the website�s 
files. 

For example, create a directory called C:\InetPub\wwwroot\webq

8. Copy the following files from IC_INSTALL_DIR\IC61\httpd to the IIS webq 
directory you created above:

● cal.gif
● find.gif
● login.htm
● option.class
● optionwidget.class
● rw.gif
● webqbar.gif
● webqbtm.gif
● webqbutn.gif
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● webqmenu.gif
● webqpg1.jpg
● webqpgn.gif

9. Configure and start the WebQ server.

10. Configure and start the WebQ Router.

Configuring Letter Generator
Letter Generator allows you to create letter and form templates, and then generate mass 
mailings or single documents from those templates. Letter Generator works with the Avaya 
Business Applications. Your Avaya IC system must include a Business Application if you 
want to use Letter Generator.

Batch Administrator is a feature of Letter Generator that controls when and how generated 
documents are processed. All such documents are sent to a batch, which is a collection of 
documents and their destinations. The destination can to a printer, email message, or 
PostScript file. Once a document is sent to a batch, it stays there until the Administrator 
freezes the batch and processes its contents.

To use the Letter Generator and Batch Administrator, perform the steps in the following 
topics:

1. Prerequisites for Letter Generator on page 454.

2. Configuring the Letter Generator Web application on page 454.

3. Editing Letter Generator properties in IC Manager on page 464.

4. Configuring a Workflow server for Letter Generator on page 464.

5. Configuring Letter Generator for Japanese on page 466.

Note:
Note: Avaya recommends that you install Letter Generator on a different machine 

from the Web Management servers to avoid potential conflicts.
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Prerequisites for Letter Generator
Before you configure the Letter Generator Web application, you must:

● Create an HTTP Connector server in the same Avaya IC domain as the Workflow server 
for Letter Generator or in that domain�s failover path. For more information, see Creating 
an HTTP Connector server on page 142.

● Install GhostScript and GhostViewer on the machine where you plan to use the 
Workflow server for Letter Generator.

● Install Adobe Acrobat on the machine where you plan to run the Batch Administrator.

Configuring the Letter Generator Web application
Letter Generator requires a Web application. You configure Letter Generator on the Web 
tab of the Avaya IC Configuration Tool. 

This section describes how to install and configure the Letter Generator Web application 
as a single Web application on the target machine. This section includes the following 
topics:

● Where to configure the Letter Generator Web application on page 454.

● Hosting multiple Web applications on one machine on page 454.

● Advanced properties for the Letter Generator Web application on page 455.

● Configuring the Letter Generator Web application on Windows on page 455.

● Configuring the Letter Generator Web application on Solaris on page 458.

● Configuring the Letter Generator Web application on AIX on page 461.

Where to configure the Letter Generator Web application

Perform this procedure on the machine that hosts the Workflow server for Letter 
Generator.

Hosting multiple Web applications on one machine

If the Avaya IC system includes more than one Web application on the same machine as 
the WebLM, Avaya recommends that you:

● Select Multiple for the Tomcat Setup option.

● Configure all of the Web applications on the target machine at the same time.
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! Important:! Important:
Important: If you do not configure all of the Web applications simultaneously, leave the 

options for all Web applications on the target machine checked when you re-
run the Configuration Tool to create the new Web applications. If you do not 
leave the options for the previously created Web applications checked, the 
Configuration Tool may delete those Web applications from the machine.

Advanced properties for the Letter Generator Web application

The Web tab also includes advanced properties for the Java Virtual Machine. 

Only configure the advanced properties if you expect a high volume of access to Letter 
Generator. For more information, see Advanced properties on the Web tab on page 501. 

Configuring the Letter Generator Web application on Windows

Use these instructions if you plan to host the Letter Generator Web application on a 
Windows machine.

You do not need to stop the IIS Web server on Windows machines.

To configure the Letter Generator Web application on a Windows machine:

1. To start the Configuration Tool, select Start > Programs > Avaya Interaction Center 
6.1 > Configuration Tool.
If the Configuration Tool is already open, close and re-open it to ensure that the 
Configuration Tool includes all system changes, such as new servers.

2. Log in with your IC Manager login ID and password.

3. Complete the general fields in the following table.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple
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JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

C:\jdk1.3.1_06

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600

IIS Website The name of the IIS Web server that the Web 
application will use. 
Tip: For a localized version of IIS, type the 
localized name for the IIS Web server.

Default Web Site

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct. 

xyzcorp.com

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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4. Complete the Letter Generator fields in the following table.

5. Select Apply Settings. 

6. Select OK in the Success dialog box.

7. Select Exit.
8. To complete the configuration, perform the following steps to ensure that all Letter 

Generator services start properly:

a. Open the Windows Services control panel.

b. Start the Tomcat NT services:

● For a multiple Tomcat setup, start Avaya IC Letter Generation Service 6.1.

● For a single Tomcat setup, start Avaya IC Jakarta Service 6.1.

For more information about how to start and stop Web application services, see 
Starting and stopping Avaya IC services on page 154.

Field Description Sample entry

Configure Letter 
Generator

Check this box if you want to configure the Web 
application for Letter Generator on the target 
machine.
After you check this box, the Configuration Tool 
displays the other required fields for Letter 
Generator.

Checkmark in box

HTTPConnector The HTTP Connector server used by Letter 
Generator.
You must create the HTTP Connector server 
before the Configuration Tool can include the 
server in the drop-down list. If the list does not 
include the server, close the Configuration Tool 
and create the server. 

HTTPConnector_User1

GhostScript Home The directory path for the GhostScript 
executable.

C:\ghostscript
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Configuring the Letter Generator Web application on Solaris

Use these instructions if you plan to host the Letter Generator Web application on a Solaris 
machine.

! Important:! Important:
Important: To configure the Letter Generator Web application on Solaris, you must log 

in as a user with write permissions on the Web server directories and the 
Avaya IC installation directories. The root user usually has these write 
permissions.

To configure the Letter Generator Web application to run on a Solaris machine:

1. Stop the Sun ONE server that hosts the Letter Generator Web application with the stop 
script packaged with the Web server: 
<SunONE_install_dir>/servers/<my_ONE_server>/stop

2. Start the Configuration Tool:

a. Navigate to IC_INSTALL_DIR/IC61/bin 

b. Run ./configure

If the Configuration Tool is already open, close and re-open it to ensure that the 
Configuration Tool includes all system changes, such as new servers.

3. Log in with your IC Manager login ID and password.

4. Complete the general fields in the following table.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple

JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

/opt/j2sdk1_3_1_06

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600



Configuring Letter Generator

Issue 2.0 June 2004 459

Web Server Home The installation path for the Sun ONE� Server 
that hosts the Web application.

/opt/iplanet

Web Server Name The root name of the server as found in the Sun 
ONE� Server home directory.
Note: Do not include https- in the Web server 
name.

testbox.xyzcorp.com

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct. 

xyzcorp.com

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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5. Complete the Letter Generator fields in the following table.

6. Select Apply Settings. 

7. Select OK in the Success dialog box.

8. Select Exit.
9. To complete the configuration, perform the following steps to ensure that all Letter 

Generator services start properly:

a. In the Sun ONE Server installation directory:

● Open the https-admserv directory.

● If the directory includes a file called start-ICEnv.backup, execute the following 
command to rename the file:

mv start-ICEnv.backup oldstart-ICEnv

b. Start the Sun ONE server that hosts the Letter Generator Web application with the 
following start script:

<SunONE_install_dir>/servers/<my_ONE_server>/start

c. Navigate to the IC_INSTALL_DIR/IC61/bin directory.

d. Use the following script to start Tomcat:

● If you selected Multiple in the Tomcat Setup field: 

./ictomcat.sh start all

● If you selected Single in the Tomcat Setup field:

./ictomcat.sh start docgen

Field Description Sample entry

Configure Letter 
Generator

Check this box if you want to configure the Web 
application for Letter Generator on the target 
machine.
After you check this box, the Configuration Tool 
displays the other required fields for Letter 
Generator.

Checkmark in box

HTTPConnector The HTTP Connector server used by Letter 
Generator.
You must create the HTTP Connector server 
before the Configuration Tool can include the 
server in the drop-down list. If the list does not 
include the server, close the Configuration Tool 
and create the server. 

HTTPConnector_User1

GhostScript Home The directory path for the GhostScript 
executable.

/opt/gs
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Configuring the Letter Generator Web application on AIX

Use these instructions if you plan to host the Letter Generator Web application on an AIX 
machine.

! Important:! Important:
Important: To configure the Letter Generator Web application on AIX, you must log in 

as a user with write permissions on the Web server directories and the 
Avaya IC installation directories. The root user usually has these write 
permissions.

To configure the Letter Generator Web application to run on an AIX machine:

1. Stop the IBM HTTP Server that hosts the Letter Generator Web application with the 
stop script packaged with the Web server: 
./httpserver.sh stop

2. Start the Configuration Tool:

a. Navigate to IC_INSTALL_DIR/IC61/bin 

b. Run ./configure

If the Configuration Tool is already open, close and re-open it to ensure that the 
Configuration Tool includes all system changes, such as new servers.

3. Log in with your IC Manager login ID and password.

4. Complete the general fields in the following table.

Field Description Sample entry

Tomcat Setup This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. 
The Single option creates a single Tomcat server 
that controls all Web applications. 
For more information, see General fields on the 
Web tab on page 495.

Multiple

JDK Home The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

/usr/java131

Tomcat Base Port The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600
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Web Server Home The installation path for the IBM HTTP server 
instance that hosts the Web application.

/usr/HTTPServer

Web Server Host The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: Verify the default DNS domain carefully to 
ensure that it is correct. 

xyzcorp.com

Web Server Port The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, type: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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5. Complete the Letter Generator fields in the following table.

6. Select Apply Settings. 

7. Select OK in the Success dialog box.

8. Select Exit.
9. To complete the configuration, perform the following steps to ensure that all Letter 

Generator services start properly:

a. Start the IBM HTTP Server that hosts the Letter Generator Web application with the 
following start script:

./httpserver.sh start

b. Navigate to the IC_INSTALL_DIR/IC61/bin directory.

c. Use the following script to start Tomcat:

● If you selected Multiple in the Tomcat Setup field: 

./ictomcat.sh start all

● If you selected Single in the Tomcat Setup field:

./ictomcat.sh start docgen

Field Description Sample entry

Configure Letter 
Generator

Check this box if you want to configure the Web 
application for Letter Generator on the target 
machine.
After you check this box, the Configuration Tool 
displays the other required fields for Letter 
Generator.

Checkmark in box

HTTPConnector The HTTP Connector server used by Letter 
Generator.
You must create the HTTP Connector server 
before the Configuration Tool can include the 
server in the drop-down list. If the list does not 
include the server, close the Configuration Tool 
and create the server. 

HTTPConnector_User1

GhostScript Home The directory path for the GhostScript 
executable.

/usr/gs
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Editing Letter Generator properties in IC Manager
To configure the server and port number for Letter Generation:

1. In IC Manager, select Tools > Groups.

2. Select IC in the left pane of the Group Manager.
3. Select the Properties tab.

4. Select QUI > Letter Generator from the Sections list.

5. Double-click ServerNameAndPort. 
6. Set this property to point to the server and port where you deployed the Letter 

Generator Web application.

For example, if your server is qapc18, and your port is 80, type qapc18:80.

7. Select OK.

Note:
Note: Close and re-open all agent applications, so your changes take effect.

Configuring a Workflow server for Letter Generator
Create at least one dedicated Workflow server for Letter Generator. The Letter Generator 
Workflow server must be:

● In the same domain as the HTTP Connector server, or you must configure the Letter 
Generator domain to failover to the domain that contains the HTTP Connector server.

● On the same physical machine as the Letter Generator Workflow server.The Letter 
Generator Workflow server uses the data source for your Business Application.

To configure the Workflow server for Letter Generator, perform the steps in the following 
topics:

1. Creating a Workflow server for Letter Generator on page 464.

2. Using workflows for Letter Generator on page 465.

Creating a Workflow server for Letter Generator

Note:
Note: The Letter Generator Workflow server shares the same Windows temp file 

as the Tomcat server used by Letter Generator. You must install the 
Workflow server and the Web application for Letter Generator on the same 
physical machine.
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To create a Workflow server for Letter Generator:

1. Select Server > New in IC Manager.

2. Select Workflow from the list of servers. Select OK.

3. Select the General tab, and complete the fields as shown in the following table:

4. Select the Workflow tab.

5. From the IC Data Source drop-down list, select the data source for your Business 
Application.

For example, if your Avaya IC system includes Request-based CallCenterQ, the 
default name for the data source is ccq_request.

You can use the default settings for the Workflow server to get your system up and 
running. For more detailed information about these parameters and how to customize 
them for your system, see IC Administration Volume 1: Servers & Domains.

6. Select Apply.

7. Select OK.

Using workflows for Letter Generator

Letter Generator uses the sample workflows in the DocGen project. Avaya IC installs the 
DocGen project in the following directory on the machine that hosts Workflow Designer:

IC_INSTALL_DIR\IC61\design\IC\Flows\Avaya\DocGen

The Avaya IC seed data includes compiled sample workflows for this project. When you 
created the CCQ database, you imported the compiled workflows with the seed data and 
stored them in the database.

For a complete list of the workflows in the docgen project, including the directories where 
Avaya IC installs the workflows, see Avaya Workflow Designer User Guide.

Field Recommended entry Notes

Name DocGenWorkflowServer

Domain Select the Avaya IC domain 
for the server from the drop-
down list.

For example, select Default 
from the drop-down list if the 
server is in the Default domain.

Host Select the machine�s IP 
address from the drop-down 
list, or type in the IP address 
if it is not in the list.

When you select the host, IC 
Manager fills in the fields for 
Directory, Port, and Executable.
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Configuring Letter Generator for Japanese
To process and view documents in Japanese, perform the steps in the following topics:

1. Installing Japanese fonts on page 466.

2. Modifying the Letter Generator configuration files on page 467.

3. Using Japanese fonts in Letter Generator on page 468.

Note:
Note: The examples in this section use Mincho font. If your Avaya IC system uses 

a different Japanese font, replace the Mincho information with the 
appropriate font information.

Installing Japanese fonts

Letter Generator supports Japanese fonts in the following formats:

● True Type Fonts (.ttf) 

● True Type Collection (.ttc)

● Adobe type 1 (.pfm)

To install Japanese fonts:

1. If you host Letter Generator on Windows, open a command prompt window:

a. Select Start > Run. 

b. Type cmd in the Open field.

c. Select OK.

2. From a command prompt, navigate to the Letter Generator directory: 

● Windows, navigate to IC_INSTALL_DIR\IC61\docgen

● Solaris, navigate to IC_INSTALL_DIR/IC61/docgen

● AIX, navigate to IC_INSTALL_DIR/IC61/docgen
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3. Execute the appropriate command, shown in the following table:

For example, on a Windows machine where Avaya IC was installed in the default directory 
and the fonts are stored in the c:\winnt\fonts directory. to create the mincho.xml file 
and use the Mincho font, run the following command:

Tip:
Tip: More information about installing fonts is available on the following Website: 

http://xml.apache.org/fop/fonts.html.

Modifying the Letter Generator configuration files

To modify the Letter Generator configuration files:

1. Edit the following file: IC_INSTALL_DIR/IC61/docgen/WEB-
INF/userconfig.xml

a. Open the file in a text editor, such as Notepad.

b. Add the following text to the file:

c. Save and close the file.

Operating 
system

Font type Command

Windows Adobe type 1 (.pfm) pfmtoxml.bat <font_dir>/<font_name> 
<IC_install_dir>/docgen/WEB-INF/<font>.xml

● True Type Fonts 
(.ttf) 

● True Type 
Collection (.ttc)

ttftoxml.bat <font_dir>\<font_name> 
"<IC_install_dir>\docgen\WEB-INF\<font>.xml"

Solaris and AIX Adobe type 1 (.pfm) pfmtoxml.sh <font_dir>/<font_name> 
<IC_install_dir>/docgen/WEB-INF/<font>.xml

● True Type Fonts 
(.ttf) 

● True Type 
Collection (.ttc)

ttftoxml.sh <font_dir>/<font_name> 
<IC_install_dir>/docgen/WEB-INF/<font>.xml

ttftoxml.bat c:\winnt\fonts\mincho.ttc c:\Program 
Files\Avaya\IC61\docgen\WEB-INF\mincho.xml

<font metrics-file="<install_dir>/IC61/docgen/WEB-INF/msmincho.xml" embed-
file="<install_dir>/IC61/mincho.ttc" kerning="yes">
    <font-triplet name="Mincho" style="normal" weight="normal"/>
    <font-triplet name="Mincho" style="normal" weight="bold"/>
    <font-triplet name="Mincho" style="italic" weight="normal"/>
    <font-triplet name="Mincho" style="italic" weight="bold"/>
   </font>

http://xml.apache.org/fop/fonts.html
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2. Edit the following file: IC_INSTALL_DIR/IC61/docgen/xsl/fonts.xml

a. Open the file in a text editor, such as Notepad.

b. Add the following text to the file:

c. Save and close the file.

Using Japanese fonts in Letter Generator

To use Japanese fonts in Letter Generator:

1. Create a letter template that includes Japanese text. 

2. In the template editor, select all the text in the template.

3. Set the font to the Japanese font on your system, such as Mincho.

4. Generate and process the documents in Letter Generator.

Installing and configuring a second ICM server 
The ICM Server hosts the Web Management conferences between agents and customers. 
You can install a second ICM Server, for one or both of the following reasons: 

● To increase the capacity or load sharing of chat functionality

● To use a secure server for chat escalations from one site but not another

Install the second ICM server on a dedicated machine for scalability. Do not install the 
second ICM server on the machine that hosts your database software.

If you�re setting up a secure ICM, follow the instructions in the section Configuring SSL 
security for Web servers (optional) on page 295, as well as the instructions below.

<font name="Mincho">
<style name="normal">
Mincho
</style>
<style name="bold">
Mincho
</style>
<style name="bolditalic">
Mincho
</style>
<style name="italic">
Mincho
</style>
</font>
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You can configure a second ICM server in one of the following ways:

● With a CIRS server for load balancing. In this configuration, users enter the Website on 
the primary machine and are redirected to an ICM server on a different machine based 
on the load. For more information, see Configuring a second ICM server with a CIRS 
server on page 469.

● Without a CIRS server. In this configuration, each combination of ICM server and 
Website is independent. 

Configuring a second ICM server with a CIRS server
To configure a second ICM server to work with a CIRS server and the website, you must 
designate the machine that hosts an ICM server and Website combination as the primary 
server machine. 

After you select the primary server machine, perform the steps in the following topics:

1. Configuring the primary ICM server on page 469.

2. Configuring the second ICM server on page 470.

3. Configuring the CIRS server on page 471.

4. Configuring the CIRS servlet for Website on page 472.

5. Adding ICM servers to the ICM Bridge on page 474.

Configuring the primary ICM server

To configure the Primary ICM server:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Chat > ICM.

3. Select the ICM table with the same name as the dsObjectName in 
IC_INSTALL_DIR/IC61/etc/SystemParms.txt

If the table does not exist, create a new table. For more information, see Configuring 
the ICM server on page 282.
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4. Update the fields in the right pane shown in the following table:

For information on all other fields, see Configuring the ICM server on page 282.

5. Select OK.

6. Restart the ICM server 

7. Start the CIRS server.

8. Add the ICM server to the ICM Bridge. For more information, see Adding ICM servers 
to the ICM Bridge on page 474. 

Configuring the second ICM server

Before you configure the second ICM server, you must do the following:

1. Install and configure secondary Avaya IC servers, including a secondary ORB server, 
on the machine that will host the second ICM server.

For more information, see Configuring secondary servers on page 161.

2. Copy the vesp.imp file from the machine that hosts the primary server to the following 
directory on the machine that hosts the secondary servers 
IC_INSTALL_DIR/IC61/etc.

To configure the second ICM Server:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Chat > ICM.

3. Select New.

Property Recommended entry

Global ICM Name Type the value of dsObjectName.

ICM Server Name Type the fully-qualified domain name of the 
machine that hosts the primary ICM server.

CIRS Host Type the hostname of the machine that hosts the 
primary ICM server.

CIRS Port Type the port for the CIRS server.
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4. Update the following fields in the right pane shown in the following table:

For information on all other fields, see Configuring the ICM server on page 282.

5. Select OK.

6. Restart the ICM server 

7. Start the CIRS server.

8. Add the ICM server to the ICM Bridge. For more information, see Adding ICM servers 
to the ICM Bridge on page 474. 

Configuring the CIRS server

To configure the CIRS server:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Chat > CIRS.

3. Select the CIRS table with the same name as the dsObjectName in 
IC_INSTALL_DIR/IC61/etc/cirsParms.txt

If the table does not exist, create a new table. For more information, see Configuring 
the Central Internet Routing service on page 286.

4. In the Global CIRS Name field in the right pane, type the value of dsObjectName in 
IC_INSTALL_DIR/IC61/etc/cirsParms.txt

For information on all other fields, see Configuring the Central Internet Routing 
service on page 286.

5. Select OK.

6. Start the CIRS server.

Property Recommended entry

Global ICM Name Type a name for the second ICM server.
For example, type icm2.

ICM Server Name Type the fully-qualified domain name of the 
machine that hosts the second ICM server.

CIRS Host Type the hostname of the machine that hosts the 
primary ICM server.

CIRS Port Type the port for the CIRS server.
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Configuring the CIRS servlet for Website

For more information about Website applications, see Configuring the Website on 
page 288.

To configure the CIRS servlet for website:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Website > Website Context.
3. Create or update the websitecontext record for each Web Management application 

that chat users must access. 

a. Right-click in the right pane and check the box next to Show Advanced Properties.

b. Complete the fields as shown in the following table:

For information on all other fields, see Configuring the Central Internet Routing 
service on page 286.

4. Select OK. 

5. Restart each server that hosts a Website application.

6. Start the ICM server.

Configuring an independent second ICM server
Before you configure an independent ICM server, you must do the following:

1. Install and configure secondary Avaya IC servers, including a secondary ORB server, 
on the machine that will host the second ICM server.

For more information, see Configuring secondary servers on page 161.

2. Copy the vesp.imp file from the machine that hosts the primary server to the following 
directory on the machine that hosts the secondary servers 
IC_INSTALL_DIR/IC61/etc.

Property Recommended entry

Global Name Type the value of dsObjectName in 
IC_INSTALL_DIR/IC61/comp/website/WEB
-INF/web.xml.

ICM Servlets Active Check this box.

ICM CIRS Servlet Active Check this box.
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After you select the primary server machine, perform the steps in the following topics:

1. Configuring a second ICM server on page 473.

2. Disabling the CIRS servlet for Website on page 473.

3. Adding ICM servers to the ICM Bridge on page 474.

Configuring a second ICM server

To configure an independent second ICM server:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Chat > ICM.

3. Select New.

4. Type a name for the second ICM server in the Global ICM Name field.

For information on all other fields, see Configuring the ICM server on page 282.

5. Select OK.

6. Restart the ICM server 

7. Add the ICM server to the ICM Bridge. For more information, see Adding ICM servers 
to the ICM Bridge on page 474. 

Disabling the CIRS servlet for Website

For more information about Website applications, see Configuring the Website on 
page 288.

To disable the CIRS servlet for website:

1. In IC Manager, select the Configuration tab.

2. From the Tables list in left pane, select Website > Website Context.
3. Create or update the websitecontext record for each Web Management application 

that chat users must access. 

a. Right-click in the right pane and check the box next to Show Advanced Properties.

b. Complete the fields as shown in the following table:

Property Recommended entry

Global Name Type the value of dsObjectName in 
IC_INSTALL_DIR/IC61/comp/website/WEB
-INF/web.xml.

ICM CIRS Servlets Active Do not check this box.
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4. Select OK. 

5. Restart each server that hosts a Website application.

6. Start the ICM server.

Adding ICM servers to the ICM Bridge
You add ICM servers to the ICM bridge in the Attribute server configuration. For more 
information, see Creating the WebACD server on page 249.

To add the second ICM server to the ICM Bridge:

1. In IC Manager, double-click the Attribute server in the list of servers.

2. Select the Attribute tab.

3. Select the Ellipsis (�) next to the ICM Servers field.

4. In the ICM Servers dialog box:

a. Select New.

b. Check Enabled.

c. In the Host field, type the name and domain of the machine that hosts the ICM 
server. For example, type TESTBOX.xyzcorp.com.

d. Accept the default port number (8103) or change to an available port.

e. Select OK.

Repeat these steps for each ICM server in your Avaya IC system.

5. Select OK.

6. Restart the Attribute server
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Installing the SDK for Avaya IC servers
Avaya IC provides a Software Development Kit (SDK) for the Avaya IC servers. The SDK 
includes all of the files that you require to build your own Avaya IC servers, including:

● Header files

● Libraries

● Sample server project files

To install the SDK:

1. Navigate to the following directory in the Avaya Interaction Center CD-ROM:

2. Copy the compressed SDK file to your Avaya IC directory.

3. Uncompress the file and extract the contents.

4. Verify that the files have been extracted into the folder that you selected. This folder 
should include C files and a makefile 

For more information, see IC Client and Server Programmer's Design Guide.

Operating system Directory path

Windows <CD-ROM_drive>\Utils\Sdk\sdkwin32.zip

Solaris <CD-ROM_drive>/Solaris/Sdk/sdk.tar

AIX <CD-ROM_drive>/Aix/Sdk/sdk.tar
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Appendix A: Using the Configuration Tool

You use the Configuration Tool to perform the following tasks when you install and 
configure Avaya Interaction Center (Avaya IC):

● Configure the primary server environment and start the primary ORB server.

● Configure secondary server environments and start secondary ORB servers.

● Configure the client environment for the Design & Administration Tools.

● Specify the switch associated with a Telephony server.

● Create and configure Tomcat Web applications for:

- Web License Manager

- Web Management Websites

- Email Template Administration

- Letter Generator

● Configure database access for:

- Suggested Response feature of the WACD server

- Datawake recording feature of the Attribute server

● Configure Outbound Contact Reports.

This section contains detailed information about the Configuration Tool, and information 
about how to use it when you configure Avaya IC. This section includes the following 
topics:

● Configuration Tool basics on page 478.

● Initial Configuration tab on page 480.

● Outbound Contact tab on page 491.

● Web tab on page 492.
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Configuration Tool basics
The Configuration Tool works with all operating systems, databases, and web servers 
supported by Avaya IC. 

This section describes basic information you need to know before you use the 
Configuration Tool. This section includes the following topics:

● Understanding the required permissions on page 478.

● Configuration Tool and Web servers on page 478.

● Backing up configuration files on page 479.

● Starting the Configuration Tool on page 479.

Understanding the required permissions
When you log in to use the Configuration Tool, you must have a user account with the 
permissions described in the following table.

Configuration Tool and Web servers
On some operating systems, you need to stop the Web server before you run the 
Configuration Tool.

The requirements for Web servers are:

● On Solaris machines, stop the Sun ONE server that hosts the Web License Manager 
application with the stop script packaged with the Web server: 
<SunONE_install_dir>/servers/<my_ONE_server>/stop

● On AIX machines, stop the IBM HTTP Server that hosts the Web License Manager 
application with the stop script packaged with the Web server: 
<IBMHTTP_install_dir>/bin/apachectl stop

● On Windows machines, you do not need to stop the IIS Web server.

Operating system User account

Windows Administrator

Solaris Root user

AIX Root user
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Backing up configuration files
Before the Configuration Tool updates or changes a configuration file, the Configuration 
Tool backs up those files. The Configuration Tool stores backup copies of all configuration 
files in the following directory: bin\config\backup. 

The Configuration Tool makes a backup of the iplanet configuration files for Sun ONE 
Server in the form of *.backup. 

Starting the Configuration Tool
To run the Configuration Tool from a command line, you must run the configure command 
from the working directory of IC_INSTALL_DIR\IC61\bin. If you run the configure 
command from another directory, the Configuration Tool may not work correctly.

This section includes the following topics:

● Starting the Configuration Tool in Windows on page 479.

● Running the Configuration Tool from a command line in Windows on page 479.

● Running the Configuration Tool from a command line in Solaris and AIX on page 479.

Starting the Configuration Tool in Windows

To start the Configuration Tool in Windows:

● Select Start > Programs > Avaya Interaction Center 6.1 > Configuration Tool.

Running the Configuration Tool from a command line in Windows

To run the Configuration Tool from a command line:

1. From a command line, navigate to IC_INSTALL_DIR\IC61\bin

2. Type configure and press Enter.

Running the Configuration Tool from a command line in Solaris and AIX

To run the Configuration Tool from a command line:

1. From a command line, navigate to IC_INSTALL_DIR/IC61/bin

2. Type ./configure and press Enter.
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Initial Configuration tab
When you run the Configuration Tool after you install Avaya IC servers or Design & 
Administration Tools, the Initial Configuration tab is the only tab available. You use the 
Initial Configuration tab to perform the following tasks:

● Configure the primary server environment and start the primary ORB server.

● Configure secondary server environments and start secondary ORB servers.

● Configure the client environment for the Design & Administration Tools.

● Specify the switch associated with a Telephony server.

This section includes the following topics that describe the fields on this tab:

● Primary server fields on the Initial Configuration tab on page 481.

● Secondary server fields on the Initial Configuration tab on page 484.

● Client fields on the Initial Configuration tab on page 487.

● Oracle database fields on the Initial Configuration tab on page 489.

● DB2 database fields on the Initial Configuration tab on page 490.
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Primary server fields on the Initial Configuration tab
Use the primary server fields on the Initial Configuration tab to configure the primary server 
environment on the machine that hosts the primary ORB server. 

The following figure shows the primary server fields on the Initial Configuration tab, 
including the optional fields to configure a system that includes an Oracle database or a 
DB2 database.
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The following table describes the general fields on the Initial Configuration tab that are 
visible when you select the Primary mode. For information about when you use the 
Configuration Tool to configure the primary servers, and the other steps that you must 
perform to complete the configuration, see Creating the primary server environment on 
page 58.

Field Description Sample entry

Select Mode The option you choose from this drop-down list 
specifies the Avaya IC components that you want 
to configure with the Configuration Tool. 
The Primary option in this drop-down list tells the 
Configuration Tool that you want to configure the 
core servers, including the primary ORB server.

Primary

IP Address The IP address for the machine that hosts the 
primary ORB server.
Note: If the primary ORB server runs on a 
machine with multiple network interface cards, 
you must select the IP address for the first 
network interface card on the machine. The 
primary ORB server cannot run on any other 
network interface card.

145.170.12.245

Start Port The port that the primary ORB server uses for 
communications.
You must make sure that the port assignment in 
the Start Port field is an available port. Type a 
new port assignment if necessary.

Default:
9001

Start ORB Server If you place a checkmark in this box, the 
Configuration Tool automatically starts the 
primary ORB server on the target machine.

Checkmark in box

Telephony Server This is an optional field that you select if the 
target machine hosts a Telephony server.
After you select this box, the Configuration Tool 
displays the Telephony Switch drop-down list.

Checkmark in box

Telephony Switch The Telephony Switch drop-down list includes all 
switches that Avaya IC supports. 
Select the switch with which the Telephony server 
on the target machine needs to communicate.
You must select a switch that is supported for the 
operating system of the server. For example, do 
not select a Nortel switch if you plan to host the 
Telephony server on an AIX machine. For more 
information about switch support, see IC 
Installation Planning and Prerequisites.

Avaya Definity
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Oracle Setup This is an optional field that you select if the 
Avaya IC system includes an Oracle database.
After you select this box, the Configuration Tool 
displays the Oracle configuration fields. For more 
information, see Oracle database fields on the 
Initial Configuration tab on page 489.

Check this box.

DB2 Setup This is an optional field that you select if the 
Avaya IC system includes a DB2 database.
After you select this box, the Configuration Tool 
displays the DB2 configuration fields. For more 
information, see DB2 database fields on the Initial 
Configuration tab on page 490.

Check this box.

Locale Required for AIX and Solaris only. Do not 
complete for Windows.
The primary locale of the machine that hosts the 
servers. 
The drop-down list includes all of the locales 
supported by the operating system. For a list of 
the locales supported by Avaya IC, see IC 
Installation Planning and Prerequisites.

For AIX, select EN_US.

For Solaris, select 
en_US.UTF-8.

Field Description Sample entry
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Secondary server fields on the Initial Configuration tab
Use the secondary server fields on the Initial Configuration tab to configure a secondary 
server environment on every machine that hosts a secondary ORB server. You must 
configure a secondary server environment on every machine that runs Avaya IC servers, 
except the machine that hosts the primary ORB server.

The following figure shows the secondary server fields on the Initial Configuration tab, 
including the optional fields to configure a system that includes an Oracle database or a 
DB2 database.
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The following table describes the fields on the Initial Configuration tab that are visible when 
you select the Secondary mode. For information about when you use the Configuration 
Tool to configure the secondary servers, and the other steps that you must perform to 
complete the configuration, see Configuring secondary servers on page 161.

Field Description Sample entry

Select Mode The option you choose from this drop-down list 
specifies the Avaya IC components that you want 
to configure with the Configuration Tool. The 
Secondary option in this drop-down list tells the 
Configuration Tool that you want to configure a 
secondary server environment, including a 
secondary ORB server, on the target machine.

Secondary

IP Address The IP address for the machine that hosts the 
secondary ORB server.
Note: If the secondary ORB server runs on a 
machine with multiple network interface cards, 
you must select the IP address for the first 
network interface card on the machine. The 
secondary ORB server cannot run on any other 
network interface card.

145.170.12.245

Secondary ORB 
Port

The port on the target machine that the 
secondary ORB server uses for communications.
Because the secondary ORB server is on a 
different machine from the primary ORB server, 
the secondary ORB server can use the same port 
as the primary ORB server.
You must make sure that the port assignment in 
the Start Port field is an available port. Type a 
new port assignment if necessary.

Default:
9001

Primary Host Name The name of the machine that hosts the primary 
ORB server.
The primary host name can be the IP Address or 
fully-qualified domain name of the machine.

coresvr.avaya.com

Primary ORB Port The port that the primary ORB server uses for 
communications.

Default: 
9001

IC Login The administrative login ID that you must create 
for Avaya IC servers.
For more information, see Setting up 
administrative accounts on page 119.

serveradmin

IC Password The password associated with the IC Login. admin1

IC Domain This is the Avaya IC domain that includes the 
primary ORB server. This domain is typically the 
Default domain.

Default
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Start ORB Server If you place a checkmark in this box, the 
Configuration Tool automatically starts the 
secondary ORB server on the target machine.

Checkmark in box

Telephony Server This is an optional field that you select if the 
target machine hosts a Telephony server.
After you select this box, the Configuration Tool 
displays the Telephony Switch drop-down list.

Checkmark in box

Telephony Switch The Telephony Switch drop-down list includes all 
switches that Avaya IC supports. You must select 
the switch with which the Telephony server needs 
to communicate.

Avaya Definity

Oracle Setup This is an optional field that you select if the 
Avaya IC system includes an Oracle database.
After you select this box, the Configuration Tool 
displays the Oracle configuration fields. For more 
information, see Oracle database fields on the 
Initial Configuration tab on page 489.

Check this box.

DB2 Setup This is an optional field that you select if the 
Avaya IC system includes a DB2 database.
After you select this box, the Configuration Tool 
displays the DB2 configuration fields. For more 
information, see DB2 database fields on the Initial 
Configuration tab on page 490.

Check this box.

Locale Required for AIX and Solaris only. Do not 
complete for Windows.
The primary locale of the machine that hosts the 
servers. 
The drop-down list includes all of the locales 
supported by the operating system. 

For AIX, select EN_US.

For Solaris, select 
en_US.UTF-8.

Field Description Sample entry
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Client fields on the Initial Configuration tab
Use the client fields on the Initial Configuration tab to configure the environment for Design 
& Administration Tools. You must configure a client environment on every machine that 
hosts Design & Administration Tools.

The following figure shows the client fields on the Initial Configuration tab.
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The following table describes the fields on the Initial Configuration tab that are visible when 
you select the Client mode. For information about when you use the Configuration Tool to 
configure the design and administration environment, and the other steps that you must 
perform to complete the configuration, see Configuring the design and administration 
environment on page 66.

! Important:! Important:
Important: You do not need to complete the optional fields for the Telephony server, an 

Oracle database, a DB2 database, or Locale.

Field Description Sample entry

Select Mode The option you choose from this drop-down list 
specifies the Avaya IC components that you want 
to configure with the Configuration Tool. The 
Client option in this drop-down list tells the 
Configuration Tool that you want to configure the 
design and administration environment on the 
target machine.

Client

Primary Host Name The name of the machine that hosts the primary 
ORB server.
The primary host name can be the IP Address or 
fully-qualified domain name of the machine.

coresvr.avaya.com

Primary ORB Port The port that the primary ORB server uses for 
communications.

Default:
9001

IC Domain This is the Avaya IC domain that includes the 
primary ORB server. This domain is typically the 
Default domain.

Default
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Oracle database fields on the Initial Configuration tab
When you configure a primary server environment, you must also complete the Oracle 
database fields if your Avaya IC system includes an Oracle database. 

Note:
Note: You do not need to complete these fields for a client environment.

The following table includes the fields on the Initial Configuration tab that are visible when 
you check the Oracle Setup box.

Field Description Sample entry

Oracle Setup This option is only required if your Avaya IC 
system includes an Oracle database. 
After you select this option, the Configuration Tool 
displays the following fields. 

Checkmark in box

NLS LANG You must complete this field for Oracle databases 
on Windows or Solaris.
Oracle uses National Language Support (NLS 
LANG) values to set up language-specific 
databases. The character set part of the 
NLS_LANG parameter specifies the character set 
used by the Data server. 
Do not use abbreviations in the NLS LANG 
parameter. For example, do not use "US" to 
designate American English. For a list of NLS 
LANG parameters for supported languages, see 
Specifying the NLS Lang property for Oracle on 
page 544.
The following are examples of NLS Lang 
properties for English and Japanese:
● AMERICAN_AMERICA.UTF8 
● JAPANESE_JAPAN.UTF8 
On Solaris, NLS_LANG is specified as an 
environment variable.
On Windows, NLS_LANG is set in the registry 
under HKEY_LOCAL_MACHINE > SOFTWARE 
> ORACLE > HOMEn.
See the Oracle documentation for more 
information.
Caution: The character set in the NLS LANG 
parameter must match the character set of your 
Oracle database. If these character sets are 
different, strange character conversions and 
string truncations may result.

AMERICAN_AMERICA.UT
F8
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DB2 database fields on the Initial Configuration tab
When you configure a primary server environment or a secondary server environment, you 
must also complete the DB2 database fields if your Avaya IC system includes a DB2 
database on AIX. 

Note:
Note: You do not need to complete these fields for a client environment.

The following table includes the fields on the Initial Configuration tab that are visible when 
you check the DB2 Setup box.

Oracle Home The home directory of the Oracle client on the 
machine that hosts the core servers.

/opt/oracle/8.1.7

Oracle SID
(UNIX only)

Oracle databases on Solaris only.
The Oracle SID of your database.
Note: The Oracle SID field is case-sensitive.

icutf8db

Oracle version
(UNIX only)

Oracle databases on Solaris only.
The supported version of Oracle that hosts the 
Avaya IC databases.

Oracle 9

Field Description Sample entry

Field Description Sample entry

DB2 Setup This option is only required if your Avaya IC 
system includes a DB2 database on AIX. 
After you select this option, the Configuration Tool 
displays the following fields. 

Checkmark in box

DB2 Home Enter the home directory of the DB2 client on the 
machine that hosts the core servers.

/usr/lpp/db2_07_01

DB2 Instance Enter the name of the DB2 instance. db2inst1
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Outbound Contact tab
You use the Outbound Contact tab to configure Outbound Contact Reports. 

The Outbound Contact tab is only visible if you select the option to run Outbound Contact 
Reporting when you install the Design & Administration Tools on the target machine.

Tip:
Tip: If you do not see the Outbound Contact tab, and you need to configure 

Outbound Contact Reports on the target machine, re-run the Avaya IC 
installation and select the option to run Outbound Contact Reporting.

The following figure shows the Outbound Contact tab of the Configuration Tool.

The following table describes the fields on the Outbound Contact tab.

Field Description Sample entry

Dialer Data Source The Dialer data source that you create with the 
Dialer database. For more information, see 
Generating the Dialer application and data 
source on page 227.

dialer

Database Login A DBA login ID for your Dialer database.
Enter a DBA login ID for the database server. 
Do not use the DBA login for a database client.

sa

Database 
Password

The password for the DBA login ID. admin1

Oracle Home For Oracle databases on Windows or Solaris.
Enter the home directory of the Oracle client on 
the machine that hosts the core servers.

/opt/oracle/8.1.7
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Web tab
Use the Web tab of the Configuration Tool on the following: 

● Machines that host Web applications to create and configure the Tomcat Web 
applications for the following Avaya IC components:

- Web License Manager

- Web Management Websites

- Email Template Administration

- Letter Generator

● Machines that host the WebACD server and Attribute servers to configure database 
access for:

- Suggested Response feature of the WebACD server

- Datawake recording feature of the Attribute server

You can choose to create and configure multiple Tomcat Web applications on the same 
machine, or to create and configure the Web applications on different machines.

This section includes the following topics:

● Web tab basics on page 492.

● General fields on the Web tab on page 495.

● Web License Manager fields on the Web tab on page 497.

● Letter Generator fields on the Web tab on page 497.

● Email Template Administration fields on the Web tab on page 498.

● Web Management fields on the Web tab on page 499.

● Advanced properties on the Web tab on page 501.

Web tab basics
The fields on the Web tab are dynamic and change according to the operating system of 
the machine on which the Configuration Tool is run.

This section includes figures that show the fields on the Web tab for each operating system 
that Avaya IC supports. Topics include:

● Web tab on a Windows machine on page 493.

● Web tab on a Solaris or AIX machine on page 494.
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Web tab on a Windows machine

The following figure shows all available fields on the Web tab of the Configuration Tool 
when you run the Configuration Tool on a Windows machine.
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Web tab on a Solaris or AIX machine

The following figure shows all available fields on the Web tab of the Configuration Tool 
when you run the Configuration Tool on a Solaris or AIX machine.
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General fields on the Web tab
The following table describes the fields on the Web tab that apply to all Web applications. 
The only general field that is not required is the IC Test field. 

Field Description Sample entry

Tomcat Setup Required for all Web applications.
This option determines how many Tomcat servers 
the Configuration Tool must configure on the 
target machine.
Tip: Avaya recommends that you use the Multiple 
option.
The Multiple option creates a separate Tomcat 
server for each Web application. Choose Multiple 
if the machine hosts more than one Web 
application, and you want to start and stop all 
Web applications separately.
The Single option creates a single Tomcat server 
that controls all Web applications. Choose Single 
if the machine hosts:
● Only one Web application.
● More than one Web application and you do not 

want to start and stop the Web applications 
separately.

Multiple

JDK Home Required for all Web applications.
The path to the directory where the Java SDK is 
installed. 
For more information about the Java SDK, see IC 
Installation Planning and Prerequisites.

Windows:
C:\jdk1.3.1_06

Solaris:
/opt/j2sdk1_3_1_06

AIX:
/usr/java131

Tomcat Base Port Required for all Web applications.
The port used to configure the following ports:
● Tomcat HTTP ports for Web applications
● Tomcat AJP (Web server connector) ports

Default:
9600

Web Server Home Solaris or AIX only.
The installation path for the Sun ONE� Server or 
IBM HTTP server instance that hosts the Web 
application.

Solaris:
/opt/iplanet

AIX:
/usr/HTTPServer
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IIS Website Windows only.
The name of the IIS Web server that the Web 
application will use. 
Tip: For a localized version of IIS, type the 
localized name for the IIS Web server.

Default Web Site

Web Server Name Solaris only.
The root name of the server as found in the Sun 
ONE� Server home directory.
Note: Do not include https- in the Web server 
name.

testbox.xyzcorp.com

Web Server Host Required for all Web applications.
The name of the machine that hosts the Web 
server.
Do not include the DNS domain.

testbox

DNS Domain Required for all Web applications.
The network (DNS) domain of the machine that 
hosts your Web server. Do not enter an Avaya IC 
domain. 
Note: The Configuration Tool automatically 
enters a default DNS domain. Check this default 
entry carefully to ensure that it is correct. 

xyzcorp.com

Web Server Port Required for all Web applications.
The port that your Web server uses for 
communication. Make sure that the port matches 
the protocol used by your Web server for 
communication. The default ports are:
● HTTP port is 80.
● HTTPS port is 443.
Do not change the default port unless you assign 
a different port to the Web server.

Default:
80

IC Test Optional.
IC Test is a Web application that you can use to 
test your Tomcat configuration. 
If you install multiple versions of Tomcat, the 
Configuration Tool creates an IC Test application 
on each version of Tomcat. The Configuration 
Tool also creates a separate Tomcat server to 
host IC Test. 
To access IC Test, use the Tomcat HTTP port in 
the URL. For example, enter: 
http://<server>.<domain>.com:9606/ictest
Note: The port number is not required if you 
install a single version of Tomcat, or access IC 
Test from the separate Tomcat server for IC Test.

Checkmark in box

Field Description Sample entry
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Web License Manager fields on the Web tab
The following table describes the fields on the Web tab that are unique to Web License 
Manager. In addition to the fields in this table, you must also complete the required general 
fields to configure Web License Manager.

For information about when you use the Configuration Tool to configure Web License 
Manager, and the other steps that you must perform to complete the configuration, see 
Installing Avaya IC licenses on page 175.

Letter Generator fields on the Web tab
The following table describes the fields on the Web tab that are unique to Letter Generator. 
In addition to the fields in this table, you must also complete the required general fields to 
configure Letter Generator.

For information about when you use the Configuration Tool to configure Letter Generator, 
and the other steps that you must perform to complete the configuration, see Configuring 
Letter Generator on page 453.

Field Description

Configure Web License 
Manager

Check this box if you want to configure the Web 
application for the Web License Manager on the target 
machine.

Field Description Sample entry

Configure Letter 
Generator

Check this box if you want to configure the Web 
application for Letter Generator on the target 
machine.
After you check this box, the Configuration Tool 
displays the other required fields for Letter 
Generator.

Checkmark in box
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Email Template Administration fields on the Web tab
The following table describes the fields on the Web tab that are unique to Email Template 
Administration. In addition to the fields in this table, you must also complete the required 
general fields to configure Email Template Administration.

For information about when you use the Configuration Tool to configure Email Template 
Administration, and the other steps that you must perform to complete the configuration, 
see Configuring Email Template Administration on page 328.

HTTPConnector The HTTP Connector server used by Letter 
Generator.
You must create the HTTP Connector server 
before the Configuration Tool can include the 
server in the drop-down list. If the list does not 
include the server, close the Configuration Tool 
and create the server. 

HTTPConnector_User1

GhostScript Home The directory path for the GhostScript 
executable.

Windows:
C:\ghostscript

Solaris:
/opt/gs

AIX:
/usr/gs

Field Description Sample entry

Field Description

Configure Email Template 
Administration

Check this box if you want to configure the Web 
application for Email Template Administration on the 
target machine.
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Web Management fields on the Web tab
The following table describes the fields on the Web tab that you use to:

● Configure the Website Web application for Web Management

● Configure database access for:

- Suggested Response feature of the WACD server

- Datawake recording feature of the Attribute server

In addition to the fields in this table, you must also complete the general fields that are 
required for the target machine. For more information, see General fields on the Web 
tab on page 495.

For information about when you use the Configuration Tool to configure Web Management, 
and the other steps that you must perform to complete the configuration, see Configuring 
Web Management services on page 257.

Field Description Sample entry

Configure Web 
Management

Check this box if you want to configure Web 
Management services on the target machine.
After you check this box, the Configuration Tool 
automatically:
● Displays the other Web Management fields
● Checks the following boxes:

- Website
- ICM
- CIRS
- Attribute - DataWake recording (PDM)

Checkmark in box

Website Creates the Website Web application and 
performs other tasks that are required to 
configure a Web Management Website on the 
target machine.
After you check this box, the Configuration Tool 
displays the following required fields for the 
Website:
● Website Virtual Directory Name
● WebACD
● Attribute Server

Checkmark in box

Website Virtual 
Directory Name

The name of the virtual directory for the Website. website
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WebACD The WebACD server in your Avaya IC system.
You must create the WebACD server before the 
Configuration Tool can include the server in the 
drop-down list. If the list does not include the 
server, close the Configuration Tool and create 
the server. For more information, see Creating 
the WebACD server on page 249.

WebACD_web

Attribute Server The Attribute server that the Datawake plug-in 
uses.
You must create the Attribute server before the 
Configuration Tool can include the server in the 
drop-down list. If the list does not include the 
server, close the Configuration Tool and create 
the server. For more information, see Creating 
the Attribute server on page 252.

Attribute_web

ICM Service Configures the ICM server and related 
components on the target machine.
For more information, see Configuring the ICM 
server on page 282.

Checkmark in box

CIRS Service Configures the CIRS server and related 
components on the target machine.
For more information, see Configuring the Central 
Internet Routing service on page 286.

Checkmark in box

Attribute - 
DataWake 
recording (PDM)

Configures the DataWake recording feature of 
the Attribute server.

Checkmark in box

IC Login Use the website account that you imported into 
the database with the seed data. 
If you have not already done so, change the 
default password for this account. For more 
information, see IC Administration Volume 2: 
Agents, Customers, & Queues.
Note: Do not use the Administrator account for IC 
Manager or any other account for which the 
password may change. 

website

IC Password The password used by the IC Login. website

IC Data Source The Interaction Center data source that you 
create with the Interaction Center application for 
the CallCenterQ database. For more information, 
see Generating the Interaction Center 
application on page 109.

interaction_center

Field Description Sample entry
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Advanced properties on the Web tab
The Web tab includes advanced properties that specify the following properties for the 
Java Virtual Machine:

● Minimum Heap size and maximum Heap size

● Minimum Stack size and maximum Stack size

The fields that the Configuration Tool displays for the advanced properties depend upon 
the value you choose for Tomcat setup and which Web applications you select. The 
sample entries provided are the default values.

Repository Data 
Source

The Repository data source that you create with 
the repository application for the IC Repository 
database. For more information, see Generating 
the IC Repository application on page 98.

repository

Database Login Enter a DBA login ID for the database server. 
Note: Do not use the DBA login for a database 
client on a DB2 database.

SQL Server:
sa

Oracle:
sys

DB2:
db2inst1

Database 
Password

The password for the DBA login ID. admin

Database Host Solaris or AIX only.
The host name of the machine that hosts your 
database server.

testbox.xyzcorp.com

DB2 Port DB2 databases on AIX only.
The port that the target machine uses to 
communicate with the DB2 database. 

Default:
50,000

Oracle SID Oracle databases on Solaris only.
The Oracle SID of your database.
Note: The Oracle SID field is case-sensitive.

icutf8db

Oracle Home Oracle databases only.
The home directory of the Oracle client on the 
machine that hosts the Web Management 
servers.

SQL Server: leave empty

Oracle: 
C:\Oracle\Ora81

Field Description Sample entry
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Tip:
Tip: Configure the advanced properties only if you expect a high volume of 

contacts or access to the Web application. For example, configure the 
advanced properties for the Website and the ICM server if you expect a high 
volume of chat contacts from the customer Website. For information about 
performance and contact volume, see the benchmarking information 
available through an Avaya representative.

This section describes the advanced properties on the Web tab and how to access those 
properties. Topics include:

● Accessing the advanced properties on page 502.

● Advanced properties on page 502.

● Recommended settings for the advanced properties on page 503.

Accessing the advanced properties

To access the advanced properties on the Web tab of the Configuration Tool:

1. Right-click in an empty space on the Web tab.

2. Check the box next to Show Advanced Properties.

Advanced properties

The following table describes the fields on the Web tab for advanced properties.

Field Description Sample entry

Tomcat JVM 
Options

Available only when you select the following:
● Tomcat Setup: Single
● Configure box for one or more Web 

applications
Entries must use the following format:
-<min_heap> -<max_heap> -<thread_stack>

Default:
-Xms32m -Xmx64m -
Xss64k

Web License 
Manager JVM 
Options

Available only when you select the following:
● Tomcat Setup: Multiple
● Configure Web License Manager
Entries must use the following format:
-<min_heap> -<max_heap> -<thread_stack>

Default:
-Xms32m -Xmx64m -
Xss64k

Letter Generator 
JVM Options

Available only when you select the following:
● Tomcat Setup: Multiple
● Configure Letter Generator
Entries must use the following format:
-<min_heap> -<max_heap> -<thread_stack>

Default:
-Xms32m -Xmx64m -
Xss64k
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Recommended settings for the advanced properties

The recommended tuning parameters in IC Administration Volume 1: Servers & Domains 
also includes some recommended settings for the advanced properties. 

After you install the development Avaya IC system as described in this document:

1. Review those tuning parameters.

2. Verify the expected contact volume in the production system.

3. Test the recommended settings for the tuning parameters to find the optimal settings 
for the production system.

Email Template 
Administration 
JVM Options

Available only when you select the following:
● Tomcat Setup: Multiple
● Configure Email Template Administration
Entries must use the following format:
-<min_heap> -<max_heap> -<thread_stack>

Default:
-Xms32m -Xmx64m -
Xss64k

Website JVM 
Options

Available only when you select the following:
● Tomcat Setup: Multiple
● Configure Website
Entries must use the following format:
-<min_heap> -<max_heap> -<thread_stack>

Default:
-Xms32m -Xmx64m -
Xss64k

ICM JVM Options Available only on Windows, when you select the 
following:
● Tomcat Setup: Multiple
● ICM Service
Entries must use the following format:
-<min_heap> -<max_heap> -<thread_stack>

Default:
-Xms32m -Xmx64m -
Xss64k

CIRS JVM Options Available only when you select the following:
● Tomcat Setup: Multiple
● CIRS Service
Entries must use the following format:
-<min_heap> -<max_heap> -<thread_stack>

Default:
-Xms32m -Xmx64m -
Xss64k

Field Description Sample entry
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Appendix B: Troubleshooting

The following troubleshooting is available for Avaya� Interaction Center (Avaya IC). 
Additional troubleshooting information is available in the documentation for each Avaya IC 
component. If you encounter an issue not in the documentation, contact Avaya CRM 
Technical Support.

● General troubleshooting problems and solutions on page 506.

● Troubleshooting the Configuration Tool on page 508.

● Troubleshooting the Data server on page 509.

● Troubleshooting the Workflow server on page 510.

● Troubleshooting the refresh in IC Manager on page 510.

● Troubleshooting the ICM server on page 511.

● Troubleshooting Web Management on page 516.

● Troubleshooting DataWake on page 522.

● Troubleshooting Outbound Contact Management on page 523.

● Troubleshooting Business Advocate on page 524.

● Troubleshooting Letter Generator on page 526.

● Troubleshooting agent issues on page 527.

● Troubleshooting the secondary ORB configuration on page 529.

● Troubleshooting Avaya FTSE on page 529.

● Troubleshooting Windows configuration on page 536.

● Uninstalling Avaya IC on page 536.

● Uninstalling FTSE on page 541.

Note:
Note: Always consult the log files for information that can assist you in 

troubleshooting the problem. Always retain the relevant log files until you 
have resolved the problem.
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General troubleshooting problems and solutions
The following table contains a series of common problems that can occur during Avaya IC 
installation and configuration. This information is in addition to the more specific 
information in the other topics of this appendix.

Problem Solution

The Avaya IC installation on Solaris does 
not display anything on the monitor or 
stops abruptly.

● Is the DISPLAY property set? 
● Does /var/tmp have sufficient space

The Avaya IC installation on Solaris does 
not display anything on the monitor or 
stops abruptly.

● Is the DISPLAY property set? 
● Does /tmp have sufficient space

Avaya IC requests fail with Timeout 
errors.

If you change the system clock in large increments (over 
2-3 seconds per minute) when IC is running, IC requests 
may fail with "Timeout" errors.
Do not change the system in large increments when IC is 
running. Some commercial time synchronization 
products may provide gradual clock corrections over 
time. We recommend that you take advantage of such 
features if possible. For more information, see IC 
Installation Planning and Prerequisites.

Avaya Agent shows an error when an 
agent logs in.

Did you assign the correct data source for the IC data 
source of the Workflow server that processes events for 
the agent?

Avaya Agent menu leaves blank space on 
Avaya Agent when an agent clicks off the 
menu.

Windows XP Professional does not repaint display 
correctly. 
To repaint and display the missing area:

1. Minimize Avaya Agent.
2. Restore Avaya Agent to full size.

The Start menu for Windows XP 
Professional displays behind Avaya Agent 
if Avaya Agent is set to Always On Top.

Windows XP Professional does not handle Always on 
Top setting correctly.
To view and access the Start menu for Windows XP 
Professional, perform one of the following:
● Minimize Avaya Agent.
● Select the Avaya Agent Start menu and disable 

Always On Top. If you choose this option, you must 
enable Always on Top again, if you do not want other 
applications to open on top of Avaya Agent.
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The ICM server is running, but my 
customer chat cancels out saying that the 
lines are busy.

● The Attribute Server may not have established 
communication properly. Stop and restart the ICM 
server.

● Check the ICM server configuration on the Attribute 
tab of the Attribute server. Make sure that this 
configuration includes the ICM server on the machine 
that hosts the Website where the customer is 
attempting to chat with an agent.

The Web Agent does not appear on the 
agent desktop, even though Avaya Agent 
is running.

● Make sure that the agent desktop knows the location 
of the Paging server. In IC Manager, set the 
Agent/Desktop/WAC/Server property to the fully-
qualified domain name of the machine that hosts the 
Paging server.

The Web Agent appears, but the WACD 
light is green and the IC Email server light 
is Red.

Did you start the WebACD server before the License 
server? If so, the WebACD server cannot access your 
Avaya IC license. Stop and restart the WebACD server.

Shared Browsing with customer does not 
work. Chat applet on Website displays 
error message advising that Java Plugin 
is enabled and requesting that the user to 
disable it for Shared browsing to work 
correctly.

Customer has Sun Java Plug-in enabled. To use Shared 
Browsing with the chat applet, the customer must disable 
the Sun Java Plug-in and enable the Java Virtual 
Machine.

The Alarm Monitor in IC Manager displays 
the following alarm: "Could not resolve 
queue pkey or agent for queuing the 
contact."

The update_qw_cache workflow did not run. 
● In Workflow Designer, build and reload this workflow.
● Confirm that you configured this workflow in the 

synchronous startup flows for the Workflow servers 
that process chat and email contacts. For more 
information, see Creating a Workflow server for Web 
Management on page 274.

The Alarm Monitor in IC Manager displays 
the following alarm: 
"approverqueue@DefaultTenant" may not 
have been created or update_qw_cache 
workflow may not have run.

Either the queue does not exist or you must modify the 
workflow with the correct queue where the email contacts 
for approval have to be routed.
● In IC Manager, confirm that you have created a queue 

where email contacts for approval can be routed. If 
not, create the queue.

● In Workflow Designer, open the Qualify Email 
workflow, confirm that the ApprovalQueueID property 
in the Approval Queue/Agent block includes the ID of 
the email approval queue. Build and reload the 
workflow.

● Confirm that you configured the synchronous startup 
flows for the Workflow servers that process web and 
email contacts. For more information, see Creating a 
Workflow server for Web Management on page 274.

Problem Solution
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Troubleshooting the Configuration Tool
The following table contains problems you may encounter with the Avaya IC Configuration 
Tool.

Problem Recommended Solution

Cannot access the Initial 
Configuration tab again to update or 
change the values chosen to 
configure the server or client 
environment.

To access the Initial Configuration tab after you 
have configured the server or client environment 
on a machine:

1. Rename the vesp.imp file in 
IC_INSTALL_DIR\IC61\etc to 
vesp_old.imp.

2. Open the Configuration Tool.

Apply Settings is not enabled in 
the Configuration Tool.

Make a change to a field in the Configuration Tool. 
Apply Settings should be enabled.
If Apply Settings is still not enabled, close and re-
open the Configuration Tool.

Cannot start a service for a Web 
application with the 
httpserver.sh start script.

The .../HTTPServer/conf.httpd.conf file 
includes multiple instances of ictomcat.cfg. 
Open the file in a text editor and remove the 
multiple entries for ictomcat.cfg. 
Restart the IBM http server with the 
httpserver.sh start script, as described in 
Starting and stopping IBM http Web server on 
page 157.

Some service requests timeout 
without completing. For example, 
the ORB server or Avaya IC ORB 
Service 6.1 do not start 
automatically on a Windows 
machine.

If your Avaya IC system uses Tardis as a time 
synchronization utility, Tardis may make large time 
changes at unpredictable times, instead of gradual 
adjustments. The large changes can cause some 
service requests to time out. For example, the 
ORB server and ORB NT service may not start 
automatically when you restart the machine.
To avoid this timeout problem with Tardis, set the 
time adjustment increments in milliseconds, as 
follows:

1. From the Windows Control Panel, open 
Tardis.

2. Adjust the following settings:
- For Maximum correction allowed, set in 

a range from a minimum of 50 milliseconds 
to a maximum of 500 milliseconds

- For How often the time is set, set to 
Every Minute

For more information, see the Online Help 
provided with Tardis.
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Troubleshooting the Data server
The following table contains a problem you may encounter when you configure the Data 
server.

Problem Description Recommended Solution

IC Manager displays the 
following error message: 
"Cannot find 
implementation".

IC Manager has not 
updated one of the 
following servers with the 
Data server configuration:
● ORB Server
● Directory Server

1. Right-click on the ORB Server.
2. Select Update.
3. Start the Data server.

If you get the same message:
1. Stop and start the Directory Server.
2. Start the Data server.

Note: Never stop and start the ORB 
server in IC Manager.

The Alarm Manager 
displays the following error 
message: "ld.so.1: 
/dbspaces2/subhag/build0
7/Avaya/IC61/bin/qorasrv: 
fatal: libclntsh.so.8.0: open 
failed: No such file or 
directory".

ORACLE_HOME is set to 
the wrong value. 

Use the Configuration Tool to set 
ORACLE_HOME to the correct value.

Data server fails for an 
Avaya IC system that 
includes an Oracle 
database.

Log file for the Data server 
includes the following 
error: 
OCI Error: ORA-04031

Increase the value for the shared pool 
size. The shared pool size is a 
configuration parameter for the Oracle 
database.
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Troubleshooting the Workflow server
The following table contains a problem you may encounter when you configure the 
Workflow server.

Troubleshooting the refresh in IC Manager
If you do not receive a Success message after you select Manager > Refresh in IC 
Manager, perform the following steps to troubleshoot the problem. Attempt to refresh the 
Directory server after each step.

1. Stop and then restart the Directory server.

2. If you still do not receive a Success message, stop and then restart the Data server. 

3. If you still do not receive a Success message, check the connections to the database. 

4. If you still do not receive a Success message, exit IC Manager, then log back in.

Problem Description Recommended Solution

Workflow server cannot 
assign to another Avaya IC 
server. For example, the 
Workflow server cannot 
assign to an ADU server.

● The channel 
configuration of the 
Workflow server is set to 
"Server type".

● The name of the second 
Avaya IC server is 
identical to the server 
type.

1. Rename the other server, following 
the Server naming guidelines on 
page 128.

2. Restart the Workflow server.
3. Verify that the Workflow server can 

assign to the other server.
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Troubleshooting the ICM server
The following table contains some problems you may encounter with the ICM server.

Problem Description Recommended Solution

Chat failure - 
Applet Download

This problem can display several 
symptoms, including:
● When you initiate a chat session 

from the Website, the Chat applet 
does not download. 

● Chat applet window shows HTTP 
404 error.

● In Web browser, the following URL 
gives a 404 error 
http://<server_name>/icm/
blank.html.

You must configure the Chat applet 
download virtual directory on the 
Website:

1. Re-run the Configuration Tool 
on the machine that hosts the 
ICM server. 

2. In the Web tab:
- From the Configuration Type 

drop-down list, select 
Everything or External Web 
Server.

- Check the ICM Service box.
- For Windows, in the IIS 

Default Site type the name of 
the IIS Web Site where you 
want to configure the chat 
download directory. 

- For Solaris, in the Web Server 
Name field, type the name of 
Sun ONE web server where 
you want to configure the chat 
download directory. 

- For Sun ONE server, make 
sure the Web Server Home 
field includes the root 
installation directory of the 
Web server.

- Select Apply Settings.

Chat failure -
Connections

This problem can display several 
symptoms, including:
● When you initiate a Chat contact 

from the Website, Chat applet 
displays connection failure 
message such as "Error in 
connecting to server".

● icmlog.txt file includes a Java 
Bind Exception for the Caller Port 
(9502), Agent Port (9501), or ICM 
Bridge Port (9503).

● Avaya Agent displays error 
message when trying to connect to 
ICM server.

The ICM server is not running.
Start the ICM server:
● For Windows, from the Services 

Control Panel, start Avaya IC ICM 
Service 6.1

● For Solaris, run the following shell 
script: ../bin/icm.sh

● For AIX, run the following shell 
script: ../bin/icm.sh
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Chat failure - Login 
Connections

This problem can display several 
symptoms, including:
● ICM server is running but cannot 

log into Avaya IC core servers.
● icmlog.txt file may include the 

following repeated message: 
initToolkit@IcmParmMgr - 
Error: Toolkit Login Failed

ICM server may have an invalid login 
in the systemParms.txt file or the 
Toolkit environment may not be 
properly configured.

1. Verify that AVAYA_IC_HOME 
system variable is set to 
<install_dir>\IC61.

2. Verify that the Avaya IC core 
servers are up and running.

3. Verify that the vesp.imp 
configuration file is up-to-date in 
the 
IC_INSTALL_DIR\IC61\etc 
directory. 

4. If necessary, re-run the 
Configuration Tool on the 
machine that hosts the ICM 
server, making sure that the IC 
Login and IC Password fields 
contain valid information.

5. Restart the ICM server:
- For Windows, from the 

Services Control Panel, start 
Avaya IC ICM Service 6.1

- For Solaris, run the following 
shell script: ../bin/icm.sh

- For AIX, run the following shell 
script: ../bin/icm.sh

Chat failure -
Connections

This problem can display several 
symptoms, including:
● ICM server is running but is unable 

to bind to its service ports (9501-
9520). Another server is using 
these ports.

● ICM server or another java process 
may have been started while 
another ICM server was running 
(either as a Windows service or 
Java application). 

To resolve this problem:
1. Stop all instances of the ICM 

service or icm java application 
(javaw.exe). 
Note: Be careful terminating the 
ICM java applications. You must 
determine which javaw.exe 
process represents the ICM.

2. Restart the ICM server:
- For Windows, from the 

Services Control Panel, start 
Avaya IC ICM Service 6.1

- For Solaris, run the following 
shell script: ../bin/icm.sh

- For AIX, run the following shell 
script: ../bin/icm.sh

3. Reconfigure the ICM ports as 
described in Changing the 
default ICM service ports on 
page 35. Then restart the ICM 
server.

Problem Description Recommended Solution
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Chat failure - No 
Resources

This problem can display several 
symptoms, including:
● When you initiate a chat session 

from the Website, the Chat applet 
displays an establishing connection 
message then hangs.

● Chat applet displays an 
establishing connection message, 
then displays "Missing Phrase" 
repeatedly.

● The <icm_name>_website.log file 
contains error messages indicating 
a problem with the PDM.

The ICM server is running but cannot 
read the configuration data from 
database due to PDM initialization 
failure or PDM query error. 
The PDM file may not be properly 
configured, the database login 
credentials may be incorrect, 
database client software may be 
improperly configured, or the Data 
server or Database server may be 
down.

To resolve this problem:
● Verify that the Data server is 

running.
● Verify that the Database server is 

running:
- For SQL Server, verify that the 

SQL Server DSNs are 
configured correctly and that 
the Database application is 
running.

- For Oracle, verify that the 
Oracle client software is 
installed and that the Oracle 
Service Name is correctly 
configured on the client.

- For DB2, verify that the DB2 
client software is installed.

● Restart the Tomcat server that 
hosts your Website application, as 
described in Starting and stopping 
Avaya IC services on page 154:

If these do not resolve the problem:
● Re-run the Configuration Tool on 

the machine that hosts the ICM 
server with the following 
information In the Web tab:

- Make sure the IC Login and 
IC Password fields contain a 
valid Avaya IC login and 
password.

- Make sure the Database 
Login and Database 
Password fields contain a 
valid database login and 
password. Type a DBA login 
ID for the database server. Do 
not use the DBA login for a 
database client.

- Check Configure Website.
- Select Apply Settings.

Problem Description Recommended Solution



Troubleshooting

514 Installation and Configuration

Chat failure - 
System Out of 
Service

● When you initiate a chat session 
from the Website, the Chat applet 
displays a message stating that the 
server connection is established, 
then displays a "System is Out of 
Service" message.

● icmlog.txt file contains an "Agent 
Router Not Ready" error.

● The Alarm Monitor in IC Manager 
displays an "Error calling WACD 
Assign" alarm.

The ICM server is running, but the 
ICM Bridge in the Attribute server, or 
the WebACD server is not available.
● In IC Manager, start the Attribute 

server. The Attribute Server will 
attempt to start the WebACD 
server.

ICM server is running but the ICM 
Bridge has not been configured to 
connect to the ICM.
● See Creating the Attribute 

server on page 252.
ICM, Attribute, and WebACD servers 
are running and the ICM Bridge has 
been configured, but the ICM Bridge 
cannot login, or can log-in but cannot 
connect to the WebACD. 
● See Creating the Attribute 

server on page 252.
● Verify that the IC Login name and 

password in the ICM Bridge are 
valid. Re-type password if 
necessary.

● Verify that the IC Login is in the 
same Avaya IC domain as the 
WebACD server. 
If the IC Domain is different and 
cannot be changed, make sure the 
domain of the WebACD server is in 
the failover path domain of the IC 
Login.

Transcript failure - 
Transcript not sent

Transcripts from completed chats are 
not sent to callers.

The default SMTP server for the 
transcripts has not been set.
● Set the SMTP Host parameter of 

the ICM server. See Configuring 
the ICM server on page 282.

● Restart the ICM server:
- For Windows, from the 

Services Control Panel, start 
Avaya IC ICM Service 6.1

- For Solaris, run the following 
shell script: ../bin/icm.sh

- For AIX, run the following shell 
script: ../bin/icm.sh

Problem Description Recommended Solution
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Understanding ICM server configuration files
The ICM server uses the configuration files in the following table.

Understanding ICM server log files
The ICM server uses the log files in the following table.

File Name File Location Description

systemParms.txt IC_INSTALL_DIR\IC61\etc\s
ystemParms.txt

The ICM server uses this bootstrap file 
to log into Avaya IC Core servers. Use 
the Configuration Tool to update this file.

pdm.xml IC_INSTALL_DIR\IC61\etc\p
dm.xml

This property configuration database 
access file contains database and Data 
server configuration information. Use the 
Configuration Tool to update this file.

cirssystemParms.txt IC_INSTALL_DIR\IC61\etc\c
irssystemParms.txt

The CIRS server uses this bootstrap file 
to log into Avaya IC Core servers. Use 
the Configuration Tool to update this file.

vesp.imp
vespidl.pk

IC_INSTALL_DIR\IC61\etc\v
esp.imp
IC_INSTALL_DIR\IC61\etc\v
espidl.pk

Avaya IC server configuration files. The 
machine that hosts the ICM server must 
have copies of these files.

File Name File Location Description

icmlog.txt IC_INSTALL_DIR\IC61\logs\
icmlog.txt

This file is the main log file for the ICM 
server. This file contains server and 
connectivity status and call events.

icmlog.txt - 
icmlocalparms.txt

IC_INSTALL_DIR\IC61\logs\
icmlog.txt - 
icmlocalparms.txt

This file is a temporary log file used by 
the ICM server. Do not edit this file.

<icm>_website.log IC_INSTALL_DIR\IC61\logs\
icm_website.log

This file is the main log file for the 
Website.
<icm> is the value of the dsObjectName 
property in the systemParms.txt file.

<icm>_*.log IC_INSTALL_DIR\IC61\logs\
icm_*.log

All other log files generated by the 
integration of the ICM server and the 
Avaya IC servers.
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Troubleshooting Web Management
This section includes the following topics:

● Troubleshooting Website pages on page 516

● Troubleshooting Web Management integration on page 519

● Understanding Web Management configuration files on page 521

● Understanding Web Management log files on page 521

Troubleshooting Website pages
The following table contains some problems you may encounter with Website pages.

Problem Description Recommended Solution

Cannot Access 
Pages

See an error in browser, such as Host 
Name Not Resolved or Cannot Find 
Server.

Confirm the following:
● Web server has started. Restart 

Web server, such as IIS, Sun ONE 
server or IBM http server.

● Tomcat servers have started. See 
Starting and stopping Avaya IC 
services on page 154.

● Verify that the password you used 
for the IC Password field of the 
Configuration Tool when you 
configured the Website has not 
expired. See Configuring Web 
Management services on 
page 257.
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Cannot Access 
Pages

Browser is having DNS problems 
resolving location of web server.

To resolve this problem:
1. Test for DNS issues by trying to 

access the home page of the 
Web server at the following 
URL:
http://<server>.<domain>.com

2. Test for DNS issues by trying to 
access home page of Web 
server with its IP address:
http://123.123.123.123

3. Follow the instructions in IC 
Installation Planning and 
Prerequisites for configuring 
DNS resolution.

● Check to see if your Web browser 
proxy settings are interfering with 
host name resolution.

● Consult your Network Administrator 
about the DNS resolution of the 
Web server.

Cannot Access 
Pages

● Website did not initialize properly 
and has redirected browser to 
invalid URL.

● URL in Web browser contains the 
word "null"

● website.log file contains PDM 
error messages

The PDM file may not be properly 
configured, the database login 
credentials may be incorrect, 
database client software may be 
improperly configured, or the Data 
server or Database server may be 
down.
See Chat failure - No Resources on 
page 513 for solutions.

Public Website - 
Blank start page

● Trying to access the public website 
shows a blank start page containing 
just the Avaya logo.

● Web browser displays a 
"website.pages.startpage" 
metadata error.

● Web browser displays a 
"website.pages.public" metadata 
error.st

● Web browser displays a null pointer 
exception error message.

PDM file is not properly configured or 
database services are unavailable. 
See Chat failure - No Resources on 
page 513 for solutions.

Public Website ● Website application is running but 
cannot login to Avaya IC core 
servers.

● website.log file may contain 
repeated login failed exception.

● website.log may contain 
repeated "Retry Toolkit Login after 
60 seconds ..." message.

See Chat failure - Login 
Connections on page 512 for solution.

Problem Description Recommended Solution
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Customer 
Management 
Failure

You get repeated generic error 
messages when you:
● Add a customer from the Web 

Management Public Website 
● Manage Customer accounts from 

the Multi Tenancy Administration 
Web pages

Workflow server is not running or is 
not available:
● Start the Workflow server in IC 

Manager
● Verify that the Workflow server is in 

the same Avaya IC domain as the 
IC Login used by the Web 
Management application.

This Login is the one that was 
entered in the IC Login field of the 
Configuration Tool. See the 
dsLogin parameter of the following 
file:

IC_INSTALL_DIR\IC61\comp\web
site\WEB-INF\web.xml
● If Workflow server is in a different 

domain from the IC Login, make 
sure the Workflow server domain is 
in the failover path of the IC Login 
domain.

Web Management Customer 
Management Workflows have not 
been loaded
● Build and load the Customer 

Management Workflows in the 
webcenter project. For more 
information, see Using workflows 
for Web Management on page 277.

● Restart the Workflow server in IC 
Manager.

Problem Description Recommended Solution
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Troubleshooting Web Management integration
The following table contains some problems you may encounter with Web Management 
integration.

Problem Description Recommended Solution

IC Manager and 
Web Management 
Integration

You see an error message indicating 
that an authentication key could not 
be retrieved when you select one of 
the following options from the 
Services menu in IC Manager:
● WebACD
● Web Response Unit (Self-Service)
● Multi-tenant Administration

You have not configured IC Manager 
to access Web Management:
● Repeat the steps in Integrating 

Web Management 
Administration on page 272.

Web Management is not running:
● Restart the Tomcat server that 

hosts your Website application. For 
more information, see Starting and 
stopping Avaya IC services on 
page 154.

Your administrative login for IC 
Manager has just has to reset its 
password:
● Restart IC Manager.

IC Manager and 
Web Management 
Integration

Your Web browser is not opened 
when you select one of the following 
options from the Services menu in IC 
Manager:
● WebACD
● Web Response Unit (Self-Service)
● Multi-tenant Administration

Configure IC Manager for your Web 
browser:

1. In IC Manager, select Manager 
> Options.

2. Select the Environment tab.
3. Select the Ellipsis (�) button 

next to the Browser field.
4. Select Select from List.
5. Select Search Filesystem.
6. Select the drive where the 

browser is installed. Select OK.
7. After the search is complete, 

select the Web browser from the 
list. Select OK.

8. Select OK.
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IC Manager and 
Web Management 
Integration

Your Web browser displays a 
message stating that there was an 
internal error, when you select 
Services > WebACD in IC Manager.

The domain of the URL used to 
access the WebACD server is 
different from the domain expected by 
the WebAdmin plugin.
● In IC Manager, verify that the 

following properties are the same:
- System/Configuration - 

ChatLoginServer
- WebACD server - WACD Web 

Server
- Configuration Tool - Web 

Server Host and Web Server 
Domain

● If ChatLoginServer is different: 
- Type the correct value
- Select Manager > Refresh

● If WACD Web Server is different:
- Type the correct value
- Restart the Tomcat server that 

hosts your Website 
application. For more 
information, see Starting and 
stopping Avaya IC services on 
page 154.

- Restart the WebACD server in 
IC Manager

● If the Configuration Tool values are 
different:

- Rerun the Configuration Tool 
with the correct values

- Restart the Tomcat server that 
hosts your Website 
application. For more 
information, see Starting and 
stopping Avaya IC services on 
page 154.

- Restart your Web server (IIS 
or iPlanet)

Problem Description Recommended Solution
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Understanding Web Management configuration files
Web Management uses the configuration files in the following table.

Understanding Web Management log files
Web Management uses the log files in the following table.

File Name File Location Description

web.xml IC_INSTALL_DIR\IC61\comp\
website\WEB-INF\web.xml

Web Management uses this Servlet API 
application startup file as a bootstrap file 
to log into the Avaya IC core servers. 
Use the Configuration Tool to update this 
file.

pdm.xml IC_INSTALL_DIR\IC61\etc\p
dm.xml

This property configuration database 
access file contains database and Data 
server configuration information. Use the 
Configuration Tool to update this file.

vesp.imp
vespidl.pk

IC_INSTALL_DIR\IC61\etc\v
esp.imp
IC_INSTALL_DIR\IC61\etc\v
espidl.pk

Avaya IC server configuration files. The 
machine that hosts Web Management 
must have copies of these files.

local.properties IC_INSTALL_DIR\IC61\serve
rs\
IC_INSTALL_DIR/IC61/local
.properties

This configuration file contains the 
definition of the Website application, 
including the Classpath and JNI path 
settings.

File Name File Location Description

<website>.log IC_INSTALL_DIR\IC61\logs\
website.log

This file is the main property 
configuration log file for Web 
Management. 
<website> is the value of the 
dsObjectName property in the web.xml 
file.

<website>_*.log IC_INSTALL_DIR\IC61\logs\
website_*.
log

All other log files generated by the 
integration of the ICM server and the 
Avaya IC servers.
<website> is the value of the 
dsObjectName property in the web.xml 
file.



Troubleshooting

522 Installation and Configuration

Troubleshooting DataWake
The following table contains a problem you may encounter with the DataWake feature of 
Web Self-Service.

Problem Description Recommended Solution

Administrator or agent 
does not see any 
Datawake records for a 
customer in Web Self-
Service.

The Configuration Tool did 
not insert the Datawake 
Sensor filter into IIS when 
you created the Website.

The connector filter for the Website 
Tomcat server is either not present or is a 
global filter. Datawake requires that the 
connector filter be a local filter.

To add the local filter to IIS:
1. In Internet Services Manager, right-

click on the Web Service where you 
installed the filter for the Website 
and select Properties.

2. Select the ISAPI Filters tab.
3. If there is no dwsensor filter listed or 

the filter has a red arrow to the left:
- Select Add.
- Type dwsensor in Filter Name 

field.
- Type the following directory and 

file name in the Executable field.
IC_INSTALL_DIR\IC61\bin\dws
ensor.dll

- Select OK.
4. Select OK in the ISAPI Filters tab.
5. In the Windows Services control 

panel, stop and restart the World 
Wide Web Publishing Service.



Troubleshooting Outbound Contact Management

Issue 2.0 June 2004 523

Troubleshooting Outbound Contact Management
The following table contains problems you may encounter with Outbound Contact 
Management (Outbound Contact). Further information about Outbound Contact is 
available in IC Administration Volume 2: Agents, Customers, & Queues and Configuring 
Outbound Contact on page 219.

.

Problem Description Recommended Solution

Cannot do one of the 
following:
● Delete numbers that 

were imported from an 
Import List.

● Load a calling list into 
Outbound Contact.

Outbound Contact may 
timeout when accessing 
the database under the 
following conditions:
● The calling list is very 

large.
● In the Outbound Contact 

Calling List window, you 
selected a field name in 
the Order by group box.

You might receive an error, 
such as "A database error 
occurred."
You can view the timeout 
messages in the import 
and Data server logs.

To increase the timeout value in Database 
Designer:

1. In Database Designer, select File > 
Open and open the following ADL: 
IC_INSTALL_DIR\IC61\design
\SoftDialer\dialer.adl

2. In the tree pane, expand 
Components > Physical DB 
Connections and select 
dialerDBConnectionSet.

3. Type a larger number in the 
Timeout field in the right pane.

4. Select File > Save to save the file.
5. Select File > Generate Windows 

Application.
6. In the Generate Windows 

Application dialog box, Select OK.
7. Select File > Exit.
8. Exit from the following 

Administration tools:
- Outbound Contact
- IC Manager

9. Open IC Manager and Outbound 
Contact and delete the numbers.

If necessary, repeat these steps to 
increase the Timeout value again.
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Troubleshooting Business Advocate
The following table contains problems you may encounter with Business Advocate 
components. Further information about Business Advocate is available in Installing 
Business Advocate components on page 419 and IC Business Advocate Configuration 
and Administration.

.

Cannot access Outbound 
Contact Supervisor from IC 
Manager. 

IC Manager toolbar does 
not include Supervisor.

Perform the following steps to add a 
button for Supervisor.

1. In IC Manager, select Tools > 
Customize.

2. Select New in the Customize 
dialog box.

3. Select Java Frame from the drop-
down list.

4. Do not check Add to tab panel.
5. Type Supervisor in the Name field.
6. Type the following string in the 

Class field:
com.avaya.superdesktop.UI.
TeCISupervisorDeskTop

7. Select OK.

Problem Description Recommended Solution

Problem Description Recommended Solution

Unable to install 
Resource Manager 
because DTC access 
is not enabled.

Business Advocate installer 
displays the following error:
"The installation process has 
detected that your Microsoft 
Distributed Transaction Coordinator 
(DTC) service is not configured to 
access the network."

When you use Add/Remove 
programs to configure the application 
server role, instead of the Manage 
Your Server wizard, Windows Server 
2003 does not enable DTC access.
In Add/Remove programs, use 
Add/Remove Windows components 
and services to enable DTC access.
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Unable to install 
Resource Manager.

Business Advocate installer 
displays one or both of the following 
error messages:
● Debug Assertion Failed!
● EvtQmaker.exe encountered a 

problem and needed to close.

1. Restart the machine.
2. Verify the DNS settings on the 

machine. Make sure that the 
first DNS suffix is the same as 
the domain of the machine or 
that the suffix field is empty.

3. Correct the DNS settings, if 
necessary.

4. Restart the machine.
5. Restart the Business Advocate 

installation.

Error received from 
Microsoft Message 
Queueing Service 
(MSMQ). WARNING: 
Resource Manager 
won't be notified 
about administrative 
changes until the 
problem is corrected.

Resource Manager cannot access 
MSMQ during start up, and 
generates a High alarm in the 
Alarm Monitor of IC Manager. 
This error message occurs when 
MSMQ is in an indeterminate state.
This error message signifies a 
known problem with MSMQ, and 
does not signify a problem with 
Business Advocate or Avaya IC.

1. Uninstall MSMQ.
2. Reinstall MSMQ.
3. Configure MSMQ.
4. Restart all machines that host 

Resource Manager servers. 
For more information about how to 
install and configure MSMQ, see IC 
Installation Planning and 
Prerequisites.
If this solution does not work:

1. Remove the machine from the 
active directory domain.

2. Re-assign the machine to the 
active directory domain.

Note: According to Microsoft, this 
problem will be resolved in Service 
Pack 1 of Windows Server 2003. To 
resolve this issue, install Service Pack 
1 when it becomes available.

Problem Description Recommended Solution



Troubleshooting

526 Installation and Configuration

Troubleshooting Letter Generator
The following table contains problems you may encounter with Letter Generator and Batch 
Administrator. Further information about Letter Generator is available in Business 
Application Tools Reference.

.

Problem Description Recommended Solution

Unable to process a frozen 
batch in the Batch 
Administrator.

The pdfsvcport setting in 
the docgen.properties file 
is incorrect.

Configure the pdfsvcport property in the 
docgen.properties file to the same as the 
web server port used by the Letter 
Generator Web application. For example, 
if the Letter Generator Web application 
uses 9605 for the web server port, then 
set the "pdfsvcport" to 9605.

Unable to create a 
Template Pack.

Internet Explorer settings 
are incorrect.

1. In Internet Explorer, select Tools > 
Internet Options.

2. Select the Advanced tab.
3. Clear the following box: Display a 

notification about every script error
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Troubleshooting agent issues
The following table contains problems you may encounter when you configure agent 
desktop applications. Further troubleshooting information for agent configurations is 
available in Avaya Agent Integrator�s Guide.

Problem Description Recommended Solution

Agent desktop applications 
do not start.

Avaya Agent displays the 
following message after 
login attempt: Avaya Agent 
Agent layout not found.

In IC Manager, check the following 
configuration property for the individual 
agent or for the group:
Agent/Desktop/Layout
The value of this property must be set to 
the name of the Avaya Agent layout file, 
without the CDL extension. For example, 
if your Avaya IC system includes the 
default English Avaya Agent layout, type 
avaya_agent_en.

Machine that hosts Avaya 
Agent or another Avaya IC 
agent desktop application 
has a power failure while 
application was running.
When power is restored, 
the agent receives an error 
attempting to log back in.

Avaya IC agent desktop 
application displays an 
error message, such as 
"The Object has 
disconnected from its 
clients".

This error can occur if the script cache 
(.sch) file on the agent machine has been 
corrupted.
Delete the script cache files on the agent 
machine from all Avaya IC directories. 
When the agent logs back in, Avaya IC 
automatically recreates the script cache 
files. 

Avaya Agent fails. Agent 
can log back in to email 
channel and chat channel. 
Agent cannot log back in to 
voice channel.

Avaya Agent displays 
license error when 
attempting to log back in to 
voice channel. 

To log in to the voice channel, agent can 
do one of the following:
● Login through Softphone
● Log out of Avaya Agent, then log back 

in again.

Avaya Agent fails requiring 
you to use Windows Task 
Manager to shutdown the 
application. Subsequent 
login attempts fail.

Avaya Agent displays a 
Login Failed message 
when an agent tries to 
login.

When Avaya Agent fails, the VTel 
application for Telephony continues to run 
in the background. You must shutdown 
the VTel application:

1. In Windows Task Manager, select 
the Processes tab.

2. Find the vtel.exe process. 
3. Select Shutdown.

You cannot enable the 
Email channel in Avaya 
Agent.

WebACD server is not 
properly configured for 
Email Management.

Add the configuration parameter 
emailservername to the WebACD server. 
For more information, see Configuring the 
WebACD server for Email 
Management on page 345.
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Web Agent does not open 
with Avaya Agent on the 
agent desktop.

Agent/Desktop/WAC/
Server property is not 
properly configured.

Confirm that the Agent/Desktop/WAC/
Server property is set correctly:

1. In IC Manager, select Tools > 
Groups.

2. Select the Properties tab.
3. Select the IC node in the left pane.
4. In the Sections list, select 

Agent/Desktop/WAC.
5. Select the Server property and set 

it to the fully-qualified domain name 
of the machine that hosts the 
Paging server.

6. Select Apply. 
7. Select OK.

Agent gets an error while 
launching a Voice Chat 
contact from text chat.

Agent sees an error 
message, such as "No 
Destination No default".
Alarm Monitor in IC 
Manager displays an 
alarm, such as: 
"QWorkflow.WriteEDU 
error gives "NO VduID" 
and QWorkflow.FetchEDU 
gives "No EDU"

This error occurs if the agent or customer 
have been idle in the chat for longer than 
the length of time set in the No User 
Interval field on the ADU tab of the ADU 
server.
To resolve the immediate issue, the agent 
should:

1. Wrap up the chat contact.
2. Initiate a new contact with the 

customer.
If one or more agents frequently 
encounter this problem:

1. In IC Manager, double-click the 
ADU server for the agents who 
perform voice chats. 

2. Select the ADU tab.
3. Increase the number of seconds in 

the No User Interval field. 
Avaya recommends that you first increase 
the interval to 300 seconds. You can 
increase the interval further, if required.

Agent receives an error 
when transferring a contact 
to another agent. Agent 
may see an error such as 
"Error occurred while 
searching the selected 
Object. Please select new 
object and consult the 
administrator."

Virtual queue is visible and 
appears available for 
transfers in Unified Agent 
Directory. However the 
queue cache on the 
Workflow server that runs 
workflows for the Unified 
Agent Directory was not 
updated when a new 
queue was created. 

To allow agents to transfer contacts to a 
new virtual queue, do one of the following 
for every Workflow server in a user 
domains that runs workflows for the 
Unified Agent Directory:
● Manually run the 

sys_transfer.update_vq_cache 
workflow

● Restart each Workflow server

Problem Description Recommended Solution
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Troubleshooting the secondary ORB configuration
The following table contains a common problem you may see with a secondary ORB 
server.

Troubleshooting Avaya FTSE
This section includes information about troubleshooting problems that you may encounter 
when you configure Avaya FTSE. This section includes the following topics:

● Troubleshooting FTSE installation on AIX on page 530.

● Troubleshooting full text searches on page 530.

● Troubleshooting Web Self-Service configuration on page 531.

● Troubleshooting Web Self-Service pages on page 533.

● Troubleshooting QKnowledge on page 533.

Problem Description Recommended Solution

Configuration tool displays 
the following message, 
"Failed to load vesp.imp"

N/A To resolve this problem, try the following 
solutions, then re-run the Configuration 
Tool:
● Ensure the IC Login and Password are 

correct
● Make sure the ORB port matches the 

port of the ORB server on the primary 
machine

● Make sure you can "ping" the primary 
hostname

● Make sure that you called configure 
from the Start menu or from within the 
working directory of 
IC_INSTALL_DIR\IC61\bin. 

● If none of the above solutions work:
- From 
IC_INSTALL_DIR\IC61\bin 
run configure -d

- Contact Avaya CRM Technical 
Support and provide the following 
logs: General.log, 
General_Admin.log, and 
Admin.log
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Troubleshooting FTSE installation on AIX
The following table contains some problems you may encounter with Web Self-Service 
pages.

Troubleshooting full text searches
The following table includes some of the messages and errors that you might see when 
you configure full-text searches. These messages can occur on any operating system. 

Problem Description Recommended Solution

Cannot run 
configftse.

If the machine does not have fonts 
compatible with the EN_US locale, 
you will get an error that says "Cannot 
create fontset" and configftse will fail 
to run from the bin directory.

To run configftse on AIX:
1. Navigate to 

IC_INSTALL_DIR/IC61/lib 
2. Execute the following 

command: 
export 
AVAYA_IC61_HOME=<path 
to Avaya home> 

3. Execute the following 
command: 
./configftse

Message Description

The object, "w_qw_wru_view", 
already exists in database.

You can ignore this message. 
This message does not indicate that you have 
encountered a problem with the configuration.
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Troubleshooting Web Self-Service configuration
This section includes the following topics, which assist you to troubleshoot and verify the 
Web Self-Service configuration:

● Verifying the Web Self-Service configuration on Microsoft Windows on page 531.

● Verifying the Web Self-Service configuration on Sun Solaris on page 532.

● Verifying the Web Self-Service configuration on IBM AIX on page 532.

Verifying the Web Self-Service configuration on Microsoft Windows

If any of the following configuration settings are not present, or are invalid, re-run the 
configuration of Web Self-Service, as described in Running the Web Self-Service 
Configuration Tool on page 409.

To verify the Web Self-Service configuration:

1. In Windows ODBC Administration, verify that the following system DSN was 
successfully created: ICWRU

2. In a text editor, such as Notepad, verify the Web Self-Service settings in the pdm.xml 
file:

a. Open the following file: IC_INSTALL_DIR\IC61\etc\pdm.xml

b. Find the section between the following headings: 
<QE name="fulcrum"> ... </QE>

c. Make sure that this section is not commented out.

ERROR at line 1:
ORA-00955: name is already used 
by an existing object

You can ignore this error. This message indicates 
that the view already exists.

execsql: execute failed 
SQLSTATE: SGS00, Native error: 
0, error text 
[Hummingbird][SearchServer]
Invalid table name

You may see this error message twice in 
fulcrum.err. This error occurs because the script 
is attempting to drop a table that does not yet 
exist. 
You can ignore this error when you run the 
fulcrum_setup command for the first time on a 
machine. However, if you receive this error when 
you repeat the command on a machine, 
investigate why the script cannot access the 
database to perform the following tasks:
● unprotect table qw_wru_en
● drop table qw_wru_en

Message Description
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3. In a text editor, such as Notepad, verify the database settings in the ec56.did file:

a. Open the following file: IC_INSTALL_DIR\IC61\etc\wru_sql\ec56.did

b. Find the entries for the database user name and password.

c. Confirm that these entries are valid.

Verifying the Web Self-Service configuration on Sun Solaris

To verify the Web Self-Service configuration:

1. Verify the database settings in the ec56.did file:

a. Open the following file: IC_INSTALL_DIR\IC61\etc\wru_sql\ec56.did

b. Find the entries for the database user name and password.

c. Confirm that these entries are valid.

2. Verify that the following script was created in IC_INSTALL_DIR/IC61/bin: 
fulcrumenv.sh

Verifying the Web Self-Service configuration on IBM AIX

To verify the Web Self-Service configuration:

1. Verify that the following files were successfully created in 
IC_INSTALL_DIR\IC61\etc\wru_sql

● ODBC.ini

● wru_createview.sql

2. Verify that the fulcrumenv.sh script was created in IC_INSTALL_DIR/IC61/bin.
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Troubleshooting Web Self-Service pages
The following table contains some problems you may encounter with Web Self-Service 
pages.

Troubleshooting QKnowledge
This section includes information about troubleshooting QKnowledge. This section 
includes the following topics:

● Verifying the QKnowledge configuration on page 534.

● Troubleshooting QKnowledge Web application on page 534.

Problem Description Recommended Solution

Web Self-Service 
Failure (FAQ)

● Web Self-Service Management 
fails when trying to submit, update, 
or delete documents

● See generic error message when 
trying to search FAQs

● See PDM errors in website.log 
when you search, submit, update, 
or delete documents

You have not configured Search 
Server integration correctly:
● Repeat steps to configure Web 

Self-Service.
● Restart the ICM server:

- For Microsoft Windows, from 
the Services Control Panel, 
start Avaya IC ICM Service 6.1

- For Sun Solaris, run the 
following shell script: 
../bin/icm.sh

- For IBM AIX, run the following 
shell script: ../bin/icm.sh

Web Management database access 
manager (PDM) has lost database 
connectivity:
● Verify that the Data server is 

running.
● Verify that the Database server for 

the RDBMS is running.
● Restart the Tomcat server that 

hosts your Website application. For 
more information, see IC 
Installation and Configuration.
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Verifying the QKnowledge configuration

If QKnowledge does not function correctly, verify that the following occurred during the 
QKnowledge configuration. 

1. In Windows ODBC Administration, verify that the following system DSN was 
successfully created: QKnowledge_60

2. In the Windows Services control panel, verify that the following Windows service was 
successfully created: Avaya IC Knowledgebase Service 6.1

3. In Windows Explorer, verify that the user has read and write permissions for the 
following folder and all contents: IC_INSTALL_DIR\IC61\fulcrum\bin

Troubleshooting QKnowledge Web application

The following table contains common problems you may see with the QKnowledge Web 
application.

Problem Description Recommended Solution

Web browser displays an 
Unresolved Host Name 
message.

Cannot open QKnowledge 
in a Web browser with the 
following URL: 
http://<machine_name
>:<port>/qk/qk.htm

If your contact center uses a proxy server 
or enhanced security for Internet Explorer, 
verify that the address for the 
QKnowledge Web application is included 
in the browser exception list and the 
acceptable Web addresses list. 
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Web browser displays a 
blank page or one of the 
following messages:
● Page cannot be found
● Unresolved host name

Cannot open QKnowledge 
in a Web browser with the 
following URL: 
http://<machine_name
>:<port>/qk/qk.htm

On the machine that hosts IIS:
1. In Internet Services Manager, right-

click on the Web Service where you 
installed the Web application for 
QKnowledge.

2. Select Properties.
3. Select the ISAPI Filters tab.
4. Delete the filters.
5. In the Windows Services control 

panel, stop and restart the World 
Wide Web Publishing Service.

On the machine that hosts QKnowledge:
● Re-run the Configuration Tool to 

configure the QKnowledge Web 
application.

On the machine that hosts IIS:
1. In Internet Services Manager, right-

click on the Web Service where you 
installed the Web application for 
QKnowledge.

2. Select Properties.
3. Select the ISAPI Filters tab.
4. Confirm that the following ISAPI 

filters were added:
- dwsensor � C:\ Program 

Files\Avaya\IC61\bin\dwsenso.dll
- WebAdmin � C:\Program 

Files\Avaya\comp\icws\isplugin.dl
- AICJakartaFilter � C:\Program 

Files\Avaya\IC61\tomcat\modules\
isapi_redirect.dll

5. If the filters are not there, add them 
manually.

6. In the Windows Services control 
panel, stop and restart the World 
Wide Web Publishing Service.

7. Stop and restart the QKnowledge 
service.

Problem Description Recommended Solution
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Troubleshooting Windows configuration
You can receive an Out of Disk Space error even if the target drive is not full. If you install 
Avaya IC on a drive other than C:\, Avaya IC uses the C:\Temp directory for staging the 
installation files.

To resolve this issue:

● Free up space on the C:\ drive

● Changing the machine�s TEMP environment variable to point to a folder on another 
drive

For more information, see the Windows documentation provided by Microsoft.

Uninstalling Avaya IC
If you must uninstall Avaya IC from a machine, perform the following steps to ensure that 
all services, files, and related components are removed.

1. Uninstalling Avaya IC components for Windows on page 536.

2. Uninstalling Avaya IC servers for Solaris and AIX on page 537.

3. Uninstalling Web server components on page 538.

4. Uninstalling Business Advocate on page 538.

5. Uninstalling related third-party components on page 539.

6. Uninstalling Avaya IC agent desktop applications on page 540.

Uninstalling Avaya IC components for Windows
Perform these steps to uninstall Design & Administration Tools and any Avaya IC servers 
that you host on Windows machines.

Note:
Note: The Avaya IC uninstaller occasionally does not remove all entries to the 

Windows registry. After you uninstall an Avaya IC component from a 
Windows machine, remove any remaining entries from the Windows 
Registry.
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To uninstall Avaya IC components on Windows:

1. In IC Manager, select Server > Shutdown to stop all Avaya IC servers on the 
machine.

2. Close all Avaya IC applications on the target machine.

3. Stop the following services:

● Avaya IC ORB Service 6.1
● Avaya Voice Media Manager
● Avaya IC ICM Service
● Avaya IC CIRS Service
● All Tomcat services
● Web server service (for example, World Wide Web Publishing for IIS)

4. In the Windows Control Panel:

a. Open Add/ Remove Programs.

b. Select Avaya Interaction Center 6.1.

c. Select Change/Remove to start the Avaya IC Uninstaller.

Follow the prompts in the Avaya IC Uninstaller to uninstall Avaya IC services, delete 
registry settings, and remove files that are not in use. 

5. In the Windows Control Panel, delete the Avaya IC environment variable:

a. Double-click System.

b. On the Advanced tab, select Environment Variables.

c. Select the Avaya IC environment variable in the System Variables box.

d. Select Delete.

e. Select OK.

6. Delete the remaining folders and files in the IC_INSTALL_DIR\IC61\ directory.

7. Delete all shortcuts that you added to the desktop.

8. Open the Windows Registry and confirm that all Avaya IC entries have been removed.

9. Continue with Uninstalling Web server components on page 538 without restarting the 
target machine.

Uninstalling Avaya IC servers for Solaris and AIX
You do not need to perform these steps if you host your servers on Windows machines.

To uninstall Avaya IC servers on Solaris:

1. Close all Avaya IC applications on the target machine.
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2. In a command window on the target machine, stop the Avaya IC servers as described 
in Stopping all servers with the Avaya IC Admin utility on page 153.

3. In a command window on the target machine, stop the Avaya IC services as described 
in Starting and stopping services on Solaris and AIX on page 155.

4. Remove all Avaya IC commands that you added to the UNIX startup script.

5. Delete the Avaya IC root directory.

6. Continue with Uninstalling Web server components on page 538 without restarting the 
target machine.

Uninstalling Web server components
Perform these steps if the target machine includes a Web server. 

If the target machine does not include Web server components, continue with one of the 
following procedures:

● Uninstalling Business Advocate on page 538.

● Uninstalling related third-party components on page 539. 

To uninstall Web server components:

1. For Tomcat, perform the following steps:

a. Delete all Tomcat servers that you created to host Web applications, such as the 
Website and WebLM.

b. Uninstall Tomcat, if desired.

2. For the Web server, perform the following steps: 

a. Remove the virtual directories from your Web site.

b. If your Web server is IIS:

● Right-click on the Web site and select Properties. 

● Select the ISAPI Filters tab and remove the dwsensor and Jakarta Connector 
filters.

Uninstalling Business Advocate
For an Avaya IC system which includes Business Advocate, you must uninstall the 
Business Advocate components separately. Perform these steps for each machine that 
hosts Resource Manager servers and other Business Advocate components.

If the target machine does not include Business Advocate components, continue with 
Uninstalling related third-party components on page 539.
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To uninstall Business Advocate:

1. If you have not already done so, in IC Manager, stop all Resource Manager servers 
and other Business Advocate on the machine.

2. Close all Business Advocate applications on the target machine.

3. In the Windows Control Panel:

a. Open Add/ Remove Programs.

b. Select Avaya Business Advocate version 2.0.

c. Select Change/Remove to start the Business Advocate Uninstaller.

Follow the prompts in the Business Advocate Uninstaller to uninstall services, delete 
registry settings, and remove files that are not in use. 

4. Re-start the target machine.

5. Log back into the machine and delete the remaining folders and all files in those 
folders:

● C:\Program Files\Avaya\Avaya Business Advocate
● C:\nethome

6. Delete all shortcuts that you added to the desktop.

7. Continue with Uninstalling related third-party components on page 539 without 
restarting the target machine.

8. Re-start the target machine.

! Important:! Important:
Important: Do not re-install or upgrade Business Advocate components without re-

starting the Business Advocate machines.

Uninstalling related third-party components
Perform these steps to complete your uninstallation.

To uninstall related third-party components:

1. Uninstall all related third-party components that you installed on the target machine.

For information on uninstallation procedures, see the manufacturer�s documentation.

2. If the target machine has a Windows operating system, navigate to c:\WINNT\Temp 
and delete all numbered _istmp directories.

3. Restart the target machine.
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Uninstalling Avaya IC agent desktop applications
Perform these steps to uninstall Avaya IC agent desktop applications.

Note:
Note: The Avaya IC agent application uninstaller does not always remove all 

entries to the Windows registry. The remaining entries in the Windows 
Registry will not block functionality for other applications on the machine.

To uninstall Avaya IC agent desktop applications.

1. Close all Avaya IC applications on the target machine.

2. In the Windows Control Panel:

a. Open Add/ Remove Programs.

b. Select Avaya Interaction Center 6.1.

c. Select Change/Remove to start the Avaya IC Uninstaller.

Follow the prompts in the Avaya IC Uninstaller to uninstall Avaya IC services, delete 
registry settings, and remove files that are not in use. 

3. In the Windows Control Panel, delete the Avaya IC environment variable:

a. Double-click System.

b. On the Advanced tab, select Environment Variables.

c. Select the Avaya IC environment variable in the System Variables box.

d. Select Delete.

e. Select OK.

4. For the ...\Backup directory that was created by the agent installer:

a. Review the files in the directory.

b. Confirm that the System32 files are not required by another application. 

c. Restore any files required by another application.

d. Delete the directory.

5. Delete any remaining folders and files in the IC_INSTALL_DIR\IC61\ directory.

6. Delete all shortcuts that you added to the desktop.
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Uninstalling FTSE
If you need to uninstall Avaya FTSE from a machine, perform the following steps to ensure 
that all services, files, and related components are removed.

1. Uninstalling Avaya IC components for Windows on page 536.

2. Uninstalling Avaya IC servers for Solaris and AIX on page 537.

Uninstalling Avaya FTSE components for Windows
Perform these steps to if you host Avaya FTSE on Windows machines.

Note:
Note: The Avaya FTSE uninstaller occasionally does not remove all entries to the 

Windows registry. After you uninstall an Avaya IC component from a 
Windows machine, you may need to manually remove any remaining entries 
from the Windows Registry.

To uninstall Avaya FTSE components on Windows:

1. In IC Manager, select Server > Shutdown to stop all Avaya IC servers on the 
machine.

2. Close all Avaya IC and Avaya FTSE applications on the target machine.

3. Stop the following services:

● IC Knowledgebase Service 6.1
● AIC FTSE Connector v1.0
● AIC FTSE Connector v1.0 Manager
● AIC FTSE for Java v1.0
● AIC FTSE STR Service v1.0
● Web server service (for example, World Wide Web Publishing for IIS)

4. In the Windows Control Panel:

a. Open Add/ Remove Programs.

b. Select Avaya FTSE.

c. Select Change/Remove to start the Uninstaller.

Follow the prompts in the Uninstaller to uninstall Avaya FTSE services, delete registry 
settings, and remove files that are not in use. 

5. If no other Avaya IC components are hosted on the machine, in the Windows Control 
Panel, delete the Avaya IC environment variable:

a. Double-click System.
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b. On the Advanced tab, select Environment Variables.

c. Select the Avaya IC environment variable in the System Variables box.

d. Select Delete.

e. Select OK.

6. Delete the remaining folders and files for Avaya FTSE in the 
IC_INSTALL_DIR\IC61\ directory.

7. For Tomcat, perform the following steps:

a. Delete all Tomcat servers that you created to host Web applications, such as the 
Website and WebLM.

b. Uninstall Tomcat, if desired.

8. For the Web server, perform the following steps: 

a. Right-click on the Web site and select Properties. 

b. Select the ISAPI Filters tab and remove the dwsensor and Jakarta Connector 
filters.

9. Delete all shortcuts that you added to the desktop.

10. Open the Windows Registry and confirm that all Avaya FTSE entries have been 
removed.

Uninstalling Avaya FTSE components for Solaris and AIX
To uninstall Avaya FTSE components on Solaris:

1. Close all Avaya IC and Avaya FTSE applications on the target machine.

2. In a command window on the target machine, stop the Avaya IC servers as described 
in Stopping all servers with the Avaya IC Admin utility on page 153.

3. In a command window on the target machine, stop the Avaya IC services as described 
in Starting and stopping services on Solaris and AIX on page 155.

4. For Tomcat, perform the following steps:

a. Delete all Tomcat servers that you created to host Web applications, such as the 
Website and WebLM.

b. Uninstall Tomcat, if desired.

5. Remove all Avaya FTSE commands that you added to the UNIX startup script.

6. Delete the Avaya IC root directory.
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Appendix C: Configuring a localized version

To configure a localized version of Avaya IC, perform the steps in the following topics 
during the installation:

● Specifying the NLS Lang property for Oracle on page 544.

● Enabling Database Designer for localization on page 545.

● Configuring Avaya Agent for a supported language on page 548.

● Configuring Avaya Agent for multiple languages on page 549.

● Importing localized seed data on page 550.

● Configuring the Website for supported languages on page 550.

● Setting language properties for agents on page 551.

● Customizing a localized Business Application on page 552 (optional).

● Configuring a Notification server for alternate email encodings on page 560.

● Configuring an HTTP Connector server for Traditional Chinese on page 561.

Note:
Note: Some menu items in Avaya IC 6.1.1 applications are not completely 

localized. These items display in English. For example, you may see English 
in some secondary built in forms and menu items, and on OK and Cancel 
buttons on some dialog boxes.
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Specifying the NLS Lang property for Oracle
If your Avaya IC system includes an Oracle database, you must specify the NLS Lang 
property on the Initial Config tab of the Configuration Tool when you configure a primary 
or secondary server environment.

This section includes the following topics:

● About the NLS Lang property on page 544.

● Where Oracle specifies the NLS Lang property on page 544.

● Cautions for the NLS Lang property on page 544.

● NLS Lang settings for supported languages on page 545.

For more information, see the Oracle documentation.

About the NLS Lang property
Oracle uses National Language Support (NLS LANG) values to set up language-specific 
databases. The character set part of the NLS_LANG parameter specifies the character set 
used by the Data server.

Where Oracle specifies the NLS Lang property
On Solaris, NLS_LANG is specified as an environment variable.

On Windows, NLS_LANG is set in the registry under the following:

HKEY_LOCAL_MACHINE > SOFTWARE > ORACLE > HOMEn

Cautions for the NLS Lang property
Do not use abbreviations in the NLS LANG parameter. For example, do not use "US" to 
designate American English. You must use AMERICAN_AMERICA.UTF8.

The character set in the NLS LANG parameter must match the character set of your Oracle 
database. If these character sets are different, strange character conversions and string 
truncations may result.
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NLS Lang settings for supported languages
The following table includes the NLS Lang settings for the languages supported in this 
Avaya IC release.

Enabling Database Designer for localization
To use Database Designer with languages other than English, you must add a Localization 
section to the Database Designer INI file (qdesigner.ini). This section identifies the 
character encoding that you are using for translations in your locale.

When you open an ADL file for localization, your Database Designer INI file must contain a 
Localization section with character encoding that matches the language in the localized 
design. 

The Localization section includes the following:

● ISO-639-1 (alpha 2) two letter language abbreviations

● Character encoding used in the output generated by Database Designer

Language NLS Lang Setting

English AMERICAN_AMERICA.UTF8

Spanish SPANISH_SPAIN.UTF8

German GERMAN_GERMANY.UTF8

French FRENCH_FRANCE.UTF8

Italian ITALIAN_ITALY.UTF8

Portuguese BRAZILIAN PORTUGUESE_BRAZIL.UTF8

Simplified Chinese SIMPLIFIED CHINESE_CHINA.UTF8

Korean KOREAN_KOREA.UTF8

Japanese JAPANESE_JAPAN.UTF8

Thai THAI_THAILAND.UTF8

Traditional Chinese TRADITIONAL CHINESE_TAIWAN.UTF8
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The two letter language abbreviation also identifies the language in all language-specific 
files. For more information about the names of language-specific files, see Translating 
string table messages on page 553.

Note:
Note: Do not use the Localization node to customize CallCenterQ in English, as 

this can cause serious problems with migration in the future.

To enable localization in Database Designer:

1. With Database Designer closed, open the Database Designer INI file 
(qdesigner.ini) in Notepad or another text editor.

The Database Designer INI file is installed in the Windows directory. For example, in 
machines using Windows, the Windows directory is typically C:\winnt. 

2. Add a Localization section at the end of the INI file, including values for 
TargetLanguage and TargetEncoding fields to match the desired locale using the 
information in the following table:

Language Language Code Localization Section Update

English en [Localization]
;English
TargetLanguage=en
TargetEncoding=windows-1252

Spanish es [Localization]
;Spanish
TargetLanguage=es
TargetEncoding=windows-1252

German de [Localization]
;German
TargetLanguage=de
TargetEncoding=windows-1252

French fr [Localization]
;French
TargetLanguage=fr
TargetEncoding=windows-1252

Italian it [Localization]
;Italian
TargetLanguage=it
TargetEncoding=windows-1252

Portuguese pt [Localization]
;Portuguese
TargetLanguage=pt
TargetEncoding=windows-1252
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3. Save the INI file.

4. Close the text editor.

Simplified Chinese zh [Localization]
;Simplified Chinese
TargetLanguage=zh
TargetEncoding=gb2312

Korean ko [Localization]
;Korean
TargetLanguage=ko
TargetEncoding=korean

Japanese ja [Localization]
;Japanese
TargetLanguage=ja
TargetEncoding=shift_jis

Thai th [Localization]
;Thai
TargetLanguage=th 
TargetEncoding=windows-874

Traditional Chinese zt [Localization]
;Traditional Chinese 
TargetLanguage=zt 
TargetEncoding=Big5

Language Language Code Localization Section Update
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Configuring Avaya Agent for a supported language
The steps in this section include a summary of the steps in Creating installation files for 
agent applications on page 355.

! CAUTION:
CAUTION: Before you or an agent runs the Agent Installer on an agent desktop 

machine, confirm that there are no Avaya IC agent desktop applications or 
qui.exe processes running on the agent machine. The Agent Installer may 
stop responding or pause indefinitely if an agent desktop or qui.exe 
process is still running.

To configure Avaya Agent for a non-English language:

1. When you generate your agent desktop application (as discussed in Generating the 
Interaction Center application on page 109), you must:

a. Check the Help box and select a help file for the appropriate language.

b. Check the Avaya Agent Layout box and select an Avaya Agent Layout for the 
appropriate language.

c. Check the EDU Layout box and select an EDU Layout for the appropriate 
language.

If you do not know the directory path, select the Ellipsis (�) button and navigate to 
the directory.

Note:
Note: The Avaya IC 6.1.1 CD-ROM does not include translated help files for 

CallCenterQ or Avaya Agent in the supported non-English languages. The 
English help files have been placed on the CD as placeholders for the 
translated help files. When the translated help files are available, you will be 
able to download them from the CRM Technical Support Web site at 
http://www.avaya.com/support/qq. 

2. To create and run the Agent Installer, follow the instructions in Creating installation files 
for agent applications on page 355.

Note:
Note: If you plan to replace the English help files with translated help files when 

they become available, choose Yes to Automatic Updates when you create 
the Agent Installer.

http://www.avaya.com/support/qq
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3. The Avaya IC 6.1 agent installer includes English resource files. To add the resource 
files for a supported non-English language, install an Agent Language Pack:

● To install the Agent Language Pack on a single agent machine, run the following 
command from the Avaya IC 6.1 CD 1: 
<cd-rom_dir>\Agent\LangPack\LangPack.exe

● To deploy the Agent Language Pack on all agent machines, follow the instructions 
for Language Pack Updates in Configuring automatic updates for agent 
applications on page 376.

When you run the Agent Installer, the installer checks for an existing Avaya IC 6.1 
installation. If there is an Avaya IC 6.1 installation, a message box asks you if it is okay 
to continue.

Configuring Avaya Agent for multiple languages
If your Avaya IC systems requires that Avaya Agent run in multiple languages, you must 
store the messages for each language in the database. Perform these steps after you 
generate the CallCenterQ application for the first language.

To configure Avaya Agent for multiple languages:

1. Close Database Designer if you have it open. 

2. Update the [Localization] section of the Database Designer INI file for the new 
language.

For more information, see Enabling Database Designer for localization on page 545.

3. In Database Designer, open the CallCenterQ ADL file.

4. Select File > Generate Windows Application.

5. In the Generate Windows Application dialog box:

a. Check the Messages box only.

b. Check the Avaya Agent Layout box and select an Avaya Agent Layout for the 
appropriate language.

c. Check the EDU Layout box and select an EDU Layout for the appropriate 
language.

If you do not know the directory path, select the Ellipsis (�) button and navigate to 
the directory.

d. Select OK.

Repeat these steps for each additional language.



Configuring a localized version

550 Installation and Configuration

Importing localized seed data
The localized seed data allows your Avaya IC system to have localized interfaces for the 
Website, the ICM caller applet, and the Voice Chat interfaces. You perform these steps on 
the machine that hosts Database Designer.

To install the localized seed data:

1. In Notepad or another text editor, open the following file: 
IC_INSTALL_DIR\IC61\design\CallCenterQ\data\seed_L10N.cfg

2. Find the DestinationPasswd field and verify that the value is the correct password for 
the Admin account.

3. Save the seed_L10N.cfg file.

4. Open a command window.

5. Navigate to IC_INSTALL_DIR\IC61\design\CallCenterQ\data

6. Run the following file to import the localized seed data: import_seed_L10N.bat

Configuring the Website for supported languages
To configure your Website for supported languages:

1. In IC Manager, select Services > MultiTenancy Administration.

2. Select Define Languages from the Tenants Admin menu.

3. In the Properties box:

a. Select a language code.

For both Simplified Chinese and Traditional Chinese, select zh.

b. Assign a country code:

● For Traditional Chinese, select TW.

● For all other languages, leave the country code blank.

c. Type a default description.

d. Type a default display name.

e. Select Add Language.

4. In the Enable Languages page, select a tenant.
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5. Select Customize Tenant Languages:

a. Check the Enabled box to allow the tenant to use the new language.

By default, all languages are enabled in the default tenant.

b. Select a default language for the tenant.

If Avaya IC cannot find a property for a supported language, Avaya IC will use the 
default language. English is always the default language for the default tenant.

Setting language properties for agents
When you configure the language for an agent, you specify the language that the agent 
desktop applications use, including Web Agent and Avaya Agent. Web Agent obtains the 
language setting from Avaya Agent. You do not need to configure the language for Web 
Agent separately.

To configure the language for an agent:

1. In IC Manager, select the Agent tab and double-click the agent in the list of agents.

2. Select the Properties tab.

3. Select Agent in the Sections list.

4. Select Add Property.

5. From the Property drop-down list, select UILanguage.

6. From the Property Value drop-down list, select one of the following values:

Value Language

de German

en English

es Spanish

fr French

it Italian

ja Japanese

ko Korean

pt Portuguese

th Thai
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7. Select OK. 

8. Select Apply.

You can define the language for all agents by modifying the Global Properties for all 
agents. For more information, see Setting global properties for all agents on page 389.

Customizing a localized Business Application
With Database Designer�s localization node, you can customize CallCenterQ in all 
supported languages. In addition to the ADL, ADC, and ADF files, localization uses the 
following unique application design files to generate a localized application.

With localization enabled, you can use Database Designer to translate the following 
components from US English:

● String table entries, such as error messages and confirmation messages in IC Scripts

● Form titles

● Group labels

● Object labels 

● Search browser column labels

● In-form browser column labels

● Enumeration field labels

zh Simplified Chinese

zt Traditional Chinese
Note: zt is a non-standard two letter language code that 
certain components of Avaya IC use differentiate between 
Traditional Chinese and Simplified Chinese.

Value Language

File Description

ALF (Application Language 
Forms)

Translated form definitions, including forms, groups, 
and objects.

ALM (Application Language 
Messages)

Translated string table entries, including error 
messages and warnings in IC Scripts.
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Localizing the money field
You can localize the Currency symbol used in fields with a data type of money. For 
example, you can change the currency symbol from $. For more information, see IC 
Database Designer User Guide.

To change the value of the currency symbol:

1. Select Edit > Localize Money Fields.

2. Type the desired values in the following fields:

● Money Symbol

● Scale

3. Select OK.

Translating string table messages
Database Designer stores the error and confirmation messages that form the string table 
entries in a message file. The message file name uses the naming convention: 
<app>_<lang>.alm, where <app> is your Business Application, and <lang> is the 
ISO-639-1 two letter abbreviation for the language used in your string table entries. The 
table below includes the names of the ALM and ALF files for each supported language.

Note:
Note: Avaya IC does not support the Business Applications in Traditional Chinese. 

Information about Traditional Chinese is provided as part of the ALM file is 
used by the Interaction Center application and data source.

Language ALM File Name ALF File Name

English ccq.alm ccq_en.alf

Spanish ccq_es.alm ccq_es.alf

German ccq_de.alm ccq_de.alf

French ccq_fr.alm ccq_fr.alf

Italian ccq_it.alm ccq_it.alf

Portuguese ccq_pt.alm ccq_pt.alf

Simplified Chinese ccq_zh.alm ccq_zh.alf

Korean ccq_ko.alm ccq_ko.alf
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When you configure your database and generate your application, Database Designer 
uploads the message file to the database.

You can add, delete, and edit messages and their translations in the String Table 
Properties tab. 

To translate string table messages:

1. Under the Localization placeholder, select String Table in the tree view.

The String Table Properties tab opens and displays all available string table 
messages.

2. In the String Table Properties tab, select the message to be translated.

3. Select the message text in the String Text column.

4. Delete the message text and type in the translation.

5. Select File > Save to save the ADL file with the localized string table entries and 
generate the ALM file.

Deleting string table messages

If you delete a string table message that is connected to a form, the Avaya Business 
Application will not be able to display the message to the user. 

To delete a string table message.

1. In the String Table Properties tab, select the message to be deleted.

2. Select Delete.

Japanese ccq_ja.alm ccq_ja.alf

Thai ccq_th.alm ccq_th.alf

Traditional Chinese ccq_zt.alm ccq_zt.alf

Language ALM File Name ALF File Name
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Translating forms
Forms are organized by type of data (such as calls or customers) and by specific task 
(such as data entry and data management). A form contains one or more groups. Each 
group contains one or more objects. 

The objects appear to an application user as fields, text boxes, combo boxes, and buttons 
within a group in a form. For more information about how forms work in an application, see 
the IC Database Designer User Guide or the Database Designer online help.

You can translate the following within a form: 

● Translating form titles. Identify the type of data or activity in the workflow that the user 
can perform with the form. 

● Translating group labels. Identify the tasks the user needs to perform to complete the 
workflow. 

● Translating object labels. Identify the steps within the tasks, and the type of data that the 
user can review, edit, or add to the database with the object.

Translated titles and labels can be longer or shorter than the US English versions provided 
with the out-of-the-box application. After you localize the form, open the Layout Editor from 
the localized form and make the necessary adjustments to the Adjusting the form layout 
required by the translated object labels. 

The language you use to translate titles and labels must be the same language you 
entered in the INI file when you enabled localization. If the Localization placeholder does 
not appear in the Database Designer tree view, you must enable localization as described 
in Enabling Database Designer for localization on page 545).

Translating form titles

The form title identifies the contents of a form and appears on a button above the browser 
section. We recommend that the form title reflect the workflow in the form.

To translate a form title:

1. Under the Localization placeholder, double-click Forms in the tree view.

2. Select the form to be translated to open the Form Properties tab.

3. Type the translation of the title in the Translated text box.

4. Select File > Save.
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Translating group labels

The group label identifies the contents of a group and is displayed in a form in:

● The heading for the group

● The tab for the associated browser.

The group label usually reflects the name of the group�s anchor table alias. For more 
information about how groups work in an application, see the IC Database Designer User 
Guide or the Database Designer online help.

To translate a group label:

1. Under the Localization placeholder, double-click the desired form to view a list of the 
groups.

2. Select the group to open the Group Properties tab.

3. Type the translation of the title in the Translated text box.

4. Select File > Save.

Translating object labels

The object label identifies the contents of the object. For most objects, the label text 
appears to the left of the object in the application interface. For more information about the 
types of objects, their data types, and how they work in an application, see the IC 
Database Designer User Guide.

You can translate the labels for all objects in a group, including text boxes, long text fields, 
date/time widgets, buttons, and right-click menu options.

To translate an object label:

1. Under the Localization placeholder, double-click the desired form to view a list of the 
groups.

2. Select the group that contains the objects to be translated to open the Group 
Properties tab.

3. In the Object Properties group, select in the Translated Caption column for the 
object to be translated, delete the existing text and type the translation.

4. When you have finished localizing the objects, select File > Save.

Adjusting the form layout

Translated titles and labels are frequently longer than the US English versions provided 
with the out-of-the-box application. Database Designer automatically adjusts:

● Size of the buttons above the search browser to the length of the form title

● Space needed for the group label.
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However, Database Designer does not automatically update the layout of objects or the 
size of button objects to compensate for longer, translated words. 

Note:
Note: What you see in the Layout Editor is not identical to the layout of the 

generated Windows application. The size, spacing, and positions of some 
groups and controls might change in the generated application. Also, when 
you double-click a caption, the Layout Editor displays the text in English, not 
the translated text strings in the Localization node.

To update the form layout for translated labels:

1. Under the Localization placeholder, select the translated form.

2. Select Edit > Form Layout to open the Layout Editor with the translated labels.

You must open the Layout Editor from the translated form under the Localization 
placeholder to access the translated title and labels.

3. In the Layout Editor, you can change:

● Spacing between objects

● Location of objects on the form

● Size of the control for an object label.

For specific instructions on using the Layout Editor to customize the appearance of your 
translated form, see IC Database Designer User Guide.

Translating search browsers
When a user performs a search in a Business Application, the search browser returns the 
results in the columns of the search browser. The browser displays the results in the same 
language that they were saved in the database.

You can localize the labels that appear at the top of search browser columns by translating 
them in Database Designer.

To translate a search browser column label:

1. Under the Localization placeholder, select the desired search browser to display the 
Browser Properties tab.

2. In the Columns list box, click in the Translated Label column for the column to be 
translated, delete the existing text and type the translation.

3. When you have finished localizing the column labels, select File > Save.
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Translating in-form browsers
In-Form Browsers (IFBs) are displayed within a group as a table with editable columns and 
summary rows. Depending on the IFB, the columns display either information retrieved 
from the database table or information entered by the application user. 

You can localize column and row labels of IFBs by translating them in Database Designer:

● Column labels

● Summary column labels

● Summary row labels.

You localize the IFB labels in the In-Form Browser Properties tab, accessed by selecting 
the IFB below the Localization placeholder.

Translating in-form browser column labels

IFB column labels identify the information displayed in each column. The columns can 
include search results for a field from the browser�s anchor table alias and one or more 
foreign fields, or information entered by the user.

To translate IFB column labels:

1. Under the Localization placeholder, select the desired IFB to display the In-Form 
Browser Properties tab.

2. In the Columns list box, click in the Translated Label column for the column to be 
translated, delete the existing text and type the translation.

3. When you have finished localizing the column labels, select File > Save.

Translating in-form browser summary column labels

IFB summary columns display the subtotal for a single column of an IFB. The application 
uses the formula you enter through Database Designer to total up the amounts in the 
column. The summary column label identifies the contents of the summary field. 

To translate IFB summary column labels:

1. Under the Localization placeholder, select the desired IFB to display the In-Form 
Browser Properties tab.

2. In the Summary Columns list box, click in the Translated Label column for the 
column to be translated, delete the existing text and type the translation.

3. When you have finished localizing the summary column labels, select File > Save.



Customizing a localized Business Application

Issue 2.0 June 2004 559

Translating in-Form browser summary row labels

Summary rows are displayed in the browser one above another at the bottom of an IFB. 
The IFB calculates the values of summary rows from the formula specified in the IFB 
properties through Database Designer. Summary rows can be:

● Visible. For example, a Tax summary row where the total tax is calculated from the 
values in the visible Cost column.

● Invisible. For example, a Tax summary row where the total tax is calculated from a sum 
of individual taxes in an invisible Tax column associated with the IFB.

To translate IFB summary row labels:

1. Under the Localization placeholder, select the desired IFB to display the In-Form 
Browser Properties tab.

2. In the Row Summary list box, click in the Translated Label column for the summary 
row label to be translated, delete the existing text and type the translation.

3. When you have finished localizing the summary row labels, select File > Save.

Translating enumeration field labels
Enumeration fields display data in combo boxes with a drop-down list. An agent can select 
a value for the field from a fixed list of alphanumeric values, such as Red, Yellow, or Blue. 

To translate enumeration field labels:

1. Under the Localization placeholder, select the desired table to display the list of tables.

2. Select the field to open the Field Properties tab.

3. In the Enum Values list box, double-click in the Translated Caption column for the 
enumeration field label that you want to translate. 

4. Delete the existing text and type the translation.

5. When you have finished localizing the enumeration field labels, select File > Save.
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Configuring a Notification server for alternate email 
encodings

The Notification server uses a default Microsoft Windows codepage value for the outgoing 
email charset. You can override this value on the Configuration tab of the Notification 
server in IC Manager.

For example, if your Avaya IC system includes a supported language, such as Traditional 
Chinese, which is not available in the Language drop-down list, you need to configure the 
alternate email encoding for that language.

Note:
Note: The following instructions use Traditional Chinese email encodings as an 

example.

To configure a Notification server for alternate email encodings:

1. In IC Manager, double-click the Notification server in the lists of servers.

2. Select the Configuration tab.

3. Select New.

4. In the CTI Type Editor dialog box:

a. Complete the fields as shown in the following table:

b. Select OK.

5. Select OK.

6. Stop and restart the Notification server.

Field Recommended entry

CTI Type Couple

Name charset
This field is case-sensitive.

Value EmailCharset
where EmailCharset is the character set for the 
supported language. For example, type iso-2022-jp for 
Japanese or Big5 for Traditional Chinese.
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Configuring an HTTP Connector server for 
Traditional Chinese

To configure an HTTP Connector server for Traditional Chinese:

1. In IC Manager, double-click the HTTP Connector server in the lists of servers.

2. Select the Configuration tab.

3. Select New.

4. In the CTI Type Editor dialog box:

a. Complete the fields as shown in the following table:

b. Select OK.

5. Select OK.

6. Stop and restart the HTTP Connector server.

Field Recommended entry

CTI Type Couple

Name charsetmap
This field is case-sensitive.

Value Big5:Big5
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